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Safety Instructions 
 

Before using the product … 

 

For your safety and effective operation, please read the safety instructions 

thoroughly before using the product. 

 

► Safety Instructions should always be observed in order to prevent accident 

or risk with the safe and proper use the product. 

 

► Instructions are divided into “Warning” and “Caution”, and the meaning of 

the terms is as follows. 

 

This symbol indicates the possibility of serious injury 

or death if some applicable instruction is violated  

 

This symbol indicates the possibility of severe or 

slight injury, and property damages if some 

applicable instruction is violated 

 

Moreover, even classified events under its caution category may develop into 

serious accidents relying on situations. Therefore we strongly advise users to 

observe all precautions properly just like warnings. 

 

► The marks displayed on the product and in the user’s manual have the 

following meanings. 

Be careful! Danger may be expected. 

Be careful! Electric shock may occur. 

 

► The user’s manual even after read shall be kept available and accessible to 

 any user of the product. 

Warning 

Caution 
    



 

Safety Instructions 
 

Safety Instructions for design process 
 

 

 

 

 

 

 

 

 

 

 

 Please install a protection circuit on the exterior of PLC so that the  

whole system may operate safely regardless of failures from  

external power or PLC. Any abnormal output or operation from PLC 

may cause serious problems to safety in whole system.  

- Install protection units on the exterior of PLC like an interlock circuit 

that deals with opposite operations such as emergency stop, 

protection circuit, and forward/reverse rotation or install an interlock 

circuit that deals with high/low limit under its position controls. 

- If any system error (watch-dog timer error, module installation error, 

etc.) is detected during CPU operation in PLC, all output signals are 

designed to be turned off and stopped for safety. However, there 

are cases when output signals remain active due to device failures 

in Relay and TR which can’t be detected. Thus, you are 

recommended to install an addition circuit to monitor the output 

status for those critical outputs which may cause significant 

problems.  

 

 Never overload more than rated current of output module nor  

allow to have a short circuit. Over current for a long period time may 

cause a fire . 

 

 Never let the external power of the output circuit to be on earlier  

than PLC power, which may cause accidents from abnormal output or 

operation. 

 

 Please install interlock circuits in the sequence program for safe 

operations in the system when exchange data with PLC or modify 

operation modes using a computer or other external equipments 

Read specific instructions thoroughly when conducting control 

operations with PLC.  

Warning 



 

Safety Instructions 
 

Safety Instructions for design process 
 

 

 

 

 

 

 

 

Safety Instructions on installation process 

 I/O signal or communication line shall be wired at least 100mm 

 away from a high-voltage cable or power line. Fail to follow this 

 instruction may cause malfunctions from noise 

Caution 
    

 Use PLC only in the environment specified in PLC manual or 

general standard of data sheet. If not, electric shock, fire, abnormal 

operation of the product may be caused. 

 

 Before install or remove the module, be sure PLC power is off. If 

not, electric shock or damage on the product may be caused. 

 

 Be sure that every module is securely attached after adding a 

module or an extension connector. If the product is installed 

loosely or incorrectly, abnormal operation, error or dropping may be 

caused. In addition, contact failures under poor cable installation will 

be causing malfunctions as well. 

 

 Be sure that screws get tighten securely under vibrating 

environments. Fail to do so will put the product under direct 

vibrations which will cause electric shock, fire and abnormal 

operation. 

 

 Do not come in contact with conducting parts in each module, 

which may cause electric shock, malfunctions or abnormal operation. 

Caution 
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Safety Instructions for wiring process 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Prior to wiring works, make sure that every power is turned off. If 

not, electric shock or damage on the product may be caused. 

 

 After wiring process is done, make sure that terminal covers are 

installed properly before its use. Fail to install the cover may cause 

electric shocks. 

Warning 

 Check rated voltages and terminal arrangements in each product 

prior to its wiring process. Applying incorrect voltages other than 

rated voltages and misarrangement among terminals may cause fire 

or malfunctions. 

 

 Secure terminal screws tightly applying with specified torque. If 

the screws get loose, short circuit, fire or abnormal operation may be 

caused. Securing screws too tightly will cause damages to the module 

or malfunctions, short circuit, and dropping. 

* 

 Be sure to earth to the ground using Class 3 wires for FG 

terminals which is exclusively used for PLC. If the terminals not 

grounded correctly, abnormal operation or electric shock may be 

caused. 

 

 Don’t let any foreign materials such as wiring waste inside the 

module while wiring, which may cause fire, damage on the product 

or abnormal operation. 

 

 Make sure that pressed terminals get tighten following the 

specified torque. External connector type shall be pressed or 

soldered using proper equipments.  

 

Caution 
    



 

Safety Instructions 
 

Safety Instructions for test-operation and 
maintenance 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 Don’t touch the terminal when powered. Electric shock or abnormal 

operation may occur. 

 

 Prior to cleaning or tightening the terminal screws, let all the 

external power off including PLC power. If not, electric shock or 

abnormal operation may occur. 

 

 Don’t let the battery recharged, disassembled, heated, short or 

soldered. Heat, explosion or ignition may cause injuries or fire. 

Warning 

 Do not make modifications or disassemble each module. Fire, 

electric shock or abnormal operation may occur. 

  Prior to installing or disassembling the module, let all the 

external power off including PLC power. If not, electric shock or 

abnormal operation may occur. 

 Keep any wireless equipment such as walkie-talkie or cell phones 

at least 30cm away from PLC. If not, abnormal operation may be 

caused. 

 When making a modification on programs or using run to modify 

functions under PLC operations, read and comprehend all 

contents in the manual fully. Mismanagement will cause damages to 

products and accidents. 

 Avoid any physical impact to the battery and prevent it from 

dropping as well. Damages to battery may cause leakage from its 

fluid. When battery was dropped or exposed under strong impact, 

never reuse the battery again. Moreover skilled workers are needed 

when exchanging batteries.  

Caution 
    



 

Safety Instructions 
 

 

Safety Instructions for waste disposal 

 

 

 

 

 

 

 Product or battery waste shall be processed as industrial waste. 

The waste may discharge toxic materials or explode itself. 

Caution 
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About User’s Manual 

 

Thank you for purchasing PLC of LSIS Co., Ltd. 

Before use, make sure to carefully read and understand the User’s Manual about the functions, 

performances, installation and programming of the product you purchased in order for correct use and 

importantly, let the end user and maintenance administrator to be provided with the User’s Manual.  

The User’s Manual describes the product. If necessary, you may refer to the following description and order 

accordingly. In addition, you may connect our website(http://eng.lsis.biz/) and download the information as a 

PDF file.  

Relevant User’s Manuals 

Title Description 
No. of User’s 

Manual 

XG5000 user’s 

manual 

It describes how to use XG5000 software about online functions 

such as programming, printing, monitoring and debugging by 

using XGB series products. 

10310000512 

XG5000 user’s 

manual (for 

XGI/XGR/XEC) 

It describes how to use XG5000 software about online functions 

such as programming, printing, monitoring and debugging by 

using XGB (IEC language) 

10310000834 

XGK/XGB 

Instructions & 

Programming 

It is the user’s manual for programming to explain how to use 

commands that are used PLC system with XGB CPU. 

10310000510 

XGI/XGR/XEC 

Instructions & 

Programming 

It is the user’s manual for programming to explain how to use 

commands that are used in XGB (IEC language) 

10310000833 

XGB hardware 
It describes power, IO, extension specification and system 

configuration, built-in high speed counter of XGB main unit.  

10310000693 

XGB hardware (IEC) 
It describes power, IO, extension specification and system 

configuration, built-in high speed counter of XGB (IEC) main unit. 

10310000983 

XGB Analog 

user’s manual 

It describes how to use the specification of analog input/analog 

output/temperature input module, system configuration and built-in 

PID control for XGB basic unit. 

10310000920 

XGB Position 

User’s manual 

It describes how to use the specification of analog input/analog 

output/temperature input module, system configuration and built-in 

PID control for XGB basic unit. 

10310000927 

XGB Cnet I/F 

It is the user’s manual about XGB Cnet I/F that describes built-in 

communication function and external Cnet I/F module of XGB 

basic unit 

10310000816 

XGB FEnet I/F It describes how to use XGB FEnet I/F module. 10310000873 

XBC Standard / 

Economic Type 

Main Unit 

It describes power, I/O, extension specification and system 

configuration, built-in high speed counter of XGB standard / 

economic type main unit. 

10310001091 
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Title Description 
No. of User’s 

Manual 

XGB High speed 

counter User’s 

Manual 

It is the user’s manual for High speed counter extension module of 

XGB basic unit to explain High speed counter extension module 

function of XGB basic unit. 

10310001242 

XGB Fast Ethernet 

I/F 
It describes how to use XGB FEnet I/F module.   10310000873 

XGB CANopen I/F 
It describes how to use the CANopen that is kind of opened type 

network. 

10310001245 
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Chapter 1 General 
 
Here describes about analog module and built-in PID function of XGB series. 
 

1.1 Analog Product List 
  

Classification Name 
No. of 

channel 
Range Resolution Characteristic 

Voltage/ 

Current input 

XBF-AD04A 4 

0 ~ 10V 2.5 ㎷ 1.Range selection by external switch and  

parameter setting 

2. External DC24V used 
0 ~ 20 ㎃ 

4㎃~20㎃ 
5.0 ㎂ 

XBF-AD04C 4 

1 ~ 5V 0.250㎷ 1.Range selection by external switch and  

parameter setting 

2 Function of. Filter, Average,  

Detection disconnection, Alarm,  

Retaining Valid conversion value  

3. External DC24V used 

0 ~ 5V 0.3125㎷ 

0 ~ 10V 0.625㎷ 

±10V 1.250㎷ 

4 ~ 20㎃ 1.0㎂ 

0 ~ 20㎃ 1.25㎂ 

XBF-AD08A 8 

4~20㎃ 

0~20㎃ 
5.0 ㎂ 1.Range selection by external switch and  

parameter setting 

2. Filter function, average function 

3. External DC24V used 

1~5V 

0~5V 
1.25 ㎷ 

0~10V 2.5 ㎷ 

Voltage output 

XBF-DV04A 4 0 ~ 10V 2.5 ㎷ 
1. External DC24V used 

2. Designates output in case of Error and  

CPU STOP 

3. Interpolation function (Linear, S-type) 

XBF-DV04C 4 

1 ~ 5V 0.250㎷ 

0 ~ 5V 0.3125㎷ 

0 ~ 10V 0.625㎷ 

±10V 1.250㎷ 

Current output 

XBF-DC04A 4 
0 ~ 20㎃ 

4㎃~20㎃ 
5.0 ㎂ 

1. External DC24V used 

2. Designates output in case of Error and  

CPU STOP XBF-DC04B 4 0 ~ 1.2㎃ 0.3㎂ 

XBF-DC04C 4 

4~20㎃ 1.0㎂ 

1. 1. External DC24V used 

2. Designates output in case of Error and  

CPU STOP 

3. Interpolation Function(Linear, S-type) 

4. Detection disconnection 
0 ~ 20㎃ 1.25㎂ 

RTD input 
XBF-RD04A 4 PT100 

JPT100 
0.1℃ 

1. External DC24V used 

2. Filter function XBF-RD01A 1 

 

Thermocouple 

Input module 

 

XBF-TC04S 

4 K / J / T / R Note1) 
1. External DC24V used 

2. Filter function, average function 
XBF-TC04B 

Note1) for more detail on thermocouple input module resolution, refer to Ch.5.2.6 accuracy/resolution. 
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Classification Name 
No. of 

channel 
Range Resolution Characteristic 

Analog combo 

(voltage/current 

I/O) 

XBF-AH04A 
2(Input) 

2(Output) 

4~20㎃ 

0~20㎃ 
5.0 ㎂ 

1.Range selection by external switch  

and parameter setting 

2.Filter function, averaging function 

3.Specifies output when error or CPU 

 STOP 

4. Uses external DC24V 

1~5V 

0~5V 
1.25 ㎷ 

0~10V 2.5 ㎷ 

Analog Input 

Option Board XBO-AD02A 2 
4~20㎃ 6.25 ㎂ 

1. Parameter setting 

2. Filter function, average function 

3. Internal VDD 5V 

0~20㎃ 5.0 ㎂ 
Analog Output 

Option Board 
XBO-DA02A 2 

0~10V 2.5 ㎷ 

Analog IO  

Option Board 
XBO-AH02A 

1(Input) 
4~20㎃ 6.25 ㎂ 

1. Parameter setting 

2. Filter function, average function 

3. Internal VDD 5V 

0~20㎃ 5.0 ㎂ 

1(Output) 
0~10V 2.5 ㎷ 

RTD Input  

Option Board 
XBO-RD01A 1 

PT100 

JPT100 
0.1℃ 

1. Internal VDD 5V 

2. Filter function, average function 

Thermocouple 

Input Option 

Board 

XBO-TC02A 2 K / J Note2) 
1. Internal VDD 5V 

2. Filter function, average function 

 
Note2) for more detail on Thermocouple Input Option Board resolution, refer to Ch.12.5 accuracy 
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Here describes about specification of analog module of XGB series. 
 

1.2.1 Analog input 

Item XBF-AD04A 

Analog input 
range 

Type Voltage Current 

Range 
DC 0 ~ 10V 

(Input resistance: 1 MΩ min.) 

DC 4 ~ 20㎃ 

DC 0 ~ 20㎃ 

(Input resistance: 250 Ω) 

Digital output 

Type 12 bit binary data 

Range 

Unsigned 
value 

0 ~ 4000 

Signed value -2000 ~ 2000 

Precise value 0 ~ 1000 400 ~ 2000/0 ~ 2000 

Percentile 
value 

0 ~ 1000 

Max. resolution 2.5㎷(1/4000) 5㎂(1/4000) 

Accuracy ± 0.5% or less 

Max. conversion speed 1.5ms/channel 

Absolute max. input DC ±15V DC +25㎃ 

No. of output channel 4 channels 

Insulation method 
Photo-coupler insulation between input terminal and PLC power 
(No insulation between channels) 

Connection Terminal 11 point terminal block 

I/O points occupied Fixed type: 64 points 

Max. number of equipment 
7 (when using XBM(C)-DxxxS type) 
10 (when using XB(E)C-DxxxH type) 

Consumption 
current 

Inner (DC 5V) 120㎃ 

External (DC 24V) 62㎃ 

Weight 64g 

Additional function Filter-processing, average-processing (time, count) 

 
 
 
 
 
 
 
 
 

1.2 Specification of Analog Module 
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Items XBF-AD04C 

Number of channels 4 channels 

Analog 

input 

Type Voltage Current 

Range 

DC 1 ~ 5V 

DC 0 ~ 5V 

DC 0 ~ 10V 

DC -10 ~ 10V 

(Input resistance: 1 ㏁ min) 

DC 4 ~ 20mA 
DC 0 ~ 20mA 
(Input resistance: 250 Ω) 

Current input or Voltage input can be selected through the external 

terminal wiring setting. 

►In voltage mode, use V+ and COM terminal for the channel. 

In current mode, short V+ and COM terminal and then use I+  

and COM terminal. 

Digital 
output 

Type 16 bit binary data (Data : 14Bit) 

Range 

Unsigned 
value  

0 ~ 16,000 

Signed value -8,000 ~ 8,000 

Precise value 

1,000 ~ 5,000 (1 ~ 5V) 

0 ~ 5,000 (0 ~ 5V) 

0 ~ 10,000 (0 ~ 10V) 

-10,000 ~ 10,000 (±10V) 

4,000 ~ 20,000 (4 ~ 20㎃) 

0 ~ 20,000 (0 ~ 20㎃) 

 

 

Percentile 
value 

0 ~ 10,000 

Max. resolution 

1/16,000 

0.250㎷ (1 ~ 5V) 

0.3125㎷ (0 ~ 5V) 

0.625㎷ (0 ~ 10V) 

1.250㎷ (±10V) 

1.0㎂ (4 ~ 20㎃) 

1.25㎂ (0 ~ 20㎃) 

 

 

Accuracy 
±0.2% or less (When ambient temperature 25℃) 

±0.3% or less (When ambient temperature 0 ~ 55℃) 

Max. conversion speed 1㎳/ channel 

Absolute max. input DC ±15V DC ±30㎃ 

 

Addition 

function 

Filter  Digital filter(4 ~ 64,000㎳) 

Average  
Time average (4~16,000㎳) 

Count average (2~64,000times) 

Detection alarm Disconnection(DC 1~5V, DC 4~20㎃) 

Hold last value 
When input signal exceeds the effective range, holds the last effective  

value. 

Alarm function When input signal exceeds the effective range, relevant flag turns on. 

Insulation method 
Photo-coupler insulation between input terminal and 
PLC power (No insulation between channels) 

Connection terminal 15 point terminal block 

I/O points occupied Fixed type assignment: 64 

Max. attachable number 
7ea (when using XBM(C)-DxxxS type) 
10ea (when using XB(E)C-DxxxH type) 

Consumption 
current 

Internal (DC 5V) 110mA 

External (DC 24V) 100mA 

Weight 72g 

Module input power DC 20.4~28.8V 
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Item XBF-AD08A 

Analog input 
range 

Type Voltage Current 

Range 

DC 1 ~ 5V 
DC 0 ~ 5V 
DC 0 ~ 10V 
 (Input resistance: 1 MΩ min.) 

DC 4 ~ 20㎃ 

DC 0 ~ 20㎃ 

 (Input resistance: 250 Ω) 

Input range can be voltage/current selector switch after being set 
by user program or I/O parameter for each channel  

Digital output 

Type 12 bit binary data 

Range 

Unsigned 
value 

0 ~ 4000 

Signed value -2000 ~ 2000 

Precise value 
100 ~ 500 (DC 1 ~ 5V) 
0 ~ 500 (DC 0 ~ 5V) 
0 ~ 1000 (DC 0 ~ 10V) 

400 ~ 2000 (DC 4 ~ 20㎃) 

0 ~ 2000 (DC 0 ~ 20㎃) 

 

Percentile 
value 

0 ~ 1000 

Max. resolution 

1/4000 

1.25㎷ (DC 1~5V, 0~5V) 

2.5㎷ (DC 0~10V) 

5㎂ (DC4~20㎃, 0~20㎃) 

 

Accuracy ± 0.5% or less 

Max. conversion speed 1.5ms/channel 

Absolute max. input DC ±15V DC +25㎃ 

No. of output channel 8 channels 

Insulation method 
Photo-coupler insulation between input terminal and PLC power 
(No insulation between channels) 

Connection Terminal 11 point terminal block 

I/O points occupied Fixed type: 64 points 

Max. number of equipment 
7 (when using XBM(C)-DxxxS type) 
10 (when using XB(E)C-DxxxH type) 

Additional 
function 

Filter function Digital filter (4~64,000ms) 

Average function 

Time average (4~16,000ms) 

Count average (2~64,000 times) 

Moving average (2~100) 

Alarm function Disconnection detection (DC 1~5V, DC 4~20㎃) 

Consumption 
current 

Inner (DC 5V) 105㎃ 

External (DC 24V) 85㎃ 

Weight 81g 
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1.2.2 Analog output 
 

Item XBF-DV04A XBF-DC04A XBF-DC04B 

Analog 

output 

Type Voltage Current Current 

Range 

DC 0 ~ 10V 

(Load resistance:  

2kΩ or more) 

DC 4 ~ 20mA 

DC 0 ~ 20mA 

(Load resistance: 

510Ω or less) 

DC 0 ~ 1.2mA 

(Load resistance: 
510Ω or less) 

Digital 

input 

Type 12-bit binary data 

Range 

Signed 

value 
0 ~ 4000 0 ~ 4000 0 ~ 4000 

Unsigned 

value 
-2000 ~ 2000 -2000 ~ 2000 -2000 ~ 2000 

Precise 

value 
0 ~ 1000 400 ~ 2000/0 ~ 2000 0 ~ 1,200 

Percentile 

value 
0 ~ 1000 0 ~ 1000 0 ~ 1,000 

Maximum resolution 2.5㎷ (1/4000) 5㎂ (1/4000) 0.3㎂ (1/4000) 

Accuracy ±0.5% or less 

Maximum conversion speed 1 ㎳/channel 

Absolute maximum output DC ±15V DC +25㎃ 

Number of maximum 

channel 
4 channels 

Insulation method 
Photo-coupler insulation between input terminal and PLC power 

(no insulation between channels) 

Terminal connected 11-point terminal block 

I/O points occupied Fixed type: 64 points 

Max. no. of installation 
7 (when using XBM(C)-DxxxS type) 
10 (when using XB(E)C-DxxxH type) 

Current 

consump

tion 

Internal (DC 5V) 110mA 110mA 

External (DC 24V) 70mA 120mA 

Weight 64g 70g 
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Items XBF-DV04C XBF-DC04C 

Channels 4 channels 

Analog 

output 

range 

Type Voltage Current 

Range 

DC 1 ~ 5V 

DC 0 ~ 5V 

DC 0 ~ 10V 

DC -10 ~ 10V 

(Load resistance: 1㏀ or more) 

DC 4 ~ 20㎃ 

DC 0 ~ 20㎃ 

(Load resistance: 600Ω or less) 

Output ranges are set in user program or I/O parameter per each 

channel. 

Digital 
input 

Type 16 bit binary data (Data : 14Bit) 

Range 

Unsigned 
value  

0 ~ 16,000 

Signed value -8,000 ~ 8,000 

Precise value 

1,000 ~ 5,000 (1 ~ 5V) 

0 ~ 5,000 (0 ~ 5V) 

0 ~ 10,000 (0 ~ 10V) 

-10,000 ~ 10,000 (±10V) 

4,000 ~ 20,000 (4 ~ 20㎃) 

0 ~ 20,000 (0 ~ 20㎃) 

 

 

Percentile 
value 

0 ~ 10,000 

Max. resolution 

1/16,000 

0.250㎷ (1 ~ 5V) 

0.3125㎷ (0 ~ 5V) 

0.625㎷ (0 ~ 10V) 

1.250㎷ (±10V) 

1.0㎂ (4 ~ 20㎃) 

1.25㎂ (0 ~ 20㎃) 

Accuracy 
±0.2% or less (When ambient temperature is 25℃) 

±0.3% or less (When ambient temperature is 0 ~ 55℃) 

Max. conversion speed 1㎳/ channel 

Additional function 

Setting of channel output status 

(Select one among previous, Min, Max value) 

Setting of interpolation method  

(Linear interpolation, S-type interpolation) 

Insulation method 
Photo-coupler insulation between output terminal and PLC power 
(no insulation between channels) 

Terminal connected 11 point terminal 

I/O occupied points  Fixed point assignment: 64 points 

Max. attachable number 
7ea (when using XBM(C)-DxxxS type) 
10ea (when using XB(E)C-DxxxH type) 

Weight 68g 69g 

Consumed 
current 

Internal (DC 5V) 75mA 

External (DC 24V) 170mA 

Power Supply DC 20.4V ~ 28.8V 
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1.2.3 RTD input 

Item XBF-RD04A XBF-RD01A 

No. of input channel 4 channels One channel 

Input sensor 

type 

PT100 JIS C1604-1997 

JPT100 JIS C1604-1981 , KS C1603-1991 

Temperature 

input range 

PT100 -200 ~ 600℃ 

JPT100 -200 ~ 600℃ 

Digital output 

PT100 -2000 ~ 6000 

JPT100 -2000 ~ 6000 

Scaling display 

 

0 ~ 4000 

Accuracy 

Normal 

temp.(25℃) 
Within ±0.3%  

Full temp.(0~55℃) Within ±0.5%  

Conversion speed 40ms / channel 

Insulation 

Channel to 

Channel 

 

Non-insulation 

Terminal to PLC 

Power 
 Insulation (Photo-Coupler) 

Terminal block 15-point terminal block 

I/O points occupied Fixed type: 64 points 

Wiring method 3-wire 

Max. number of equipment 
7 (when using XBM(C)-DxxxS type) 

10 (when using XB(E)C-DxxxH type) 

Function 
Filtering Digital filter (160 ~ 64000ms) 

Alarm Disconnection detection 

Current 

consumption 

Inner DC5V 100㎃ 

external DC24V 100㎃ 

Weight 63g 
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1.2.4 Thermocouple input 
 

(1) Thermocouple input specification (XBF-TC04S / XBF-TC04B) 
 

Items Specification 

Number of input channel 

4 channels 

Select channel type by parameter 

(thermocouple input) 

Type of input sensor 
Thermocouple K / J / T / R type 

JIS C1602-1995 

Range of input 

temperature 

K -200.0℃ ~ 1300.0℃ 

J -200.0℃ ~ 1200.0℃ 

T -200.0℃ ~ 400.0℃ 

R 0.0℃ ~ 1700.0℃ 

Digital output 

Temp. display 
Displaying down to one decimal place – note1) 

K, J, T type: 0.1℃, R type: 0.5℃ 

Scaling display 

(user-defined scaling) 

Unsigned scaling (0 ~ 65535) 

Signed scaling (-32768 ~ 32767) 

Accuracy 

Ambient temperature(25℃) Within ±0.2% – note 2) 

Temp. coefficient 

(range of operating temp) 
±100 ppm/℃ 

Conversion time 50ms / channel 

Reference 

junction 

compensation 

Auto compensation by RJC sensing (Thermistor) 

Compensation amount ±1.0℃ 

Warming-up time 15 min or above –note 3) 

 
Note1), Note2) For more detail specification, refer to 5.2.6 accuracy/resolution. 
Note 3) Warming-up time: for stability of measured temperature, 15 min is necessary after power is on. 
 
 
(2) Voltage input specification (XBF-TC04B) 
 

Items Specification 

Number of input channel 

4 channels 

Select channel type by parameter 

(thermocouple/voltage input) 

Analog input range 
0 ~ 100 ㎷ 

(Input impedance: 1㏁ or above) 

Digital output 

Type 0 ~ 20000 

Scaling display 

(user-defined scaling) 

Unsigned scaling (0 ~ 65535) 

Signed scaling (-32768 ~ 32767) 

Max. resolution 1/20000 (0.005mV) 

Accuracy 

Ambient temperature (25℃) Within ±0.2% 

Temp. coefficient 

(operating temp. range) 
±100 ppm/℃ 

Conversion time 50ms / channel 
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(3) Common specification (XBF-TC04S / XBF-TC04B) 

 

Items Specification 

Insulation 

Insulation 

method 

Terminal – inner 

circuit 
Photo-coupler insulation 

Terminal – operating 

power 
DC/DC converter insulation 

Between channels Photomos relay insulation 

Dielectric withstand voltage 
400 V AC, 50/60 Hz, 1min, 

leakage current 10㎃ or below 

Insulation resistance 500 V DC, 10 MΩ or below 

Terminal block 11 point terminal 

I/O occupied points 64 points 

Max. number of equipment 
7 (when using XBM(C)-DxxxS type) 

10 (when using XB(E)C-DxxxH type) 

Additional 

function 

Filter process Digital filter (200 ~ 64,000㎳) 

Average process 

Time average (400~64,000㎳) 

Count average (2~64,000 times) 

Moving average (2~100) 

Alarm Disconnection detection 

Max./Min. display Display Max./Min. 

Scaling function Signed scaling / Unsigned scaling 

Consumption 

current 

Inner DC5V 100㎃ 

External DC24V 100㎃ 

Weight 63g 
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1.2.5 Analog Combo 
      

(1) Input performance specification 
 

Items XBF-AH04A 

No. of input channel 2 channels 

Analog 

input 

range 

Type Voltage Current 

Range 

DC 1 ~ 5V 

DC 0 ~ 5V 

DC 0 ~ 10V 

(input resistor: 1 MΩ or above) 

DC 4 ~ 20㎃ 

DC 0 ~ 20㎃ 

(input resistor 250 Ω) 

 

Input range can be set through external voltage/current selector switch after 

setting at user program or I/O parameter per input channel 

Digital 

output 

Type 12bit binary data 

Range 

Unsigned 

value 
0 ~ 4000 

Signed value -2000 ~ 2000 

Precise 

value 

100 ~ 500 (DC 1 ~ 5V) 

0 ~ 500 (DC 0 ~ 5V) 

0 ~ 1000 (DC 0 ~ 10V) 

400 ~ 2000 (DC 4 ~ 20㎃) 

0 ~ 2000 (DC 0 ~ 20㎃) 

 

Percentile 

value 
0 ~ 1000 

Max. resolution 

1/4000 

1.25㎷ (DC 1~5V, 0~5V) 

2.5㎷ (DC 0~10V) 

5㎂ (DC4~20㎃, 0~20㎃) 

 

Precision ±0.5% or less 

Max. conversion speed 1ms/channel 

Absolute max. input DC ±15V DC ±25㎃ 

Additional 

function 

Filter function Digital filter (4 ~ 64,000㎳) 

Averaging 

function 

Time averaging (4~16,000㎳) 

Cyclic averaging (2~64,000cycle) 

Moving averaging (2~100samples) 

Alarm function Disconnection detection (DC 1~5V, DC4~20㎃) 
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(2) Output performance specification 

Items XBF-AH04A 

No. of output channel 2 channels 

Analog 

output 

range 

Type Voltage Current 

Range 

DC 1 ~ 5V 

DC 0 ~ 5V 

DC 0 ~ 10V 

(Load resistor: 2kΩ or above) 

DC 4 ~ 20㎃ 

DC 0 ~ 20㎃ 

(Load resistor 510 Ω or less) 

 

Input range can be set through external voltage/current selector switch after 

setting at user program or I/O parameter per input channel 

Digital 

input 

Type 12 bit binary data 

Range 

Unsigned 

value 
0 ~ 4000 

Signed value -2000 ~ 2000 

Precise 

value 

100 ~ 500 (DC 1 ~ 5V) 

0 ~ 500 (DC 0 ~ 5V) 

0 ~ 1000 (DC 0 ~ 10V) 

400 ~ 2000 (DC 4 ~ 20㎃) 

0 ~ 2000 (DC 0 ~ 20㎃) 

 

Percentile 

value 
0 ~ 1000 

Max. resolution 

1/4000 

1.25㎷ (DC 1~5V, 0~5V) 

2.5㎷ (DC 0~10V) 

5㎂ (DC4~20㎃, 0~20㎃) 

 

Precision ±0.5% or less 

Max. conversion speed 1ms/channel 

Absolute max. output DC ±15V DC 25㎃ 

Additional function 
Function setting channel output status 

(Can select one among Previous, Minimum, median, maximum) 

(3) I/O common performance specification 

Items XBF-AH04A 

Insulation method 
Photo coupler insulation between I/O terminal and PLC power (not 

insulated between channels) 

I/O terminal block 11 points terminal block 

No. of I/O occupation point Fixed type: 64 points 

Max. number of equipment 
7 (when using XBM-DxxxS type) 

10 (when using XB(E)C-DxxxH type) 

Consumption 

current 

Internal (DC 5V) 120㎃ 

External (DC 24V) 130㎃ 

Weight 73g 
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1.2.6 Analog Input Option Board 
 

Items XBO-AD02A 

Number of channel 2 channels 

Analog input 
range 

Type Voltage Current 

Range 

DC 0 ~ 10V 

(Input resistance: 1 ㏁ or above) 

DC 4 ~ 20㎃ 

DC 0 ~ 20㎃ 

(Input resistance 250 Ω) 

Set by external voltage/current selector switch after being set at user 
program or I/O parameter per each channel 

Digital output 

Type 12 bit binary data 

Range 

Unsigned 
value 

0 ~ 4000 

Signed value -2000 ~ 2000 

Precise 
value 

0 ~ 1000 (DC 0 ~ 10V) 
400 ~ 2000 (DC 4 ~ 20㎃) 

0 ~ 2000 (DC 0 ~ 20㎃) 

Percentile 
value 

0 ~ 1000 

Max. resolution 

1/4000 (DC 4~20㎃: 1/3200) 

2.5㎷ (DC 0~10V) 
5㎂ (DC 0~20㎃) 

6.25㎂ (DC 4 ~ 20㎃) 

Accuracy ±1.0% or less 

Max. conversion speed 1ms/channel + scan time 

Absolute max. input DC +12V / -10V DC ±25㎃ 

Additional 
function 

Average function Count average (2 ~ 64,000 times) 

Gain adjustment  
function 

Gain adjustment (-40~40) 

Insulation method 
No insulation between channels  
No insulation between input terminal and PLC main unit 

Input terminal 5 - point terminal block 

I/O points occupied Fixed type: 64 points 

Max. no. of installation  
1 (when using XBC-DR10E/DR14E type) 
2 (when using XBC-DR20E/DR30E type) 

2 (when using XBC-DxxxS/SU type) 

Supply power Internal DC 5V 

Consumption current 50㎃ 

Weight 20g 
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1.2.7 Analog Output Option Board 
 

Item XBO-DA02A 

No. of channels 2 channels 

Analog 

output 

range 

Type Voltage Current 

Range 

DC 0 ~ 10V 

(Load resistance: 2㏀ or more) 

DC 4 ~ 20㎃ 

DC 0 ~ 20㎃ 

(Load resistance: 450Ω) 

Output range can be set at user program or I/O parameter for each 

channel 

Digital 

input 

Type 12-bit binary data 

Range 

Unsigned 

value 
0~4000 

Signed value -2000 ~ 2000 

Precise value 0 ~ 1000 (DC0~10V) 
400 ~ 2000 (DC4~20㎃) 

0 ~ 2000 (DC0~20㎃) 

Percentile value 0 ~ 1000 

Maximum resolution 

1/4000 (DC 4 ~ 20mA: 1/3200) 

2.5㎷ (DC 0 ~ 10V) 
5㎂ (DC 0~20㎃) 

6.25㎂ (DC 4~20㎃) 

Accuracy ±1.0% or less 

Maximum conversion speed 1㎳/channel + scan time 

Additional function 
Channel output state setting (former, min, middle, max value) 

Gain adjustment function 

Insulation method 
no insulation between analog output channels  

no insulation between output terminal and PLC main unit  

I/O terminal 5-point terminal block 

Power supply Internal 5V 

I/O points occupied Fixed type: 64 points 

Supply power Internal DC5V 

Current consumption 150㎃ 

Weight 20g 
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1.2.8 Analog I/O Option Board 

 
(1) Input performance specification 

Items XBO-AH02A 

Number of channels 1 channel 

Analog 

input 

range 

Type Voltage Current 

Range 

DC 0 ~ 10V 

(Input resistance: 1㏁ or above) 

DC 4 ~ 20㎃ 

DC 0 ~ 20㎃ 

(Input resistance: 250 Ω) 

Set by external voltage/current wiring after being set at user program 

or I/O parameter per each channel 

Digital 

output 

Type 12 bit binary data 

Range 

Unsigned 
value 

0 ~ 4000 

Signed value -2000 ~ 2000 

Precise 

value 
0 ~ 1000 (DC 0 ~ 10V) 

400 ~ 2000 (DC 4 ~ 20㎃) 

0 ~ 2000 (DC 0 ~ 20㎃) 

Percentile 

value 
0 ~ 1000 

Max. resolution 

1/4000 (DC 4~20㎃: 1/3200) 

2.5㎷ (DC 0~10V) 
5㎂ (DC 0~20㎃) 

6.25㎂ (DC 4~20㎃) 

Accuracy ±1.0% or less 

Max. conversion speed 1ms/channel + scan time 

Absolute max. input DC +12V / -10V DC ±25㎃ 

Additional 

function 

Average function Count average (2 ~ 64,000 times) 

Gain adjustment  

function 
Gain adjustment (-40~40) 

 
(2) Output performance specification 

Items XBO-AH02A 

Number of channels 1 channel 

Analog 

output 

range 

Type Voltage Current 

Range 

DC 0 ~ 10V 

(Load resistance: 2kΩ or above) 

DC 4 ~ 20㎃ 

DC 0 ~ 20㎃ 

(Load resistance: 450 Ω) 

Set at user program or I/O parameter per each channel per each 

channel 

Digital 

input 

Type 12 bit binary data 

Range 

Unsigned 

value 
0 ~ 4000 

Signed value -2000 ~ 2000 

Precise 

value 
0 ~ 1000 (DC 0 ~ 10V) 

400 ~ 2000 (DC 4 ~ 20㎃) 

0 ~ 2000 (DC 0 ~ 20㎃) 

Percentile 

value 
0 ~ 1000 

Max. resolution 

1/4000 (DC 4 ~ 20㎃: 1/3200) 

2.5㎷ (DC 0~10V) 
5㎂ (DC 0~20㎃) 

6.25㎂ (DC 4~20㎃) 

Accuracy ±1.0% or less 

Max. conversion speed 1ms/channel + scan time 

Additional function 
CH output status setting(select among former, min, middle, max value) 

Gain adjustment function 
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(3) I/O Common performance specification 

Items XBO-AH02A 

Insulation method 
Non-insulation betweens analog I/O channels 
Non-insulation between I/O terminal and PLC main unit 

I/O terminal 5-point terminal block 

I/O occupation point Fixed type: 64 points 

Max. installation count 

1(when using XBC-DR10E/DR14E type) 

2(when using XBC-DR20E/DR30E type) 

2(when using XBC-DxxxS/SU type) 

Supply power Internal DC5V 

Consumption current 150㎃ 

Weight 20g 

 
1.2.9 RTD Input Option Board 

Items XBO-RD01A 

No. of input channels One channel 

Input sensor 

type 

PT100 JIS C1604-1997 

JPT100 JIS C1604-1981 , KS C1603-1991 

Temperature 

input range 

PT100 -200 ~ 600℃ 

JPT100 -200 ~ 600℃ 

Digital output 
PT100 -2000 ~ 6000 

JPT100 -2000 ~ 6000 

Accuracy Within ±1.0% 

Conversion speed 25m/1 channel 

Insulation 

Channel to 

Channel 

 

Non-insulation 

Terminal to PLC 

Power 
Insulation (Photo-Coupler) 

Terminal block 5-point terminal block 

I/O points occupied Fixed type: 64 points 

Max. number of equipment 

1 (when using XBC-DR10E/DR14E type) 

2 (when using XBC-DR20E/DR30E type) 

2 (when using XBC-DxxxS type) 

Wiring method 3-wire type 

Function 
Averaging Count averaging function 

Alarm Disconnection detection 

Supply power Internal DC5V 

Consumption current 30㎃ 

Weight 20g 
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1.2.10  Thermocouple Input Option Module 

Items XBO-TC02A 

Number of input channel 2 channels 

Type of input sensor Thermocouple K / J type (JIS C1602-1995) 

Range of input 
temperature 

K type sensor -200.0℃ ~ 1300.0℃ 

J type sensor -200.0℃ ~ 1200.0℃ 

Digital output Temp. display unit 
16 bit binary data 
Displaying down to one decimal place  
(K, J, type: 0.1℃) 

Accuracy ±1.0% or less 

Conversion speed 50ms/2chanelles –note1) 

Reference 
junction 

compensation 

Auto compensation by RJC sensing (Thermistor) 

Compensation amount ±1.0℃ 

Additional 
function 

Average process Count averaging 

Alarm Input disconnection detection 

Warming-up time 15 min or above – note2) 

Insulation method 
Non-insulation between input channels 
Non-insulation between input terminal and PLC 
main unit 

I/O terminal 5-point terminal block 

Max. number of equipment 

1 (when using XBC-DR10E/DR14E type) 

2 (when using XBC-DR20E/DR30E type) 

2 (when using XBC-DxxxS type) 

Supply power Internal DC5V 

I/O occupied points Fixed type: 64 points 

Consumption current 50㎃ 

Weight 20g 
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Chapter 2 Analog Input Module  
 

2.1 Setting Sequence before operation 
 

Before using the analog input module, follow steps below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 

 

XBF-AD04A 

 

 

 

 

 

 Checking performance specification 

Wiring 

Reading analog input data 

Setting parameter 

Programming 

Setting external voltage/current switch 

Specification (2.2 performance specification) 
 Operating environment 
 Input type and range 
 Digital output range 

Wiring 
 Wiring power (External DC24V) 
 Wiring analog input  

Setting switch 
 Setting voltage/current input type 

Analog input test 
 XG5000 special module monitor test mode 

Parameter 
 XG5000 I/O parameter 

Programming 
 Programming for reading analog data 

 (U device) 

Refer to trouble shooting when there is error 
or analog data is abnormal. 
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2.2 Specifications 
 

2.2.1 General specifications 

General specifications are as follows. 

 

 
 
 

No. Items Specification 
Related 

standards 

1 
Operating 

temperature 
0 ~ 55 C  

2 
Storage 

temperature 
25 ~ 70 C  

3 
Operating 

humidity 
5∼95%RH (Non-condensing)  

4 
Storage 

humidity 
5∼95%RH (Non-condensing)  

5 
Vibration 

immunity 

For discontinuous vibration -  

Frequency Acceleration Amplitude Times 

IEC61131-2 

10  f  57Hz  0.075mm 

Each 10 

times in 

X,Y,Z 

directions 

57  f  150Hz 9.8m/s
2
(1G)  

For continuous vibration 

Frequency Acceleration Amplitude 

10  f  57Hz  0.035mm 

57  f  150Hz 4.9m/s
2
(0.5G)  

6 
Shocks 

immunity 

  Max. impact acceleration : 147 m/s
2
(15G) 

  Authorized time : 11ms 
  Pulse wave : Sign half-wave pulse (Each 3 times in X,Y,Z directions) 

IEC61131-2 

7 
Noise 

immunity 

Square wave 

impulse noise 

AC: 1,500 V 

DC: 900 V 
LSIS standard 

Electrostatic 

discharging 
Voltage : 4kV(Contact discharging) 

IEC61131-2 

IEC61000-4-2 

Radiated 

electromagnetic 

field noise 

80 ~ 1,000 MHz,  10V/m 
IEC61131-2, 

IEC61000-4-3 

Fast transient 
/burst noise 

Segment 
Power 
module 

Digital/Analog I/O 

communication interface IEC61131-2 

IEC61000-4-4 
Voltage 2kV 1kV 

8 
Ambient 

conditions 
No corrosive gas and dust  

9 
Operating 

height 
2000m or less  

10 
Pollution 

degree 
2 or less  

11 Cooling type Natural air cooling  
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2.2.2 Performance specifications 

Performance specifications are as follows. 

Items XBF-AD04A 

Analog input 
range 

Type Voltage Current 

Range 
DC 0 ~ 10V 
(Input resistance: 1 MΩ min.) 

DC 4 ~ 20mA 
DC 0 ~ 20mA 
(Input resistance 250 Ω) 

Digital output 

Type 12 bit binary data 

Range 

Unsigned 
value  

0 ~ 4000 

Signed value -2000 ~ 2000 

Precise 
value 

0 ~ 1000 400 ~ 2000/0 ~ 2000 

Percentile 
value 

0 ~ 1000 

Max. resolution 2.5㎷(1/4000) 5㎂(1/4000) 

Accuracy ±0.5% or less 

Max. conversion speed 1.5ms/channel 

Absolute max. output DC ±15V DC ±25㎃ 

No. of output channel 4 channels 

Insulation method 
Photo-coupler insulation between input terminal and PLC power 

(No insulation between channels) 

Connection terminal 11 point terminal block 

I/O points occupied Fixed type: 64 points 

Max. no of installation 
7 (when using XBM(C)-DxxxS type) 
10 (when using XB(E)C-DxxxH type) 

Consumption 
current 

Inner (DC 5V) 120㎃ 

External (DC 24V) 62㎃ 

Weight 64g 

Additional function Filter-processing, average-processing (time, count) 

 

 

 

 

Notes  

1) When A/D conversion module is released from the factory, Offset/Gain value is as adjusted for respective 
analog input ranges, which is unavailable for user to change. 

2) Offset Value: Analog input value where digital output value is 0 when digital output format is set to 
Unsigned Value.  

3) Gain Value: Analog input value where digital output value is 16000 when digital output format is set to 
Unsigned Value. 
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2.3 Name of part and function 
 

 

Respective designations of the parts are as described below.   

 

    

 
 

No. Description 

① 

RUN LED 

▪ Displays the operation status of XBF-AD04A 
On: Operation normal 

Flickering: Error occurs (page 12-30) 

Off: Module error 

② 

Terminal block 

▪ Analog input terminal, whose respective channels can be connected with 
external devices. 

③ 

Voltage/Current selection switch 

▪ Switch for voltage and current selection of analog input 

 

① 

② 

③ 
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2.4 Characteristic of I/O conversion 
 

 

Characteristics of I/O conversion are the inclination connected in a straight line between Offset and 
Gain values when converting analog signal (voltage or current input) from PLC’s external device to 
digital value. I/O conversion characteristics of A/D conversion modules are as described below. 
 

Digital 

output 

value

0

1000

2000

3000

4000

4047

2

- 2000

- 1000

0

1000

2000

2047

0

250

500

750

1000

1011

Analog 

input value

Analog input applicable 
range

  

Offset value 

Gain 

value

DC 0 ~ 10 V 0 V 5V 10V
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2.5 Conversion Characteristic according to Input Range 
 
Voltage input range can be set through user program or special module package for respective 
channels. Output formats of digital data are as specified below; 

 
 A. Unsigned Value 
 B. Signed Value 
 C. Precise Value 
 D. Percentile Value 

 

2.5.1  If the range is DC 0 ~ 10V 
 

D
ig

it
a

l 
o

u
tp

u
t 
v
a

lu
e

0

1000

2000

3000

4000

4047

-2000

-1000

0

1000

2000

2047

0

250

500

750

1000

1011

0 V 10 V5 V

1011

1000

750

500

250

0

7.5 V2.5 V

Analog input value (voltage)
 

Digital output value for voltage input characteristic is as specified below.   
(Resolution (based on 1/4000): 2.5 mV) 

 

Digital output 
range 

Analog input voltage (V) 

0 2.5 5 7.5 10 10.11 

Unsigned value 

(0 ~ 4047) 
0 1000 2000 3000 4000 4047 

Signed value 

(-2000 ~ 2047) 
-2000 -1000 0 1000 2000 2047 

Precise value 

(0 ~ 1011) 
0 250 500 750 1000 1011 

Percentile value 

(0 ~ 1011) 
0 250 500 750 1000 1011 
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2.5.2 If the range is DC 0 ~ 20mA  
 

D
ig

it
a

l 
o

u
tp

u
t 
v
a

lu
e

0

1000

2000

3000

4000

4047

-2000

-1000

0

1000

2000

2047

0

250

500

750

1000

1011

0mA 20mA10mA

2023

2000

1500

1000

500

0

15mA5mA

Analog input value (current)  

 
 
 

▪ Digital output value for current input characteristic is as specified below.  

  (Resolution (based on 1/4000): 5 ㎂) 

 

Digital output 
range 

Analog input current (㎃) 

0 5 10 15 20 20.23 

Unsigned value 

(0 ~ 4047) 
0 1000 2000 3000 4000 4047 

Signed value 

(-2000 ~ 2047) 
-2000 -1000 0 1000 2000 2047 

Precise value 

(0 ~ 2023) 
0 500 1000 1500 2000 2023 

Percentile value 

(0 ~ 1011) 
0 250 500 750 1000 1011 
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2.5.3 If range is DC4 ~ 20mA 
 

D
ig

it
a

l 
o

u
tp

u
t 
v
a

lu
e

0

1000

2000

3000

4000

4047

-2000

-1000

0

1000

2000

2047

0

250

500

750

1000

1011

4mA 20mA12mA

2023

2000

1600

1200

800

400

16mA8mA

Analog input value (voltage)

-2048 -48381

 
 

▪ Digital output value for current input characteristic is as specified below.  

(Resolution (Based on 1/4000): 5 ㎂) 

 

Digital 
Output range 

Analog input current (㎃) 

0 4 8 12 16 20 20.23 

Unsigned value 

(-48 ~ 4047) 
-48 0 1000 2000 3000 4000 4047 

Signed value 

(-2048 ~ 2047) 
-2048 -2000 -1000 0 1000 2000 2047 

Precise value 

(381 ~ 2023) 
381 400 800 1200 1600 2000 2023 

Percentile value 

(-12 ~ 1011) 
-12 0 250 500 750 1000 1011 

 
 

Notes  

1) If analog input value exceeding digital output range is input, the digital output value will be kept to be 
the max. or the min. value applicable to the output range specified. For example, if the digital output 
range is set to unsigned value (0 ~ 4000) and the digital output value exceeding 4047 or analog 
value exceeding –0 is input, the digital output value will be fixed as 0~4047. 

2) Voltage and current input shall not exceed ±15 V and ±25 ㎃ respectively. Rising heat may cause 

defects. 
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2.6 Accuracy 
 

 
Accuracy of digital output value does not changed even if input range is changed. Figure below 

shows the range of the accuracy with analog input range of 0 ~ 10 V and digital output type of 
unsigned value selected.  

Accuracy of XBF-AD04A is ±0.5%. 
 

0

0V 5V

2000

10 V

4000

Analog input voltage

D
ig

ita
l o

u
tp

u
t 
va

lu
e

3980

4020

-20

20

 

           [ Accuracy ] 
      
 

 (1) Accuracy when using 5V input 
4000 × 0.5% = 20 
Therefore the range of the accuracy will become (2000-20) ~ (2000+20) = 1980 ~ 2020  
when using 5V input. 

 
 (2) Accuracy when using 10V input  

4000 × 0.5% = 20 
Therefore the range of the accuracy will become (4000-20) ~ (4000+20) = 3980 ~ 4020  
when using 10V input. 
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2.7 Functions of Analog Input Module 
 
 Functions of XBF-AD04A conversion module are as described below.  

Function Description 

Channel Run/Stop 

setting 

(1) Specify Run/Stop of the channel to execute A/D conversion. 

(2) If the unused channel is set to Stop, whole Run time can be reduced. 

Input voltage/Current 

range setting 
(1) Specify analog input range to be used. 
(2) Select range in parameter setting after select Voltage/Current switch. 

Output data format 

setting 

(1) Specify digital output type. 

(2) 4 output data formats are provided in this module. 

A/D conversion 

methods 

(1) Sampling processing 

Sampling process will be performed if A/D conversion type is not specified. 

(2) Filter processing 

Used to delay the sudden change of input value. 

(3) Average processing 

Outputs average A/D conversion value based on frequency or time. 

 
There are three A/D conversion methods, sampling processing, filter processing and average processing. 
 

Sampling Processing

Filter Processing

Average Processing

A/D Conversion Methods

Time Average

Count Average
 

 
(1) Sampling processing 

It collects analog input sign through general A/D conversion processing at a specific interval so to 

convert to digital. The time required for A/D conversion of analog input sign till saved on the memory 

depends on the number of channels used.  

 

(Processing time)  = (Number of channels used) X (Conversion speed) 

 

(Ex.) If the number of channels used is 3, its process time will be 

3 x 1.5 ㎳ = 4.5 ㎳ 

 
Sampling is to calculate the sampling value of continuous analog sign at a specific interval.  

 



Chapter 2 Analog Input Module (XBF-AD04A) 

2 - 11 

 

 
(2) Filter processing 

Filter process function is used to obtain stable digital output value by filtering (delaying) noise or 
sudden change of input value. Filter constant can be specified for respective channels through user 
program or I/O parameters setting. 

 

• Setting range: 1 ~ 99 (%) 

 

F[n] = (1 - α) x A[n] + α x F [n - 1] 

         F[n]: Present filter output value 
         A[n]: Present A/D converted value 
         F[n-1]: Previous filter output value 
         Α: Filter constant (0.01 ~ 0.99: previous value added) 

 

 If filter setting value is not specified within 1 ~ 99, RUN LED flickering at an interval of 1 second. 
In order to set RUN LED to On status, reset the filter setting value within 1 ~ 99 and then 
convert PLC CPU from STOP to RUN. Be sure to use request flag of error clear (UXY.11.0) to 
clear the error through modification during RUN. 

 

• Analog input range: DC 0 ~ 10 V, Digital output range: 0 ~ 4000 

• If analog input value changes 0 V  10 V (0  4000), filter output value based on  value is 

as specified below.  

value Filter output value 
 value 

d 1 scan 2 scan 3 scan 
*1)

 0.01 0 3600 3960 3997 1% inclined toward previous value 

*2) 
0.66 0 1360 2257 2850 50% inclined toward previous value 

*3) 
0.99 0 40 80 119 99% inclined toward previous value 

*1) 4000 output after about 4 scans 
*2) 4000 output after about 18 scans 
*3) 4000 output after about 950 scans(1.19 s for 1 channel Run) 
 

 If filter process function is not used, present A/D converted value will be output as it is. The filter 
process function takes value-added data between ‘Present A/D converted value’ and ‘Previous 
A/D converted value’. And the value-added data can be decided with filter constant. If output 
data shakes too much, set a big filter constant value. 
 

(3) Average processing 

This process is used to execute A/D conversion of the channel designated for specified frequency or 
for specified time and save the average of the accumulated sum on memory. Average processing 
option and time/frequency value can be defined through user program or I/O parameters setting for 
respective channels. 

 
(a) What is the average process used for 

This process is used for A/D conversion of abnormal analog input signal such as noise to a value 
near to normal analog input signal.  

 

(b) Average processing type 

Average processing type is of time average and count average. 
 

 1) Time average processing 
▪ Setting range: 4 ~ 16000 (ms) 
▪ Average processing count within specified time is decided based on the number of channels 

used.  
 

Speed) Conversion( x used) Channels of(Number 

 timeSetting
count  processingAverage 

 

0 scan 
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Ex.1) Channels used: 1, setting time: 16000 ms 

 

times
ms

ms
10667

5.11

16000



 count processing Average  

 

Ex.2) Channels used: 4, setting time: 4 ms 

 

times
ms

ms
1

5.14

4



 count processing Average  

 

If setting value of time average is not specified within 4 ~ 16000, RUN LED flickering at an 
interval of 1 second. In order to set RUN LED to On status, reset the setting value of time 
average within 4 ~ 16000 and then convert PLC CPU from STOP to RUN. Be sure to use 
request flag of error clear (UXY.11.0) to clear the error through modification during RUN.  
 
• Time average is processed after converted to average of the times inside the A/D conversion 

module. In this case, a remainder may be produced when setting time is divided by (number of 
channels used X conversion speed), which will be disregarded. Thus, the average processing 
frequency will be the quotient of [(setting time) ÷ (number of channels used x conversion 
speed)]. 

 

Ex.) If the number of channels used is 5, and setting time is 151 ms  
 

151 ms ÷ (4 X 1.5 ms) = 26 times …… Remainder of 2  26 times 
 

 
2) Count average process 

• Setting range: 2 ~ 64000 (times) 

• The time required for average value to be saved on memory when frequency average used 

depends on the number of channels used. 
 

Process time = setting frequency X number of channels used X conversion speed 
 

If setting value of count average is not specified within 2 ~ 64000, RUN LED 
flickering at an interval of 1 second. In order to set RUN LED to On status, reset the 
setting value of frequency average within 2 ~ 64000 and then convert PLC CPU from 
STOP to RUN. Be sure to use request flag of error clear (UXY.11.0) to clear the error 
through modification during RUN. 

 
Ex.) If the number of channels used is 4, and average processing frequency is 50 

50 X 4 X (1.5 ms) = 300 ms 
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2.8 Wiring  
 

2.8.1 Precaution for wiring  
(1) Don’t let AC power line near to A/D conversion module’s external input sign line. With an enough 

distance kept away between, it will be free from surge or inductive noise. 
 (2) Cable shall be selected in due consideration of ambient temperature and allowable current, 

whose size is not less than the max. cable standard of AWG22 (0.3㎟). 

 (3) Don’t let the cable too close to hot device and material or in direct contact with oil for long, which 
will cause damage or abnormal operation due to short-circuit. 

 (4) Check the polarity when wiring the terminal. 
 (5) Wiring with high-voltage line or power line may produce inductive hindrance causing abnormal 

operation or defect. 

 

2.8.2 Wiring examples  
(1) Example of voltage wiring 

- In case of voltage/current input, wiring is same. Adjust the voltage/current setting switch 

according to the case. 

 

+

-

CH0+

-

+

-

CH2+

-

+

-

CH1+

-

+

-

CH3+

-

DC power

(For analog 

supply)

CH0+

CH0-

CH1+

CH1-

CH2+

CH2-

CH3+

CH3-

DC24V+

DC24V-

 

 
(a) Input resistance of current input circuit is 250 Ω (typ.).  

     (b) Input resistance of voltage input circuit is 1 MΩ (min.).  
     (c) Enable the necessary channel only. 

(d) Analog input module doesn’t support power for input device. Use the external power  
supplier. 
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(2) Wiring example of 2-Wire sensor/transmitter (current input) 

- In case of voltage/current input, wiring is same. Adjust the voltage/current setting switch 

according to the case. 

DC power

(for analog 

supply)

CH0+

CH0-

CH1+

CH1-

CH2+

CH2-

CH3+

CH3-

DC24V+

DC24V-

+2- Wire 
Tansmitter

-

CH0
DC

+

-

+2- Wire 
Transmitter

-

CH1
DC

+

-

+2- Wire 
Transmitter

-

CH2
DC

+

-

+2- Wire 
Transmitter

-

CH3
DC

+

-

 
 

(a) Input resistance of current input circuit is 250 Ω (typ.).  
 (b) Input resistance of voltage input circuit is 1 MΩ (min.).  
 (c) Enable the necessary channel only. 
 (d) Analog input module doesn’t support power for input device. Use the external power supplier. 
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(3) Wiring example of 4-Wire sensor/transmitter (Voltage/Current input) 

- In case of voltage/current input, wiring is same. Adjust the voltage/current setting switch 

according to the case. 

DC power

(For analog 

supply)

CH0+

CH0-

CH1+

CH1-

CH2+

CH2-

CH3+

CH3-

DC24V+

DC24V-

+4- Wire 
Transmitter

-

CH0
DC

+

-

+

-

CH1

+

-

CH2

+

-

CH3

4- Wire 
TransmitterDC

+

-

4- Wire 
TransmitterDC

+

-

4- Wire 
TransmitterDC

+

-

 
 

          (a) Input resistance of current input circuit is 250 Ω (typ.).  
          (b) Input resistance of voltage input circuit is 1 MΩ (min.).  
          (c) Enable the necessary channel only. 
          (d) Analog input module doesn’t support power for input device. Use the external  

power supplier. 
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(4) Relationship between voltage input accuracy and wiring length 

In voltage input, the wiring (cable) length between transmitter or sensor and module has an effect 
on digital-converted values of the module as specified below; 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
       

 
 

 
Where,        

 
Rc: Resistance value due to line resistance of cable 

        
       Rs: Internal resistance value of transmitter or sensor 
 

       Ri: Internal resistance value (1㏁) of voltage input module 

  
       Vin: Voltage allowed to analog input module  
 
       % Vi: Tolerance of converted value (%) due to source and cable length in voltage input 
 
 

                 
  RiRcRs

VsRi
Vin






2
  

 
 

1001% 









Vs

Vin
Vi %  

 
 

Vs 

Rs Rc 

Rc 

Ri 

Load 

 

Analog input (Voltage) 

Vin 
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2.9 Operation Parameter Setting 
 

A/D conversion module’s operation parameters can be specified through XG5000’s [I/O parameters]. 

 

(1) Settings 

For the user’s convenience of A/D conversion module, XG5000 provides GUI (Graphical User 
Interface) for parameters setting of A/D conversion module. Setting items available through [I/O 
parameters] on the XG5000 project window are as described below in the table.  

 

 

Item Details 

[I/O parameter] 

(1) Specify the following setting items necessary for the module 

operation. 

- Channel Enable/Disable setting 

- Setting ranges of input voltage/current 

- Output data format setting 

- Filter processing Enable/Disable setting 

- Filter constant setting 

- Average processing Enable/Disable setting 

- Average processing method setting 

- Average value setting 

(2) The data specified by user through S/W package will be saved on A/D 

conversion module when [Special Module Parameters] are 

downloaded. In other words, the point of time when [Special Module 

Parameters] are saved on A/D conversion module has nothing to do 

with PLC CPU’s status RUN or STOP. 

 

(2) I/O Parameter setting 

(a) Run XG5000 to create a project.  
   (Refer to XG5000 program manual for details on how to create the project) 

 
(b) Double-click [I/O parameters] on the project window.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 
(c) On the ‘I/O parameters setting’ screen, find and click the slot of the base A/D conversion module  

is installed on. 4-channel voltage type of A/D conversion module is installed on Base No.0, Slot  
No.4 in this description. 
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(d) Click the arrow button on the screen above to display the screen where an applicable module  
can be selected. Search for the applicable module to select. 

 

 

 

 

 

 

 

 

 

 

 

 

(e) After the module selected, click [Details]. 
 

 

 

 

 

 

 

 

 

 

 

 

(f) A screen will be displayed for you to specify parameters for respective channels as shown below. 
Click a desired item to display parameters to set for respective items. 
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Functions of Special Module Monitoring are as described below.  

 

 (1) Monitor/Test 
Through applicable XG5000 menu of [Monitor] -> [Special Module Monitoring], A/D converted 
value can be monitored and the operation of A/D conversion module can be tested. 

 (2) Monitoring the max./min. value  
The max./min. value of the channel can be monitored during Run. However, the max./min. value 
displayed here is based on the present value shown on the screen. Accordingly, when 
[Monitoring/Test] screen is closed, the max./min. value will not be saved. 

 

▪ The parameters specified for the test of A/D conversion module on the “Special Module 

Monitoring” screen of [Special Module Monitoring] will be deleted the moment the “Special 

Module Monitoring” screen is closed. In other words, the parameters of A/D conversion module 

specified on the “Special Module Monitoring” screen will not be saved in [I/O parameters] located  

 

 

 

▪ Test function of [Special Module Monitoring] is provided for user to check the normal operation of 
A/D conversion module even without sequence programming. If A/D conversion module is to be 
used for other purposes than a test, use parameters setting function in [I/O parameters]. 

 

2.10 Special Module Monitoring Functions 

Not saved in  
[I/O parameters] 
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2.10.1 How to use special module monitoring 
 

Monitoring special module will be based on XBF-AD04A.  
 

 (1) Start of [Special Module Monitoring] 

 Go through [OnLine] -> [Connect] and [Monitor] -> [Special Module Monitoring] to start. If the 
status is not [OnLine], [Special Module Monitoring] menu will not be active. 

 

 
 

 

 (2) How to use [Special Module Monitoring] 

(a) With XG5000 connected to PLC CPU (on-line status), click [Monitor] -> [Special Module 
Monitoring] to display ‘Special Module Select’ screen as in Fig. 5.1 showing base/slot 
information in addition to special module type. The module installed on the present PLC system 
will be displayed on the list dialog box. 
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(b) Select Special module and click [Module information] to display the information as below.  
 
 

 

 

(c) Click [Monitor] on the “Special Module” screen in [Special Module List] to display [Special Module 
Monitoring] screen as below, where 4 options are available such as [Reset max./min. value], [start 
Monitoring], [Test] and [Close]. A/D conversion module’s output value and max./ min. value are 
displayed on the monitoring screen at the top of the screen, and parameters items of respective 
modules are displayed for individual setting on the test screen at the bottom of the screen. 
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(d) [Start Monitoring]: Click [Start Monitoring] to display A/D converted value of the presently  
operated channel. Below screen is the monitoring screen displayed when the whole channels 
are in Stop status. In the present value field at the screen bottom, presently specified 
parameters of A/D conversion module are displayed 
.    
 

 

 Execution screen of [Start Monitoring] 
 

 

(e) [Test]: [Test] is used to change the presently specified parameters of A/D conversion module. 
Click the setting value at the bottom field of the screen to change parameters. Below screen 
will be displayed after [Test] is executed with channels 0’s input voltage range changed to -
0~20 mA in the state of input not wired.  

 

 
Execution screen of [Test] 
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(f) [Reset max/min value]: The max/min value field at the upper screen shows the max. value  

and the min. value of A/D converted value. Click [Reset max/min value] to initialize the  
max./min. value. Below screen is after [Reset max/min value] button is clicked in the screen  
of Special Module Monitor, where channel 0’s A/D converted value can be checked as reset.  

 

 

Execution screen of [Reset max/min value] 
 

. 

(g) [Close]: [Close] is used to escape from the monitoring/test screen. When the monitoring/test 
screen is closed, the max. value, the min. value and the present value will not be saved any 
more. 
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2.11 Register U devices 
 
Register the variables for each module referring to the special module information that is set in the I/O 
parameter. The user can modify the variables and comments. 

 
(1) Procedure 

 
(a) Select the special module type in the [I/O Parameter Setting] window. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
(b) Double click ‘Variable/Comment’ from the project window. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
(c) Select [Edit] – [Register U Device]. 
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(d) Click ‘Yes’.  
 

 
 
 

 
(e) As shown below, the variables are registered.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

     (f) For IEC type, as shown below, the variables are registered. 

 
 
(2) Save variables 

(a) The contents of ‘View Variable’ can be saved as a text file. 
(b) Select [Edit] -> [Export to File]. 
(c) The contents of ‘View variable’ are saved as a text file. 
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(3) View variables 

The example of XGB ‘S’ type and ‘H’ type is as follows. 
(a) The example program of XG5000 is as shown below.   

 
 
(b) Select [View] -> [Variables]. The devices are changed into variables. 

 

 
 

(c) Select [View] -> [Devices/Variables]. Devices and variables are both displayed. 
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(d) Select [View] -> [Device/Comments]. Devices and comments are both displayed. 

 

 
 

     (e) In case of IEC, you can see variables with diverse option at ‘View’ menu like (b)~(d). The following 
is example selecting ‘View Variable/Comment’ at IEC type.   
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2.12 Configuration and Function of Internal Memory 
 

A/D conversion module has the internal memory to transmit/receive data to/from PLC CPU.  

 

2.12.1 I/O area of A/D converted data 
I/O area of A/D converted data is as displayed in table.  

 

Device assigned 
(“S” or “H” type) 

Device assigned 
(IEC type) 

Details R/W Sign direction 

UXY.00.0 
UXY.00.F 

%UX0.x.0 
%UX0.x.15 

Module ERROR flag  
Module READY flag 

R A/D → CPU 

UXY.01.0 
UXY.01.1 
UXY.01.2 
UXY.01.3 

%UX0.x.16 
%UX0.x.17 
%UX0.x.18 
%UX0.x.19 

CH0 Run flag 
CH1 Run flag 
CH2 Run flag 
CH3 Run flag 

R A/D → CPU 

UXY.02 %UW0.x.2 Ch0 digital output value R 

A/D → CPU 

 

UXY.03 %UW0.x.3 Ch1 digital output value R 

UXY.04 %UW0.x.4 Ch2 digital output value R 

UXY.05 %UW0.x.5 Ch3 digital output value R 

UXY.11.0 %UX0.x.176 Flag to request error clear W CPU → A/D 

 
- In the device assigned, X stands for the Base No. and Y for the Slot No. on which module is installed. 
- In order to read ‘CH1 digital output value’ of A/D conversion module installed on Base No.0, Slot No.4, 

it shall be displayed as U04.03. (in case of IEC type, %UW0.4.3) 
 

Device Type

Base No.

U 0 4 . 0 3

Slot No.

Word Sorter

Word

 
 

- In order to read ‘Flag to detect CH4 disconnection’ of A/D conversion module installed on Base No.0, 
Slot No.5, it shall be displayed as U05.10.4. 
 

 

Device Type

Base No.

U 0 5 . 1 0

Slot No.

Word Sorter

Word

. 4

Bit Sorter

Bit

 
 
 

Device Type

 % U W 0 . 4 . 3

Slot No.

Base No

Word

“S” or “H” type IEC type 

“S” or “H” type 

Device Type

 % U X 0 . 5 . 19

Slot No.

Base No

 Bit

IEC type 
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 (1) Module Ready/Error flag (U0x.00, x: slot number) 

(a) U0x.00.F: It will be ON when PLC CPU is powered or reset with A/D conversion ready to 
process A/D conversion. 

    (b) U0x.00.0: It is a flag to display the error status of A/D conversion module. 
 

 

 

 

 

 

 

 

 

 

(2) Run channel flag (UXY.01, X: Base No., Y: Slot No.) 

The area where Run information of respective channels is saved  
* XGB series base number is 0  

 
 

 

 

 

 

 

 

 

 

(3) Digital output value (UXY.02 ~ UXY.09, X: Base No., Y: Slot No.) 

(a) A/D converted-digital output value will be output to buffer memory addresses UXY.02 ~  
UXY.05 (%UW0.x.2 ~ %UW0.x.5) for respective channels. 

(b) Digital output value will be saved in 16-bit binary. 

※ XGB PLC’s base number is 0. 
                              

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Channel 0 digital output value 

Channel 1 digital output value 

Channel 2 digital output value 

Channel 3 digital output value 
                                

 

 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

R
e

a
d

y
 

— — — — — — — — — — — — — — 

E
rro

r  

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — — — — — — 

C

H

3 

C

H

2 

C

H

1 

C

H

0 

Error status 
Bit On (1): error, Bit Off (0): normal 

U0x.00 

Module READY 
 Bit On (1): normal, Bit Off (0): error 

Run channel information 
Bit ON (1): During Run, Bit Off (0): Operation Stop 

UXY.01 

(UW0.x.0) 

(%UW0.x.1) 

 

U0x.02 

U0x.03 

U0x.04 

U0x.05 

U0x.02 

U0x.03 

U0x.04 

U0x.05 

(%UW0.x.2) 

(%UW0.x.3) 

(%UW0.x.4) 

(%UW0.x.5) 
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(4) Flag to request error clear (( ) means the case of IEC type, x: slot number) 

(a) If a parameters setting error occurs, address No.22’s error code will not be automatically  

erased even if parameters are changed correctly. At this time, turn the ‘error clear request’ bit 

ON to delete address No.22’s error code and the error displayed in XG5000’s [System  

Monitor]. In addition, RUN LED which flickering will be back to On status. 

(b) The ‘flag to request error clear’ shall be used surely together with UXY.00.0 attached thereon 
 for guaranteed Normal operation. 

   ※ XGB PLC base number is 0 

 

 

 

 

 

 

 

 

 

 

 

 

 
[How to use the flag to request error clear (“S” type or “H” type)] 

 

 

 

[How to use the flag to request error clear (IEC type)] 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — — — — — — — — — 

E 

C 

R 

Flag to request error clear (UXY.11.0) 
Bit ON (1): Error clear request, Bit Off (0): Error clear standing-by 

UXY.11.0 

(%UX0.x.11) 
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2.12.2 Operation parameters setting area  

 
Setting area of A/D conversion module’s Run parameters is as described in Table. 

 

Memory address 
Details R/W Remark 

Hex. Dec. 

0H 0 Channel enable/disable setting R/W PUT 

1H 1 
Setting ranges of input 

voltage/current 
R/W PUT 

2H 2 Output data format setting R/W PUT 

3H 3 
Filter processing enable/disable 

setting 
R/W PUT 

4H 4 CH0 filter constant 

R/W PUT 
5H 5 CH1 filter constant 

6H 6 CH2 filter constant 

7H 7 CH3 filter constant 

CH 12 
Average processing enable/disable 

setting 
R/W 

PUT 

DH 13 Average processing method setting R/W 

EH 14 CH0 average value 

R/W 
FH 15 CH1 average value 

10H 16 CH2 average value 

11H 17 CH3 average value 

16H 22 Error code R/W GET 

※R/W is to denote Read/Write if available from PLC program. 
 

  
(1) Setting operation channels 

If the channel to use is not specified, all the channels will be set to prohibit. 
 
 
 

 
 
 
 
 
 
 
 

(2) Setting input range 
The range of analog voltage input is DC 0~10V, the range of analog current input is DC 4~20mA.  

 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

— — — — — — — — — — — — 
CH. 

3 

CH. 

2 

CH. 

1 

CH. 

0 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

— — — — — — — — CH.3 CH.2 CH.1 CH.0 

Setting channel to use (bit) 
      Bit On (1): Run, Bit Off (0): Stop 

Address 0  

Setting input range (bit) 
 00: 0 ~ 10V(4 ~ 20mA) 
 01: 0 ~ 20mA 
 11: 4 ~ 20mA 

Address 1 
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(3) Setting output data type 

 (a) The range of digital output data for analog input can be specified for respective channels.  
 (b) If the output data range is not specified, the range of all the channels will be set to 0 ~ 4000. 

 
 
 

 
 
 
 
 
 
 
 

 
 

 
(4) Setting filter process 

If the filter process is not specified, the filter process of all channels will not be executed. 
 
 
 

 
 
 
 
 
 

 
 

  (5) Setting filter constant 
            When using the filter process, specify the filter constant. 

 
 
 
 
 
 
 
 
 
 

(6) Setting average process 
If the average process is not specified, the average process of all channels will not be executed. 

 
 
 

 
 
 
 
 
 

 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

— — — — — — — — CH.3 CH.2 CH.1 CH.0 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

— — — — — — — — — — — — 
CH. 

3 

CH. 

2 

CH. 

1 

CH. 

0 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

CH.0 filter constant 

CH.1 filter constant 

CH.2 filter constant 

CH.3 filter constant 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 it0 

— — — — — — — — — — — — 
CH. 

3 

CH. 

2 

CH. 

1 

CH. 

0 

Setting output data type (bit) 
 00: 0 ~ 4000 
 01: -2000 ~ 2000 
 10: 0 ~ 1000(400 ~ 2000/0 ~ 2000) 
 11: 0 ~ 1000 
 

Address 2 

Setting filter process (bit) 
            Bit On (1): used, bit Off (0): not used 

Address 3 

Address 4 

Address 5 

Address 6 

Address 7 

Setting average process (bit) 
Bit On (1): used, Bit Off (0): not used 

Address 12 
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(7) Setting average process method 
 This area is used to specify average processing method, where ‘count average’ and ‘time 
average’ are available.  

 
 
 

 
 
 
 
 
 
 
 

 
 

(8) Error code (address 22) 

(a) It saves the error code detected from A/D conversion module.  
(b) Error type and details is as below.  
  

 
 

 

  

 

Error code (Dec.) Details Remark 

0 Normal operation RUN LED flickering 

50#  Exceeding of filter constant setting range 

Flickering RUN LED  
1s intervals 

60# Exceeding of time average setting range 

70# 
Exceeding of Frequency average setting 
range 

80#  Setting error of analog input range 

 

※ # of the error codes stands for the channel with error found.  

 

(c) If 2 or more errors occur, the module sill not save other error codes than the first error code 
found. 

(d) If an error found is corrected, use the ‘flag to request error clear’, or let power OFF  ON in  
order to stop LED blinking and to delete the error code. 

. 

 

 

 

 

 

 

 

 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

— — — — — — — — CH.3 CH.2 CH.1 CH.0 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

— — — — — — — — Error code 

Address 22 

Setting average process method (bit) 
 00: count average 
 01: time average 

Address 13 
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2.13 Example Program 
 

2.13.1 Program to sort A/D converted value in size  
(1) System configuration 

 
 

 
 
 
 
 
 
 
 
 
  
 

 
  

(2) Initial setting 

 

No. Item Details 
Internal memory 

address 
The value to write in 
internal memory 

1 Channel Ch0, Ch1, Ch2 0 h0007 

2 Input voltage range 0 ~ 10 V 1 h0000 

3 Output data range 0 ~ 4000 2 h0000 

4 Filter process Ch 0 3 h0001 

5 Ch 0 filter constant 50 4 50 

6 Average process Ch1, Ch2 12 h0006 

6 
Average process 

method 
Frequency average: Ch1 
Time average: Ch2 

13 h0100 

7 Average value 

Frequency average value: 

100 (times) 
15 100 

Time average value:  

200 (ms) 
16 200 

 
(3) Program  

(a) If Ch 0’s digital value is less than 3000, Contact No. 0 (P00080) of relay output module 
installed on Slot No.2 will be On.   

(b) If CH 1’s digital value is greater than 3200, Contact No.2 (P00082) of relay output module 
installed on Slot No.2 will be On. 

(c) If CH 2’s digital value is greater than or equal to 3000 and less than or equal to 3200, Contact 
No.4 (P00086) of relay output module installed on Slot No.2 will be On. 

(d) If CH 2’s digital value is equal to 3200, Contact No.5 (P00085) of relay output module installed 
on Slot No.2 will be On. 
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(4) Program 

(a) Program example using [I/O Parameters] 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   
[Program in case of “S” type or “H” type] 

Slot no. Internal 
memory 
address 

Device for 
saving 

Data no. to read 

Read error code 
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[Program in case of IEC type] 
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(b) Program example of PUT/GET instruction used 

 

 

 
[Program in case of “S” type or “H” type] 

Channel Run signal 
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[Program in case of IEC type]
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2.14 Troubleshooting 
 

2.14.1 RUN LED flickers 
 

 
 

Error code 
(Dec.) 

Error Details Action 

50# 
Filter constant setting 

range exceeded 
Change filter constant setting value within 1 ~ 99. 

60# 
Time average setting 

range exceeded 
Change time average setting value within 4 ~ 
16000. 

70# 
Frequency average 

setting range exceeded 
Change frequency average setting value within 2 
~ 64000. 

 ※ # indicates channel number. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RUN LED flickers. 

RUN LED flickers 0.2s intervals. 

It seems to be a module defect.  
Contact the nearest agency or LS branch office. 

RUN LED flickers 1s intervals. 

It is Run parameters setting error. Check the error code to 
take action against as follows in the table below. 

Yes 

No 

Yes 
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2.14.2 RUN LED is off 

RUN LED is off. 

A/D conversion module is installed on the base 

correctly? 

Correctly install A/D conversion module on the base. 

. 

Contact the nearest agency or A/S center. 

 

I/O information can be seen at the XG5000. 

Normally operated if A/D conversion module with 

error is changed to another module 

No 

Yes 

No 

Yes 

Yes Contact the nearest agency or A/S center. 
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2.14.3 A/D conversion value is not normal 

A/D conversion value is “0”. 

Channel status is set as Enable. 

External power (DC 24V) is supplied. 

Check and correct the channel status on the I/O parameter. 

Supply external power (DC 24V) 

Refer to 2.8.2 and wire properly. 

Wiring of each channel is normal. 

Input voltage/current of external terminal block  
is normal. 

Check the status of the external input sensor 

No 

Yes 

No 

Yes 

No 

Yes 

No 
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2.14.4 Status check of A/D conversion module through XG5000 system monitor 
 
Module type, module information, OS version and module status of A/D conversion module can be 
checked through XG5000 system monitoring function. 
 

1) Execution sequence 

Two routes are available for the execution. 
(1) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button to 

display [Module Information]. 
(2) [Monitor] -> [System Monitoring] -> And Double-click the module screen. 

 

2) Module information 

(1) Module type: shows the information of the module presently installed. 
(2) Module information: shows the OS version information of A/D conversion module. 
(3) O/S version: shows the OS prepared date of A/D conversion module. 
(4) Module status: shows the present error code. (Refer to 7.1 for detailed error codes) 
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Chapter 3 Analog Output Module 
 

3.1 Setting Sequence before Operation  
 

Before using the analog output module, follow steps below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 

 

XBF-DV04A / XBF-DC04A/ XBF-DC04B 

 

 

 

 

 

 Checking performance specification 

System configuration and selection 

Wiring 

Checking analog output data 

Setting parameter 

Programming 

Specification 
 Operating environment 
 Digital input range 
 Analog output range 

System configuration 
 Max. No. equip-able 
 Selecting the external power 

Wiring 
 Wiring (external DC24V) 
 Analog output wiring 

Analog output test 
 XG5000 special module monitor 

test mode 

Parameter 
 XG5000 I/O parameter 

Programming 
 Program for writing digital data  

(U device) 

 
If there is error or analog output  
is abnormal, refer to the trouble shooting. 
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3.2 Specification 
 

3.2.1 General specifications 
 
Here describes general specification of analog output module. 

No. Items Specification Reference 

1 
Operating 

temperature 
0 ~ 55 C 

 

2 
Storage 

Temperature 
25 ~ 70 C 

3 
Operating 

humidity 
5 ~ 95%RH (Non-condensing) 

4 
Storage 

humidity 
5 ~ 95%RH (Non-condensing) 

5 
Vibration 

immunity 

Occasional vibration  

Frequency Acceleration Pulse width Times 

IEC61131-2 

10    f    57Hz  0.075mm 

10 times 

each 

direction  

(X,Y and Z) 

57    f    150Hz 9.8m/s
2 
(1G)  

Continuous vibration 

Frequency Acceleration Pulse width 

10    f    57Hz  0.035mm 

57    f    150Hz 4.9m/s
2 
(0.5G)  

6 
Shocks 

immunity 

 Peak acceleration : 147 m/s
2 
(15G) 

 Duration : 11ms 

 Pulse wave type : Half-sine (3 times each direction per each axis) 

7 
Noise 

immunity 

Square wave 

impulse noise 

AC: 1,500 V 

DC:  900 V 
LSIS standard 

Electrostatic 

discharge 
Voltage: 4kV (Contact discharge) 

IEC61131-2 

IEC61000-4-2 

Radiated 

electromagnetic 

field noise 

80 ~ 1,000 MHz, 10V/m 
IEC61131-2, 

IEC61000-4-3 

Fast transient 

/Burst noise 

Segment 
Power 

supply 

Digital/Analog Input/Output, 

Communication Interface 
IEC61131-2 

IEC61000-4-4 
Voltage 2kV 1kV 

8 
Operation 

ambience 
Free from corrosive gases and excessive dust 

 9 Altitude Less than 2,000m 

10 Pollution degree Less than 2  

11 Cooling method Air-cooling 
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3.2.2 Performance specifications 
 
Here describes performance specification of analog output module. 

Item 
Specification 

XBF-DV04A XBF-DC04A XBF-DC04B 

Analog 

output 

Type Voltage Current Current 

Range 

DC 0 ~ 10V 

(Load resistance:  

2kΩ or more) 

DC 4 ~ 20mA 

DC 0 ~ 20mA 

(Load resistance: 

510Ω or less) 

DC 0 ~ 1.2mA 

(Load resistance: 
510Ω or less) 

Digital 

input 

Type 12-bit binary data 

Range 

Signed value 0 ~ 4000 0 ~ 4000 0 ~ 4000 

Unsigned value -2000 ~ 2000 -2000 ~ 2000 -2000 ~ 2000 

Precise value 0 ~ 1000 400 ~ 2000/0 ~ 2000 0 ~ 1,200 

Percentile value 0 ~ 1000 0 ~ 1000 0 ~ 1,000 

Maximum resolution 2.5㎷ (1/4000) 5㎂ (1/4000) 0.3㎂ (1/4000) 

Accuracy ±0.5% or less 

Maximum conversion speed 1 ㎳/channel 

Absolute maximum output DC ±15V DC +25 ㎃ 

Number of maximum channel 4 channels 

Insulation method 
Photo-coupler insulation between input terminal and PLC power 

(no insulation between channels) 

Terminal connected 11-point terminal block 

I/O points occupied Fixed type: 64 points 

Max. no. of installation 
7 (when using XBM(C)-DxxxS type) 
10 (when using XB(E)C-DxxxH type) 

Current 

consump

tion 

Internal (DC 5V) 110mA 110mA 

External  

(DC 21.6 ~26.4V) 
70mA 120mA 

Weight 64g 70g 

 
 

 

 

 

 

 

 

Remark  

Offset and gain about analog output range have been set at the factory and the user can change them.  
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3.3 Designations and Functions  
 

 

Here describes designation and functions.  

 
 

 
           

No. Description 

① 

RUN LED  

It displays the operation status of D/A conversion module 

- On: Normal operation status 

- Flickering: Error occurred 

- Off: Power off or abnormal status of the module 

② 

Analog output terminal (Voltage, Current)  

It is an output terminal to connect an analog output (Voltage, Current) of each 

channel to external machinery and tools. 

③ 

External power input terminal  

It is an external DC 24V input terminal that supplies power for an analog 

output (voltage, current). 
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3.4 Characteristic of I/O Conversion  
 

Characteristic of I/O conversion converts a digital input into an analog output (voltage, current) and 
displays a straight line with the gradient as shown below. The range of digital input is shown with 
Unsigned Value, Signed Value, Precise Value, and Percentile Value such as the graph below.  
 

Digital input range

Offset value

Gain 

value

Digital 

input

Analog 

output

2000 40000-48 4047

0 2000-2000-2048 2047

500 10000-12 1011

500 10000-12 1011

Unsigned value

Singed value

Precise value

Percentile value

10V

0V

5V

A
n

a
lo

g
 o

u
tp

u
t ra

n
g

e

20mA

4mA

12mA

20mA

0mA

10mA

1200 2000400381 2018

1000 20000-24 2023
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3.5 Characteristic of Input/Output 
 

The range of a voltage output is DC 0 ~ 10V and a current output is DC 4 ~ 20mA / DC 0 ~ 20mA. 

  
 

Digital input value toward analog voltage output is shown below. 

Resolution: 2.5mV (1/4000), Accuracy: within ±0.5% 

The range of 

digital input 

Analog voltage output 

under 0V 0V 2.5V 5V 7.5V 10V over 10V 

Unsigned value 

(-48 ~ 4047) 
under 0 0 1000 2000 3000 4000 over 4000 

Signed value 

(-2048 ~ 2047) 
under -2000 -2000 -1000 0 1000 2000 over 2000 

Precise value 

(-12 ~ 1011) 
under 0 0 250 500 750 1000 over 1000 

Percentile value 

(-12 ~ 1011) 
under 0 0 250 500 750 1000 over 1000 

 

Digital input value toward analog current output is shown below. 

Resolution: 5μA (1/4000), Accuracy: within ±0.5% 

The range of 

digital input 

Analog current output 

under 4mA 4mA 8mA 12mA 16mA 20mA over 20mA 

under 0mA 0mA 5mA 10mA 15mA 20mA over 20mA 

Unsigned value 

 (-48 ~ 4047) 
under 0 0 1000 2000 3000 4000 over 4000 

Signed value 

(-2048 ~ 2047) 
under -2000 -2000 -1000 0 1000 2000 over 2000 

Precise value 

(381 ~ 2018, -24 ~ 2023) 

under 400 400 800 1200 1600 2000 over 2000 

under 0 0 500 1000 1500 2000 over 2000 

Percentile value 

(-12 ~ 1011) 
under 0 0 250 500 750 1000 over 1000 
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3.6 Accuracy 
 

Though the range of input is changed, the accuracy for the analog output values doesn’t change. The 

range of accuracy is displayed at the ambient temperature of 25 ± 5 ℃ if you select unsigned value as 

your range of the digital input. The accuracy is satisfied ±0.5%.  

 

2000 40000

10V

0V

5V

10.05V

9.95V

0.05V

-0.05V

Digital input

A
n

a
lo

g
 o

u
tp

u
t

20mA
20.1mA

19.9mA

0mA
0.1mA

-0.1mA

10mA

 
 

 
 
 (1) Accuracy in case of 5V output 
 4000 × 0.5% = 20 

in case of 5V output, accuracy range is 
(5V - 20×0.0025V) ~ (5V+20×0.0025V) = 4.95V ~ 5.05V  

 
 
 (2) Accuracy in case of 10V  
 4000 × 0.5% = 20 
 in case of 10V output, accuracy range is  

(10V - 20×0.0025V) ~ (10V + 20×0.0025V) = 9.95 ~ 10.05 
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3.7 Functions of Analog Output Module 
 

 
Here describes functions of XBF-DV04A/DC04A module. 

Function Details 

Operation 

channel 

1) It sets up Run/Stop of a channel that will operate an analog output. 

2) You can save the time of whole operation by stopping unused channels. 

The range of 

output 

1) It sets up the range of an analog output. 

2) Analog voltage output module offers one range of output (DC 0 ~ 10V) and 

analog current output module offers two (DC 4 ~ 20mA, DC 0 ~ 20mA). 

The range of 

input data 

1) It sets up the range of a digital input. 

2) It offers four ranges of a digital input. 

The status of 

channel output 

1) It sets up the output status of a channel when it switches Run to Stop. 

2) It offers four types of output status. 
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3.8 Wiring  
 

3.8.1 Precautions for wiring  
 

(1) Use separate cable of an A.C. power line and an external output signal of an analog output 

 module to prevent a surge or inductive noise from the A.C. side. 

(2) Select the cable with consideration of an ambient temperature and a permitted current limit. It is 

 recommended over AWG22 (0.3㎟). 

(3) Don’t let the cable at close range to hot devices or materials. And don’t bring it into contact with  

oil for a long time. These are the factors of a short circuit occurs unusual operation or damages  

devices. 

(4) Check the polarity before external power is supplied to the terminal. 

(5) It may produce inductive hindrance that is a cause of unusual operations or defects if you wire  

the cable with a high-voltage line or a power line.  

 

3.8.2 Wiring example  
(1) Wiring example for analog voltage output module 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

(2) Wiring example for analog current output module 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
※1: Use a 2-core twisted shielded wire. 
 

D/A 

Conversion 

circuit

DC/DC 

Conversion circuit

CH0+

CH0-

CH3+

CH3-

CH1+

CH1-

CH2+

CH2-

DC +24V

DC 0V

CH0

CH3

+15V

-15V

DC +24V

DC 0V

Over 2kΩ

Over 2kΩ

Motor driver etc.

Motor driver etc.

GND

GND

XBF-DV04A

※1

※1

D/A 

Conversion 

circuit

DC/DC 

Conversion circuit

CH0+

CH0-

CH3+

CH3-

CH1+

CH1-

CH2+

CH2-

DC +24V

DC 0V

CH0

CH3

+15V

-15V

DC +24V

DC 0V

Under 
510Ω

Under 
510Ω

Motor driver etc.

Motor driver etc.

GND

GND

XBF-DC04A

※1

※1



XGB Analog edition manual 

3 - 10 

 

 

3.9 Operation Parameter Setting   
 

You can specify operation parameters of the analog output module through [I/O parameters] menu in 
XG5000. 
 

(1) Setting items  

For the user’s convenience, XG5000 provides GUI (Graphical User Interface) for parameters setting of 

analog voltage/current output module. 
Followings are available through [I/O parameters] on the XG5000 project window. 

 

Item Details 

[I/O Parameters] 
(1) It specifies the following items for the module operation. 

- Channel Enable/Disable 

- Analog output range 

- Input type 

- Channel output type 
(2) After the parameters that user specified in XG5000 are downloaded, 

they will be saved to a flash memory in the CPU unit.. 

 

(2) How to use [I/O Parameters] menu  

(a) Run XG5000 to create a project. (Refer to XG5000 program manual for details on how to create  
the project) 

 
(b) Double-click [I/O Parameters] on the project window. 

 
 
(c) Click the slot of the base that contains analog output module in the [I/O Parameter Setting] window. 

In the example, the analog output module is contained in the slot 1. 
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(d) Click the arrow button then you can see the menu to choose the applicable module. Select the  

applicable module. 

 
 
 
(e) Double-click the applicable slot that is selected for the parameters setting or click [Details]. 

 
 
 
(f) A screen will be displayed for you to specify parameters for respective channels as shown below.  

Click a desired item to display parameters to set for respective items. 
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3.10 Special Module Monitoring Function 
 

You can start to test the analog output module connecting by [Online]  [Connect] and then click 
[Monitor]  [Special Module Monitoring] menu in XG5000. 
 

Remark  

1) If the program is not displayed normally because of insufficient system resource, you may start  
XG5000 again after close the program and other applications. 

2) I/O parameters those are specified in the state of [Special Module Monitoring] menu are temporarily  
set up for the test. They will be disappeared when the [Special Module Monitoring] is finished. 

3) Testing of [Special Module Monitoring] is the way to test the analog output module. It can test the  
module without a sequence program. 

 

3.10.1 How to use special module monitoring 
 
Special module monitoring function is described below based on the analog voltage output module (XGF-
DV04A). 

 

 (1) Start of [Special Module Monitoring] 
Go through [Online]  [Connect] and [Monitor]  [Special module Monitoring] to start. If the  
status is not online, [Special Module Monitoring] menu will not be activated.  

 

 
 

 (2) How to use [Special Module Monitoring]  
(a) Connecting XG5000 with PLC basic unit, [Special Module List] window will show base/slot 

information and types of special module by click [Monitor]  [Special Module Monitoring].  
   Special Module List wiil display the modules that are installed in PLC now. 
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(b) Select a special module then click [Module Info.] button to display the information as described 
below. 

 
 

(c) Click [Monitor] button in the [Special Module List] window to display the [Special Module 
Monitor] window as below 

 

Parameter setting for a test 
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(d) [Start Monitoring] button will show you digital input data of the operating channel.  

 
 

(e) [Test] is used to change the parameters of the voltage output module. You can change the 
parameters when you click the values at the bottom of the screen. It is only available when 
XGB CPU unit’s status is in [Stop Monitoring]. 

                     
 

(f) [Close] is used to escape from the monitoring/test screen.  

Monitoring screen 

Details of channel 0 
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3.11 Register U devices (special module variable) 
 

Register the variables for each module referring to the special module information that is set in the I/O 
parameter. The user can modify the variables and comments. 

  
 (1) Registration sequence 

(a) Select a special module type in [I/O Parameter Setting] window.  
 

 
 

(b) Double-click [Variable/Comment] from the project window. 

 
 

(c) Select [Edit]  [Register U Device]. 
In case of IEC, select [Edit] [Register special module variable] 
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(d) Click ‘Yes’. 

 
 

(e) As shown below, the variables are registered. 
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 (2) Save variables 

(a) The contents of ‘View Variables’ can be saved as a text file 
(b) Click [Edit]  [Export to File]. 
(c) The contents of ‘View Variable’ are saved as a text file.  

 
 
 

 (3) View variables in a program 
(a) The example of XG5000 is shown below.  

 
 

(b) Select [View]  [Variables]. The devices are changed into variables. 

 
 

(c) Select [View]  [Devices/Variables]. Device and variable both are displayed. 
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(d) Select [View]  [Devices/Comments]. Device and comment both are displayed. 
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3.12 Internal memory  
 

Describes configuration and function of internal memory 
 

3.12.1  Data I/O area 
Describes data I/O area of analog output module 

Address 
(‘s’, ‘h’ type) 

Address 
(IEC type) 

Description Details Remarks 

U0x.00 %UW0.x.0 Module Ready / Error 
F(15) Bit On(1): Module Ready 

0~3 Bit On(1): Channel Error Read 

available 
U0x.01 %UW0.x.1 CH operation information 

Bit On(1): Channel Run 

Bit Off(0): Channel Stop 

U0x.02 %UW0.x.2 Output setting 
Bit On(1): Output Allow 

Bit Off(0): Output Forbid 

Read/Write 

available 

U0x.03 %UW0.x.3 CH0 digital input value 

12-bit binary data 
U0x.04 %UW0.x.4 CH1 digital input value 

U0x.05 %UW0.x.5 CH2 digital input value 

U0x.06 %UW0.x.6 CH3 digital input value 

※ In the device assignment, x stands for a slot number that the module is installed 
 

(1) Module Ready/Channel Error information ( ( ) means deice name of IEC type) 
(a) U0x.00.F (%UX0.x.15): It will be ON when XGB CPU unit is powered or reset with the condition 

that an analog output module has prepared to convert. 
(b) U0x.00.0 ~ U0x.00.3 (%UW0.x.0~%UW0.x.3): It is the flags those display error status of each 

channel in the analog output module. 
 

 
 
 
 
 
 
 

 
 
 
 
 
(2) Channel operation information 

(a) This area is used to display the channel being used. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

R
e
a
d
y 

— — — — — — — — — — — 
C
H
3 

C
H
2 

C
H
1 

C
H
0 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — — — — — — 
C
H
3 

C
H
2 

C
H 
1 

C
H 
0 

Error information (bit) 
 Bit On (1): Error 
 Bit Off (0): Normal 

Module Ready 
 Bit On (1): Ready 
 Bit Off (0): Not Ready  

Run channel information (bit) 
 Bit On (1): During Run 
 Bit Off (0): Operation Stop 

U0x.00 

U0x.01 

(%UW0.x.0) 

(%UW0.x.1) 
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(3) Output setting 

(a) Each channel can be specified enable/disable the analog output. 
(b) If the output is not specified, output of all the channels will be disabled. 
 

 
 
 
 
 
 
 

 
 
 
 
(4) Digital input 

(a) Digital input value can be selected and used within the range of -48~4047, -2048~2047, -
12~1011 (381~2018/-24~2023), and -12~1011 based on input type. 

(b) If the digital input value is not specified, it will be set to 0. 
 

 
 
 
 
 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — — — — — — 
C
H 
3 

C
H 
2 

C
H 
1 

C
H 
0 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Digital input Data of CH0 

Digital input Data of CH1 

Digital input Data of CH2 

Digital input Data of CH3 

Address 

(‘S’, ‘H’ type) 
Address 

(IEC type) 
Details 

U0x.03 %UW0.x.3 Digital input value of CH0 

U0x.04 %UW0.x.4 Digital input value of CH1 

U0x.05 %UW0.x.5 Digital input value of CH2 

U0x.06 %UW0.x.6 Digital input value of CH3 

Output status setting (bit) 
 Bit On (1): Allowed 
 Bit Off (0): Forbidden 

U0x.02 

U0x.03 
 

U0x.04 
 

U0x.05 
 

U0x.06 

 

(%UW0.x.2) 

(%UW0.x.3) 

(%UW0.x.4) 

(%UW0.x.5) 

(%UW0.x.6) 
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3.12.2  Setting area of operation parameters 
 
XBF-DV04A 

Address 
(Dec) 

Description Details Remarks 

0 Set up the run channel 
Bit On(1): Run 
Bit Off(0): Stop 

Read/Write 
available 

1 Set up the output voltage range Bit (00): 0 ~ 10V 

2 Set up the input data type 

Bit (00): 0 ~ 4000  
Bit (01): -2000 ~ 2000 
Bit (10): 0 ~ 1000 
Bit (11): 0 ~ 1000 

3 Set up the output type of CH0 
0: outputs the previous value 
1: outputs the min. value of output range 
2: outputs the mid. value of output range 
3: outputs the max. value of output range 

4 Set up the output type of CH1 

5 Set up the output type of CH2 

6 Set up the output type of CH3 

11 CH0 setting error 

Error code 
Read 

available 

12 CH1 setting error 

13 CH2 setting error 

14 CH3 setting error 

 
XBF-DC04A 

Address 
(Dec) 

Description Details Remarks 

0 Set up the run channel 
Bit On(1): Run 
Bit Off(0): Stop 

Read/Write 
available 

1 Set up the output voltage range 
Bit (00): 4 ~ 20mA 
Bit (01): 0 ~ 20mA 

2 Set up the input data type 

Bit (00): 0 ~ 4000  
Bit (01): -2000 ~ 2000 
Bit (10): 400 ~ 2000/0 ~ 2000 
Bit (11): 0 ~ 1000 

3 Set up the output type of CH0 
0: outputs the previous value 
1: outputs the min. value of output range 
2: outputs the mid. value of output range 
3: outputs the max. value of output range 

4 Set up the output type of CH1 

5 Set up the output type of CH2 

6 Set up the output type of CH3 

11 CH0 setting error 

Error code 
Read 

available 

12 CH1 setting error 

13 CH2 setting error 

14 CH3 setting error 
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XBF-DC04B 

Address 
(Dec) 

Description Details Remarks 

0 Set up the run channel 
Bit On(1): Run 
Bit Off(0): Stop 

Read/Write 
available 

1 Set up the output voltage range 
Bit (00): 4 ~ 20mA 
Bit (01): 0 ~ 20mA 

2 Set up the input data type 

Bit (00): 0 ~ 4000  
Bit (01): -2000 ~ 2000 
Bit (10): 0 ~ 1200 
Bit (11): 0 ~ 1000 

3 Set up the output type of CH0 
0: outputs the previous value 
1: outputs the min. value of output range 
2: outputs the mid. value of output range 
3: outputs the max. value of output range 

4 Set up the output type of CH1 

5 Set up the output type of CH2 

6 Set up the output type of CH3 

11 CH0 setting error 

Error code 
Read 

available 

12 CH1 setting error 

13 CH2 setting error 

14 CH3 setting error 

 
 
 
(1) Setting up the run channel 

If the run channel is not specified, all the channels will be set to Stop. 
 

 
 
 
 
 
 
 
 
 

(2) Setting up the output voltage/current range 
The range of analog output voltage is DC 0 ~ 10V and analog output current is DC 4 ~ 20mA,  
DC 0 ~ 20mA. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

- — — — — — — — — — — — 
C
H
3 

C
H 
2 

C
H 
1 

C
H 
0 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

- — — — — — — — CH 3 CH 2 CH 1 CH 0 

Run channel (bit) 
 1: Run 
 0: Stop 

Output range (bit) 
 00: 0 ~ 10V(4 ~ 20mA) 
 01: 0 ~ 20mA 
 

Address “0” 

Address “1” 
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(3) Setting up the input data type 
(a) Input type can be specified for respective channels. 
(b) If input data type is not specified, all the channels will be set to the range of 0 ~ 4000. 

 
 

 
 
 
 
 
 
 

 
 
 

(4) Setting up the output type 
   (a) It defines an analog output status when XGB CPU unit is stopped. 

       (b) The range is 0 ~3 and used devices are regarded as Words. 
 

 
 

 
 
 
 

Address Details 

3 Set up the output type of CH0  

4 Set up the output type of CH1 

5 Set up the output type of CH2 

6 Set up the output type of CH3 

 
 

(5) Error code 
It displays error codes of each channel. 

 
 

 
 
 
 
 
 
 
 
 

Error code 
(Dec) 

Details LED status 

- Offset/Gain setting error 
Flickering 2s 

intervals 

31# Exceed the range of parameter Flickering 1s 
intervals 41# Exceed the range of digital input 

※ # stands for the channel with error found. 

 
 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

- — — — — — — — CH 3 CH 2 CH 1 CH 0 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

- - - - - - - - - - - - - - Value 

B15 B14 B12 B11 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Address Details 

11 CH0 error 

12 CH1 error 

13 CH2 error 

14 CH3 error 

Input data type (bit) 
 00: 0 ~ 4000 
 01: -2000 ~ 2000 
 10: 0 ~ 1000(400 ~ 2000/0 ~ 2000) 
 11: 0 ~ 1000 
 

Address “2” 

Address “3” 
~ 

Address “6” 

 

Address “11” 
~ 

Address “14” 

 

Input data type (bit) 
 00: Previous value 
 01: Min. value 
 10: Mid. value 
 11: Max. value  
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3.13 Example Program 
 

3.13.1  Analog output program  
 

(1) Program example using [I/O Parameter Setting]. 
 

 
 

 
 

Module ready

Digital input dataCH. Run information 
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(2) Program example with PUT/GET instruction. 

Slot No.

Internal memory 

address

Data

Data No. to write
Module ready

Digital input dataCH. Run information

 
 

 
(3) Program example using parameter in case of IEC type 
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4) Program example using PUT/GET instruction in case of IEC type 
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3.14 Troubleshooting  
 

3.14.1 RUN LED flickers 
 

 
 
 

Error Code 
(Dec.) 

Error Details Action 

31# Parameter range excess error Adjust parameter setting range 

41# Digital input value range excess error Adjust digital input value range 

※ # indicates channel number. 
 
 

3.14.2 RUN LED is off 

RUN LED flickers. 

RUN LED flickers 0.2s intervals. 

It seems to be a module defect.  
Contact the nearest agency or LS branch office. 

 

RUN LED flickers 1s intervals. 

It is Run parameters setting error. Check the error code to 
take action against as follows in the table below. 

Yes 

No 

Yes 

RUN LED is Off. 

D/A conversion module is installed on the base 

correctly? 

Correctly install D/A conversion module on the base. 

. 

Contact the nearest agency or A/S center. 

 

I/O information can be seen at the XG5000. 

Normally operated if D/A conversion module with 

error is changed to another module. 

No 

Yes 

No 

Yes 

Yes Contact the nearest agency or A/S center. 
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3.14.3 Analog output value is not normal. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

D/A conversion value is “0”. 

Channel status is set as Enable. 

External power (DC 24V) is supplied. 

Check and correct the channel status on the I/O parameter. 

Supply external power (DC 24V) 

Refer to 2.8.2 and wire properly. 

Wiring of each channel is normal. 

Input voltage/current of external terminal 
block is normal. 

Set U0x.02 to enable the output referring to p3-19 

No 

Yes 

No 

Yes 

No 

Yes 

No 
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3.14.4 Status check of D/A conversion module through XG5000 system monitor 
 
Module type, module information, O/S version and module status of D/A conversion module can be 
checked through XG5000 system monitoring function. 
 

(1) Execution sequence 

Two routes are available for the execution. 
(a) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button to 
display [Module Information]. 
(b) [Monitor] -> [System Monitoring] -> And Double-click the module screen. 

 

(2) Module information 

(a) Module type: shows the information of the module presently installed. 
(b) Module information: shows the O/S version information of A/D conversion module. 
(c) O/S version: shows the O/S prepared date of A/D conversion module. 
(d) Module status: shows the present error code. (Refer to 3.23 for detailed error codes) 
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Chapter 4 RTD Input Module 
 

4.1 Setting Sequence before Operation 
 

Before using the RTD input module, follow steps below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 

 

XBF-RD04A / XBF-RD01A 

 

 

 

 

 

 Checking performance specification 

System configuration and selection 

Wiring 

Reading temperature data 

Setting parameter 

Programming 

Specification 
 Operating environment 
 Digital input range  

System configuration 
 Max. No. equip-able 
 Selecting the external power 

Wiring 
 Wiring (external DC24V) 
 RTD input wiring 

RTD input test 
 XG5000 special module 

monitor test mode 

Parameter 
 XG5000 I/O parameter 

Programming 
 Program for writing digital data  

(U device) 

If there is error or RTD input value Is 
 abnormal, refer to the trouble shooting 
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4.2 Specification 
 

4.2.1 General Specifications 
 
Here describes general specifications of RTD input module. 

No. Items Specification Reference 

1 
Operating 

temperature 
0 ~ 55 C 

 

2 
Storage 

Temperature 
25 ~ 70 C 

3 
Operating 

humidity 
5 ~ 95%RH (Non-condensing) 

4 
Storage 

humidity 
5 ~ 95%RH (Non-condensing) 

5 
Vibration  

immunity 

Occasional vibration  

Frequency Acceleration Pulse width Times 

IEC61131-2 

10    f    57Hz  0.075mm 

10 times 

each 

direction  

(X,Y and Z) 

57    f    150Hz 9.8m/s
2 
(1G)  

Continuous vibration 

Frequency Acceleration Pulse width 

10    f    57Hz  0.035mm 

57    f    150Hz 4.9m/s
2 
(0.5G)  

6 
Shocks  

immunity 

 Peak acceleration : 147 m/s
2 
(15G) 

 Duration : 11ms 

 Pulse wave type : Half-sine (3 times each direction per each axis) 

7 
Noise  

immunity 

Square wave 

impulse noise 

AC: 1,500 V 

DC:  900 V 
LSIS standard 

Electrostatic 

discharge 
Voltage: 4kV (Contact discharge) 

IEC61131-2 

IEC61000-4-2 

Radiated 

electromagnetic 

field noise 

80 ~ 1,000 MHz, 10V/m 
IEC61131-2, 

IEC61000-4-3 

Fast transient 

/Burst noise 

Segment 
Power 

supply 

Digital/Analog Input/Output, 

Communication Interface 
IEC61131-2 

IEC61000-4-4 
Voltage 2kV 1kV 

8 
Operation 

ambience 
Free from corrosive gases and excessive dust 

 9 Altitude Less than 2,000m 

10 Pollution degree Less than 2  

11 Cooling method Air-cooling 
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4.2.2 Performance specifications 
 
Here describes general specifications of RTD input module. 

Item 
Specifications 

XBF-RD04A XBF-RD01A 

No. of input channel 4 channels One channel 

Input sensor 

type 

PT100 JIS C1604-1997 

JPT100 JIS C1604-1981 , KS C1603-1991 

Temperature 

input range 

PT100 -200 ~ 600℃ 

JPT100 -200 ~ 600℃ 

Digital output 

PT100 -2000 ~ 6000 

JPT100 -2000 ~ 6000 

Scaling display 

 

0 ~ 4000 

Accuracy 

Normal 

temp.(25℃) 
Within ±0.3%  

Full temp.(0~55℃) Within ±0.5%  

Conversion speed 40ms / channel 

Insulation 

Channel to 

Channel 

 

Non-insulation 

Terminal to PLC 

Power 
 Insulation (Photo-Coupler) 

Terminal block 15-point terminal block 

I/O points occupied Fixed type: 64 points 

Wiring method 3-wire 

Max. number of equipment 
7 (when using XBM(C)-DxxxS type) 

10 (when using XB(E)C-DxxxH type) 

Function 
Filtering Digital filter (160 ~ 64000ms) 

Alarm Disconnection detection 

Current 

consumption 

Inner DC5V 100㎃ 

external DC24V 100㎃ 

Weight 63g 
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4.3 Part Names and Functions  
 

Here describes part names and functions.  

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

No. Name Descriptions 

① RUN LED 

▶ Displays the hardware operation status of XBF-RD04A 

On: Normal 
Flickering: Error (0.2s intervals) 

Off: power disconnected, hardware error  

② ALM LED 

▶Displays the disconnection status of XBF-RD04A  

(Alarm indication LED) 
Flickering: Disconnection is detected (1s intervals) 

Off: normal operation 

③ 
Terminal 

block 
▶Terminal block for connecting external RTD temperature sensor 

④ 

External 

power supply 

terminal 

▶Terminal for supplying external DC24V  

⑤ 
Connector for 

extension 
▶Connection connector for connecting extension module  

 
 

 

 

 

 

 

  

② 

① 

④ 

 

③ 

  

⑤ 
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4.4 Temperature Conversion Characteristic 
 

Since RTD sensor has non-linear characteristic, RTD input module linearizes the relationship between 
input and output in each section. 
The graph below is an example to describe the linearization process and is different with graph about 
sensor temperature input.   

 

  (1) PT100: JIS1604-1997 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

(2) JPT100: JIS C1604-1981, KS C1603-1991 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 
 

Non-linear characteristics: The resistance-temperature characteristics for RTD sensor are presented 
with table (JIS C1604-1997). This characteristics table displays resistance value of the sensor to 

temperature, namely, the change of the resistance value per increment of 1℃. When the 

temperature is changed by 1℃, the change of resistance is not in constant width but in different 

width per section, which is called the non-linear characteristics.  

600.0℃ 

0.0℃ 

-200.0℃ 

18.52 

Measured temperature 
Resistance (Ω) 

측온저항값(Ω) 

Temperature (℃) 

100 313.71 

Linearized sensor characteristics 

선형화된 센서 특성 Real Sensor characteristics 

0.0℃ 

-

200.0℃ 

17.14 

Measured temperature 
Resistance (Ω) 

Temperature (℃) 

100 317.28 

Linearized sensor characteristics 

Real sensor characteristics 

600.0℃ 

Remark 
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4.5 Conversion Speed 
 

The conversion speed of XGF-RD4A is 40 ms per channel and each channel is converted 
sequentially, that is, one channel is converted and then the next channel is converted.  

 (Run/stop can be specified independently for each channel.) 
The conversion speed includes the time to convert input temperature (resistance value) to digital 
value and to save the converted digital data into the internal memory. 

 

∴ Processing time = 40ms X Number of the using channels  

 
[Example] 3 channels are used: Processing time = 40ms X 3 = 120ms 

 
 
 

4.6 Accuracy 
 

The accuracy of RTD module is described below. 

• When the ambient temperature is 25 ± 5℃: within ±0.3% of available input range  

• When the ambient temperature is 0 to 55℃: within ±0.5% of available input range  

 

 Example) PT100 is used and the ambient temperature is normal. 

To measure 100℃, the conversion data output range:   

 100℃ - [ { 600 - (-200) } x 0.3 % ]  ~  100℃ + [ { 600 - (-200) } x 0.3 % ] 

 Namely, 97.6 ~ 102.4 [℃]  

 
 
 

4.7 Temperature Display 
 

(1) The input temperature is converted to digital value down to the one decimal place. 

 
Ex.) If the detected temperature is 123.4℃, its converted value to be saved to the internal 

memory will be 1234. 

 

(2) Temperature can be converted to Celsius or Fahrenheit scale temperature value as desired. 
 

Ex) If Pt100 sensor is used, the temperature of 100.0℃ can be converted to 2120 when 

Fahrenheit scale is used. 

• Conversion ℃ to ℉, 32
5

9
 CF   

• Conversion ℉ to ℃,  32
9

5
 FC   

(3) Maximum temperature input range is higher/lower within 10℃ than regular temperature input 

range. However, the precision will not be guaranteed for any temperature out of regular 

temperature input range. 

    
Maximum temperature input ranges of sensor are as follows; 

• PT100 : -210.0 ~ 610.0℃ 

• JPT100 : -210.0 ~ 610.0℃ 
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4.8 Scaling Function 
 

It is used to scale and output the range specified by the user other than temperature range. 

 

• Scaling expression =  
2

)200010( eTemperatur
 

    

     

Ex.) When scaling is allowed and sensor input is 200℃ with PT100 sensor, scaling value is as follows.  

        Scaling value = 
2

)200010200( 
  = 2000 

  

      The figure below displays the relation between temperature input and scaling value.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

0.0 

-200.0 

Temperature 
Conversion value 

Scaling 
conversion 
value 

600.0 

 4000 

2000 

200.0 
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4.9 Disconnection Detection Function 
 

(1) As a module used to measure the temperature with the RTD temperature sensor directly 

connected, it detects and displays disconnection of the sensor connected. If any disconnection 

occurs in the sensor used and extended lead wire, LED (ALM) will flicker in a cycle of 1 second 

and produce an error code. 

 
(2) Disconnection can be detected per channel, however, only for the channel specified to run. 

     LED (ALM) is used in common for all the channels. It will flicker if one or more channels are 
disconnected.  

 

(3) The figure below shows the temperature sensor’s appearance of the 3-wired RTD.  

(The appearance depends on sensor type)  

 
 

 

 

 

  

* A disconnection: if disconnected between terminal A and terminal board of the module in the  

sensor figure. 

* B disconnection: if disconnected between terminal B (two for 3-wired sensor) and terminal  

board of the module in the sensor figure, or if A and B lines are all disconnected. 

 

(4) The basic connection between RTD module and RTD Sensor is based on 3-wired RTD sensor. 

If 2-wired or 4-wired sensor is used, the connection between the sensor and the module shall be 

kept as 3-wired. Disconnection will be detected on the basis of 3-wired wiring. 

 

        (5) In case of disconnection, status of ALD LED and operation of disconnection flag are as follows. 

    - For disconnection flag, refer to 12.3.14 internal memory. 

Connection status 
Channel 

status 

 ALM LED 

status 

Disconnection 
flag 

Normal 

Run Off Off 

Stop Off Off 

A line disconnected or  

B line disconnected 

Run Flicker (1s) On 

Stop Off 
 

Off 

Any sensor is not 

connected 

Run Flicker (1s) 
 

On 

Stop Off Off 

 
 
 
 

 

 

 

A terminal 

B terminal 
  

 

 

B 

b 

A 
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4.10 Wiring  
 

- 3 types of sensor-connecting methods are available (2, 3 and 4-wired). 

- The standard wiring method for XGF-RD4A module is 3-wired wiring. 

- Use an identical type of wire (thickness, length, etc.) for each 3 wire when extended lead wire is 

 used. 

- The resistance of each conductor is to be less than 10Ω. (If larger than this, it will cause an error.) 

- Resistance difference of each conductor is to be less than 1Ω. (If larger than this, it will cause an  

error.) 

- Length of wire is to be as short as possible and it is recommended to connect the wire directly to the  

terminal block of module without connection terminal unit. If a connection terminal is to be used,  

compensating wire shall be connected as shown below.  

 

4.10.1 If 2-wired sensor is used (connection terminal unit is used) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.10.2 If 3-wired sensor is used (connection terminal unit is used) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*1 If sensor and compensating wire are shielded, 
shield line can be connected to FG terminal of 
the module. 

*2 Let the terminals B and b short on the terminal  
block of the module if 2-wired sensor is to be  
connected. 

*3 DC 24V external supply terminal to supply the 
 analog power to module 

B 

FG 

b 

A 

 

*1 

*2 

Terminal block 

 

 

 

24V 

24G 

*3 

*1 

*1 If sensor and compensating wire are shielded, 
shield line can be connected to FG terminal of 
the module. 

*2 DC 24V external supply terminal to supply the  
analog power to module  

B 

FG 

b 

A 

 

 

Terminal block 

 

 

 

 
24V 

24G 

*2 
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4.10.3 If 4-wired sensor is used (connection terminal unit is used) 
 

           

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2* DC 24V external supply terminal to supply  
the analog power to module  

1* If sensor and compensating wire are  
shielded, shield line can be connected to  
FG terminal of the module. 

B 

FG 

b 

A 

 

*1

2 

 

 

 

 

Terminal block 

24V 

24G 

*2 
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4.11 Filtering Function 
 

Based on the filter value (time-constant) which defines the temperature-converted value of the specified 

channel, it performs and outputs calculation as below. 

 

)40(

(

used Channelsvalue Filter

used) Channelstemp.x40 input (Presently)value Filtertemp.x  filtered Previously
etemperatur Filtered






msms

msms  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    

 

 

 • Filtering constant setting range = 160 ~ 64000 [ms] 

 Temperature(℃) 
Filtered Temperature 

Actual temperature 

100 ℃ 

63.2 ℃ 

0 ℃ 

 Time (ms) 

Filtering 
Constant (ms) 
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4.12 Operation Parameter Setting  
 

Operation parameters of RTD module can be specified through [I/O parameters] of XG5000. 

 

4.12.1 Setting items  
 
For the user’s convenience, XG5000 provides GUI (Graphical User Interface) for parameters setting 
of RTD module. Setting items available through [I/O parameters] of the XG5000 project window are 
described below.  

Item Details 

[I/O Parameter] 

(1) Specify the following setting items necessary for the module operation. 

- Channel Run/Stop 

- Sensor type  

- Filter setting 

- Scaling setting 

(2) The data specified by user through S/W package will be saved on the 

flash memory of RTD module when [I/O Parameters] are downloaded.  

 

4.12.2 How to use [I/O Parameter] 
 

(1) Run XG5000 to create a project. (Refer to XG5000 programming manual for details on how to  

create the project) 

 

(2) Double-click [I/O Parameter] on the project window. 

 
  

(3) If [I/O Parameter Setting] screen appears, click Module part at relevant slot and select relevant 

module. 

(4) On the ‘I/O parameters setting’ screen, find and click the slot of the base where RTD module is 

installed on.  
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(5) Click the arrow button on the screen to display the screen where an applicable module can be 

selected. Search for the applicable module to select.  

 
 

(6) After the module selected, click [Details] or double-click relevant slot. 

 
 

(7) A screen will be displayed to specify parameters for respective channels as shown below. Click a 

desired item to display parameters to set for respective items.  

 
 

(8) The initial values of respective items are as follows. 

(a) Channel status setting screen 
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(b) Input sensor type setting screen 

 
 

(c) Temp. unit setting screen 

 
 

(d) Scaling setting screen 

 
 

(9) If necessary setting is complete, press OK.  

 

(10) Check the check box on the parameter menu to select and change setting of a channel then the  

setting value of all the channels will be identical to changed setting value. The figure below shows  

an example with this function that channel status is changed to ‘Enable’ of all the channels. 
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4.13 Special Module Monitoring 
 

Run Special Module Monitoring by selecting [On-Line] -> [Connect] and [Monitor] -> [Special Module 
Monitoring]. If the status is not [On-Line], [Special Module Monitoring] menu will not be activated. 

 

Remark  

1) If the program is not displayed normally because of insufficient system resource, you may start  
XG5000 again after close the program and other applications. 

2) I/O parameters those are specified in the state of [Special Module Monitoring] menu are temporarily  
set up for the test. They will be disappeared when the [Special Module Monitoring] is finished. 

3) Testing of [Special Module Monitoring] is the way to test the analog output module. It can test the  
module without a sequence program. 

 

 

4.13.1 How to use special module monitoring 
 

 (1) Start of [Special Module Monitoring]  
Go through [Online]  [Connect] and [Monitor]  [Special module Monitoring] to start. If the 
status is not online, [Special Module Monitoring] menu will not be activated.  
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 (2) How to use [Special Module Monitoring]  
(a) [Special Module List] window will show base/slot information and types of special module by  

click [Monitor]  [Special Module Monitoring].In this list box, the modules that are now  
installed in PLC system will be displayed. 

 
 

  

(b) Select a special module then click [Module Info.] button to display the information as  
described below.  

 

 

(c) Select a special module then click [Start Monitoring] button to display the information as  
described below. 
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(d) [Start Monitoring]: [Start Monitoring] button will show you digital input data of the operating  

channel. The figure below is monitoring screen when all channels are Run status.  

 

[Start Monitoring] execution screen 
 

(e) [Test]: [Test] is used to change the parameters of the RTD input module. You can change the 
parameters when you click the values at the bottom of the screen. It is only available when 
XGB CPU unit’s status is in [Stop]. 

 
[Test] execution screen 

 

(g) [Close]: [Close] is used to escape from the monitoring/test screen. When the monitoring/test 

screen is closed, the max. value, the min. value and the present value will not be saved any 
more. 

Remark [Test] function is only available when XGB CPU unit’s status is in [Stop] 

 

Monitoring screen 

Detail of channel 0 
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Register the variables for each module referring to the special module information that is set in the I/O  

parameter. The user can modify the variables and comments. 

  
 (1) Procedure  

(a) Select the special module type in the [I/O Parameter Setting] window.  

 
 

(b) Double click ‘Variable/Comment’ from the project window. . 

 
 

(c) Select [Edit] – [Register U Device]. 
   In case of IEC, select [Edit] – [Register special module variable] 

 

4.14 Register U devices (Special module variable) 
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(d) Click ‘Yes’.  

 
 

(e) As shown below, the variables are registered.  

 
 
 
 (2) Save variables  

(a) The contents of ‘View Variable’ can be saved as a text file.  
(b) Select [Edit] -> [Export to File]. 
(c) The contents of ‘View variable’ are saved as a text file.  
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(3) View variables  

(a) The example program of XG5000 is as shown below.    

 
 
 

(b) Select [View] -> [Variables]. The devices are changed into variables. 

 
 

(c) Select [View] -> [Devices/Variables]. Devices and variables are both displayed. 

 
 

 
(d) Select [View] -> [Device/Comments]. Devices and comments are both displayed. 
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4.15 Configuration and Function of Internal Memory  
 

Here describes configuration and function of internal memory. 
 

4.15.1  Data I/O area of RTD input module 
Data I/O area of RTD input module is as shown below. 

Area 

(‘S’, ‘H’ type) 

Area 

(IEC type) 
Details Content R/W 

U0x.00.0 

U0x.00.F 

%UX0.x.0 

%UX0.x.15 

Module ERROR flag  

Module READY flag 

0 Bit On(1): module error 

F(15) Bit On(1): module normal 
R 

U0x.01.0 

U0x.01.1 

U0x.01.2 

U0x.01.3 

%UX0.x.16 

%UX0.x.17 

%UX0.x.18 

%UX0.x.19 

CH0 Run flag 
CH1 Run flag 
CH2 Run flag 
CH3 Run flag 

 

Bit On(1): channel run 

Bit Off(0): channel stop 

 

R 

U0x.01.4 

U0x.01.5 

U0x.01.6 

U0x.01.7 

%UX0.x.20 

%UX0.x.21 

%UX0.x.22 

%UX0.x.23 

CH0 Disconnection flag 

CH1 Disconnection flag 

CH2 Disconnection flag 

CH3 Disconnection flag 

Bit On(1): Disconnection 

Bit Off(0): Normal 
R 

U0x.04 %UW0.x.4 
CH0 digital output 

value 
Temperature value ×10 R 

U0x.05 %UW0.x.5 
CH1 digital output 

value 
 R 

U0x.06 %UW0.x.6 
CH2 digital output 

value 
 R 

U0x.07 %UW0.x.7 
CH3 digital output 

value 
 R 

U0x.08 %UW0.x.8 CH0 scaling value 0 ~ 4000 R 

U0x.09 %UW0.x.9 CH1 scaling value  R 

U0x.10 %UW0.x.10 CH2 scaling value  R 

U0x.11 %UW0.x.11 CH3 scaling value  R 

※ In the device assigned, x stands for the slot no. on which module is installed. 
 

(1) Module ready/channel error information ( ( ) means device name of IEC type) 
(a) U0x.00.F (%UX0.x.15): It will be ON when PLC CPU is powered or reset with A/D conversion 

ready to process A/D conversion. 
(b) U0x.00.0 ~ U0x.00.3 (%UW0.x.0~%UW0.x.3): It is a flag to display the error status of A/D 

conversion module. 
 

 

 

 

 

 

 

 

 

 

 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

R
e
a

d
y
 

— — — — — — — — — — — — — — 

E
rro

r  

Error status 
Bit On (1): error, Bit Off (0): normal 

U0x.00 

Module READY 
 Bit On (1): normal, Bit Off (0): error 

(%UW0.x.0) 
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(2) Channel run/stop information 

(a) It displays which channel is being used. 
 
 

 
 

 
 
 
 
 
 

 
(3) Temperature value 

It displays current temperature value. Its form is temperature value ×10. 
 

 
 
 
 
 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

— — — — — — — — 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

CH0 temperature conversion value 

CH1 temperature conversion value 

CH2 temperature conversion value 

CH3 temperature conversion value 

U0x.01 

Run channel information 
Bit On (1): Run 
Bit Off (0): Stop 

Disconnection information (bit) 
Bit On (1): Disconnection 
Bit Off (0): Normal 

U0x.04 

U0x.05 

U0x.06 

U0x.07 

(%UW0.x.1) 

(%UW0.x.4) 

(%UW0.x.5) 

(%UW0.x.6) 

(%UW0.x.7) 
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4.15.2 Operation parameter setting area 
Operation parameter setting areas of RTD input module are as follows. 

Memory address 
Details R/W Remark 

Hex. Dec. 

0H 0 Channel enable/disable setting R/W PUT 

1H 1 CH0 sensor type setting R/W PUT 

2H 2 CH1 sensor type setting R/W PUT 

3H 3 CH2 sensor type setting R/W PUT 

4H 4 CH3 sensor type setting R/W PUT 

5H 5 Temperature display unit setting R/W PUT 

6H 6 CH0 filter constant setting R/W PUT 

7H 7 CH1 filter constant setting R/W PUT 

8H 8 CH2 filter constant setting R/W PUT 

9H 9 CH3 filter constant setting R/W PUT 

AH – 11H 10~17 Not used   

12H 18 Scaling setting R/W PUT 

13H - 43H 19~67 Not used   

44H 68 CH0 disconnection information (code) R/W GET 

45H 69 CH1 disconnection information (code) R/W GET 

46H 70 CH2 disconnection information (code) R/W GET 

47H 71 CH3 disconnection information (code) R/W GET 

 

(1) Run channel setting 
If Run channel is not specified, all channels will be stop status. 

 
 
 
 

 
 
 
 
 
 
 

(2) Sensor type setting 

If it is not specified manually, all channels will be specified as Pt100.  
 
 
 
 
 
 

 
 
 
 

Word Description 

0 Specified as PT100 

1 Specified as JPT100 

 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

— — — — — — — — — — — — 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

Ch0 sensor type setting 

Ch1 sensor type setting 

Ch2 sensor type setting 

Ch3 sensor type setting 

Setting channel to use (bit) 
       Bit On (1): Run, Bit Off (0): Stop 

Address 0 

Address 1 

 
Address 2 

Address 3 

Address 4 
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(3) Setting temperature display unit 

Unit of temperature conversion value can be specified as Celsius/ Fahrenheit.  
 
 
 
 

 
 
 
 

Bit Description 

0 Celsius 

1 Fahrenheit 

 
(4) Setting filter constant 

If filter constant is not specified or specified as “0”, relevant channel is not filtered.  
 
 
 

 
 

 
 
 

 
 
(5) Setting scaling 

It specifies whether scaling function is used or not. 
 
 
 

 
 

 
 
 
 
 
    

 
(6) Disconnection information 

It outputs disconnection information of each channel. 
 

 

 

 

 

 

 

 

 

 

bit15 bit14 Bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 Bit0 

— — — — — — — — — — — — 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

Setting Ch0 filter constant (1~99) 

Setting Ch1 filter constant (1~99) 

Setting Ch2 filter constant (1~99) 

Setting Ch3 filter constant (1~99) 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

— — — — — — — — — — — — 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

Bit Description 

0 Scaling function is not used 

1 Scaling function is used 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 

Channel 0 disconnection information  

(0: normal,1: sensor A disconnection, 2: sensor B disconnection) 

Channel 1 disconnection information 

(0: normal,1: sensor A disconnection, 2: sensor B disconnection) 

Channel 2 disconnection information 

(0: normal,1: sensor A disconnection, 2: sensor B disconnection) 

Channel 3 disconnection information 

(0: normal, 1: sensor A disconnection, 2: sensor  B disconnection) 

Address 5 

Address 10 

Address 6 
 
Address 7  
 

Address 8 
 
Address 9 
 

Address 68 
 
Address 69 
 

Address 70 
 
Address 71 
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4.16 Example Program 
 

- Here describes how to specify the operation condition of RTD input module.  

- RTD input module is installed on slot 2. 

- Initial setting condition is that with one input, initial setting value is saved in internal memory of 

module. 

- The following program is an example to read temperature value and disconnection information. 

 
 

(1) Program example using [I/O Parameter Setting] 

 
 

 
 

 
 
 
 
 

Moving channel 0 temp. value to  
D0 area 

Moving channel 1 temp. value to  
D1 area 

 

Moving channel 0 disconnection 
information to M0 

Moving channel 1 disconnection 
information to M1 
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(2) Program example using PUT/GET command 
 

  
 
(3) Program example using parameter in case of IEC 

CH Enable  

Sensor type (PT100) 

Temperature unit (Celsius) 

Filter value  

Moving channel 0 
temp. value to  
D0 area 

 

Moving channel 1 
temp. value to  
D1 area 

 

Moving channel 0 disconnection 
information to M0 

 Moving channel 1 disconnection 
information to M 
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(4) Program example using PUT/GET function block inn case of IEC  
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4.17 Trouble Shooting 
 

4.17.1 RUN LED flickers 
 
 
 
 
 
 
 
 
 
 
 
 

4.17.2 RUN LED is off 
 

 
 
 
 
 
 

RUN LED flickers. 

RUN LED flickers 0.2s intervals. 

Contact the nearest agency or LS branch office. 

 

Yes 

RUN LED is off. 

RTD input module is installed on the base correctly? 

Correctly install A/D conversion module on the base. 

 

Contact the nearest agency or LS branch office. 

 

I/O information can be seen at the XG5000. 

Normally operated if RTD input module with error is 

changed to another module 

No 

Yes 

No 

Yes 

Yes Contact the nearest agency or LS branch office. 
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4.17.3 ALM (Alarm) LED flickers 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.17.4 Temperature conversion value is not normal. 
 
 
 
 
 
 
 
 
 
 
 

ALM LED flickers. 

3 wired wiring is normal. 

Wire properly referring to 4.10 

. 

Wire properly referring to 4.10 

Wiring to sensor is normal 

No 

Yes 

No 

Yes 

Contact the nearest agency or A/S center. 

 

Temperature conversion value is not normal. 

External DC 24V input power is normal. 

FG ground is normal. 

 Supply external power (DC 24V) 

 

Execute FG ground properly referring to 4.10 

Contact the nearest agency or A/S center. 

No 

Yes 

No 

Yes 
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4.17.5 Stats check of RTD input module through XG5000 system monitor 
 
Module type, module information, O/S version and module status of RTD input module can be 
checked through XG5000 system monitoring function. 
 

(1) Execution sequence 

Two routes are available for the execution. 
(a) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button to  

display [Module Information]. 
(b) [Monitor] -> [System Monitoring] -> And Double-click the module screen. 

 

(2) Module information 

(a) Module type: shows the information of the module presently installed. 
(b) Module information: shows the O/S version information of module. 
(c) O/S version: shows the O/S prepared date of module. 
(d) Module status: shows the present error code.  
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Chapter 5 Thermocouple Input Module 
 

5.1 General 
 

Here describes specification, handling, and programming of XGB thermocouple input module (XBF-
TC04S/XBF-TC04B).  
Thermocouple input module is used to convert the temperature data detected from thermocouple to 
signed 16 bit data. 

 

5.1.1 Characteristic 
 

(1) Module selection according to purpose  
XBF-TC04S/XBF-TC04B: 4 channel input (Insulation between channels by photomos relay) 

 
(2) Four kinds of thermocouple available (K / J / T / R) 

Available to select the different thermocouple according to each channel 
 

(3) Voltage input (0 ~ 100㎷) available (XBF-TC04B) 

Available to select voltage input (0~100㎷) and thermocouple (K type / J type / T type / R type) 

for each channel  
 
(4) Disconnection detection 

If thermocouple is disconnected, it is detected and indicated.  
 

(5) Celsius (℃)/ Fahrenheit (℉) type available  

Temperature conversion data of Celsius (℃)/ Fahrenheit (℉) is indicated down to one decimal 

place 
 

(6) Temperature data scaling function  
(Available to use it as additional data than temperature indication) 
Scaling conversion of temperature data is available within -32,768~32,767/0~65,535.  

 
(7) Various additional function 

Filter process, Average process (time/count/moving), Max./Min. detection process 
 

(8) Parameter setting / Monitoring by GUI (Graphical user interface) method 
It enhanced user-friendly features by changing to I/O parameter settings (intensify user 
interface) from parameter settings by previous instructions.   
By [I/O Parameter], the sequence program can be reduced and by [Special Module Monitoring], 
it is easy to monitor the temperature conversion value. 

 

5.1.2 Required version 
 

When making the system, the version below is required. 
 

Basic unit type 
Basic unit 

name 
Type 

Required version 

XBF-TC04S XBF-TC04B 

XGB modular standard type 

basic unit (XBMS) 
XBM-DxxS 

Basic unit Ver 1.8 or above - 

XG5000 Ver 2.2 or above - 

XGB compact standard type 

basic unit (XBCS) 
XBC-DxxS 

Basic unit Ver 1.8 or above Ver 1.12 or above 

XG5000 Ver 3.61 or above Ver 3.62 or above 

XGB compact high-end type 

basic unit (XBCH) 
XBC-DxxH 

Basic unit Ver 1.8 or above - 

XG5000 Ver 2.2 or above - 

XGB IEC high-end type basic 

unit (XECH) 
XEC-DxxH 

Basic unit Ver 1.0 or above - 

XG5000 Ver 3.0 or above - 
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5.1.3 Setting sequence before operation 
 

1) Before using the thermocouple input module, follow steps below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 

 

XBF-TC04S 

 

 

 

 

 

 Checking performance specification 

System configuration and selection 

Wiring 

Reading temp. data 

Setting parameter 

Programming 

Specification 
- Operating environment 
- Thermocouple sensor type and temperature 
range 
- Digital output range 

System configuration 
- Equip-able number  
- External power selection 

Wiring 
- Power wiring (External DC24V) 
- Thermocouple input wiring 

Thermocouple input test 
- XG5000 special module monitor  

Parameter 
- XG5000 I/O parameter 

Programming 
- Program to read analog data 

(U device) 

If there is error or thermocouple input 
data is abnormal, refer to the trouble 
shooting. 

 



Chapter 5 Thermocouple Input Module (XBF-TC04S,TC04B)  

 

5 - 3 

 

 

 
2) Before using the thermocouple/voltage input module, follow steps below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 

 

XBF-TC04B 

 

 

 

 

 

 

 

 

 

 

Checking performance specification 

 

System configuration and selection 

 

Wiring 

 

Reading temp./voltage input data 

 

Setting parameter 

Programming 

Specification 
- Operating environment 
- Thermocouple sensor type, voltage input and 

temperature range 
- Digital output range 

 
System configuration 
- Equip-able number  
- External power selection 

 

Wiring 
- Power wiring (External DC24V) 
- Thermocouple input wiring 

 

Thermocouple input test/Voltage input test 
- XG5000 special module monitor  

 

Programming 
- Program to read analog data 

(U device) 

If there is error or thermocouple/voltage 
input data is abnormal, refer to the 
trouble shooting. 
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5.2 Specification 
 

5.2.1 General specification 

General specifications are as follows. 

No. Items Specification 
Related 

standards 

1 
Operating 

temp. 
0 ~ 55 C  

2 
Storage 

temp. 
25 ~ 70 C  

3 
Operating 

humidity 
5∼95%RH (Non-condensing)  

4 
Storage 

humidity 
5∼95%RH (Non-condensing)  

5 
Vibration 

immunity 

For discontinuous vibration -  

Frequency Acceleration Amplitude Times 

IEC61131-2 

10    f    57Hz  0.075mm 

Each 10 

times in 

X,Y,Z 

directions 

57    f    

150Hz 
9.8m/s

2
(1G)  

For continuous vibration 

Frequency Acceleration Amplitude 

10    f    57Hz  0.035mm 

57    f    

150Hz 
4.9m/s

2
(0.5G)  

6 
Shocks 

Immunity 

  Max. impact acceleration : 147 m/s
2
(15G) 

  Authorized time : 11ms 
  Pulse wave : Sign half-wave pulse (Each 3 times in X,Y,Z 

 directions) 

IEC61131-2 

7 
Noise 

immunity 

Square wave 

impulse noise 
1,500 V LSIS standard 

Electrostatic 

discharging 
Voltage : 4kV(contact discharging) 

IEC61131-2 

IEC61000-4-2 

Radiated 

electromagnetic 

field noise 

80 ~ 1,000 MHz,  10V/m 
IEC61131-2, 

IEC61000-4-3 

Fast 
Transient 

/burst 

noise 

Segment 
Power 
module 

Digital/ 
Analog I/O 

communication interface 
IEC61131-2 

IEC61000-4-4 
Voltage 2kV 1kV 

8 
Ambient 

conditions 
No corrosive gas or dust  

9 
Operating 

height 
2000m or less  

10 
Pollution 

degree 
2 or less  

11 Cooling type Natural air cooling  
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5.2.2 Performance Specification 

 
 (1) Thermocouple input specification (XBF-TC04S/XBF-TC04B) 
 

Items Specification 

Number of input channel 

4 channels 

Select channel type by parameter  

(thermocouple input) 

Type of input sensor 
Thermocouple K / J / T / R type 

JIS C1602-1995 

Range of input 

temperature 

K -200.0℃ ~ 1300.0℃ 

J -200.0℃ ~ 1200.0℃ 

T -200.0℃ ~ 400.0℃ 

R 0.0℃ ~ 1700.0℃ 

Digital output 

Temp. display 
Displaying down to one decimal place – note1) 

K, J, T type: 0.1℃, R type: 0.5℃ 

Scaling display 

 (user-defined scaling) 

Unsigned scaling (0 ~ 65535) 

Signed scaling (-32768 ~ 32767) 

Accuracy 

Ambient temperature(25℃)  Within ±0.2% – note 2) 

Temp. coefficient  

(range of operating temp) 
±100 ppm/℃ 

Conversion time 50ms / channel 

Reference 

junction 

compensation 

Auto compensation by RJC sensing (Thermistor) 

Compensation amount ±1.0℃ 

Warming-up time 15 min or above –note 3) 

 
Note1), Note2) For more detail specification, refer to 5.2.6 accuracy/resolution. 
Note 3) Warming-up time: for stability of measured temperature, 15 min is necessary after power is on. 

      
      (2) Voltage input specification (XBF-TC04B) 
 

Items Specification 

Number of input channel 

4 channels 

Select channel type by parameter 

(thermocouple/voltage input) 

Analog input range 
0 ~ 100 ㎷ 

(Input impedance: 1㏁ or above) 

Digital output 

Type 0 ~ 20000 

Scaling display 

(user-defined scaling) 

Unsigned scaling (0 ~ 65535) 

Signed scaling (-32768 ~ 32767) 

Max. resolution 1/20000 (0.005mV) 

Accuracy 

Ambient temperature (25℃) Within ±0.2%  

Temp. coefficient  

(operating temp. range) 
±100 ppm/℃ 

Conversion time 50ms / channel 
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(3) Common specification (XBF-TC04S/XBF-TC04B) 
 

Items Specification 

Insulation 

Insulation 

method 

Terminal – inner 

circuit 
Photo-coupler insulation 

Terminal – operating 

power 
DC/DC converter insulation 

Between channels Photomos relay insulation 

Dielectric withstand voltage 
400 V AC, 50/60 Hz, 1min,  

leakage current 10㎃ or below 

Insulation resistance 500 V DC, 10 MΩ or below 

Terminal block 11 point terminal 

I/O occupied points 64 points 

Max. number of equipment 
7 (when using XBM(C)-DxxxS “S”) 

10 (when using XB(E)C-DxxxH “H”) 

Additional 

function 

Filter process Digital filter (200 ~ 64,000㎳) 

Average process 

Time average (400~64,000㎳) 

Count average (2~64,000 times) 

Moving average (2~100) 

Alarm Disconnection detection 

Max./Min. display Display Max./Min. 

Scaling function Signed scaling / Unsigned scaling 

Consumption 

current 

Inner DC5V 100㎃ 

External DC24V 100㎃ 

Weight 63g 
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5.2.3 Name of part and function 
 

Respective designations of the parts are as described below  
 

①
②

③

④

⑤

⑥

 

 

①
②

③

④

⑤

⑥

 

 

XBF-TC04B

XBF-TC04B

+  -

K,J,T,R
0~100mV

XBF-TC04S

 
 
 

No. Name Description 

① RUN LED 

▶ Displays the status of thermocouple input module 

On: operation normal 

Flickering: Error occurs (0.2s flickering) 

Off: power Off or module error 

② ALM LED 

▶ Displays the disconnection status of thermocouple input 

module (Alarm indication LED) 

Flickering: Disconnection error occurs (1s flickering) 

Off: operation normal 

③ 
Terminal 

block 

▶ Terminal block for wiring to connect the thermocouple  

(K, J, T, R type) (0~100mV, XBF-TC04B) 

④ 

External 

power supply 

terminal 

▶Terminal for supply of external DC24V  

⑤ 
Connector for 

extension 
▶Connection connector for connecting the extension module 

⑥ 

Reference 

junction 

compensator 

▶ Thermistor for reference junction compensation (RJC) 
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5.2.4 Characteristic of thermocouple temperature conversion 
 
Thermocouple input module connect 4 kinds of thermocouple and one voltage input (XBF-TC04B) 
directly, input characteristic are as described below. 

 

(1) Thermocouple K (JIS C1602-1995): -200 ℃(-5891 ㎶) ~ 1300 ℃(52410 ㎶) 

 
 
 

(2) Thermocouple J (JIS C1602-1995): -200 ℃(-7890 ㎶) ~ 1200 ℃(69553 ㎶) 
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Temperature 
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(3) Thermocouple T (JIS C1602-1995): -200 ℃(-5603 ㎶) ~ 400 ℃(20872 ㎶) 

 
 

(4) Thermocouple R (JIS C1602-1995): 0 ℃(0 ㎶) ~ 1700 ℃(20222 ㎶) 

 
 

 

 
 

Thermocouple characteristics: thermocouple sensor measures temperature by using fine voltage 
(electromotive force), which occurs when applying temperature gradient to a junction between two 
different metals.  
The temperature-electromotive force relation specification of normal thermocouple sensor provides 
the electromotive force, which is measured when a sensor’s measuring point is at O℃. On that 
account, when measuring temperature by using thermocouple sensor, cold junction compensation 
(reference junction compensation, RJC) is used. (built-in function of temperature measuring module).  

Remark 
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Temperature 

 

 

Temperature 
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(5) Temperature conversion characteristic 

Thermocouple input module converts the thermocouple input with non-linear characteristics into 
A/D and outputs the temperature conversion that is linearly treated.  
Temperature conversion to thermocouple input has non-linear characteristics. 

 

 
 
 
 

(6) Voltage input range (0 ~ 100㎷) 

Digital 
output

0

5000

10000

15000

20000

DC 0 ~ 100㎷ 100㎷Analog 
input

Analog input practical 
range

Offset

Gain

50㎷0㎷

20200

 

 
 

Non-linear characteristics: regarding the relation of temperature(℃) and electromotive force(㎶) of a 
thermocouple sensor, electromotive force is different by sections even though temperature changes 
by a certain amount, which is called ‘non-linear characteristics.’ As seen in the above graph, it is 
shown that the relation of temperature and electromotive force is a curve by temperature sections. 
The module processes the non-linear characteristics table as linear.  

 

 

 

 

Remark 
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5.2.5 Temperature display 
 

(1) Temperature is displayed down to one decimal place. 
In the XG5000, when monitoring the temperature conversion value, select “Signed decimal” 
According to monitor indication type, temperature is monitored like figure below. 
 
Ex.) if displaying -123.0℃ by converting, the value stored in the internal memory would  

be -1230.  
 

 
 
 

Monitor indication type 
Indication 
contents 

Unsigned decimal 64306 

Signed decimal 
-1230 

(-123.0℃) 

Hexadecimal hFB32 

As instruction 64306 

 
 
(2) Temperature display unit 

(a) K, J, T type: 0.1℃ 

(b) R type: 0.5℃ 

 
(3) Temperature may be displayed by Celsius or Fahrenheit, depending on the settings.  
 

Ex.) if displaying 100 ℃ in Fahrenheit, it would be 212 °F  by using the following formula.  

(a) From Celsius to Fahrenheit degree  32
5

9
 CF  

(b) From Fahrenheit to Celsius degree   32
9

5
 FC  

 

Temperature  
value 

Temperature indication value 
(Inner memory) 

 

13000 -123.0℃ 

-1230 
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5.2.6 Accuracy / Resolution 
 

Accuracy / Resolution are as follows according to ambient temperature 
 

Thermocouple 
type 

Measurement 
temperature 

range 

Indication temperature 
range 

Accuracy - note1) 

resolution 
Normal 

temperature 

(25℃) 

Operating 
temperature - 

note2) 

(0℃ ~ 55℃) 

K 
-200.0℃ ~ 

1300.0℃ 

-270.0℃ ~ -200.0℃ - note3) 

-200.0℃ ~ 0.0℃ ±3.0℃ ±7.5℃ 0.2℃ 

0.0℃ ~ 1300.0℃ ±3.0℃ ±7.5℃ 0.1℃ 

1300.0℃ ~ 1372.0℃ - note3) 

J 
-200.0℃ ~ 

1200.0℃ 

-210.0℃ ~ -200.0℃ - note3) 

-200.0℃ ~ -100.0℃ ±2.8℃ ±7.0℃ 0.2℃ 

-100.0℃ ~ 1200.0℃ ±2.8℃ ±7.0℃ 0.1℃ 

T 
-200.0℃ ~ 

400.0℃ 

-270.0℃ ~ -200.0℃ - note3) 

-200.0℃ ~ 400.0℃ ±1.2℃ ±3.0℃ 0.1℃ 

R 
0.0℃ ~ 

1700.0℃ 

-50.0℃ ~ 0.0℃ - note3) 

0.0℃ ~ 1700.0℃ ±3.5℃ ±8.5℃ 0.5℃ 

1700.0℃ ~ 1768.0℃ - note3) 

 
Note1) Total accuracy (normal temp.) = accuracy (normal temp.) + cold junction compensation accuracy  

= ±(full scale X 0.2% + 1.0℃) 

     Cold junction compensation accuracy = ±1.0℃ 

Note2) Temp. coefficient: ±100 ppm/℃ 

Note3) Measuring the temp. is available, but accuracy and resolution is not guaranteed. 
 
 

(1) When ambient temp. is normal (25 ± 5℃): within the ±0.2% range of measurement temp.  

(2) When ambient temp. is operating temp. (0 ~ 55℃): within the ±0.5% range of measurement temp.  

 

 
Ex.) When K type thermocouple is used and ambient temperature is normal. 

In case of measuring 1000℃ temperature, output range of conversion data is 

1000℃ - [{1300 - (-200)} x 0.2 %] - 1  ~  1000℃ + [{1300 - (-200)} x 0.2 %] + 1 

 namely, 996.0 ~ 1004.0 [℃]. 

 
 

 
 
 

 
 

(1) For stabilization of measurement temperature, warming-up time more than 15 min. is necessary, after 
restart. 

(2) If ambient temperature changes rapidly, measurement temperature may change temporally. Keep the 
ambient temperature steady for stabilization of measuring temperature.  

(3) If wind of the cooling pan contacts with module directly in the panel, accuracy decreases. Do not 
contact with wind directly.  

Note 
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5.2.7 Conversion velocity 

 
(1) Conversion velocity per channel: 50ms/channel 
 
(2) Sequential process method  

The next channel is converted after conversion of one channel is completed. 
 (Run/Stop of the respective channels can be set independently.) 
 

(3) Concept of conversion time 
 

The conversion velocity of XGF-TC4S module is a cycle that the temperature (electromotive 
force) entered into terminal strip is converted into digital value and stored in internal memory. 

 
Conversion time increase by a multiple of the no. of used channels   

 

∴ Conversion time = 50ms X no. of used channels 

 

 
Ex.) In case 3 channels is used: conversion time = 50ms X 3 = 150ms 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Channel 0  

Channel 1  

채널 1 

Channel 2 

채널 2 

50ms 50ms 50ms 

150ms 

Conversion 

Conversion 

Conversion 

Conversion 

Repetition 

Channel0 
Conversion 

channel1 
Conversion 

channel2 
Conversion 

channel0 
Conversion 
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5.3 Function 
 

5.3.1 Disconnection detection function 
 

Thermocouple input module has a function to detect the disconnection and display it. 
That the module detects and displays disconnection means that the following cabling path would have 
partially bad connection, which requires taking measures  
 
(1) Disconnection occurs between a sensor used/compensating cable and module, LED(ALM) flickers 

every second and generates error code.  

 
(2) Disconnection can be detected by channels. However, it is available for the only channel(s) 

designated for operation. LED (ALM) is commonly used for every channel. It flickers in case even 
only one channel is disconnected.  

 

Thermocouple connection 

status 

Channel 

run 

 ALM LED 

status 

Disconnection 
flag 

Normal 
Run Off Off 

Stop Off Off 

Thermocouple 

disconnection 

Run Flickering (1s) On 

Stop Off Off 

 
(3) In case disconnection occurs, disconnection flag of each channel will be turned on and in case 

disconnection is canceled, it will be turned off.  

Disconnection flag Contents 

U0x.01.4 Ch. 0 disconnection 

U0x.01.5 Ch. 1 disconnection 

U0x.01.6 Ch. 2 disconnection 

U0x.01.7 Ch. 3 disconnection 

 
(4) When disconnection occurs, the min value among range is displayed.  

 

Type 
Displayed temperature in case of 

disconnection 

K type -270.0℃ 

J type -210.0℃ 

T type -270.0℃ 

R type -50.0℃ 

 
 

Type Displayed value in case of disconnection 

0 ~ 100㎷ 

(XBF-TC04B) 
0 
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5.3.2 Scaling function 
 
Thermocouple input module has a function to scale value in user-defined range besides temperature 
display.  
The scope is classified into two types; 16 bits data type, -32768~32767 and 16 bits data type without 
mark, 0~65535.  
If a user selects one of these two types and sets the range, it displays the temperature through scaling 
operation.  

 

Scaling data type Scaling min. value Scaling max. value 

Signed value -32768 ~ [Scaling max. value -1] [Scaling min. value+1] ~ 32767 

Unsigned value 0 ~ [Scaling max. value-1] [Scaling min. value+1] ~ 65535 

 
 

The following graph indicates relation between scaled value and temperature input. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Scaling operation: 0Y)0XX(
)0X1X(

)0Y1Y(
Y 




  

X = Temperature value 
X0 = Thermocouple measurement min. temperature value 
X1 = Thermocouple measurement max. temperature value 
Y0 = Scaling min. value 
Y1 = Scaling max. value 
Y = Scaling  

 
 

Ex.) If scaling with mark is set with -2000 ~ 13000 and the temperature measured K type sensor is 
500.0℃, the value scaled is as follows. 

 

• Scaling conversion value 5000)200())200(500(
))200(1300(

))2000(13000(





  

 
 

-2000 

-200.0 

Temperature 
value 

Scaling 
Conversion 
value 

1300.0 

 13000 

5000 

500.0 

X X1 

X0 

Y0 

Y 

Y1 
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5.3.3 Filter function 
 

By means of filter value (time constant 63.2%) setting temperature conversion of a designated 
channel, it operates and outputs as follows.  

 

used) channels No.of(50  ueFilter val

used) channel No.of50 x  value.input temp(presen )luefileter va   value temp.filteredy (previousl
   value temp.Filtered

msms

msms






 

Filter constant setting range = 200 ~ 64000 [ms] 
 

 
 
 

 

Temperature (℃) Temperature change after filtering process 
필터처리 후 온도변화 Actual temperature change 
실제 온도변화 

100 ℃ 

63.2 ℃ 

0 ℃ 

Time (ms) 

Filter constant 
(ms) 
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5.3.4 Average function 
 

(1) Time average  
It accumulates temperature conversion values of a selected channel and displays the average 
of the total sum in digital data. 
 

 
 

Setting range of average time = 400 ~ 64000 [ms] 

Frequency of average process for a preset time can be calculated as follows.  

 

ms

ms

50 


used channel of No.

time Average
[times]Frequency  Process Average  

 
(2) Averaged frequency  

It accumulates temperature conversion values of a selected channel as many as frequency and 
displays the average of the total sum in digital data. 

 
 
Setting range of average frequency = 2 ~ 64000 [times] 
Average process interval of channel used can be calculated as follows  

 

][50][ msms  used channel or No.frequency Averageinterval process Average  

Temperature change after averaging process 

Actual temperature change 

Channel scan interval 
(40ms/channel) 

Averaging section Averaging section Averaging section 

Temperature change after averaging process 

Actual temperature change 

Averaging section Averaging section Averaging section 

Channel scan interval 
(40ms/channel) 
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(3) Moving average  

It accumulates temperature conversion values of a selected channel as many as set and 
displays the average of the total sum in digital data. In case of the moving average, it outputs 
average per scan.  

 
Setting range of average number = 2 ~ 100  

 

 
 
 

 
 
 

5.3.5 Max./Min. display  
 

It displays maximum/minimum value of temperature conversion value of a selected channel for a 
selected section (a section allowed for max./min. search) 

 

 
 

(1) time/frequency average characteristically does not output temperature data every conversion time 
and instead, it keeps a feature to maintain the previous status until it reaches time/average 
frequency. 

(2) In case of moving average, it outputs the converted temperature as taking temperature history and 
average, which are entered previously, every conversion time, so it can obtain relatively faster data 
response than time/frequency average.  

(3) Filtering can be processed with one of the foresaid averaging functions simultaneously. If 
simultaneous process is selected, filtering would be processed first and it averages and output 
temperature value in digital value. At the moment, the digital data output (temperature) is displayed 
as the value gained after the final process.   

Remark 

알아두기 

 

Average 

number 
Average 
number 

Average 

number 

Channel scan interval 
(40ms/channel) 

 

Status of command allowing/prohibiting max./min. search 

Maintaining previous 
max./min. value 

Initializing max./min. value Initializing max./min. value 

Maintaining previous 
max./min. value 

Display max./min. value Display max./min. value 
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5.4 Installation and Wiring 
 

5.4.1 Installation environment  
 

Although the device can be installed with high reliance regardless of installation environment, attention 
should be paid to the followings in order to secure the reliance and stability of the system.  

 

(1) Environmental Conditions 

(a) Install on a water-proof and dust-proof control board. 
(b) Place free of continuous impact or vibration. 
(c) Place not directly exposed to direct sunrays. 
(d) Place where dew does not form due to rapid temperature change. 

(e) Place where ambient temperature is maintained between 0 - 55℃. 

 

(2) Installation Construction 

(a) In case of screw hole processing or wiring construction, wiring dregs should not go into PLC. 
(b) Install on a position easy to access. 
(c) Should not install on the same panel which high voltage device is installed on. 
(d) It should be 50mm and longer distant from duct and modules. 
(e) Should ground in the environment where is not interrupted from noise. 
(f) Install not to contact with cooling pan in the panel 

 

(3) Cautions in handling  
It describes caution in handling from unpacking module to installation. 
(a) Do not fall or apply excessive impact on it. 
(b) Never attempt to separate PCB from the case. 
(c) Make sure that any impurities including wiring dregs should not go into the upper part of  

module during wiring work. 
(d) Never attempt to attach or detach the module when it is turned on. 

 

5.4.2  Wiring 
 

(1) Cautions in wiring  
(a) Do not place AC power line close to the AUX signal line of the module. To avoid surge or 

induced noise occurring from AC, make sure to leave a proper space.  
(b) Cable should be selected by considering ambient temperature and allowable current and the  

specification of cable should be as follows.  
 

Cable specification 

Lower limit Upper limit 

0.18mm
2
 (AWG24) 1.5 mm

2
 (AWG16) 

 
(c) If cable is placed too close to any heating device or materials or if it directly contacts oil and 

 similar materials for a long time, it may cause short-circuit, resulting in breakdown and  
malfunction.  

(d) Check the polarities during terminal strip wiring 
(e) Wiring with high voltage cable or power line may cause induction problem, causing malfunction  

or trouble.  
(f) External DC24V power should be same with power of XGB. If external DC24 V power of 

thermocouple input module is turned on/off while power of XGB main unit is on, temperature 
input value may have an error.  

(g) Thermocouple input module may use 4 types of thermocouple sensors. (K / J / T / R) 
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(2) Terminal array 

Terminal array of thermocouple input module is as follows. 
 

XBF-TC04B

XBF-TC04B

CH1 TC/Voltage input

CH2 TC/Voltage input

CH3 TC/Voltage input

DC24V supply

CH0 TC/Voltage input
CH0 +

CH0 -

DC24V+

DC24V-

NC Not used

Signal Purpose

CH1 +

CH1 -

CH2 +

CH2 -

CH3 +

CH3 -

+  -

K,J,T,R
0~100mV

XBF-TC04S

XBF-TC04S

CH1 TC input

CH2 TC input

CH3 TC input

DC24V supply

CH0 TC input
CH0 +

CH0 -

DC24V+

DC24V-

NC Not used

Signal Purpose

CH1 +

CH1 -

CH2 +

CH2 -

CH3 +

CH3 -

 
 
(3) Wiring example 

Thermocouple can be connected with module directly. If point where temperature is measured is 
far from the module, use the compensating cable to connect 
(The compensating cables are different according to thermocouple type. For more information 
about the compensating cable, contact the producer of thermocouple.) 
 

 
 

1) In case sensor and compensating cable are shielded, shield connection is possible to PLC FG terminal. 

2) It is necessary to use extension terminal block of which material is kept at uniform temperature in order 

to reduce error.  
3) Compensating cable should use the same type of sensor, which was used for measuring. 
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(4) Voltage (0~100mV) input wiring example 

XBF-TC04B+

-

CH0+

-

+

-

CH1+

-

CH0-

DC24V+

DC24V-
DC power

(Analog power 
supply)

+

-

CH2+

-

+

-

CH3+

-

CH0+

CH1-

CH1+

CH2-

CH2+

CH3-

CH3+

+  -

K,J,T,R
0~100mV

XBF-TC04B

 
 

Input resistance of voltage input circuit is 1 MΩ (min.). 
 

(5) Relationship between voltage input accuracy and wiring length 

In voltage input, the wiring (cable) length between transmitter or sensor and module has an 
effect on digital-converted values of the module as specified below; 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
       

 
Where,        

 
Rc: Resistance value due to line resistance of cable 

       Rs: Internal resistance value of transmitter or sensor 

       Ri: Internal resistance value (1㏁) of voltage input module 

       Vin: Voltage allowed to analog input module  
       % Vi: Tolerance of converted value (%) due to source and cable length in voltage input 

                   RiRcRs

VsRi
Vin






2   
 

%1001% 









Vs

Vin
Vi     

Vs 

Rs Rc 

Rc 

Ri 

Load 

 

Analog input (Voltage) 

Vin 
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5.5 Operation Setting and Monitor  

5.5.1 Operation Parameter Setting  
Operation parameter of thermocouple input module can be set through [I/O Parameter] of XG5000. 

 
(1) Setting items 

For user convenience, parameter setting of thermocouple input module is provided by GUI 
(Graphical User Interface) method in the XG5000. The items which can be set through [I/O 
Parameter] in the project window are as follows.  
 

Items Content 

[I/O Parameter] 

(a) Sets the following items for operation of module. 

1) Channel status (Disable / Enable) 

2) Sensor status (K / J / T / R) 

3) Filter constant 

4) Average processing (Sampling / Time-Avr. / Count-Avr. / Moving-Avr.) 

5) Scaling data type (Bipolar / Unipolar) 

6) Scaling min./max. value 

(b) The parameter set by the user is saved in the flash memory of XGB main 

unit after download. 

 
 

(2) How to use [I/O Parameter]  

 
(a) Execute the XG5000 and make the project.  

(For how to make the project, refer to the XG5000 user manual) 

 
(b) Double-click [I/O Parameter] on the project window. 
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(c) If [I/O Parameter Setting] window shows, find slot of base where module is installed and click it. 

 
 
(d) Register the module on a slot where module is installed on as follows. 

 
 

(e)  Select a module registered and click [Details] or double-click a module  
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(f) Select the required settings in Parameter Settings and click [OK]. 

 
 

 
(g) The initial values of each item are as figure shown below  

1) Channel status (Disable / Enable) 

 
 

2) Sensor status (K / J / T / R) 
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3) Temp. unit (Celsius / Fahrenheit) 

 
 

 

4) Filter constant (0, 200 ~ 64000) 

 
 

5) Average processing (Sampling / Time-Avr / Count-Avr / Moving-Avr) 

 
 

6) Scaling data type (Bipolar / Unipolar) 
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7) Scaling min. value/scaling max. value 

 
 

Scaling data 
type 

Scaling min value Scaling max value 

With sign -32768 ~ [scaling max value -1] [scaling min value+1] ~ 32767 

Without sign 0 ~ [scaling max value -1] [scaling min value+1] ~ 65535 

 

 
(h) Constant input 

 

1) In case the user inputs numbers directly like filter constant, if the relevant parameter is 

selected, available range is displayed in the bottom. 

 
 

2) If the number is out of range, error message is displayed.  

(If error information shows, it returns to previous status. Set again.) 
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3) If the wrong number is specified, it is displayed with red color.  

(When Average value or scaling min./max. value is out of range.) 

 
 

 

5.5.2 Special module monitoring function 
 
While XG5000 is connected with PLC, through [Monitor] -> [Special Module Monitoring], the user can 
test the operation of the analog output module. 

 

Remark  

1) If system resource is short, the screen may not be displayed properly. In case of this, shut down 
other application program and restart the XG5000.  

2) On the [Special Module Monitoring] status, I/O parameter is set temporarily to execute the test. So 
if [Special Module Monitoring] status ends, I/O parameter is not saved.  

3) By test function of [Special Module Monitoring], the user can check if analog module operates 
properly or not without any sequence program.  

 

 

(1) How to use special module monitoring 
 

(a) Start of [Special Module Monitoring] 
While XG5000 is connected with PLC, start [Monitor] -> [Special Module Monitoring]. If that is 
not online status, [Special Module Monitoring] is not activated. 
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(b) How to use [Special Module Monitoring] 

1) Click [Monitor] -> [Special Module Monitoring] while XG5000 is connected with PLC basic 

unit. ‘Special Module List’ screen is displayed as shown below and displays information of 

base/slot with special module type. On the list dialog box, The modules currently equipped 

at the PLC are displayed. 

 
 

2) Clicking [Module Info.] shows the information of special module. 

 
 

3) Clicking [Monitor] shows the following screen. 
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4) [Start Monitoring]: [Start Monitoring] button will show you digital input data of the operating 

channel. The figure below is monitoring screen when all channels are Run status.  

 
[Start Monitoring] execution screen 

  

 

5) [Test]: [Test] is used to change the parameters of the Thermocouple input module. You can 

change the parameters when you click the values at the bottom of the screen. It is only 

available when XGB CPU unit’s status is in [Stop].  

 
[Test] execution screen 

Monitoring screen 

Detail of channel 0 
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6) If [Flag Monitor] is selected on the [Special Module Monitor] window, [Temp. Measuring 

Module Command] screen can be monitored.  

           
[Temp. Measuring Module Command] execution screen 

 

7) [Temp. Measuring Module Command] screen 
On the monitoring screen, Channel status (Run/Stop) and Sensor status 
(Normal/Disconnection) can be monitored. 
On the flag command screen, Max/Min active (ENABLE/DISABLE) and cold junction 
compensation (ENABLE/DISABLE) can be specified. 

 
 

 

 

 

8) [Close]: [Close] is used to escape from the monitoring/test screen. When the 

monitoring/test screen is closed, the max. value, the min. value and the present value will 

not be saved any more. 

 

Remark  

[Test] function is only available when XGB CPU unit’s status is in [Stop]. 

 

Monitoring screen 

Flag command screen 
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5.5.3 Register U devices (Special module variable) 
 
Register the variables for each module referring to the special module information that is set in the 
I/O parameter. The user can modify the variables and comments. 

  
 

(1) Procedure  
(a) Select the special module type in the [I/O Parameter Setting] window.  

  
 
(b) Double click ‘Variable/Comment’ from the project window.  

  
 



XGB Analog edition manual 

 

5 - 32 

  

 
(c) Select [Edit] – [Register U Device]. 
   In case of XEC, select [Edit] - [Register special module variable]  
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(d) Click ‘Yes’. The previous comment will be deleted. 

  
 
(e) As shown below, the variables are registered. 
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 (2) Save variables  

(a) The contents of ‘View Variable’ can be saved as a text file.  
(b) Select [Edit] -> [Export to File]. 
(c) The contents of ‘View variable’ are saved as a text file.  

 
 

 (3) View variables  
(a) The example program of XG5000 is as shown below.   

 
 
(b) Select [View] -> [Variables]. The devices are changed into variables. 

 
 
(c) Select [View] -> [Devices/Variables]. Devices and variables are both displayed. 
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(d) Select [View] -> [Device/Comments]. Devices and comments are both displayed. 
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5.6 Configuration and Function of Internal Memory  
 

It describes the configuration and function of internal memory.  
 

5.6.1 Data I/O area (U device) 
 
(1) Data sent from module to XGB main unit (XGB PLC input area, read only) 

Device 

assignment 
Type Comment Content R/W 

Signal 

direction 

U0x.00.0 BIT CH 0 offset/gain adjustment error 

On: error, Off: 

normal 

R 

TC→CPU 

U0x.00.1 BIT CH 1 offset/gain adjustment error R 

U0x.00.2 BIT CH 2 offset/gain adjustment error R 

U0x.00.3 BIT CH 3 offset/gain adjustment error R 

U0x.00.D BIT Module offset/gain backup error R 

U0x.00.E BIT Module H/W error R 

U0x.00.F BIT Module Ready 
On: ready 

Off: not ready 
R 

U0x.01.0 BIT CH 0 running 

Channel running 

On: run, Off: stop 

R 

TC→CPU 

U0x.01.1 BIT CH 1 running R 

U0x.01.2 BIT CH 2 running R 

U0x.01.3 BIT CH 3 running R 

U0x.01.4 BIT CH 0 disconnection Thermocouple 

sensor 

On: disconnection, 

Off: normal 

R 

U0x.01.5 BIT CH 1 disconnection R 

U0x.01.6 BIT CH 2 disconnection R 

U0x.01.7 BIT CH 3 disconnection R 

U0x.01.8 BIT CH 0 setting error 
Parameter setting 

On: setting error 

Off: setting normal 

R 

U0x.01.9 BIT CH 1 setting error R 

U0x.01.A BIT CH 2 setting error R 

U0x.01.B BIT CH 3 setting error R 

U0x.04 WORD CH 0 temp. conversion value Temp. conversion 

value 

(Measured 

temp.×10) 

R 

TC→CPU 
U0x.05 WORD CH 1 temp. conversion value R 

U0x.06 WORD CH 2 temp. conversion value R 

U0x.07 WORD CH 3 temp. conversion value R 

U0x.08 WORD CH 0 scaling operation value Range with sign: 

-32768~32767 

Range without sign: 

0~65535  

R 

TC→CPU 
U0x.09 WORD CH 1 scaling operation value R 

U0x.10 WORD CH 2 scaling operation value R 

U0x.11 WORD CH 3 scaling operation value R 

U0x.12 WORD CH 0 min. temp. conversion value 

Temp. conversion 

min./max. 

accumulation 

R 

TC→CPU 

U0x.13 WORD CH 0 max. temp. conversion value R 

U0x.14 WORD CH 1 min. temp. conversion value R 

U0x.15 WORD CH 1 max. temp. conversion value R 

U0x.16 WORD CH 2 min. temp. conversion value R 

U0x.17 WORD CH 2 max. temp. conversion value R 

U0x.18 WORD CH 3 min. temp. conversion value R 

U0x.19 WORD CH 3 max. temp. conversion value R 

※ ‘x’ means slot no. where module is installed.  

   Ex.) U02.04: no.2 slot channel 0 temp. conversion value (word) 
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(2) Command sent from XGB main unit to module (XGB PLC output area, read/write available) 
 

Device 

assignment 
Type Comment Content R/W 

Signal 

direction 

U0x.29.0 BIT 
CH 0 max./min. searching 
Enable/Disable 

Min./max. search 
On: enable 
Off: disable 

R/W 

CPU↔TC 

U0x.29.1 BIT 
CH 1 max./min. searching 
Enable/Disable 

R/W 

U0x.29.2 BIT 
CH 2 max./min. searching 
Enable/Disable 

R/W 

U0x.29.3 BIT 
CH 3 max./min. searching 
Enable/Disable 

R/W 

U0x.29.8 BIT 
CH 0 cold junction compensation 

Enable/Disable 
Cold junction 
compensation 
On: enable 
Off: disable 

R/W 

U0x.29.9 BIT 
CH 1 cold junction compensation 

Enable/Disable 
R/W 

U0x.29.A BIT 
CH 2 cold junction compensation 

Enable/Disable 
R/W 

U0x.29.B BIT 
CH 3 cold junction compensation 

Enable/Disable 
R/W 

※ ‘x’ means slot no. where module is installed.  

Ex.) U03.29.02: no.3 slot, CH 2 max./min. searching Enable/Disable (bit) 
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(3) Data sent from module to XGB main unit (IEC type)  
(XGB PLC input area, read only) 

 

Device 

assignment 
Type Comment Content R/W 

Signal 

direction 

%UX0.x.0 BIT CH 0 offset/gain adjustment error 

On: error 

Off: normal 

R 

TC→CPU 

%UX0.x.1 BIT CH 1 offset/gain adjustment error R 

%UX0.x.2 BIT CH 2 offset/gain adjustment error R 

%UX0.x.3 BIT CH 3 offset/gain adjustment error R 

%UX0.x.13 BIT Module offset/gain backup error R 

%UX0.x.14 BIT Module H/W error R 

%UX0.x.15 BIT Module Ready 
On: ready 

Off: not ready 
R 

%UX0.x.16 BIT CH 0 running 

Channel running 

On: run, Off: stop 

R 

TC→CPU 

%UX0.x.17 BIT CH 1 running R 

%UX0.x.18 BIT CH 2 running R 

%UX0.x.19 BIT CH 3 running R 

%UX0.x.20 BIT CH 0 disconnection Thermocouple 

sensor 

On: disconnection, 

Off: normal 

R 

%UX0.x.21 BIT CH 1 disconnection R 

%UX0.x.22 BIT CH 2 disconnection R 

%UX0.x.23 BIT CH 3 disconnection R 

%UX0.x.24 BIT CH 0 setting error 
Parameter setting 

On: setting error 

Off: setting normal 

R 

%UX0.x.25 BIT CH 1 setting error R 

%UX0.x.26 BIT CH 2 setting error R 

%UX0.x.27 BIT CH 3 setting error R 

%UW0.x.4 WORD CH 0 temp. conversion value 
Temp. conversion 

value 

(Measured temp.×10) 

R 

TC→CPU 
%UW0.x.5 WORD CH 1 temp. conversion value R 

%UW0.x.6 WORD CH 2 temp. conversion value R 

%UW0.x.7 WORD CH 3 temp. conversion value R 

%UW0.x.8 WORD CH 0 scaling operation value Range with sign: 

-32768~32767 

Range without sign: 

0~65535 

R 

TC→CPU 
%UW0.x.9 WORD CH 1 scaling operation value R 

%UW0.x.10 WORD CH 2 scaling operation value R 

%UW0.x.11 WORD CH 3 scaling operation value R 

%UW0.x.12 WORD CH 0 min. temp. conversion value 

Temp. conversion 

min./max. 

accumulation 

R 

TC→CPU 

%UW0.x.13 WORD CH 0 max. temp. conversion value R 

%UW0.x.14 WORD CH 1 min. temp. conversion value R 

%UW0.x.15 WORD CH 1 max. temp. conversion value R 

%UW0.x.16 WORD CH 2 min. temp. conversion value R 

%UW0.x.17 WORD CH 2 max. temp. conversion value R 

%UW0.x.18 WORD CH 3 min. temp. conversion value R 

%UW0.x.19 WORD CH 3 max. temp. conversion value R 

※ ‘x’ means slot no. where module is installed.  

Ex.) %UW0.2.4: no.2 slot channel 0 temp. conversion value (word) 
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(4) Command sent from XGB main unit (IEC type) to module  
(XGB PLC output area, read/write available)  

Device 

assignment 
Type Comment Content R/W 

Signal 

direction 

%UX0.x.464 BIT 
CH 0 max./min. searching 
Enable/Disable 

Min./max. search 
On: enable 
Off: disable 

R/W 

CPU↔TC 

%UX0.x.465 BIT 
CH 1 max./min. searching 
Enable/Disable R/W 

%UX0.x.466 BIT 
CH 2 max./min. searching 
Enable/Disable R/W 

%UX0.x.467 BIT 
CH 3 max./min. searching 
Enable/Disable R/W 

%UX0.x.472 BIT 
CH 0 cold junction 
compensation Enable/Disable 

Cold junction 
compensation 
On: enable 
Off: disable 

R/W 

%UX0.x.473 BIT 
CH 1 cold junction 
compensation Enable/Disable 

R/W 

%UX0.x.474 BIT 
CH 2 cold junction 
compensation Enable/Disable 

R/W 

%UX0.x.475 BIT 
CH 3 cold junction 
compensation Enable/Disable 

R/W 

※ ‘x’ means slot no. where module is installed. 
Ex.) %UX0.3.466: no.3 slot, CH 2 max./min. searching Enable/Disable (bit) 

 
 

5.6.2 How to set operation parameter  
 
Operation parameter of thermocouple input module can be set by two methods. 
 
(1) Setting operation parameters through [I/O parameter setting] window. 
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(2) Writing operation parameters through program (PUT instruction is used.) 

 
 
 

 

Remark  

How to use PUT instruction 

 
 

[Area setting] 

Operand Description Data size 

sl Slot no. where special module is mounted WORD 

S1 Internal memory address of special module WORD 

S2 Device to save in special module WORD 

N The number of data WORD 

 

 

 
 
 

 indicates PUT instruction. 
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(3) Writing operation parameters at setting area of thermocouple input module through program  
(IEC type, PUT function block is used) 
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5.6.3 Operation parameter setting area  
 
It describes operation parameter setting area of thermocouple input module. 
 

Memory 
address Description Setting value R/W Instruction 

Hex. Dec. 

00 H 0 
Designate a channel to 

use 
bit0:bit3, 0: stop, 1: run R/W 

PUT/GET 

01 H 1 Set sensor type of CH 0 

K:0, J:1, T:2, R:3 

0~100㎷:4 (XBF-TC04B) 
R/W 

02 H 2 Set sensor type of CH 1 

03 H 3 Set sensor type of CH 2 

04 H 4 Set sensor type of CH 3 

05 H 5 
Designate temperature 

metric system 
bit0:bit3, 0: Celsius, 1: 
Fahrenheit 

R/W 

06 H 6 Set CH 0 filter value 

0 or 200 ~ 64000 R/W 
07 H 7 Set CH 1 filter value 

08 H 8 Set CH 2 filter value 

09 H 9 Set CH 3 filter value 

0A H 10 
Set averaging method 

of CH 0 

0: sampling 
1: time average 
2: count average 
3: moving average 

R/W 

0B H 11 
Set averaging method 

of CH 1 

0C H 12 
Set averaging method 

of CH 2 

0D H 13 
Set averaging method 

of CH 3 

0E H 14 Set mean value of CH 0 

Time average: 400~60000 ms 
Count average: 2~64000 times 
Moving average: 2~100 

R/W 
0F H 15 Set mean value of CH 1 

10 H 16 Set mean value of CH 2 

11 H 17 Set mean value of CH 3 

12 H 18 
Designate scaling type bit0:bit3, 

0: signed, 1: unsigned 
R/W 

13 H 19 
Set min. value of CH 0 

scaling range 

Min. value 
signed: -32768~[max.-1] 
unsigned: 0~[max.-1] 
 
Max. value 
signed: [Min.+1]~32767 
Unsigned: [Min.+1]~655535 

R/W 

14 H 20 
Set max. value of CH 0 

scaling range 

15 H 21 
Set min. value of CH 1 

scaling range 

16 H 22 
Set max. value of CH 1 

scaling range 

17 H 23 
Set min. value of CH 2 

scaling range 

18 H 24 
Set max. value of CH 2 

scaling range 

19 H 25 
Set min. value of CH 3 

scaling range 

1A H 26 Set max. value of CH 3 
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Memory 
address Description Setting value R/W Instruction 

Hex. Dec. 

scaling range 

1B H 27 Set error inf. Of CH0. 

Setting error information (Flag) R GET 
1C H 28 Set error inf. Of CH1 

1D H 29 Set error inf. Of CH2 

1E H 30 Set error inf. Of CH3 

1F H 31 

Cold junction 

compensation temp. of 

CH0. 

Measured value of cold junction 
compensation temp. 

R GET 

20 H 32 

Cold junction 

compensation temp. of 

CH1. 

21 H 33 

Cold junction 

compensation temp. of 

CH2. 

22 H 34 

Cold junction 

compensation temp. of 

CH3. 

23 H 

~3F H 
35 

~63 
System area 
(Offset gain storage area) 

Read/Write unavailable unavailable - 

 

 

Caution 
(1) If input value of memory address 00H~1AH(0~26) is out of range of setting value, 

 U0x.01.8~U0x.01.B (setting error representation flag, in case of IEC type, 

 %UX0.x.24~%UX0.x.27) are on and it acts as default setting 

 value. Error information is displayed in 1BH~1FH(27~30) area.  
(2) System area (Offset gain storage area) is area where Read/Write is unavailable. 

If this area changes, malfunction or breakdown may occur. 
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(1) Designating Channel (Address 0) 
(a) Temperature conversion module Enable/Disable can be set to each channel. 
(b) By prohibiting a channel not to use from conversion, conversion interval by channels can be 

shortened. 
(c) If channel to use is not designated, every channel can not be used. 
(d) In case of using PUT instruction,temperature conversion module Enable/Disable are as follows. 

 
 

 

 

 

 

 

 

BIT Description 

0 Stop 

1 Operate 

 
(e) Vales set in B4 ~ B15 are ignored. 
(f) This area shows the same results with operation channel designation in I/O parameter setting 

window. 

 
 

(2) Sensor Type Setting Area (Address 1~4) 
(a) Thermocouple sensor type can be set per channel.  
(b) In case of using PUT instruction, Sensor Type Setting Area is as follows. 

 

  B15 B14 B13 B12 Bt11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Address “1”  CH0 sensor type setting 

Address “2”  CH1 sensor type setting 

Address “3”  CH2 sensor type setting 

Address “4”  CH3 sensor type setting 

 

Word Description 

0 K type 

1 J type 

2 T type 

3 R type 

4 0~100mV (XBF-TC04B) 

 
(c) When input value is larger than 4, 0 (K type) is selected by force. 

But, U0x.01.8~ U0x.01.B (setting error representation, in case of IEC type, %UX0.x.24 
~ %UX0.x.27) are on, error information is displayed at bit 0 of address 27~30. 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — — — — — — 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

Address “0” 
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(d) This area shows the same results with sensor type designation in I/O parameter setting window. 

 
 

(3) Temp. unit setting area (Address 5) 
(a) Temp. unit (Celsius/ Fahrenheit) of thermocouple input module can be set per channel.  
(b) In case of PUT instruction, Temp. unit setting area is as follows. 

 
  B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Address “5”   

— — — — — — — — — — — — 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

  

 

Bit Description 

0 Celsius 

1 Fahrenheit 

 
(c) Vales set in B4 ~ B15 are ignored. 
(d) This area shows the same results with temp. unit setting in I/O parameter setting window. 

 
 
 

(4) Filter constant setting area (Address 6~9) 
(a) Filter constant can be set per channel. 
(b) Filter constant ranges 0 or 200 ~ 64000.  
(c) If filter constant is set as 0, filtering process is not executed. 
(d) When input is 1~199 or larger than 6400, 0 (filter disable) is selected by force.  

But, U0x.01.8~ U0x.01.B (setting error representation, in case of IEC type, %UX0.x.24 
~ %UX0.x.27) are on, error information is displayed at bit 1 of address 27~30. 

(e) In case of PUT instruction, filter constant setting address is as follows. 
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  B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Address “6”  CH0 filter constant setting (0, 200~64000) 

Address “7”  CH1 filter constant setting (0, 200~64000) 

Address “8”  CH2 filter constant setting (0, 200~64000) 

Address “9”  CH3 filter constant setting (0, 200~64000) 

 
(f) This area shows the same results with filter constant setting in I/O parameter setting window. 

 
 
 

(5) Average processing setting area (Address 10~13) 
(a) Average processing method can be set per channel. 
(b) Average processing method (Sampling: 0 / time-avr.: 1 / count-avr.: 2 / moving-avr.: 3)  
(c) When input is larger than 4, 0 (sampling) is set by force.  

But, U0x.01.8~ U0x.01.B (setting error representation, in case of IEC 
type, %UX0.x.24~%UX0.x.27) are on, error information is displayed at bit 2 of address 27~30. 

(d) In case of PUT instruction, average processing setting method is as follows. 
 

  B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Address “10”  CH# average processing method setting 
0: Sampling 
1: Time-average 
2: Count-average 
3: Moving-average 

Address “11”  

Address “12”  

Address “13”  

 
(e) This area shows the same results with average processing method setting in I/O parameter 

setting window. 
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(6) Average value setting area (Address 14~17) 

(a) Average value can be set per channel. 
(b) In case average processing method is sampling, values of this area are ignored. 
(c) In case of using PUT instruction, average value setting address is as follows. 

 

  B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Address “14”  CH# average value setting 
Time-average: 400 ~ 64000[ms] 
Count-average: 2 ~ 64000[times] 
Moving-average: 2 ~ 100  

Address “15”  

Address “16”  

Address “17”  

 
(d) When input is out of range, the min. value of each address is selected by force. 

But, U0x.01.8~ U0x.01.B (setting error representation, in case of IEC type, %UX0.x.24 
~ %UX0.x.27) are on, error information is displayed at bit 3~5 of address 27~30. 
(Bit 3: time-average, bit 4: count-average, bit 5: moving-average) 
Ex.) When selecting the Time-average and setting average value as 200, 400ms is selected in 

address “14” by force. 

(e) This area shows the same results with average value setting in I/O parameter setting window. 
In the I/O parameter setting window, prohibition function is provided not to set value that is out 
of range. (In case of setting value that is out of range, that values are displayed with red color 
and error message is displayed.)   

1) Time-Avr. 

 
2) Count-Avr. 

 
3) Moving-Avr. 
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(7) Scaling data type setting area (address 18) 

(a) Scaling data type can set per channel. 
(b) There are two type of scaling operation output, unsigned 16 bit (0~65535) or signed 16 bit (-

32768~32768). 
(c) In case of using PUT instruction, scaling data type setting address is as follows. 

 
  B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Address “0”  

— — — — — — — — — — — — 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

  

 
 

Bit Description 

0 Signed integer 

1 Unsigned integer 

 
(d) Values set in B4~15 are ignored. 
(e) This area shows the same results with Scaling data type setting in I/O parameter setting 

window. 

 
 
 

(8) Scaling min./max. value setting area (Address 19~26) 
(a) Scaling min./max. value can be set per channel. 
(b) There are two type of scaling operation output, unsigned 16 bit (0~65535) or signed 16 bit  

(-32768~32767).  
(c) In case of using PUT instruction, scaling min./max. value setting address is as follows. 

 

  B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Address “19”  
CH# scaling min./max. value 
1) with sign         Min.: -32768 ~ [Scaling max. value-1] 

   Max.: [Scaling min. value+1]~32767 
2) without sign      Min.: 0 ~ [Scaling max. value-1] 

   Max.: [Scaling min.value+1]~65535 
CH0: min. address 19 / max. address 20 
CH1: min. address 21 / max. address 22 
CH2: min. address 23 / max. address 24 
CH3: min. address 25 / max. address 26 

Address “20”  

Address “21”  

Address “22”  

Address “23”  

Address “24”  

Address “25”  

Address “26”  

 
(d) If input is out of range, it keeps previous value.  

But, U0x.01.8~ U0x.01.B (setting error representation, in case of IEC 
type, %UX0.x.24~%UX0.x.27) are on, error information is displayed at bit 6 of address 27~30. 
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(e) This area shows the same results with Scaling min./max. value setting in I/O parameter setting 
window. 

 
 

Scaling data 
type 

Scaling min. value Scaling max. value 

Signed -32768 ~ [Scaling max. value -1] [Scaling min. value+1] ~ 32767 

Unsigned 0 ~ [Scaling max. value-1] [Scaling min. value+1] ~ 65535 

 
 

(9) Setting error information area (address 27~30) 
(a) If there is error when setting parameter (address 1~26), error information is displayed at 

address 27~30 per channel. 
(b) In case of GET instruction, setting error information address is as follows. 

 

  B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Address “27”  CH0 setting error information 

Address “28”  CH1 setting error information 

Address “29”  CH2 setting error information 

Address “30”  CH3 setting error information 

 

Bit Description 
Related memory 

address 
Hex. Dec. 

Bit0 Sensor type (Off: normal, On: error) 01H~04H 1~4 

Bit1 Filter constant (Off: normal, On: error) 06H~09H 6~9 

Bit2 
Average processing method  

(Off: normal, On: error) 
0AH~0DH 10~13 

Bit3 Time-average value (Off: normal, On: error) 

0EH~11H 14~17 Bit4 Count-average value (Off: normal, On: error)) 

Bit5 Moving-average value (Off: normal, On: error) 

Bit6 Scaling range (Off: normal, On: error) 13H~1AH 19~26 

 
(c) In case there is error, setting error representation flag (U0x.01.8 ~ U0x.01.B, in case of IEC 

type, %UX0.x.24 ~ %UX0.x.27) will be on, it acts as default value. 
   If setting error representation flag (U0x.01.8 ~ U0x.01.B) is on, check error information 1BH ~ 

1FH (27~30) area and solve the error. 
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(10) Cold junction compensation temp. area (Address 31~34) 

(a) Cold junction compensation temp. can be seen per channel. 
(b) In case of GET instruction, cold junction compensation temp. area is as follows. 

 

  B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

Address “31”  CH0 cold junction compensation temp. 

Address “32”  CH1 cold junction compensation temp. 

Address “33”  CH2 cold junction compensation temp. 

Address “34”  CH3 cold junction compensation temp. 

 
 

(11) System area (offset gain storage area: address 35~63) 
(a) In the system area, Read/Write is unavailable.  
 

Caution 
If the user changes this area, it may cause malfunction or breakdown.  

So do not handle this area. 
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5.7 Example Program 
 

(1) It describes how to set operation parameter in the internal memory of thermocouple module. 
(2) Regarding the initial condition, the initial settings are saved in the internal memory of thermocouple 

module if saved once. 
 
(3) The following is program example that reads the temp. value of thermocouple input module of slot 

1 and check whether disconnection occurs or not. 

5.7.1 Example using [I/O Parameter] 
 
(1) I/O parameter setting window 

 

 
 
(2) Program example 

 
(a) If module is under normal operation, M0000 is on. 

U01.00.F(module Ready) = On 
U01.00.0(CH0 offset/gain adjustment error) = Off 
U01.00.E(module H/W error) = Off 
U01.00.E(CH0 running) = On 

(b) If M0000 is on, temp. conversion value (U01.04) of CH0 moves to D0000. 
(c) If disconnection error occurs at CH0, U01.01.4 (CH0 disconnection) is on and M0001 bit is set. 
 



XGB Analog edition manual 

 

5 - 52 

  

(3) Program example (in case of IEC type) 

 
 

(a) If module is running normally, operation start bit is on 
%UX0.1.15 (Module Ready) = On 
%UX0.1.0 (CH 0 offset/gain adjustment error) = Off 
%UX0.1.14 (Module H/W error) = Off 
%UX0.1.16 (CH 0 running) = On 
%UX0.1.24 (Setting error) = Off 

(b) If operation start bit is on, it moves CH 0 temp. conversion value (%UW0.1.4) into CH 0 temp.  
data 

(c) If CH 0 disconnection error occurs, %UX0.1.20 (CH0 disconnection) is on and CH 0  
disconnection error bit is set 
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5.7.2 Program example using PUT/GET instruction 
 
(1) Program example 

 
 

(a) It writes h0001 at address 0 of slot 1 in order to enable CH0. 
(b) If module is under normal operation, M0000 is on. 

U01.00.F(module Ready) = On 
U01.00.0(CH0 offset/gain adjustment error) = Off 
U01.00.E(module H/W error) = Off 
U01.00.E(CH0 running) = On 

(c) If M0000 is on, temp. conversion value of CH0 moves to D0000. 

Current temp. conversion value, 278(27.8℃2) is saving in U01.04. 

(d) If disconnection error occurs at CH0, U01.01.4 (CH0 disconnection) is on and M0001 bit is set. 
(e) If M0000 is on, setting error (address 27) of CH0 moves to D0001. Since setting error (address 

27) of CH0 is 0, there is no setting error. 
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(2) Program example (in case of IEC type) 

 

 
 

 
 
 
 
 
 
 
 
(a) Writes 1 at address 0 of slot 1 and operates CH 0 by using PUT_WORD function block. 
(b) If operation start bit is on, reads CH 0 setting error (address 27) and movies it into D0001. 
(c) If module is running normally, operation start bit is on. 

%UX0.1.15 (module Ready) = On 
%UX0.1.0 (CH 0 offset/gain adjustment error) = Off 
%UX0.1.14 (Module H/W error) = Off 
%UX0.1.16 (CH 0 running) = On 
%UX0.1.24 (setting error) = Off 

(d) Operation start bit is on, moves CH 0 temp. conversion value (%UW0.1.4) into CH 0 temp. 
data  

(e) Disconnection error occurs at CH 0, %UX0.1.20 (CH 0 disconnection) is on and CH 0 
disconnection error bit is set. 
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5.7.3 Example when error occurs 
 
(1) Program example 

 
(a) If disconnection error occurs at CH0, U01.01.4 (CH0 disconnection) is on and M0001 bit is set. 
(b) If disconnection error occurs at CH0, min. value within the range of K type temperature senor 

is displayed at U01.04. 
(c) It is monitored as follows according to monitor display type. 

When monitoring the temp. conversion value, select “Unsigned Decimal”. 
 

Monitor display type Display content 

Unsigned Decimal 62836 

Signed Decimal -2700 (-270.0℃) 

Hexadecimal hF574 

As Instruction 62836 
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5.8 Troubleshooting 
 

The chapter describes diagnostics and measures in case any trouble occurs during use of thermocouple 
input module. 

 

5.8.1 LED Indication by Errors  
 
Thermocouple input module has two LEDs and it is possible to check whether it had any error with the 
indication of RUN LED and ALM LED. 

 

Item Normal Disconnection 
Abnormal module 

H/W (error) 

RUN LED ON ON 
Flicker every 0.2 

second 

ALM LED OFF Flicker every second OFF 

Operation 
Normal operation 

Every function works 

Every function works 

Min. temp. is displayed 

Module function 

stops 

Management - Checking sensor wiring Customer service 
 

 
 

5.8.2 Stats check of module through XG5000 system monitor 
 
Module type, module information, O/S version and module status of thermocouple input module can 
be checked through XG5000 system monitoring function. 
 

(1) Execution sequence 

Two routes are available for the execution. 
(a) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button to 

display [Module Information]. 
(b) [Monitor] -> [System Monitoring] -> And Double-click the module screen. 

 

(2) Module information 

(a) Module type: shows the information of the module presently installed. 
(b) Module information: shows the O/S version information of module. 
(c) O/S version: shows the O/S prepared date of module. 
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5.8.3 Troubleshooting 
 

(1) RUN LED flickers. 
 
 
 
 
 
 
 
 
 
 
 
(2) RUN LED is off. 

RUN LED flickers. 

 

RUN LED flickers 0.2s intervals. 

 

Contact the nearest agency or LS branch office. 

 

 

Yes 

 

RUN LED is off. 

Thermocouple input module is installed correctly? 

Correctly install this module. 

Contact the nearest agency or LS branch office. 

I/O information can be seen at the XG5000. 

Normally operated if thermocouple input module with 

error is changed to another module 

No 

Yes 

No 

Yes 

Yes Contact the nearest agency or LS branch office. 
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(3) ALM LED flickers. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(4) Temperature conversion value is not normal. 

ALM LED flickers. 

 

Sensor wiring is normal. 

 

Wire properly referring to wiring method of user manual. 

. 

 

Contact the nearest agency or LS branch office. 

No 

 
Yes 

 

Temperature conversion value is not normal. 

External DC 24V input power is normal. 

FG ground is normal. 

 Supply external power (DC 24V) 

 

Execute FG ground properly referring to user 
manual 

 

Parameter setting is normal. 
(Channel status, sensor type) 

No 

 Yes 

 

No 

 Yes 

 

Contact the nearest agency or LS branch office. 

 

No 

 

 
Yes 

 

 

 Set parameter properly referring to user manual. 
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5.8.4 Error code and measure 
 
(1) Measure when error flag of data I/O area (U device) occurs. 
 

Device 

assignment 

(‘S’, ‘H’ type) 

Device 

assignment 

(IEC type) 

Description Content Measure 

U0x.00.0 %UX0.x.0 
CH0 offset/gain adjustment 

error 

On: error 

Off: normal 

If repeated when restarting 

the power, contact custom 

service center 

U0x.00.1 %UX0.x.1 
CH1 offset/gain adjustment 

error 

U0x.00.2 %UX0.x.2 
CH2 offset/gain adjustment 

error 

U0x.00.3 %UX0.x.3 
CH3 offset/gain adjustment 

error 

U0x.00.D %UX0.x.13 Module offset/gain backup error 

If repeated when restarting 

the power, contact custom 

service center 

U0x.00.E %UX0.x.14 Module H/W error 

If repeated when restarting 

the power, contact custom 

service center 

U0x.01.8 %UX0.x.24 CH0 setting error Parameter setting 

On: setting error 

Off: setting 

normal 

Check the parameter setting 

area (address 27~30) by GET 

instruction, solve the setting 

error contents. 

U0x.01.9 %UX0.x.25 CH1 setting error 

U0x.01.A %UX0.x.26 CH2 setting error 

U0x.01.B %UX0.x.27 CH3 setting error 

 
 
(2) Checking error information area (address 27~30) of operation parameter area 
 

(a) Setting error information area (address 27~30) 
 

Bit Description 
Related memory 

address 
Hex. Dec. 

Bit0 Sensor type setting (Off: normal, On: error) 01H~04H 1~4 

Bit1 Filter constant setting (Off: normal, On: error) 06H~09H 6~9 

Bit2 
Average processing method setting 

(Off: normal, On: error) 
0AH~0DH 10~13 

Bit3 Time average value (Off: normal, On: error) 

0EH~11H 14~17 Bit4 Count average value (Off: normal, On: error) 

Bit5 Moving average value (Off: normal, On: error) 

Bit6 Scaling range (Off: normal, On: error) 13H~1AH 19~26 

 
(b) Checking setting error information 

Check the setting error information (address 27~30) area by GET instruction.  
Ex.1) In case thermocouple input module is mounted at slot 1. 

 
 



XGB Analog edition manual 

 

5 - 60 

  

Ex.2) In case thermocouple input module is mounted at slot 1. (In case of IEC) 

 
  

(c) In case setting error occurs, setting error representation flag (U0x.01.8~ U0x.01.B, in case of IEC 
type %UX0.x.24 ~ %UX0.x.27) will be on and it will act as default value. If setting error representation 
flag (U0x.01.8~ U0x.01.B, in case of IEC type, %UX0.x.24 ~ %UX0.x.27) is on, check above setting 
error information 1BH ~ 1FH (address 27~30) area, check related memory address 01H ~ 1AH (address 
1~26) and cancel error.r 
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Chapter 6 Analog I/O Module 
 

6.1  Pre-operation Setting Procedure  
 

Please proceed as follows before operating analog I/O module. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 

 

XBF-AH04A 

 

 

 

 

 

 Check Performance Specifications 

Wiring 

Analog I/O Data Read/Write 

Parameter Setting 

Programming 

Eternal Voltage/Current S/W Setting 

Specification (6.2 Performance 
 Specifications) 
 Operating Environment 
 I/O Type and Range  
 Digital Output Range 
 Analog Output Range 

Wiring 
 Power supply (ext. DC24V) 
 Analog I/O wiring 

Switch Setting 
 V/A I/O Type Setting 

Analog I/O Test 
 XG5000 Special Module 

Monitor Test Mode 

Parameter 
 XG5000 I/O Parameter 

Programming 
 Analog Data Read/Write Program 

(U Device) 

 
In case of error or abnormal analog input  
or digital output, see Diagnosis. 
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6.2  Specification 
 

6.2.1  General Specification 
This section describes general specifications of the analog I/O module.  

 

 
 

No. Item Specification 
Applicable 

Standard 

1 
Operating 

temperature 
0 ~ 55 C  

2 
Storage 

Temperature 
25 ~ 70 C  

3 
Operating 

humidity 
5 ~ 95%RH, no condensate  

4 
Storage 

humidity 
5 ~ 95%RH, no condensate  

5 
Vibration 

immunity 

Intermittent Vibration   

Frequency Acceleration Amplitude Times 

IEC61131-2 

10  f  57Hz  0.075mm 

10 cycles 

for X, Y, Z 

each  

57  f  150Hz 9.8m/s
2
(1G)  

Continuous Vibration 

Frequency Acceleration Amplitude 

10  f  57Hz  0.035mm 

57  f  150Hz 4.9m/s
2
(0.5G)  

6 
Shocks 

immunity 

 Max. impact acceleration: 147 m/s
2
(15G) 

 Duration: 11ms 

 Pulse Shape: sinusoidal half-wave pulse (3 cycles in X, Y, Z) 

IEC61131-2 

7 
Noise 

immunity 

Rectangular 

Impulse Noise 

AC: 1,500 V 

DC:  900 V 

LS Self Test 

Standard 

Static Electricity 

Discharge 
Voltage: 4kV (contact discharge) 

IEC61131-2 

IEC61000-4-2 

Radiation 

Electromagnetic 

Field Noise 

80 ~ 1,000 MHz,  10V/m 
IEC61131-2, 

IEC61000-4-3 

Past Transient 

/Burst Noise 

Segment 
Power 

Module 

Digital/Analog I/O, 

Communication Interface IEC61131-2 

IEC61000-4-4 
Voltage 2kV 1kV 

8 Environment No corrosive gas or dust  

9 Altitude 2,000m max.  

10 Contamination 2 or less  

11 Cooling Natural air cooling  
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6.2.2  Performance Specification 
This section specified the performance of analog I/O module. 
 

 (1) Input Performance Specification 

Classification Input Performance Specification 

No. input channels 2 channels 

Analog 

Input 

Range 

Type Voltage Current 

Range 

DC 1 ~ 5V 

DC 0 ~ 5V 

DC 0 ~ 10V 

(Input resistance: 1 MΩ min.) 

DC 4 ~ 20㎃ 

DC 0 ~ 20㎃ 

(Input resistance 250 Ω) 

 

Input range shall be specified in user program or I/O parameters 

by channel, and selected with external voltage/current switches. 

Digital 

Output 

Type 12-bit binary data 

Value 

Range 

Unsigned 0 ~ 4000 

Signed -2000 ~ 2000 

Precise 

Value 

100 ~ 500 (DC 1 ~ 5V) 

0 ~ 500 (DC 0 ~ 5V) 

0 ~ 1000 (DC 0 ~ 10V) 

400 ~ 2000 (DC 4 ~ 20㎃) 

0 ~ 2000 (DC 0 ~ 20㎃) 

 

Percentile 

Value 
0 ~ 1000 

Max. Resolution 

1/4000 

1.25㎷ (DC 1~5V, 0~5V) 

2.5㎷ (DC 0~10V) 

5㎂ (DC4~20㎃, 0~20㎃) 

 

Precision ±0.5% max. 

Max. Conversion Rate 1ms/channel 

Max. Absolute Input DC ±15V DC ±25㎃ 

Additional 

Functions 

Filtration Digital filter (4 ~ 64,000㎳) 

Averaging 

Time average (4~16,000㎳) 

Cycle average (2~64,000 cycles) 

Moving average (2~100 values) 

Alarm Open line detection (DC 1~5V, DC4~20㎃) 

 



XGB Analog edition manual  

 

6 - 4 

 

 
 (2) Output Performance Specification  

Classification Output Performance Specification 

No. of output channels 2 channels 

Analog 

Output 

Range 

Type Voltage Current 

Range 

DC 1 ~ 5V 

DC 0 ~ 5V 

DC 0 ~ 10V 

(Load resistance: 2kΩ min.) 

DC 4 ~ 20㎃ 

DC 0 ~ 20㎃ 

(Load resistance: 510 Ω max.) 

 

Output range shall be specified in user program or I/O 

parameters by channel, and selected with external 

voltage/current switches. 

Digital 

Input 

Type 12-bit binary data 

Value 

Range 

Unsigned 0 ~ 4000 

Signed -2000 ~ 2000 

Precise 

Value 

100 ~ 500 (DC 1 ~ 5V) 

0 ~ 500 (DC 0 ~ 5V) 

0 ~ 1000 (DC 0 ~ 10V) 

400 ~ 2000 (DC 4 ~ 20㎃) 

0 ~ 2000 (DC 0 ~ 20㎃) 

 

Percentile 

Value 
0 ~ 1000 

Max. Resolution 

1/4000 

1.25㎷ (DC 1~5V, 0~5V) 

2.5㎷ (DC 0~10V) 

5㎂ (DC4~20㎃, 0~20㎃) 

 

Precision ±0.5% max. 

Max. Conversion Rate 1ms/channel 

Max. Absolute Output DC ±15V DC 25㎃ 

Additional Functions 
Channel output status setting function (selectable from previous, 

min., mean, max. value outputs)  

 
 (3) I/O Common Performance Specification 

Classification I/O Common Performance Specification 

Insulation Type 
Photo-coupler isolation between I/O terminal and PLC power 

source (no insulation between channels) 

I/O Terminals 11 point terminal block 

I/O Points Fixed type: 64 points 

Max. No. of Installation 
7 units (XBM(C)-DxxxS type) 

10 units (XB(E)C-DxxxH type) 

Current 
Internal (DC 5V) 120mA 

External (DC 24V) 130mA 

Weight 73g 

Power Supply DC 20.4 ~ 28.8V 

 

Note1) In order to use analog I/O module, the following version is needed. 

 

Main unit Version information 

XBM-DxxxS type V2.4 

XBC-DxxxH type V1.7 

XEC-DxxxH type V1.0 

XEC-DxxxS type V1.0 
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6.3  Major Components 
 

Major components are as follows; 
 

 

①

③

 

⑤

②

 

⑦

⑧

 

④

 

⑥

 
 

No. Name Description 

① INPUT LED 

▶ Indicate operation of input part 

On: normal operation 

Flickering: in error (1s intervals) 

Off: power off or module failure 

② OUTPUT LED 

▶ Indicate operation of output part 

On: normal operation 

Flikering: in error (1s intervals) 

Off: power off or module failure 

③ 
Input Volt/Current 

Select Switch 

▶ Switch for selecting voltage/current input of analog input 

 Ch 0 and Ch 1 

④ 
Output Volt/Current 

Select Switch 

▶ Switch for selecting voltage/current output of analog  

output Ch 0 and Ch 1 

⑤ 
Input Terminal 

Block 

▶ Terminal block for analog input wiring with external  

devices 

⑥ 
Output Terminal 

Block 

▶ Terminal block for analog output wiring with external  

devices 

⑦ 
Ext. Power 

Connector 
▶ Connector for DC24V external power supply 

⑧ Ext. Connector ▶ Connector for extension modules 
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6.4  Conversion Characteristics by I/O Range 
 

The input/output ranges of voltage and current can be set up per channel with user program or 
I/O parameters. The I/O types of digital data are defined as follows. 
(1) Unsigned Value 
(2) Signed Value 
(3) Precise Value 
(4) Percentile Value 

 

6.4.1  Input Characteristics 
The graph below shows the data conversion characteristics by input range. 

Digital 

output

0

1000

2000

3000

4000
4047

-48
-2000

-1000

0

1000

2000
2047

-2048
0

250

500

750

1000
1011

-12

DC 1 ~ 5 V

DC 0 ~ 5 V

DC 0 ~ 10 V

DC 4 ~ 20 mA

1 V 5 V3 V

0 V 2.5 V 5 V

0 V 5 V 10 V

4 mA 12 mA 20 mA

Analog 

input

Practical analog input range

Offset value

Gain 

value

DC 0 ~ 20 mA 0 mA 10 mA 20 mA

 

 
 (1) DC 4 ~ 20mA Range Input 

Digital  
Output Range 

Analog Input Current (mA) 

3.81 4 8 12 16 20 20.18 

Unsigned Value 
(0 ~ 4000) 

-48 0 1000 2000 3000 4000 4047 

Signed Value 
(-2000 ~ 2000) 

-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 
(400 ~ 2000) 

381 400 800 1200 1600 2000 2018 

Percentile 
Value(0 ~ 1000) 

-12 0 250 500 750 1000 1011 
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(2) DC 0 ~ 20mA Range Input 

Digital  

Output Range 

Analog Input Current (mA) 

-0.24 0 5 10 15 20 20.23 

Unsigned Value 

(0 ~ 4000) 
-48 0 1000 2000 3000 4000 4047 

Signed Value 

(-2000 ~ 2000) 
-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 

(0 ~ 2000) 
-24 0 500 1000 1500 2000 2023 

Percentile 

Value(0 ~ 1000) 
-12 0 250 500 750 1000 1011 

 
 

     (3) DC 1 ~ 5V Range Input 

Digital  
Output Range 

Analog Input Voltage (V) 

0.96 1 2 3 4 5 5.04 

Unsigned Value 
(0 ~ 4000) 

-48 0 1000 2000 3000 4000 4047 

Signed Value 
(-2000 ~ 2000) 

-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 
(100 ~ 500) 

96 100 200 300 400 500 504 

Percentile 
Value(0 ~ 1000) 

-12 0 250 500 750 1000 1011 

 
 

(4) DC 0 ~ 5V Range Input 

Digital  
Output Range 

Analog Input Voltage  (V) 

-0.06 0 1.25 2.5 3.75 5 5.05 

Unsigned Value 

(0 ~ 4000) 
-48 0 1000 2000 3000 4000 4047 

Signed Value 

(-2000 ~ 2000) 
-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 

(0 ~ 500) 
-6 0 125 250 375 500 505 

Percentile 

Value(0 ~ 1000) 
-12 0 250 500 750 1000 1011 

 
 
 (5) DC 0 ~ 10V Range Input 

Digital  
Output Range 

Analog Input Voltage  (V) 

-0.12 0 2.5 5 7.5 10 10.11 

Unsigned Value 

(0 ~ 4000) 
-48 0 1000 2000 3000 4000 4047 

Signed Value 

(-2000 ~ 2000) 
-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 

(0 ~ 1000) 
-12 0 250 500 750 1000 1011 

Percentile 

Value(0 ~ 1000) 
-12 0 250 500 750 1000 1011 
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6.4.2  Output Characteristics 
The graph below shows the data conversion characteristics by output range. 

Digital 
input

Analog 
output

Practical analog output 
range
   

Offset 
value

 

Gain 
value

DC 1 ~ 5 V

DC 0 ~ 5 V

DC 0 ~ 10 V

DC 4 ~ 20 mA

1 V 5 V3 V

0 V 2.5 V 5 V

0 V 5 V 10 V

4 mA 12 mA 20 mA

DC 0 ~ 20 mA 0 mA 10 mA 20 mA

0

1000

2000

3000

4000
4047

-48
-2000

-1000

0

1000

2000
2047

-2048
0

250

500

750

1000
1011

-12

 

 (1) DC 4 ~ 20mA Range Output 

Digital Input 
Range 

Analog Output Current (mA) 

4mA less 4 8 12 16 20 20mA over 

Unsigned Value 
(0 ~ 4000) 

0 less 0 1000 2000 3000 4000 4000 over 

Signed Value 
(-2000 ~ 2000) 

-2000 less 
-

2000 
-1000 0 1000 2000 2000 over 

Precise Value 
(400 ~ 2000) 

400 less 400 800 1200 1600 2000 2000 over 

Percentile 
Value(0 ~ 1000) 

0 less 0 250 500 750 1000 1000 over 

 
(2) DC 0 ~ 20mA Range Output 

Digital Input 

Range 

Analog Output Current (mA) 

0mA less 0 5 10 15 20 20mA over 

Unsigned Value 
(0 ~ 4000) 

0 less 0 1000 2000 3000 4000 4000 over 

Signed Value 
(-2000 ~ 2000) 

-2000 less -2000 -1000 0 1000 2000 2000 over 

Precise Value 

(0 ~ 2000) 
0 less 0 500 1000 1500 2000 2000 over 

Percentile 

Value(0 ~ 1000) 
0 less 0 250 500 750 1000 1000 over 
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     (3) DC 1 ~ 5V Range Output 

Digital Input 
Range 

Analog Output Voltage (V) 

1V less 1 2 3 4 5 5V over 

Unsigned Value 
(0 ~ 4000) 

0 less 0 1000 2000 3000 4000 4000 over 

Signed Value 
(-2000 ~ 2000) 

-2000 less -2000 -1000 0 1000 2000 2000 over 

Precise Value 
(100 ~ 500) 

100 less 100 200 300 400 500 500 over 

Percentile 
Value(0 ~ 1000) 

0 less 0 250 500 750 1000 1000 over 

 
 

(4) DC 0 ~ 5V Range Output 

Digital Input 
Range 

Analog Output Voltage  (V) 

0V less 0 1.25 2.5 3.75 5 5V over 

Unsigned Value 

(0 ~ 4000) 
0 less 0 1000 2000 3000 4000 4000 over 

Signed Value 

(-2000 ~ 2000) 
-2000 less -2000 -1000 0 1000 2000 2000 over 

Precise Value 

(0 ~ 500) 
0 less 0 125 250 375 500 500 over 

Percentile 

Value(0 ~ 1000) 
0 less 0 250 500 750 1000 1000 over 

 
 
 (5) DC 0 ~ 10V Range Output 

Digital Input 
Range 

Analog Output Voltage  (V) 

0V less 0 2.5 5 7.5 10 10V over 

Unsigned Value 

(0 ~ 4000) 
0 less 0 1000 2000 3000 4000 4000 over 

Signed Value 

(-2000 ~ 2000) 
-2000 less -2000 -1000 0 1000 2000 2000 over 

Precise Value 

(0 ~ 1000) 
0 less 0 250 500 750 1000 1000 over 

Percentile 

Value(0 ~ 1000) 
0 less 0 250 500 750 1000 1000 over 
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6.5  Precision 
 
 

6.5.1  Input Precision 

The precision of digital output is not dependent upon the input range.  
The graph below shows the variation of precision when the analog input range is 0 ~ 10 V for 
unsigned value for digital output.  

     The input precision of the XBF-AH04A is ±0.5%. 
 

0

0V 5V

2000

10 V

4000

Analog input voltage

D
ig

ita
l o

u
tp

u
t va

lu
e

3980

4020

-20

20

 
 
 (1) Precision at 5V input; 

4000 × 0.5% = 20 
Therefore, precision range at 5V input is; (2000-20) ~ (2000+20) = 1980 ~ 2020. 

 
 (2) Precision at 10V input; 

4000 × 0.5% = 20 
Therefore, precision range at 10V input is;(4000-20) ~ (4000+20) = 3980 ~ 4020. 
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6.5.2  Output Precision 

The precision of analog output is not dependent upon the output range.  
The graph below shows the variation of precision when the analog output range is 0 ~ 10 V for 
unsigned value for digital output.  
The output precision of the XBF-AH04A is ±0.5% 

      

2000 40000

10V

0V

5V

10.05V

9.95V

0.05V

-0.05V

Digital input

A
n

a
lo

g
 o

u
tp

u
t

20mA
20.1mA

19.9mA

0mA
0.1mA

-0.1mA

10mA

 
  
 

 (1) Precision at 5V output; 
4000 × 0.5% = 20, therefore,  
precision range at 5V output is; (5V - 20×0.0025V) ~ (5V+20×0.0025V) = 4.95 ~ 5.05V . 

 
 (2) Precision at 10V output; 

4000 × 0.5% = 20, therefore,  
precision range at 10V output is; (10V-20×0.0025V) ~ (5V+20×0.0025V) = 9.95 ~ 10.05V. 
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6.6  Functions of Analog I/O Module 
 

 
The functions of XBF-AH04A Module are as follows.  
 

Function Description 

Channel 

operation/stop setting 

● Specify operation/stop of the channel which will perform A/D and D/A conversion. 

● Specifying unused channels as Stop can shorted overall operation time. 

I/O Voltage /current 

range setting  

● Specify desired range of analog I/O. 

● Select voltage/current with external switch, and set up range with parameter. 

● Analog I/O Module provides 2 ranges(4~20mA, 0~20mA) of current I/O and 3 ranges  

(1~5V, 0~5V, 0~10V) of voltage I/O. 

I/O data type setting 

● Specify digital I/O types. 

● This module provides 4 output data types (Unsigned, Signed, Precision, and 

 Percentile Values) 

A/D input conversion 

method 

● Sampling Process 

- If A/D conversion method has not been specified, the module processes sampling. 

● Filter process 

- Filters rapid changes in input value by external noise. 

● Averaging process 

- Outputs A/D converted value averaged by time, cycle, and moving. 

D/A output status 

setting 

● Sets up channel output state at transition from run to stop. 

● Provides 4 output selections (Previous, Minimum, Mean, Maximum Values) 

 
 
 

6.6.1 Sampling Process 
In popular A/D conversion process, analog input signals are collected at constant time intervals 
and A/D converted. The time elapsed for the analog signals converted into digital signals and 
saved in memory device depends upon the number of channels used.  

 

(Process Time) = (No. of Channels Used) x (Conversion Rate) 

 

(Ex.) Process time when using 3 of 4 I/O channels;  

3 x 1 ㎳ = 3.0 ㎳ 

 
 The term ‘sampling’ means taking analog signal values at certain time intervals.  
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6.6.2 Filtering Function 

 
The input value of the designated channel is calculated with previously filtered input value using 
preset filter constant (time constant 63.2%) by the formula below; 
 

).1(tan

).1(Pr)tan(Pr
 Pr

UsedofChannelsNomstFilterCons

UsedofChannelsNomsesentInputtFilterConstlteredInpueviouslyFi
teredInputesentlyFil






 
 
Filter Constant setting range = 4 ~ 64000 [ms] 
 
 

 

Input

1000

632

0

Input after filtration

Actual input

Filter Constant

(ms)

Time (ms)

 
 

 
In the above graph, if the input value changes rapidly from 0 to 100, the input value is filtered.  
Filter (time) constant is the time required for input values to vary by 63.2% of the actual input 
value.  
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6.6.3 Averaging Function 
 
(1) Average by Time 

The input values of the designated channel are accumulated for the preset time, and the 
average value of the total sum is outputted in digital data. 

Channel Scanning Intervals (1ms/Ch. Used)

Averaged input value 
Actual input value

Averaging 
Section

Averaging 
Section

Sampling 
Section

 
 
 
Setting Range = 4 ~ 16000 [ms] 
For time averaging, No. of averaging cycles are calculated with the No. of channels used 
as below;  
 

msUsedofChannelsNo

eAverageTim

1 .
Cycles Averaging No.


   

 
(2) Average by Cycles 

The input values of the designated channel are accumulated for the preset cycles, and the 
average value of the total sum is outputted in digital data. 

Channel Scanning Intervals (1ms/Ch. Used)

Averaged input value 
Actual input value

Averaging 
Section

Averaging 
Section

Sampling 
Section

 
Setting Range = 2 ~ 64000 [Cycle] 
For cycle averaging, averaging interval is calculated with the No. of channels used. 
 

msUsedofChannelsNoycleAveragingCmsntervalAveragingI 1. ][   
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(3) Moving Average 

The inputs into the designated channel are accumulated for the presser number, and its 
average is calculated and outputted in digital data. However, in moving average method, 
each scan provides its average value. 
 

 
 
 

 

 
 
 
 

 
 

(1) In case of time/cycle averages. The input value is not outputted at every conversion, but the 
previous value is maintained until the average time or cycle is reached. 

(2)  In case of moving averages, the converted input is averaged with the previously entered 
value and the result is outputted at every conversion. Therefore, data response is faster than 
time/cycle averaging methods. 

(3) The three averaging methods can be processed simultaneously with the filter function 
described earlier. In such case, the filter function is executed first, and averaging function is 
processed to output the average value in digital data, which is expressed with the finally-
processed value.  

 

Note 

 

 

Averaging No. Averaging No. 

Averaging No. 
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6.6.4 Line Open Detection Function 
 
The analog I/O module has a diagnostic function which can detect and indicate open input line, when 
voltage input range of DC 1~5V or current input range of DC 4~20mA is selected as its analog input 
range. If the module indicates open input line, check the wiring. 
 
(1) If the wiring to the module is open, the Input LED flikers at 1 second intervals and the respective 

error code is generated. 

 
(2) Line open detection is available for each channel. However, open indication is provided only for 

the channel selected for the operation. The Input LED is common for the input channels 0 and 1, 
and flickering if 1 or more channels are open. 

 

Input Connection 
Channel 

Operation 

 Input LED 

State 

Open Line 
Flag 

Normal 
Working On Off 

Stopped On Off 

Input wire open or 

disconnected 

Working Flickering (1s) On 

Stopped On Off 

 
(3) At line open, the line open flag of the channel turns On, and turns Off at correction. 

 

Open Flag Description 

U0x.01.4 Ch 0 open 

U0x.01.5 Ch 1 open 

 
(4) At line open, the least of all input values is indicated. 
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6.6.5 Channel Output Status Setting Function  

 
This function sets up the output in response to PLC shutdown or failure. 
 
(1) Function 

This function is used to obtain preset output value of the analog I/O module when the PLC 
system is transferred from run to stop. 
 

(2) Type 
Channel output can be one of the followings;  
(a) Previous value: maintains the last output from normal operation. 
(b) Minimum: outputs the least values of the respective output ranges. 
(c) Median: outputs the median values of the respective output ranges. 
(d) Maximum: outputs the largest values of the respective output ranges. 
 

(3) Example 
Assume that the output channel range is set to 4 ~ 20mA and the output level is 10mA. If the 
PLC system is switched from run to stop status, the output will be one of followings according to 
the setting;  
(a) Previous value: maintains 10mA which is the previous normal operation value. 
(b) Minimum: outputs 4mA which is the minimum of the output range setting. 
(c) Median: outputs 12mA which is the median of the output range setting. 
(d) Maximum: outputs 20mA which is the maximum of the output range setting.  
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6.7  Wiring 
 

6.7.1 Precautions for Wiring 
 
(1) Keep the I/O signal lines of the analog I/O module away from AC power line. Otherwise, the 

surge or induction noise of the AC line may affect the module.  
(2) The cable should be selected taking ambient temperature and allowable current into 

consideration. Recommended cable is AWG22 (0.3㎟) or higher grade.  

(3) Keep the cables away from heat source or oil. Otherwise, short-circuit, damage, or malfunction 
of the module may occur. 

(4) Check polarity at terminal block connection.  
(5) Keep the cables away from high voltage line or power line to avoid malfunction or failure of the 

module by induction. 

 
6.7.2 Exemplary Analog Input Wiring  

 
(1) Input resistance of the current input circuit is 250 Ω (typ.).  
(2) Input resistance of the voltage input circuit is 1 MΩ (min.).  
(3) Set only the channels to be used up for operation. 
(4) Analog I/O module does not provide power supply to external input device. Use external power 

supply. 
(5) Exemplary analog input wiring  

Same wiring scheme is applied to voltage and current inputs, except that voltage/current 

setting switch must be set up accordingly. 

+

-

CH0+

-

+

-

CH1+

-

DC power
(for analog module)

CH0+

CH0-

CH1+

CH1-

DC24V+

DC24V-

Voltage/Current 

Selection 

Switch
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(6) Exemplary Wiring for Analog Input 2-Wire Sensor/Transmission  

  Same wiring scheme is applied to voltage and current inputs, except that voltage/current setting 

switch must be set up accordingly. 

+

-

CH0

+

-

CH1

DC power
(For analog module)

CH0+

CH0-

CH1+

CH1-

DC24V+

DC24V-

Voltage/Current 

selection switch

DC
+

-

DC
+

-

2-Wire

Transmitter

2-Wire

Transmitter

 

(7) Exemplary Wiring for Analog Input 4-Wire Sensor/Transmission  

  Same wiring scheme is applied to voltage and current inputs, except that voltage/current setting 

switch must be set up accordingly. 

+

-

CH0

+

-

CH1

DC power
(For analog module)

CH0+

CH0-

CH1+

CH1-

DC24V+

DC24V-

Voltage/Current 

selection switch

DC
+

-

4-Wire

Transmitter

4-Wire

Transmitter
DC

+

-
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(8) Relation between voltage input precision and cable length  

In voltage input system, the cable length between the module and transmitter or sensor 
influences on the converted digital value of the module. The value is as follows. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
       

 
Where, 

           Rc: line resistance of the wire, 
           Rs: internal resistance of the transmitter or sensor, 

           Ri: internal resistance of voltage input module (1 ㏁)  

           Vin: voltage applied to the analog input 
           % Vi: error in the converted value caused by source and cable length in voltage   
    input(%) 

                 
  RiRcRs

VsRi
Vin






2
  

 

%1001% 









Vs

Vin
Vi     

 
 

Vs 

Rs Rc 

Rc 

Ri 

Load 

 

Analog input (Voltage) 

Vin 
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6.7.3 Exemplary Analog Output Wiring 

 
(1) Exemplary analog voltage output wiring 

Same wiring scheme is applied to voltage and current outputs, except that voltage/current 

setting switch must be set up accordingly. 

 

 (2) Exemplary analog current output wiring 

Same wiring scheme is applied to voltage and current outputs, except that voltage/current 

setting switch must be set up accordingly. 

+

-

CH0

+

-

CH1

DC power
(For analog 

module)

CH0+

CH0-

CH1+

CH1-

DC24V+

DC24V-

Voltage/current 

selection switch

510Ω or

less

Load

510Ω or 

less
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6.8  Operation Parameter Setting 
 

The operation parameters of analog I/O module can be set up with XG5000 [I/O Parameter]. 

 

(1) Setting Items 

For user convenience, XG5000 provides GUI (graphic user interface) for analog I/O module 
parameter setting. The items which can be set up in the [I/O Parameter] in the XG5000 project  
window are as follows.  

 

Item Description 

[I/O 

Parameter] 

(a) Input parameter setting 

Sets up following items required for module operation. 

1) Operation channel (Stop/Run) 

2) Input voltage (current) range  

3) Output data type 

4) Filter constant 

5) averaging process 

6) Average value 

(b) Output parameter setting 

    Sets up following items required for module operation. 

1) Operation channel (Stop/Run) 

2) Output voltage (current) range  

3) Input data type 

4) Channel output status 

(c) The parameters set up in XG5000, when downloaded, are stored in the flash 

 memory of the XGB base unit. 

 
(2) Usage of [I/O Parameter] 

 (a) Create a project with XG5000. See XG5000 Program Manual for project creation. 
 (b) In the Project window, double-click [I/O Parameter]. 
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 (c) In the [I/O Parameter Setting] window, find out the slot of the base where the analog I/O  
module is installed, and click it.  

 

 

 (d) In the above window, click the arrow button to call the window where the module can be  
selected. Find out the module and select it.  

 

 

 (e) To set up parameter, double click with the respective slot being selected, or click [Detail]  
button. 
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 (f) The window below where parameters can be set up by channel appears. Click the item to set  
up. The parameters which can be set up appear by item.  

  

 

 

6.9  Special Module Monitor Function 
 

The functions of the special module monitor are as follows. 
 

 (1) Start-up of [Special Module Monitor] 
Select [Online] -> [Connect], and [Monitor] -> [Special Module Monitor] to start up. [Special  
Module Monitor] menu is enabled only in the [Online] condition. 
 

 
 

 

Note  

1) The screen may not function properly if the system resources are not sufficient. In this case, close  
the screen, exit other applications, and rerun XG5000. 

2) The I/O parameters set up in [Special Module Monitor] condition are temporarily set up for testing  
purpose. Therefore, these I/O parameters are deleted after exit from [Special Module Monitor]. 

3) the test function of the [Special Module Monitor] enables testing analog I/O modules without  
sequence programming. 
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(2) Usage of [Special Module Monitor] 

(a) With the XG5000 in connection (online) with the base unit of PLC, select [Monitor] -> 

[Special Module Monitor]. The Select Special Module window shown below will appear 

showing the type of the special modules and base/slot information. In the list dialog, the 

modules present in the PLC system are displayed. 

 
 

(b) In the above window, select the special module and click [Module Info.] to see the 

information window below.  

 
 

(c) Click the [Monitor] button in the “Special Module” window. The “Special Module Monitor’ 

window will appear as shown below.  
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(d) [Start Monitoring]: click [Start Monitoring] to look up the digital input data of the channel 

currently in operation. The screen shot below is a monitoring window when all the 

channels are in operation status.  

 
The screen executing [Start Monitoring]  

 

(e) [Test]: this function is used to change the current parameter settings of the analog I/O 

module. Click the settings in the fields in the bottom screen to change the parameters. 

[Test] can be set up only when the operation status of the XGB base unit is STOP. 

 
    The screen executing [Test] 

Input Monitoring 

Output Monitoring 

Detail information 
of input CH0 

Detail information 
of output CH0 
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(f) Minimum/Maximum Value Monitoring  
    The minimum and maximum values of the input channels in operation can be monitored. 

However, the Max/Min values in the window are based on the current value. Therefore, 
the Max/Min values are not saved when exiting from the [Monitoring/Testing Screen]. 

 
 
The screen executing [Max/Min Value Monitoring]  
 

 
(g) Close 

[Close] button is for ending/closing the monitoring/testing screen. Maximum, 
minimum, and current values are not saved at exit. 

 

 

Monitors Max/Min value 

Resets Max/Min value 
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6.10  Auto-registration of U-Device (Special Module Variable) 
 

 The variables for each module are automatically registered by referring to the information of the 
special modules set up in the [I/O Parameter]. User can modify variables and descriptions. 

 
 (1) Registration Procedure 

 (a) In [I/O Parameter], set up special module in slot. 

 
 

 (b) Double click [Variables/Comment]. 

 
 

 (c) In the ‘Edit’ menu, select ‘U-Device Auto Registration’ (special module variable auto 
registration). 
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 (d) Click ‘Yes.’ 

  
 

 (e) Variables are registered as shown below.  

 
 

 (f) In IEC types, the variables are registered as shown below. 

 
 

 
 (2) Saving Variables 

 (a) The contents in the ‘View Variables’ tab can be saved in a text file. 
 (b) In the ‘Edit’ menu, select ‘Save as Text File.’ 
 (c) The contents in the ‘View Variables’ tab are saved in a text file. 
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 (3) Viewing Variables in Program 
 
   The figures below present examples of use in XGB “S” and “H” types. 
 

 (a) Below is an exemplary program for XG5000.  

 
 

 (b) In the ‘View' menu, click ‘View Variables.’ The devices are changed into  variables. 

 
 

 (c) In the ‘View' menu, click ‘View Device/Variables’ to look up the devices and variables at the 
same time. 
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 (d) In the ‘View' menu, click ‘View Device/Description’ to look up the devices and descriptions at 
the same time. 
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 (e) For IEC type also, as shown in Fig. (a) ~ (d), you can look up variables with 
           diversified options in the ‘View’ menu. The figure below is the case of an IEC type 
           with which the ‘View Variables/Descriptions’ option. 

 

 
 

 
 



Chap. 6 Analog I/O Module (XBF-AH04A) 

6 - 33 

 

 
 

6.11  Constitution and Function of Internal Memory 
 

An analog I/O module has internal memory for data communication with XGB base unit. 

 

6.11.1 Analog Data I/O Area 

The table below presents the analog data I/O area. 
 

Variable Type 

Device Allocation 

Description 
Read/ 
Write 

Signal 
Direction “S” or “H” 

Type 
IEC Type 

_0y_ERR BIT U0y.00.0 %UX0.y.0 Module error 
Read AH04A → CPU 

_0y_RDY BIT U0y.00.F %UX0.y.15 Module ready 

_0y_AD0_ACT BIT U0y.01.0 %UX0.y.16 Input Ch 0 operating 

Read AH04A → CPU 
_0y_AD1_ACT BIT U0y.01.1 %UX0.y.17 Input Ch 1 operating 

_0y_DA0_ACT BIT U0y.01.2 %UX0.y.18 Output Ch 0 operating 

_0y_DA1_ACT BIT U0y.01.3 %UX0.y.19 Output Ch 1 operating 

_0y_AD0_IDD BIT U0y.01.4 %UX0.y.20 
Input Ch 0 open wire 
detected 

Read AH04A → CPU 
_0y_AD1_IDD BIT U0y.01.5 %UX0.y.21 

Input Ch 1 open wire  
detected 

_0y_AD0_ERR BIT U0y.01.8 %UX0.y.24 Input Ch 0 error 

Read AH04A → CPU 
_0y_AD1_ERR BIT U0y.01.9 %UX0.y.25 Input Ch 1 error 

_0y_DA0_ERR BIT U0y.01.A %UX0.y.26 Output Ch 0 error 

_0y_DA1_ERR BIT U0y.01.B %UX0.y.27 Output Ch 1 error 

_0y_AD0_DATA WORD U0y.04 %UW0.y.4 
Input Ch 0 converted 
value Read AH04A → CPU 

_0y_AD1_DATA WORD U0y.05 %UW0.y.5 
Input Ch 1 converted 
value Read AH04A → CPU 

_0y_DA0_OUTEN BIT U0y.06.0 %UX0.y.96 Ch 0 output state setting 
Write AH04A ↔ CPU 

_0y_DA1_OUTEN BIT U0y.06.1 %UX0.y.97 Ch 1 output state setting 

_0y_DA0_DATA WORD U0y.07 %UW0.y.7 Output Ch 0 input value Write AH04A ↔ CPU 

_0y_DA1_DATA WORD U0y.08 %UW0.y.8 Output Ch 1 input value Write AH04A ↔ CPU 

 
- In the device allocation, the small letter ‘y’ is the No. of the slot where the module is installed. 
- For example, to read the ‘Input Ch 1 Converted Value’ of the analog I/O module installed in the  
4

th
 slot, write in U04.05. (%UW0.4.5 for IEC types) 

Device Type

U 0 4 . 0 5

Slot No.
Word

[“S”or“H”type]

Word classifier

                   

Device Type
Slot No.

Base No

Word

[IEC type]

 % U W 0 . 4 . 5

 
- To read the ‘Output Ch 1 Output Status Setting’ of the analog I/O module installed in the 5

th
 slot,  

write in U05.06.1 (%UX0.5.97 for IEC types) 

Device Type

U 0 5 . 0 6

Slot No.

Word classifier

Word

. 1

Bit classifier

[“S”or“H”type]
               

Device Type

 % U X 0 . 5 . 97

Slot No.

Base No

[IEC type]
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 (1) Module Ready/Error Flag ( ( ) is for IEC types, x: slot No.) 

 (a) U0x.00.F(%UX0.x.15): at power on or reset of PLC CPU, turns on when the analog I/O 
conversion is ready and analog conversion is performed. 

 (b) U0x.00.0(%UX0.x.0): the flag indicating the error status of A/D conversion module. 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

-----------

U0x.00
(%UW0.x.0)

 

Error occurrence 

information

Bit On (1): error

Bit Off (0): Normal

R
e
a
d
y

E
rro

r- - -

 

Module READY

Bit On (1): Normal

Bit Off (0): error
 

 
 

 
 (2) Operation channel information/ open-wire detection information/ channel error information flags 
( ‘( )’ is for IEC types, x: slot No.) 

This is the area for storing the operation information, input wire open detection and channel error 
information by channel. 
※ The base No. of the XGB PLC is 0. 
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

O
u

tp
u

t C
H

.1

O
u

tp
u

t C
H

.0

In
p

u
t C

H
.1

In
p

u
t C

H
.0

------

U0x.01
(%UW0.x.1)

 

Operation Ch, Info.

Bit On (1): in operation

Bit Off (0): Stop operation

In
p

u
t C

H
.1

In
p

u
t C

H
.0

O
u

tp
u

t C
H

.1

O
u

tp
u

t C
H

.0

In
p

u
t C

H
.1

In
p

u
t C

H
.0

Open-wire detection info.

Bit On (1): open-wire

Bit Off (0): normal

  

Channel Error Info.

Bit On (1): error

Bit Off (0): normal
 

 
 (3) Digital Output Values ( ( ) is for IEC types, x: slot No.) 

 (a) A/D converted digital values are outputted to buffer memory address U0x.04 ~ U0x.05  
(%UW0.x.4 ~ %UW0.x.5) by channel-basis. 
 (b) Digital output values are saved in 16-bit binary figures. 

     ※ The base No. of the XGB PLC is 0. 
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

Input channel 0 converted value
U0x.04

(%UW0.x.4)

Input channel 1 converted value
U0x.05

(%UW0.x.5)
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 (4) Output Permit Setting ( ( ) is for IEC types, x: slot No.) 

(a) Output permit/prohibit can be set up for each channel. 
(b) The default setting is ‘Output Prohibited.’  
※ The base No. of the XGB PLC is 0. 

 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

O
u

tp
u

t C
H

.1

O
u

tp
u

t C
H

.0

------

U0x.06
(%UW0.x.6)

 

Output status setting

BitOn (1): Output permitted

BitOff (0): Output prohibited

---- ----

 

 
 

 (5) Digital Input Values ( ( ) is for IEC types, x: slot No.) 
 (a) Digital inputs can be set up as unsigned (-48~4047), signed (-2048~2047), precision, or  

percentile (-12~1011) values. 
(b) When digital input value is not set up, they are processed as zero. 
※ The base No. of the XGB PLC is 0. 

 

        

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

Output channel 0 input value
U0x.07

(%UW0.x.7)

Output channel 1 input value
U0x.08

(%UW0.x.8)
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6.11.2  Operation Parameter Setting Area 

The operation parameter setting area of the analog I/O module is as follows. 
 

Memory 
Add. 

Description  Setting R/W Command 

0 Appoint operating channel Bit Off (0): stop, Bit ON (1): run R/W 

PUT/GET 

1 I/O range setting 

I/O range setting (4 bit per Ch.) 

0: 4 ~ 20 ㎃ 

1: 0 ~ 20 ㎃ 

2: 1 ~ 5 V 
3: 0 ~ 5 V 
4: 0 ~ 10 V 

R/W 

2 I/O data type setting 

I/O data type setting (4 bit per Ch.) 
0: 0 ~ 4000 
1: -2000 ~ 2000 
2: Precision value 
3: 0 ~ 1000 
- for precision values; 

4 ~ 20 ㎃: 400 ~ 2000 

0 ~ 20 ㎃: 0 ~ 2000 

1 ~ 5 V: 100 ~ 500 
0 ~ 5 V: 0 ~ 500 
0 ~ 10 V: 0 ~ 1000 

R/W 

3 
Input Ch 0 filter value 
setting 

0 or 4 ~ 64000 

R/W 

4 
Input Ch 1 filter value 
setting 

R/W 

5 Averaging method setting 

Averaging method setting (4 bit per Ch.) 
0: Sampling 
1: Time average 
2: Cycle average 
3: Moving average 

R/W 

6 
Input Ch 0 average value 
setting 

Time average: 4 ~ 16000 [ms]  
Cycle average: 2 ~ 64000 [cycles] 
Moving average: 2 ~ 100 [samples] 

R/W 

7 
Input Ch 1 average value 
setting 

R/W 

8 
Channel output status  
setting 

0: previous value 
1: min. value 
2: median 
3: max. 

R/W 

9 
Set-up error information 
output area 

10#: Input Ch range setting error 
20#: Input Ch data type setting error 
30#: Input Ch filter value setting error 
40#: Input Ch averaging setting error 
50#: Input Ch average value setting error 
60#: Output Ch range setting error 
70#: Output Ch data type setting error 
80#: Ch output status setting error 
90#: Output Ch input value range-over 
error 
(#: channel number) 

R GET 

 

Note  

(1) If the memory address 0~8 area is entered with values different from the setting. 

 U0x.01.8~U0x.01.B (setting error representative flag, for IEC type, %UX0.x.24 

~%UX0.x.27) is ON and runs with default values. The error information is displayed  

in the setting error information are (No. 9).  

(2) System areas (after No. 10) are read/write protected.  

Changing these areas may cause malfunction or failure of the product. 
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(1) Operating Channel Setting 
The default setting for operating channel is ‘Stop.’  
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

O
u

tp
u

t C
H

.1

O
u

tp
u

t C
H

.0

In
p

u
t C

H
.1

In
p

u
t C

H
.0

------

Address0

 

Appoint Using CH. bit

Bit On (1): Operate

Bit Off (0): Stop

---- --

 
 
 
 

 
(2) I/O Range Setting  

(a) The analog I/O voltage range is DC 1~5V, DC 0~5V, DC 0~10V, and analog current I/O  
range is DC 4~20mA, DC 0~20mA. 

(b) Default range is DC 4~20mA. 
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

Input CH.0

Address1

 

Input ch. Set-up I/O range(by ch. 4bit)

0 : 4 ~ 20 ㎃

1 : 0 ~ 20 ㎃
2 : 1 ~ 5 V

3 : 0 ~ 5 V

4 : 0 ~ 10 V

Input CH.1Output CH.0Output CH.1

 
 

 
(3) I/O Data Type Setting  

 (a) I/O data type can be set up for each channel. 
 (b) If the I/O data type is not set up, all the channels are processed in 0~4000 range. 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Input CH. 0

Address2

 

Set-up I/O data type (by Ch.4bit)

0 : 0 ~ 4000

1 : -2000 ~ 2000

2 : Precision value

3 : 0 ~ 1000

Input CH. 1Output CH. 0Output CH. 1

- For precision values

   4 ~ 20 ㎃: 400 ~ 2000

   0 ~ 20 ㎃: 0 ~ 2000

   1 ~ 5 V: 100 ~ 500

   0 ~ 5 V: 0 ~ 500

   0 ~ 10 V: 0 ~ 1000
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(4) Filter Constant Setting 

(a) If set to 0, no filtration is processed. 
(b) Default setting is 0 – no filtration process. 

 
Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

Input channel 0 filter constant (0 or 4 ~ 64000 ms)Address3

Input channel 1 filter constant (0 or 4 ~ 64000 ms)Address4
 

 
 

 
 

(5) Averaging Method Setting 
(a) Averaging method can be one of; time average, cycle average, moving average. 
(b) Default setting is no averaging throughout the channels. 
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

Input CH.0

Address5

 

Set-up averaging method (4bit per Ch)

0 : Sampling

1 : Time average

2 : Cycle average

3 : Moving average

Input CH.1---- ----

 
 

 
 

(6) Average Value Setting 
(a) Set up average values in accordance with the setting area of the averaging method. 
(b) If the average value is out of setting range, averaging is not applied. 
 

비트15 비트14 비트13 비트12 비트11 비트10 비트9 비트8 비트7 비트6 비트5 비트4 비트3 비트2 비트1 비트0

Input channel 0 average valueAddress6

Input channel 1 average valueAddress7  

Input channel# average value setting 

Time average : 4 ~ 16000 [ms] 

Cycle average : 2 ~ 64000 [Cycle]

Moving average : 2 ~ 100 [samples]
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(7) Output Status Setting 
(a) This sets up the analog output status when the XGB base unit is changed from run to stop. 
(b) Default setting is the Previous Value output. 
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

Output Ch.0

Address8

Output Ch.1

Output channel status setting (4 bit per Ch)

0 : Previous value output

1 : Min. value output

2 : Median value output

3 : Max. value output

---- ----

 

 
 
 
 
 
 

 
 

(8) Error Code (Address 9) 

(a) Saves the error code detected by the analog I/O module. 
(b) The types and descriptions of the error are as follows. 
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

Set-up error informationAddress9
 

 
 

Type 
Error 
Code 

LED Lamp Description 
Priority 
Order 

Remark 

Input 
Error 

10# 

INPUT LED  
flickering 1s  
intervals 

Input Ch range setting error 2 

#: Ch No. 
Input Ch. 0,1 
Output Ch. 0,1 

20# Input Ch data type setting error 3 

30# Input Ch filter cons. Setting error 4 

40# Input Ch averaging setting error 5 

50# Input Ch average value setting error 6 

Output 
Error 

60# 

OUTPUT LED 
flickering 1s  
intervals 

Output Ch range setting error 7 

70# Output Ch data type setting error 8 

80# Output Ch status setting error 9 

90# Output Ch input value range-over error 1 

 
(c) In case of plural errors, the code with higher priority order will be saved.  

 

 
(9) System Area (after Address 10) 

(a) System area (after address 10) is read/write protected. 
 

 Caution Modifying this area can cause malfunction of failure of product. 
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6.12  Example Program 
 

(1) This sample program sets up operating parameters of analog I/O module. 
(2) Initial settings are saved in the internal memory of the module by input by once. 
(3) The sample program below controls the I/O data of the analog I/O module at slot #1 and check  

open wire. 
 

6.12.１ Example of [I/O Parameter] Usage 

 

 (1) I/O Parameter Setting Window 
 

 
 

 
 
    (a) Input Channel 0 is set to operating channel and input range is set to 4~20mA. 
    (b) Output Channel 0 is set to operating channel and output range is set to 4~20mA. 
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(2) Sample Input Program 
 
 

 
 

(a) When the module is in normal operation, M0000 is turned On. 
U01.00.0(Module Error) = Off 
U01.00.F(Module Ready) = On 
U01.01.0(Input Channel 0 in-operation) = On 
U01.01.8(Input Channel 0 Error) = Off 

(b) When M0000 is ON, Input Channel 0 Converted Value(U01.04) is moved to D00100. 
(c) If open-wire error occurs in channel 0, U01.01.4(channel 0 open-wire) is ON, and M0001 bit is  

set. 
 
 

(3) Sample Output Program 
 
 

 
(a) When the module is in normal operation, M00010 is turned ON. 

U01.00.0(Module Error) = Off 
U01.00.F(Module Ready) = On 
U01.01.2(Output Channel 0 in-operation) = On 
U01.01.A(Output Channel 0 Error) = Off 

(b) When M00010 is On, channel 0 output status setting (U01.06.0) is turned ON and output is 
permitted. 

(c) When M00010 is On, the data in D00200 is transmitted to Output Channel 0 input value 
(U01.07) and outputted. 

 
 

Input CH0 program 

Output CH0 program 
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(4) Sample Input Program (for IEC type) 

 
(a) When the module is in normal operation, %MX0 is turned ON. 

%UX0.1.0(Module Error) = Off 
%UX0.1.15(Module Ready) = On 
%UX0.1.16(Input Channel 0 in-operation) = On 
%UX0.1.24(Input Channel 0 Error) = Off 

(b) When %MX0 is ON, Input Channel 0 Converted Value(%UW0.1.4) is transferred to “Channel 0 
Input” variable. 

(c) If open-wire error occurs at Channel 0, %UX0.1.20(Channel0open) turns ON and %MX1 bit is 
set. 

 
 

(5) Sample Output Program (for IEC type) 

 
(a) When the module is in normal operation, %MX10 is turned ON. 

%UX0.1.0(Module Error) = Off 
%UX0.1.15(Module Ready) = On 
%UX0.1.18(Output Channel 0 in-operation) = On 
%UX0.1.26(Output Channel 0 Error) = Off 

(b) When %MX10 is ON, Channel0 output status setting (%UX0.1.96) is turned ON and output is 
permitted 

(c) When %MX10 is ON, the data of the ‘Channel 0output’ variable is transferred to Output 
Channel 0 Input Value (%UW0.1.7) and outputted. 

 
 
 

CH0Input 
Value 

CH0Output 
Value 
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6.12.２ Exemplary Usage of PUT/GET Command 

 
(1) Sample Input Program 
 Input CH0 Program 

 
(a) Using PUT command to write h0005 in the address 0, slot 1 to operate Input Channel 0 and 

Output Channel 0. 
(b) Using PUT command to write h0000 in the address 1, slot 1 to set the input range of Input 

Channel 0 to DC 4 ~ 20mA and the output range of the Output Channel 0 to DC 4 ~ 20mA. 
(c) When the module is in normal operation, M0000 is turned ON. 

U01.00.0(Module Error) = Off,  U01.00.F(Module Ready) = On 
U01.01.0(Input Channel 0 in-operation) = ON, U01.01.8(Input Channel 0 Error) = Off 

(d) When M0000 is ON, Input Channel 0 Converted Value(U01.04) is transferred to D00100. 
(e) If open-wire error occurs at Channel 0, U01.01.4(Channel0open) is ON, and M0001 bit is set. 
 
 

(2) Sample Output Program 
Output CH0 Program 

 
(a) Using PUT command to write h0005 in the address 0, slot 1 to operate Input Channel 0 and 

Output Channel 0. 
(b) Using PUT command to write h0000 in the address 1, slot 1 to set the input range of Input 

Channel 0 to DC 4 ~ 20mA and the output range of the Output Channel 0 to DC 4 ~ 20mA. 
(c) When the module is in normal operation, M00010 is turned ON. 

U01.00.0(Module Error) = Off,  U01.00.F(Module Ready) = On 
U01.01.2(Output Channel 0 in-operation) = ON, U01.01.A(Output Channel 0 Error) = Off 

(d) When M00010 is ON, Channel 0 Output Status setting (U01.06.0) is turned ON and output is 
permitted. 

(e) When M00010 is ON, data of D00200 is transferred to Output Channel 0 Input Value (U01.07) 
and outputted. 
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(3) Sample Input Program (for IEC type) 
 

 
 

(a) Using PUT command to write h0005 in the address 0, slot 1 to operate Input Channel 0 and 
Output Channel 0. 

(b) Using PUT command to write h0000 in the address 1, slot 1 to set the input range of Input 
Channel 0 to DC 4 ~ 20mA and the output range of the Output Channel 0 to DC 4 ~ 20mA. 

(c) When the module is in normal operation, %MX0 is turned on. 
%UX0.1.0(Module Error) = Off 
%UX0.1.15(Module Ready) = On 
%UX0.1.16(Input Channel 0 in-operation) = On 
%UX0.1.24(Input Channel 0 Error) = Off 

(d) When %MX0 is on, Input Channel 0 Converted Value (%UW0.1.4) is transferred to “Channel 0 
Input” variable. 

(e) If open-wire error occurs at Channel 0, %UX0.1.20(Channel0open) is turned on and %MX1 bit 
is set. 

 
 

CH0Input 
Value 
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(4) Sample Output Program (for IEC type) 
 

 
 
(a) Using PUT command to write h0005 in the address 0, slot 1 to operate Input Channel 0 and 

Output Channel 0. 
(b) Using PUT command to write h0000 in the address 1, slot 1 to set the input range of Input 

Channel 0 to DC 4 ~ 20mA and the output range of the Output Channel 0 to DC 4 ~ 20mA. 
(c) When the module is in normal operation, %MX10 is turned on. 

%UX0.1.0(Module Error) = Off 
%UX0.1.15(Module Ready) = On 
%UX0.1.18(Output Channel 0 in-operation) = On 
%UX0.1.26(Output Channel 0 Error) = Off 

(d) When %MX10 is on, Channel 0 Output Status setting (%UX0.1.96) is turned on and output is 
permitted. 

(e) When %MX10 is on, data of the ‘Channel 0output’ variable is transferred to Output Channel 0 
Input Value (%UW0.1.7) and outputted. 

 
 

CH0Outnput 
Value 
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6.13  Troubleshooting 
 
      This section describes methods for identifying the troubles which may occur during the 
      operation of analog I/O module, and their solutions. 
 
 

6.13.1 LED Indication for Error  
 

An analog I/O module has INPUT LED and OUTPUT LED to indicate error status of the module. 
 

Classification 
Normal 
State 

Channel Open 
(Input) 

Parameter 
Setting Error 

Module H/W Failure 
(Serious Failure) 

INPUT LED On Flickering 1s intervals 
Flickering 1s intervals 
(input parameter setting 
error) 

Flickering 0.2s 
intervals 

OUTPUT LED On N/A 
Flikering at 1s intervals 
(output parameter setting  
error) 

Flickering 0.2s 
intervals 

Module 
Behavior 

All functions 
are normal 

All functions are 
performed. Indicates 
min. input value 

All functions work at 
default parameter setting 

Module cannot 
function 

Action - Check input wire Check parameter setting Request for A/S  

 

 

6.13.2 Checking Module Condition 
 

XG5000’s system monitor enables verification of the analog I/O module conditions (module type, 
module information, OS version). 

 
(1) Procedure 

The verification can be done in 2 ways; 
(a) [Monitor] -> [System Monitor] -> mouse right click on module icon -> [Module Information] 
(b) [Monitor] -> [System Monitor] -> double click module icon. 

 
(2) Module Information 

(a) Module type: shows the information on the present module. 
(b) Module information: shows the OS version of the module. 
(c) OS version: shows release date of Module OS. 
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6.13.3 Troubleshooting 
 
        (1) INPUT LED or OUTPUT LED is off. 
 

INPUT LED or OUTPUT LED is off..

Analog combo module is correctly 

installed.

Install the module correctly No

Yes

XG5000 software shows I/O information

Contact nearest dealer or A/S center 
No

Yes

System resumes normal function if the 

module is replaced.

 Yes Contact nearest dealer or A/S center

 
      
 
 
 
         (2) INPUT LED flikering. 
 

INPUT LED flikering

INPUT LED flickers 0.2s intervals

Contact nearest dealer or A/S center 

No

Yes

INPUT LED flickers 1s intervals

Input wire is correct.

Correct wiring according to user manual

(Check line open)
 No

Yes

Parameter setting is normal

(Check with PUT command)

Operation parameter setting error

Correct the error according to user manual

(Check error code)

 No

 
 



XGB Analog edition manual  

 

6 - 48 

 

 
 
        (3) OUTPUT LED flikering 
 

OUTPUT LED flikering

OUTPUT LED flickers 0.2s intervals

Contact nearest dealer or A/S center 

No

Yes

OUTPUT LED flickers 1s intervals

Output channel input exceeds data 

range

Enter correctly according to the output range 

in the user manual
 

No

Yes

Parameter setting is normal

(Check with PUT command)

Operation parameter setting error

Correct the error according to user manual

(Check error code)

 No

 
 
 
        (4) Analog I/O value is abnormal. 
 

Analog I/O value is abnormal.

External DC24V input power is OK.

Supply DC 24 power No

Yes

FG ground is OK

Correct FG grounding according to the wiring 

in the user manual
 No

Yes

Parameter setting is OK

(Operation channel permit, I/O range 

setting
Set up the parameters correctly according to 

the user manual
 No

Yes

External voltage/current selector switch 

setting is correct

Set the switch according to the user manual No

Yes

Contact nearest dealer or A/S center
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Chapter 7 Analog Input Module (XBF-AD08A) 
 

7.1 Setting Sequence before operation 
 

Before using the analog input module, follow steps below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 

 

XBF-AD08A 

 

 

 

 

 

 Checking performance specification 

Wiring 

Reading analog input data 

Setting parameter 

Programming 

Setting external voltage/current switch 

Specification (2.2 performance specification) 
 Operating environment 
 Input type and range 
 Digital output range 

Wiring 
 Wiring power (External DC24V) 
 Wiring analog input  

Setting switch 
 Setting voltage/current input type 

Analog input test 
 XG5000 special module monitor test mode 

Parameter 
 XG5000 I/O parameter 

Programming 
 Programming for reading analog data 

 (U device) 

Refer to trouble shooting when there is error 
or analog data is not normal. 
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7.2 Specifications 
 

7.2.1 General specifications 

General specifications are as follows. 

 

 
 
 

No. Items Specification 
Related 

standards 

1 
Operating 

temperature 
0 ~ 55 C  

2 
Storage 

Temperature 
25 ~ 70 C  

3 
Operating 

humidity 
5∼95%RH (Non-condensing)  

4 
Storage 

humidity 
5∼95%RH (Non-condensing)  

5 
Vibration 

immunity 

For discontinuous vibration   

Frequency Acceleration Amplitude Times 

IEC61131-2 

10  f  57Hz  0.075mm 

Each 10 

times in 

X,Y,Z 

directions 

57  f  150Hz 9.8m/s
2
(1G)  

For continuous vibration 

Frequency Acceleration Amplitude 

10  f  57Hz  0.035mm 

57  f  150Hz 4.9m/s
2
(0.5G)  

6 
Shocks 

immunity 

  Max. impact acceleration : 147 m/s
2
(15G) 

  Authorized time : 11ms 
  Pulse wave : Sign half-wave pulse (Each 3 times in X,Y,Z directions) 

IEC61131-2 

7 
Noise 

immunity 

Square wave 

impulse noise 

AC: 1,500 V 

DC:  900 V 
LSIS standard 

Electrostatic 

discharging 
Voltage : 4kV(contact discharging) 

IEC61131-2 

IEC61000-4-2 

Radiated 

electromagnetic 

field noise 

80 ~ 1,000 MHz,  10V/m 
IEC61131-2, 

IEC61000-4-3 

Fast Transient 
/burst noise 

Segment 
Power 
module 

Digital/ 
Analog I/O 

communication interface 
IEC61131-2 

IEC61000-4-4 
Voltage 2kV 1kV 

8 
Ambient 

conditions 
No corrosive gas or dust  

9 
Operating 

height 
2000m or less  

10 
Pollution 

degree 
2 or less  

11 Cooling type Natural air cooling  
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7.2.2 Performance specifications 

Performance specifications are as follows. 

Items Performance specification 

Number of channel 8 channels 

Analog input 
range 

Type Voltage Current 

Range 

DC 1 ~ 5V 
DC 0 ~ 5V 
DC 0 ~ 10V 
(Input resistance: 1 MΩ or above) 

DC 4 ~ 20mA 
DC 0 ~ 20mA 

(Input resistance 250 Ω) 

Digital output 

Type 12 bit binary data 

Range 

Signed value 0 ~ 4000 

Unsigned 
value 

-2000 ~ 2000 

Precise 
value 

100 ~ 500 (DC 1 ~ 5V) 

0 ~ 500 (DC 0 ~ 5V) 

0 ~ 1000 (DC 0 ~ 10V) 

400 ~ 2000 (DC 4 ~ 20㎃) 

0 ~ 2000 (DC 0 ~ 20㎃) 

 

Percentile 
value 

0 ~ 1000 

Max. resolution 

1/4000 

1.25㎷ (DC 1~5V, 0~5V) 

2.5㎷ (DC 0~10V) 

5㎂ (DC4~20㎃, 0~20㎃) 

 

Accuracy ±0.5% or less 

Max. conversion speed 1.5ms/channel 

Absolute max. output DC ±15V DC ±25㎃ 

Additional 
function 

 

Filter function Digital filter (4 ~ 64,000ms) 

Average function 

Time average (4 ~ 16,000ms) 

Count average (2 ~ 64,000 times) 

Moving average (2 ~ 100) 

Alarm function Detecting disconnection (DC 1~5V, DC4~20mA) 

Insulation method 
Photo-coupler insulation between I/O terminal and PLC power 

(No insulation between channels) 

Input terminal 11 point terminal block 

I/O points occupied Fixed type: 64 points 

Max. no. of installation  
7 (when using XBM(C)-DxxxS type) 
10 (when using XB(E)C-DxxxH type) 

Consumption 
current 

Inner (DC 5V) 105mA 

External (DC 24V) 85mA 

Weight 81g 

Module supply power source 20.4~28.8 V 

 

 

Note1) In order to use analog input module (XBF-AD08A), the following version is needed. 
 

Main unit Version information 

XBM-DxxxS type V2.6 

XBC-DxxxH type V1.9 

XEC-DxxxH type V1.3 

XBC-DxxxS type V1.0 
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7.3 Name of part and function 
 

 

Respective designations of the parts are as described below.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

No. Name Description 

① LED 

▶ Displays the operation status of XBF-AD08A 

On: Operation normal 

Flickering: Error occurs (1s intervals) 

Off: power off or module error 

② 
Voltage/current 

selector switch 
▶ switch to select voltage/current input of analog input CH0~CH7 

③ Terminal block 
▶ Wiring terminal block to connect with external device 

(Analog input) 

④ 
External power 

supply terminal 
▶ Terminal for DC24V external power supply 

⑤ 
Connector for 

expansion 
▶ Connection connector for expansion module 

 

 

① 

③ 

④ 

 

⑤ 

② 
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7.4 Characteristic of I/O conversion 
 

The input/output ranges of voltage and current can be set up per channel with user program or I/O 
parameters. The I/O types of digital data are defined as follows. 

(1) Unsigned Value 
(2) Signed Value 
(3) Precise Value 
(4) Percentile Value 

 
 

Digital 

output

0

1000

2000

3000

4000
4047

-48
-2000

-1000

0

1000

2000
2047

-2048
0

250

500

750

1000
1011

-12

DC 1 ~ 5 V

DC 0 ~ 5 V

DC 0 ~ 10 V

DC 4 ~ 20 mA

1 V 5 V3 V

0 V 2.5 V 5 V

0 V 5 V 10 V

4 mA 12 mA 20 mA

Analog 

input

Practical analog input range

Offset value

Gain 

value

DC 0 ~ 20 mA 0 mA 10 mA 20 mA

 

 
 (1) DC 4 ~ 20mA Range Input 

Digital  
Output Range 

Analog Input Current (mA) 

3.81 4 8 12 16 20 20.18 

Unsigned Value 
(0 ~ 4000) 

-48 0 1000 2000 3000 4000 4047 

Signed Value 
(-2000 ~ 2000) 

-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 
(400 ~ 2000) 

381 400 800 1200 1600 2000 2018 

Percentile 
Value(0 ~ 1000) 

-12 0 250 500 750 1000 1011 
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(2) DC 0 ~ 20mA Range Input 

Digital  

Output Range 

Analog Input Current (mA) 

-0.24 0 5 10 15 20 20.23 

Unsigned Value 

(0 ~ 4000) 
-48 0 1000 2000 3000 4000 4047 

Signed Value 

(-2000 ~ 2000) 
-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 

(0 ~ 2000) 
-24 0 500 1000 1500 2000 2023 

Percentile 

Value(0 ~ 1000) 
-12 0 250 500 750 1000 1011 

 
 

     (3) DC 1 ~ 5V Range Input 

Digital  
Output Range 

Analog Input Voltage (V) 

0.96 1 2 3 4 5 5.04 

Unsigned Value 
(0 ~ 4000) 

-48 0 1000 2000 3000 4000 4047 

Signed Value 
(-2000 ~ 2000) 

-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 
(100 ~ 500) 

96 100 200 300 400 500 504 

Percentile 
Value(0 ~ 1000) 

-12 0 250 500 750 1000 1011 

 
 

(4) DC 0 ~ 5V Range Input 

Digital  
Output Range 

Analog Input Voltage  (V) 

-0.06 0 1.25 2.5 3.75 5 5.05 

Unsigned Value 

(0 ~ 4000) 
-48 0 1000 2000 3000 4000 4047 

Signed Value 

(-2000 ~ 2000) 
-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 

(0 ~ 500) 
-6 0 125 250 375 500 505 

Percentile 

Value(0 ~ 1000) 
-12 0 250 500 750 1000 1011 

 
 
 (5) DC 0 ~ 10V Range Input 

Digital  
Output Range 

Analog Input Voltage  (V) 

-0.12 0 2.5 5 7.5 10 10.11 

Unsigned Value 

(0 ~ 4000) 
-48 0 1000 2000 3000 4000 4047 

Signed Value 

(-2000 ~ 2000) 
-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 

(0 ~ 1000) 
-12 0 250 500 750 1000 1011 

Percentile 

Value(0 ~ 1000) 
-12 0 250 500 750 1000 1011 
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7.5 Accuracy 
 

 
Accuracy of digital output value does not changed even if input range is changed. Figure below 

shows the range of the accuracy with analog input range of 0 ~ 10 V and digital output type of 
unsigned value selected.  

Accuracy of XBF-AD08A is ±0.5%. 
 

0

0V 5V

2000

10 V

4000

Analog input voltage

D
ig

ita
l o

u
tp

u
t 
va

lu
e

3980

4020

-20

20

 

           [ Accuracy ] 
      
 

 (1) Accuracy when using 5V input 
4000 × 0.5% = 20 
Therefore the range of the accuracy will become (2000-20) ~ (2000+20) = 1980 ~ 2020  
when using 5V input. 

 
 (2) Accuracy when using 10V input  

4000 × 0.5% = 20 
Therefore the range of the accuracy will become (4000-20) ~ (4000+20) = 3980 ~ 4020  
when using 10V input. 
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7.6 Functions of Analog Input Module 
 

 The functions of XBF-AD08A Module are as follows.  
 

Function Description 

Channel 

operation/stop setting 

● Specify operation/stop of the channel which will perform A/D and D/A conversion. 

● Specifying unused channels as Stop can shorted overall operation time. 

I/O Voltage /current 

range setting  

● Specify desired range of analog I/O. 

● Select voltage/current with external switch, and set up range with parameter. 

● Analog Mix Module provides 2 ranges(4~20mA, 0~20mA) of current I/O and  

3 ranges (1~5V, 0~5V, 0~10V) of voltage I/O. 

I/O data type setting 

● Specify digital I/O types. 

● This module provides 4 output data types (Unsigned, Signed, Precision, and 

 Percentile Values) 

A/D input conversion  

method 

● Sampling Process 

- If A/D conversion method has not been specified, the module processes sampling. 

● Filter process 

- Filters rapid changes in input value by external noise. 

● Averaging process 

- Outputs A/D converted value averaged by time, cycle, and moving. 

D/A output status  

setting 

● Sets up channel output state at transition from run to stop. 

● Provides 4 output selections (Previous, Minimum, Mean, Maximum Values) 

 
 
 

7.6.1 Sampling Process 
In popular A/D conversion process, analog input signals are collected at constant time intervals 
and A/D converted. The time elapsed for the analog signals converted into digital signals and 
saved in memory device depends upon the number of channels used.  

 

(Process Time) = (No. of Channels Used) x (Conversion Rate) 

 

(Ex.) Process time when using 3 of 4 I/O channels;  

3 x 1 ㎳ = 3.0 ㎳ 

 
The term ‘sampling’ means taking analog signal values at certain time intervals.  
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7.6.2 Filtering Function 

 
The input value of the designated channel is calculated with previously filtered input value using 
preset filter constant (time constant 63.2%) by the formula below; 
 

).1(tan

).1(Pr)tan(Pr
 Pr

UsedofChannelsNomstFilterCons

UsedofChannelsNomsesentInputtFilterConstlteredInpueviouslyFi
teredInputesentlyFil






 
 
Filter Constant setting range = 4 ~ 64000 [ms] 
 
 

 

Input

1000

632

0

Input after filtration

Actual input

Filter Constant

(ms)

Time (ms)

 
 

 
In the above graph, if the input value changes rapidly from 0 to 100, the input value is filtered.  
Filter (time) constant is the time required for input values to vary by 63.2% of the actual input 
value.  
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7.6.3 Averaging Function 

 
(1) Average by Time 

The input values of the designated channel are accumulated for the preset time, and the 
average value of the total sum is outputted in digital data. 

Channel Scanning Intervals (1ms/Ch. Used)

Averaged input value 
Actual input value

Averaging 
Section

Averaging 
Section

Sampling 
Section

 
 
 
Setting Range = 4 ~ 16000 [ms] 
For time averaging, No. of averaging cycles are calculated with the No. of channels used 
as below;  
 

msUsedofChannelsNo

eAverageTim

1 .
Cycles Averaging No.


   

 
(2) Average by Cycles 

The input values of the designated channel are accumulated for the preset cycles, and the 
average value of the total sum is outputted in digital data. 

Channel Scanning Intervals (1ms/Ch. Used)

Averaged input value 
Actual input value

Averaging 
Section

Averaging 
Section

Sampling 
Section

 
Setting Range = 2 ~ 64000 [Cycle] 
For cycle averaging, averaging interval is calculated with the No. of channels used. 
 

msUsedofChannelsNoycleAveragingCmsntervalAveragingI 1. ][   
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(3) Moving Average 

The inputs into the designated channel are accumulated for the presser number, and its 
average is calculated and outputted in digital data. However, in moving average method, 
each scan provides its average value. 
 

 
 
 

 

 
 
 
 

 
 

(1) In case of time/cycle averages. The input value is not outputted at every conversion, but the 
previous value is maintained until the average time or cycle is reached. 

(2)  In case of moving averages, the converted input is averaged with the previously entered 
value and the result is outputted at every conversion. Therefore, data response is faster than 
time/cycle averaging methods. 

(3) The three averaging methods can be processed simultaneously with the filter function 
described earlier. In such case, the filter function is executed first, and averaging function is 
processed to output the average value in digital data, which is expressed with the finally-
processed value.  

 

Note 

 

 

Averaging No. Averaging No. 

Averaging No. 
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7.6.4 Disconnection detecting Function 
 
The analog mix module has a diagnostic function which can detect and indicate open input line, when 
voltage input range of DC 1~5V or current input range of DC 4~20mA is selected as its analog input 
range. If the module indicates open input line, check the wiring. 
 
(1) If the wiring to the module is open, the Input LED flickering 1 second intervals and the respective 

error code is generated. 

 
(2) Line open detection is available for each channel. However, open indication is provided only for 

the channel selected for the operation. The Input LED is common for the input channels 0 and 1, 
and flikering if 1 or more channels are open. 

 

Input Connection 
Channel 

Operation 

 Input LED 

State 

Open Line 
Flag 

Normal 
Working On Off 

Stopped On Off 

Input wire open or 

disconnected 

Working 
Flickering  

(1s intervals) 
On 

Stopped On Off 

 
(3) At line open, the line open flag of the channel turns On, and turns Off at correction. 

Open Flag Description 

U0x.10.0 Ch 0 open 

U0x.10.1 Ch 1 open 

U0x.10.2 Ch 2 open 

U0x.10.3 Ch 3 open 

U0x.10.4 Ch 4 open 

U0x.10.5 Ch 5 open 

U0x.10.6 Ch 6 open 

U0x.10.7 Ch 7 open 

 
 

(4) At line open, the least of all input values is indicated. 
 
 

 



Chapter 7 Analog Input Module (XBF-AD08A) 

7 - 13 

 

 

7.7 Wiring  
 

7.7.1 Precaution for wiring  
(1) Don’t let AC power line near to A/D conversion module’s external input sign line. With an enough 

distance kept away between, it will be free from surge or inductive noise. 
 (2) Cable shall be selected in due consideration of ambient temperature and allowable current, 

whose size is not less than the max. cable standard of AWG22 (0.3㎟). 

 (3) Don’t let the cable too close to hot device and material or in direct contact with oil for long, which 
will cause damage or abnormal operation due to short-circuit. 

 (4) Check the polarity when wiring the terminal. 
 (5) Wiring with high-voltage line or power line may produce inductive hindrance causing abnormal 

operation or defect. 

 

7.7.2 Wiring examples  
(1) Input resistance of current input circuit is 250 Ω (typ.).  
(2) Input resistance of voltage input circuit is 1 MΩ (min.).  
(3) Enable the necessary channel only. 
(4) Analog input module doesn’t support power for input device. Use the external power supplier. 

(5) Wiring example of analog input 
    In case of voltage/current input, wiring is same. Adjust the voltage/current setting switch 

according to the case. 
 

+

-

+

-

+

-

+

-

+

-

+

-

+

-

+

-

+

-

+

-

+

-

+

-

+

-

+

-

+

-

+

-

DC pwer
Supply for analog

DC24V+

CH0+

CH0-

DC24V-

CH1+

CH1-

CH2+

CH2-

CH3+

CH3-

CH4+

CH4-

CH5+

CH5-

CH6+

CH6-

CH7+

CH7-

CH0

CH1

CH2

CH3

CH4

CH5

CH6

CH7
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(6) Wiring example of analog input 2-Wire sensor/transmitter  

- In case of voltage/current input, wiring is same. Adjust the voltage/current setting switch 

according to the case. 

+

-

+

-

+

-

+

-

+

-

+

-

+

-

+

-

DC power
Supply for analog

DC24V+

CH0+

CH0-

DC24V-

CH1+

CH1-

CH2+

CH2-

CH3+

CH3-

CH4+

CH4-

CH5+

CH5-

CH6+

CH6-

CH7+

CH7-

DC
+

-

DC
+

-

DC
+

-

DC
+

-

DC
+

-

DC
+

-

DC
+

-

DC
+

-

2-Wire

Transmitter

2-Wire

Transmitter

2-Wire

Transmitter

2-Wire

Transmitter

2-Wire

Transmitter

2-Wire

Transmitter

2-Wire

Transmitter

2-Wire

Transmitter

CH0

CH1

CH2

CH3

CH4

CH5

CH6

CH7

 
 
 

(7) Wiring example of analog input 4-Wire sensor/transmitter  

- In case of voltage/current input, wiring is same. Adjust the voltage/current setting switch 

according to the case. 

        

+

-

+

-

+

-

+

-

+

-

+

-

+

-

+

-

DC power

Supply for analog

DC24V+

CH0+

CH0-

DC24V-

CH1+

CH1-

CH2+

CH2-

CH3+

CH3-

CH4+

CH4-

CH5+

CH5-

CH6+

CH6-

CH7+

CH7-

DC
+

-

-

DC
+

-

DC
+

-

DC
+

-

DC
+

-

DC
+

-

DC
+

-

DC
+

-

CH4

CH5

CH6

CH7

CH0

CH1

CH2

CH3

4 Wire

Transmitter

4 Wire

Transmitter

4 Wire

Transmitter

4 Wire

Transmitter

4 Wire

Transmitter

4 Wire

Transmitter

4 Wire

Transmitter

4 Wire

Transmitter
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(8) Relationship between voltage input accuracy and wiring length 

In voltage input, the wiring (cable) length between transmitter or sensor and module has an effect 
on digital-converted values of the module as specified below; 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
       

 
 

 
Where,        

 
Rc: Resistance value due to line resistance of cable 

        
       Rs: Internal resistance value of transmitter or sensor 
 

       Ri: Internal resistance value (1㏁) of voltage input module 

  
       Vin: Voltage allowed to analog input module  
 
       % Vi: Tolerance of converted value (%) due to source and cable length in voltage input 
 
 

                 
  RiRcRs

VsRi
Vin






2
  

 
 

1001% 









Vs

Vin
Vi %  

 
 

Vs 

Rs Rc 

Rc 

Ri 

Load 

 

Analog input (Voltage) 

Vin 
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7.8 Operation Parameter Setting 
 

A/D conversion module’s operation parameters can be specified through XG5000’s [I/O parameters]. 

 

(1) Settings 

For the user’s convenience of A/D conversion module, XG5000 provides GUI (Graphical User 
Interface) for parameters setting of A/D conversion module. Setting items available through [I/O 
parameters] on the XG5000 project window are as described below in the table.  

 

 

Item Details 

[I/O parameter] (a) Specify the following setting items necessary for the module operation. 

1) Channel Enable/Disable setting 

2) Setting ranges of input voltage/current 

3) Output data format setting 

4) Filter constant setting 

5) Average processing method setting 

6) Average value setting 

 (b) If downloading is complete Parameter set by user in XG5000 is saved 

in Flash memory of XGB main unit.  

 

(2) Usage of [I/O Parameter] 

(a) Create a project with XG5000. See XG5000 Program Manual for project creation. 

(b) In the Project window, double-click [I/O Parameter]. 
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 (c) In the [I/O Parameter Setting] window, find out the slot of the base where the analog mix module is  
installed, and click it.  

 

 

 (d) In the above window, click the arrow button to call the window where the module can be selected.  
Find out the module and select it.  

 

 

 (e) To set up parameter, double click with the respective slot being selected, or click [Detail] button. 
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 (f) The window below where parameters can be set up by channel appears. Click the item to set up.  

The parameters which can be set up appear by item.  
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The functions of the special module monitor are as follows. 
 

 (1) Start-up of [Special Module Monitor] 
Select [Online] -> [Connect], and [Monitor] -> [Special Module Monitor] to start up. [Special Module 
Monitor] menu is enabled only in the [Online] condition. 

 

 
 

 

Notes  

1) The screen may not function properly if the system resources are not sufficient. In this case, close 
the screen, exit other applications, and rerun XG5000. 

2) The I/O parameters set up in [Special Module Monitor] condition are temporarily set up for testing  
purpose. Therefore, these I/O parameters are deleted after exit from [Special Module Monitor]. 

3) the test function of the [Special Module Monitor] enables testing analog mix modules without  
sequence programming. 

 

 

 

(2) Usage of [Special Module Monitor] 

(a) With the XG5000 in connection (online) with the base unit of PLC, select [Monitor] -> [Special 

Module Monitor]. The Select Special Module window shown below will appear showing the type 

of the special modules and base/slot information. In the list dialog, the modules present in the 

PLC system are displayed. 

 

7.9 Special Module Monitoring Functions 
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(b) In the above window, select the special module and click [Module Info.] to see the 

information window below.  

 
 

(c) Click the [Monitor] button in the “Special Module” window. The “Special Module Monitor’ 

window will appear as shown below.  
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(d) [Start Monitoring]: click [Start Monitoring] to look up the digital input data of the channel 

currently in operation. The screen shot below is a monitoring window when all the 

channels are in operation status.  

 
The screen executing [Start Monitoring]  

 

(e) [Test]: this function is used to change the current parameter settings of the analog mix 

module. Click the settings in the fields in the bottom screen to change the parameters. 

[Test] can be set up only when the operation status of the XGB base unit is STOP. 

 
        The screen executing [Test] 

Monitoring 

Detail information 
of CH0 
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(f) Minimum/Maximum Value Monitoring  
    The minimum and maximum values of the input channels in operation can be monitored. 

However, the Max/Min values in the window are based on the current value. Therefore, 
the Max/Min values are not saved when exiting from the [Monitoring/Testing Screen]. 

 
 
The screen executing [Max/Min Value Monitoring]  
 

 
(g) Close 

[Close] button is for ending/closing the monitoring/testing screen. Maximum, 
minimum, and current values are not saved at exit. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Monitors Max/Min value 

Resets Max/Min value 
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7.10 Register U devices 
 

The variables for each module are automatically registered by referring to the information of the 
special modules set up in the [I/O Parameter]. User can modify variables and descriptions. 

 
(1) Registration Procedure 

       (a) In [I/O Parameter], set up special module in slot. 

 
 

      (b) Double click [Variables/Comment]. 

 
 

(c) In the ‘Edit’ menu, select ‘U-Device Auto Registration 
(special module variable auto registration). 
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 (d) Click ‘Yes.’ 

  
 

     (e) Variables are registered as shown below.  

 
 

 (f) In IEC types, the variables are registered as shown below. 

 
 

 
 (2) Saving Variables 

(a) The contents in the ‘View Variables’ tab can be saved in a text file. 
(b) In the ‘Edit’ menu, select ‘Save as Text File.’ 
(c) The contents in the ‘View Variables’ tab are saved in a text file. 
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 (3) Viewing Variables in Program 
 
       The figures below present examples of use in XGB “S” and “H” types. 
 

         (a) Below is an exemplary program for XG5000.  

 
 

          (b) In the ‘View' menu, click ‘View Variables.’ The devices are changed into  variables. 

 
 

      (c) In the ‘View' menu, click ‘View Device/Variables’ to look up the devices and variables at 
the same time. 
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 (d) In the ‘View' menu, click ‘View Device/Description’ to look up the devices and descriptions at the  
same time. 
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 (e) For IEC type also, as shown in Fig. (a) ~ (d), you can look up variables with 
           diversified options in the ‘View’ menu. The figure below is the case of an IEC type 
           with which the ‘View Variables/Comment’ option. 
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7.11 Configuration and Function of Internal Memory 
 

An analog mix module has internal memory for data communication with XGB base unit. 

 

7.11.1 Analog Data I/O Area 

The table below presents the analog data I/O area. 

Variable Type 

Device assignment 

Description 
Read/ 

Write 

Signal 

direction 
“S”or 

 “H”type 
IEC type 

_0y_ERR BIT U0y.00.0 %UX0.y.0 Module Error 
Read AD08A → CPU 

_0y_RDY BIT U0y.00.F %UX0.y.15 Module Ready 

_0y_CH0_ACT BIT U0y.01.0 %UX0.y.16 CH0 Active 

Read AD08A → CPU 

_0y_CH1_ACT BIT U0y.01.1 %UX0.y.17 CH1 Active 

_0y_CH2_ACT BIT U0y.01.2 %UX0.y.18 CH2 Active 

_0y_CH3_ACT BIT U0y.01.3 %UX0.y.19 CH3 Active 

_0y_CH4_ACT BIT U0y.01.4 %UX0.y.20 CH4 Active 

_0y_CH5_ACT BIT U0y.01.5 %UX0.y.21 CH5 Active 

_0y_CH6_ACT BIT U0y.01.6 %UX0.y.22 CH6 Active 

_0y_CH7_ACT BIT U0y.01.7 %UX0.y.23 CH7 Active 

_0y_CH0_ERR BIT U0y.01.8 %UX0.y.24 CH0 error 

Read AD08A → CPU 

_0y_CH1_ERR BIT U0y.01.9 %UX0.y.25 CH1 error 

_0y_CH2_ERR BIT U0y.01.A %UX0.y.26 CH2 error 

_0y_CH3_ERR BIT U0y.01.B %UX0.y.27 CH3 error 

_0y_CH4_ERR BIT U0y.01.C %UX0.y.28 CH4 error 

_0y_CH5_ERR BIT U0y.01.D %UX0.y.29 CH5 error 

_0y_CH6_ERR BIT U0y.01.E %UX0.y.30 CH6 error 

_0y_CH7_ERR BIT U0y.01.F %UX0.y.31 CH7 error 

_0y_CH0_DATA WORD U0y.02 %UW0.y.2 CH0 Output 

Read AD08A → CPU 

_0y_CH1_DATA WORD U0y.03 %UW0.y.3 CH1 Output 

_0y_CH2_DATA WORD U0y.04 %UW0.y.4 CH2 Output 

_0y_CH3_DATA WORD U0y.05 %UW0.y.5 CH3 Output 

_0y_CH4_DATA WORD U0y.06 %UW0.y.6 CH4 Output 

_0y_CH5_DATA WORD U0y.07 %UW0.y.7 CH5 Output 

_0y_CH6_DATA WORD U0y.08 %UW0.y.8 CH6 Output 

_0y_CH7_DATA WORD U0y.09 %UW0.y.9 CH7 Output 

_0y_CH0_IDD BIT U0y.10.0 %UX0.y.160 CH0 Disconnection flag 

Read AD08A → CPU 

_0y_CH1_IDD BIT U0y.10.1 %UX0.y.161 CH1 Disconnection flag 

_0y_CH2_IDD BIT U0y.10.2 %UX0.y.162 CH2 Disconnection flag 

_0y_CH3_IDD BIT U0y.10.3 %UX0.y.163 CH3 Disconnection flag 

_0y_CH4_IDD BIT U0y.10.4 %UX0.y.164 CH4 Disconnection flag 

_0y_CH5_IDD BIT U0y.10.5 %UX0.y.165 CH5 Disconnection flag 

_0y_CH6_IDD BIT U0y.10.6 %UX0.y.166 CH6 Disconnection flag 

_0y_CH7_IDD BIT U0y.10.7 %UX0.y.167 CH7 Disconnection flag 

_0y_ERR_CLR BIT U0y.11.0 %UX0.y.176 Error Clear Request 
Read/

Write 
AD08A ↔ CPU 
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- In the device allocation, the small letter ‘y’ is the No. of the slot where the module is installed. 
- For example, to read the ‘CH3 Output’ of the analog module installed in the slot 4, write in U04.05. 

(%UW0.4.5 for IEC types) 

Device Type

U 0 4 . 0 5

Slot No.
Word

[“S”or“H”type]

Word classifier

                   

Device Type
Slot No.

Base No

Word

[IEC type]

 % U W 0 . 4 . 5

 
 
 

 (1) Module Ready/Error Flag ( ( ) is for IEC types, y: slot No.) 
 (a) U0y.00.F (%UX0.y.15): at power on or reset of PLC CPU, turns on when the analog I/O 

conversion is ready, and analog conversion is performed. 
       (b) U0y.00.0(%UX0.y.0): the flag indicating the error status of A/D conversion module. 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

-----------

U0x.00
(%UW0.x.0)

 

Error occurrence 

information

Bit On (1): error

Bit Off (0): Normal

R
e
a
d
y

E
rro

r- - -

 

Module READY

Bit On (1): Normal

Bit Off (0): error
 

 
 

 (2) Operation channel information 
( ( ) is for IEC types, x: slot No.) 
This is the area for storing the operation information, input wire open detection, 
and channel error information by channel. 
※ The base No. of the XGB PLC is 0. 
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

C
H

.3

C
H

.2

C
H

.1

C
H

.0

C
H

.6

C
H

.7----

U0x.01
(%UW0.x.1)

 

Operation Ch, Info.

Bit On (1): in operation

Bit Off (0): Stop operation

C
H

.5

C
H

.4- - - -
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(3) Digital Output Values ( ( ) is for IEC types, y: slot No.) 

   (a) A/D converted digital values are outputted to buffer memory address U0y.02 ~ U0y.09 
(%UW0.y.2~ %UW0.y.9) by channel-basis. 

       (b) Digital output values are saved in 16-bit binary figures. 
     ※ The base No. of the XGB PLC is 0. 

 

비트15 비트14 비트13 비트12 비트11 비트10 비트9 비트8 비트7 비트6 비트5 비트4 비트3 비트2 비트1 비트0

 CH 0 Output
U0y.02

(%UW0.y.2)

 

 CH 1 Output
U0y.03

(%UW0.y.3)

 CH 2 Output
U0y.04

(%UW0.y.4)

 CH 3 Output
U0y.05

(%UW0.y.5)

 

 CH 4 Output
U0y.06

(%UW0.y.6)

 CH 5 Output
U0y.07

(%UW0.y.7)

 

 CH 6 Output
U0y.08

(%UW0.y.8)

 CH 7 Output
U0y.09

(%UW0.y.9)
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7.11.2 Operation Parameter Setting Area 

The operation parameter setting area of the analog mix module is as follows. 
 

Memory 
Add. 

Description Setting R/W Command 

0 Appoint operating channel Bit Off (0): stop, Bit ON (1): run R/W 

PUT/GET 

1 
I/O range setting 

(CH0~CH3) 

I/O range setting (bit) 
0000: 4 ~ 20 ㎃ 
0001: 0 ~ 20 ㎃ 
0010: 1 ~ 5 V 
0011: 0 ~ 5 V 
0100: 0 ~ 10 V 

R/W 

2 
I/O range setting 

(CH4~CH7) 
R/W 

3 Output data type setting 

Input data type setting (bit) 
00: 0 ~ 4000 
01: -2000 ~ 2000 
10: precise value 
11: 0 ~ 1000 
- In case of precise value 
4 ~ 20 ㎃: 400 ~ 2000 
0 ~ 20 ㎃: 0 ~ 2000 
1 ~ 5 V: 100 ~ 500 
0 ~ 5 V: 0 ~ 500 
0 ~ 10 V: 0 ~ 1000 

R/W 

4 CH0 Filter constant 

0 or 4 ~ 64000 R/W 

5 CH1 Filter constant 

6 CH2 Filter constant 

7 CH3 Filter constant 

8 CH4 Filter constant 

9 CH5 Filter constant 

10 CH6 Filter constant 

11 CH7 Filter constant 

12 Average processing method 

Specifies average processing method (2bit 
per channel) 
00: Sampling processing 
01: Time average processing 
10: Count average processing 
11: Moving average processing 

R/W 

13 CH0 average value 

Time average: 4 ~ 16000 [ms] 
Count average: 2 ~ 64000 [times] 
Moving average: 2 ~ 100 

R/W 

14 CH1 average value 

15 CH2 average value 

16 CH3 average value 

17 CH4 average value 

18 CH5 average value 

19 CH6 average value 

20 CH7 average value 

21 Error information 

Error information (Decimal, # channel n0.) 
0-7: CH0-7 
10#: error in channel range 
20#: error in channel filter value 
30#: error in channel average value   

R GET 

 

Note  

(1) If the memory address 0~8 area is entered with values different from the setting 

U0x.01.8~U0x.01.B (setting error representative flag, for IEC type, %UX0.x.24~%UX0.x.27) is 

ON and runs with default values. The error information is displayed in the setting error 

information are (No. 9).  

(2) System areas (after No. 10) are read/write protected.  

Changing these areas may cause malfunction or failure of the product. 
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(1) Operating Channel Setting 

The default setting for operating channel is ‘Stop.’  
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

C
H

.3

C
H

.2

C
H

.1

C
H

.0

C
H

.6

C
H

.7----

Address0

 

Appoint Using CH

Bit On (1): Operate

Bit Off (0): Stop

----

C
H

.4

C
H

.5

 
 
 

(2) Input Range Setting  
(a) The analog input voltage range is DC 1~5V, DC 0~5V, DC 0~10V, and analog current input  

range is DC 4~20mA, DC 0~20mA. 
(b) Default range is DC 4~20mA. 

 

BIT15 BIT14 BIT13 BIT12 BIT11 BIT10 BIT9 BIT8 BIT7 BIT6 BIT5 BIT4 BIT3 BIT2 BIT1 BIT0

CH  0

Address1 

Input range setting (4 bit per channel)  

0 : 4 ~ 20 ㎃

1 : 0 ~ 20 ㎃
2  : 1 ~ 5 V

3  : 0 ~ 5 V

4  : 0 ~ 10 V

CH  1 CH  2CH  3

BIT15 BIT14 BIT13 BIT12 BIT11 BIT10 BIT9 BIT8 BIT7 BIT6 BIT5 BIT4 BIT3 BIT2 BIT1 BIT0

CH 4

Address2

CH 5 CH 6CH 7

 
(3) I/O Data Type Setting  

        (a) I/O data type can be set up for each channel. 
        (b) If the I/O data type is not set up, all the channels are processed in 0~4000 range. 
 

 
Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

Address3

 

Input data type setting (2bit per channel))

0 : 0 ~ 4000

1 : -2000 ~ 2000

2 : Precise value

3 : 0 ~ 1000

CH 7

- For precise value

   4 ~ 20 ㎃: 400 ~ 2000

   0 ~ 20 ㎃: 0 ~ 2000

   1 ~ 5 V: 100 ~ 500

   0 ~ 5 V: 0 ~ 500

   0 ~ 10 V: 0 ~ 1000

CH 6 CH 5 CH 4 CH 3 CH 2 CH 1 CH 0
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(4) Filter Constant Setting 

(a) If set to 0, no filtration is processed. 
(b) Default setting is 0 – no filtration process. 

 
Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 CH 0 filter constant (0 or 4~64000ms) Address4

  Address5

  Address6

  Address7

  Address8

  Address9

  Address10

  Address11

CH 1 filter constant (0 or 4~64000ms)

CH 2 filter constant (0 or 4~64000ms)

CH 3 filter constant (0 or 4~64000ms)

CH 4 filter constant (0 or 4~64000ms)

CH 5 filter constant (0 or 4~64000ms)

CH 6 filter constant (0 or 4~64000ms)

CH 7 filter constant (0 or 4~64000ms)

 
 
 

 
 

(5) Averaging Method Setting 
(a) Averaging method can be one of; time average, count average, moving average. 
(b) Default setting is no averaging throughout the channels. 
 

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 CH  0

Address12

Average processing (4 bit per channel)  

0 : Sampling Processing 

1 : Time average processing  

2 : Count average processing  

3 : Moving average processing  

 CH  1CH 2CH 3CH 4CH 5CH 6CH 7
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(6) Average Value Setting 

(a) Set up average values in accordance with the setting area of the averaging method. 
(b) If the average value is out of setting range, averaging is not applied. 
 

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 CH 0 average valueAddress13

 Address14

Input channel # average value setting  

Time average : 4 ~ 16000 [ms] 

Count average : 2 ~ 64000 [times]

Moving average : 2 ~ 100 

 Address15

 Address16

 Address17

 Address18

 Address19

 Address20

CH 1 average value

CH 2 average value

CH 3 average value

CH 4 average value

CH 5 average value

CH 6 average value

CH 7 average value

 
 

(7) Error Code (Address 21) 

(a) Saves the error code detected by the analog mix module. 
(b) The types and descriptions of the error are as follows. 
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

Set-up error informationAddress21
 

 

Type 
Error 
code 

LED Description 
Error code 

Priority 
Remark 

Error 

10# LED 
flickering 
1s intervals 

Channel range set-up error 1 
# channel no. 
CH 0~7 

20# Channel filter constant set-up error 2 

30# Channel average value set-up error 3 

 
 

(c) In case of plural errors, the code with higher priority order will be saved.  
 

 
(9) System Area (after Address 22) 

(a) System area (after address 22) is read/write protected. 
 

 Caution Modifying this area can cause malfunction of failure of product. 
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7.12 Example Program 
 

(1) This sample program sets up operating parameters of analog input module. 
(2) Initial settings are saved in the internal memory of the module by input by once. 
(3) The sample program below controls the output data of the analog input module at slot #1 and  

check open wire. 
 

7.12.1 Example of [I/O Parameter] Usage 

 

 (1) I/O Parameter Setting Window 
 

 
 

 
 
    (a) Input Channel 0 is set to operating channel and input range is set to 4~20mA. 
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` 
 
(2) Sample Program 
 
 

 
 

(a) When the module is in normal operation, M0000 is turned On. 
U01.00.0 (Module Error) = Off 
U01.00.F (Module Ready) = On 
U01.01.0 (Input Channel 0 in-operation) = On 
U01.01.8 (Input Channel 0 Error) = Off 

(b) When M0000 is ON, Input Channel 0 Converted Value(U01.02) is moved to D00100. 
(c) If open-wire error occurs in channel 0, U01.10.0 (channel 0 open-wire) is ON, and M0001 bit is  

set. 
 
 

(3) Sample Program (IEC type) 
 
 

 
(a) When the module is in normal operation, %MX0 is turned ON. 

%UX0.1.0(Module Error) = Off 
%UX0.1.15(Module Ready) = On 
%UX0.1.16(Channel 0 in-operation) = On 
%UX0.1.24(Channel 0 Error) = Off 

(b) When %MX0 is ON, Input Channel 0 Converted Value(%UW0.1.4) is transferred to “CH 0 
Input” variable. 

(c) If open-wire error occurs at Channel 0, %UX0.1.160 (Channel 0 open) turns ON and %MX1 bit 
 is set. 

 

CH0 program 

Output CH0 program 

CH 0 input 
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7.13 Troubleshooting 
 

This section describes methods for identifying the troubles which may occur during the operation of 
analog input module, and their solutions. 

 
 

7.13.1 LED Indication for Error  
 

An analog input module has one INPUT LED to indicate error status of the module. 
 

Item Normal State 
Channel Open 

(Input) 
Parameter Setting 

Error 

Module H/W 
Failure 

(Serious Failure) 

LED On 
Flikering  
1s intervals 

Flikering 1s intervals 
(input parameter 
setting error) 

Flikering 0.2s 
Intervals 

Module 
Behavior 

All functions are 
normal 

All functions are 
performed. 
Indicates min. input 
value 

All functions work at 
default parameter 
setting 

Module cannot 
function 

Action - Check input wire 
Check parameter 
setting 

Request for A/S 

 
 
 

 

7.13.2 Checking Module Condition 
 

XG5000’s system monitor enables verification of the analog mix module conditions (module type, 
module information, OS version). 

 
(1) Procedure 

The verification can be done in 2 ways; 
(a) [Monitor] -> [System Monitor] -> mouse right click on module icon -> [Module Information] 
(b) [Monitor] -> [System Monitor] -> double click module icon. 

 
(2) Module Information 

(a) Module type: shows the information on the present module. 
(b) Module information: shows the OS version of the module. 
(c) OS version: shows release date of Module OS. 
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7.13.3 Troubleshooting 
 
 
        (1) INPUT LED is off. 
 

INPUT LED is off..

Analog input module is correctly 

installed.

Install the module correctly No

Yes

XG5000 software shows I/O information

Contact nearest dealer or A/S center 
No

Yes

System resumes normal function if the 

module is replaced.

 Yes Contact nearest dealer or A/S center

 
      
 
 
 
         (2) LED flickering. 
 

LED flikering

LED flikering 0.2s intervals.

Contact nearest dealer or A/S center 

No

Yes

LED flikering 1s intervals

Input wire is correct.

Correct wiring according to user manual

(Check line open)
 No

Yes

Parameter setting is normal

(Check with PUT command)

Operation parameter setting error

Correct the error according to user manual

(Check error code)

 No
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        (3) Analog input value is abnormal. 
 

Analog input value is abnormal.

External DC24V input power is OK.

Supply DC 24 power No

Yes

FG ground is OK

Correct FG grounding according to the wiring 

in the user manual
 No

Yes

Parameter setting is OK

(Operation channel permit, I/O range 

setting
Set up the parameters correctly according to 

the user manual
 No

Yes

External voltage/current selector switch 

setting is correct

Set the switch according to the user manual No

Yes

Contact nearest dealer or A/S center
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Chapter 8 Analog Input Option Board 

 

8.1 Setting Sequence before operation 
 

Before using the analog input option board, follow steps below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 

 

XBO-AD02A 

 

 

 

 

 Checking performance specification 

Wiring 

Reading analog input data 

Setting parameter 

Programming 

Specification (8.2.2 performance specification) 
 Operating environment 
 Input type and range 
 Digital output range 

Wiring 
 Wiring analog input  

Analog input test 
 XG5000 special module monitor test mode 

Parameter 
 XG5000 I/O parameter 
 Gain adjustment 

Programming 
 Programming for reading analog data 

 (U device) 

Refer to trouble shooting when there is error 
or analog data is not normal. 
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8.2 Specifications 
 
8.2.1 General specifications 

General specifications are as follows. 

 

 
 
 

No. Items Specification Related 
standards 

1 
Operating 

temperature 
0 ~ 55 °C − 

2 
Storage 

Temperature 
−25 ~ +70 °C − 

3 
Operating 
humidity 

5∼95%RH (Non-condensing) − 

4 
Storage 
humidity 

5∼95%RH (Non-condensing) − 

5 
Vibration 
immunity 

For discontinuous vibration − − 

Frequency − Amplitude Times 

IEC61131-2 

10  ≤ f <  57㎐ − 0.075㎜ 

Each 10 
times in 
X,Y,Z 

directions 

57  ≤ f ≤  150㎐ 9.8㎨(1G) − 

For continuous vibration 

Frequency Acceleration Amplitude 

10  ≤ f <  57㎐ − 0.035㎜ 

57  ≤ f ≤  150㎐ 4.9㎨ (0.5G) − 

6 
Shocks 

immunity 

•  Max. impact acceleration : 147 ㎨ (15G) 
•  Authorized time : 11㎳ 
•  Pulse wave : Sign half-wave pulse (Each 3 times in X,Y,Z directions) 

IEC61131-2 

7 
Noise 

immunity 

Square wave 
impulse noise 

AC : ±1,500 V 
DC :  ± 900 V 

LSIS standard 

Electrostatic 
discharging 

Voltage : 4㎸(contact discharging) 
IEC61131-2 

IEC61000-4-2 
Radiated 

electromagnetic 
field noise 

80 ~ 1,000㎒,10V/m 
IEC61131-2, 

IEC61000-4-3 

Fast Transient 
/burst noise 

Segment Power 
module 

Digital/ 
Analog I/O 

communication interface IEC61131-2 
IEC61000-4-4 

Voltage 2㎸ 1㎸ 

8 
Ambient 

conditions 
No corrosive gas or dust − 

9 
Operating 

height 
2000m or less − 

10 
Pollution 
degree 

2 or less − 

11 Cooling type Natural air cooling − 
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8.2.2 Performance specifications 

Performance specifications are as follows. 

Items Performance specification 

Number of channel 2 channels 

Analog input 
range 

Type Voltage Current 

Range 

DC 0 ~ 10V 
(Input resistance: 1 ㏁ Min.) 

DC 4 ~ 20㎃ 
DC 0 ~ 20㎃ 
(Input resistance 250 Ω) 

Set by external voltage/current selector switch after being set at user 
program or I/O parameter per each channel 

Digital output 

Type 12 bit binary data 

Range 

Unsigned 
value 0 ~ 4000 

Signed value -2000 ~ 2000 

Precise 
value 0 ~ 1000 (DC 0 ~ 10V) 400 ~ 2000 (DC 4 ~ 20㎃) 

0 ~ 2000 (DC 0 ~ 20㎃) 
Percentile 

value 0 ~ 1000 

Max. resolution 
1/4000 (DC 4~20㎃: 1/3200) 

2.5㎷ (DC 0~10V) 5㎂ (DC 0~20㎃) 
0 ~ 2000 (DC 0 ~ 20㎃) 

Accuracy ±1.0% or less 

Max. conversion speed 1ms/channel + scan time 

Absolute max. input DC +12V / -10V DC ±25㎃ 

Additional 
function 

Average function Count average (2 ~ 64,000 times) 

Gain adjustment  
function Gain adjustment (-40~40) 

Insulation method No insulation between channels  
No insulation between input terminal and PLC main unit 

Input terminal 5 - point terminal block 
I/O points occupied Fixed type: 64 points 

Supply power Inner DC 5V 

Consumption current 50㎃ 

Weight 20g 

 
Note1) In order to use analog input option board, the following version is needed. 
 

Main unit Version information 
XBC E type V1.1 or above 
XBC S type V1.1 or above 

XBC SU type V1.0 or above 
XEC E type V1.0 or above 

XEC SU type V1.0 or above 
XG5000 V.3.61 or above 

 
Note2) Offset/gain value on the analog input range can be adjusted at XG5000- I/O parameter 
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8.3 Name of part and function 
 

 
Respective designations of the parts are as described below. 
 
   

① Hook for fixation

② Terminal block

③ Cover

④ Hook for fixation

⑤ Connector for
    option board

⑥ Input
    connector

35.0mm

49.0mm

10.3mm

 

 
No. Name Description 

①④ Hook for fixation ▶ Hook for fixing the option board to main unit 

② Terminal block 
▶ Wiring terminal block to connect with external device 

(Analog input) 

③ Cover ▶Option board cover 

⑤ 
Connector for option 
board 

▶Connection connector for connecting the option board to the main 
unit 

⑥ Input connector ▶Wiring connector for connecting with the external device 
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8.4 Characteristic of I/O conversion 
 

The input ranges of voltage and current can be set up per channel with user program or I/O 
parameters. The output types of digital data are defined as follows. 

(1) Unsigned Value 
(2) Signed Value 
(3) Precise Value 
(4) Percentile Value 

 

Digital 
output

0

1000

2000

3000

4000
4047

-2000

-1000

0

1000

2000
2047

0

250

500

750

1000
1011

DC 4 ~ 20 mA

DC 0 ~ 20 mA

DC 0 ~ 10 V

4 mA 20 mA12 mA

0 mA

0 V 5 V 10 V

Analog 
input

Analog input practical 
range

Offset

Gain

20 mA10 mA

-48-2048-12

 
 

 
 (1) DC 4 ~ 20mA Range Input 

Digital  
Output Range 

Analog Input Current (mA) 
3.81 4 8 12 16 20 20.18 

Unsigned Value 
(0 ~ 4000) -48 0 1000 2000 3000 4000 4047 

Signed Value 
(-2000 ~ 2000) -2048 -2000 -1000 0 1000 2000 2047 

Precise Value 
(400 ~ 2000) 381 400 800 1200 1600 2000 2018 

Percentile 
Value(0 ~ 1000) -12 0 250 500 750 1000 1011 
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(2) DC 0 ~ 20mA Range Input 
Digital  

Output Range 
Analog Input Current (mA) 

-0.24 0 5 10 15 20 20.23 
Unsigned Value 
(0 ~ 4000) 

-48 0 1000 2000 3000 4000 4047 

Signed Value 
(-2000 ~ 2000) 

-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 
(0 ~ 2000) 

-24 0 500 1000 1500 2000 2023 

Percentile 
Value(0 ~ 1000) 

-12 0 250 500 750 1000 1011 

 
 
 (3) DC 0 ~ 10V Range Input 

Digital  
Output Range 

Analog Input Voltage  (V) 
-0.12 0 2.5 5 7.5 10 10.11 

Unsigned Value 
(0 ~ 4000) 

-48 0 1000 2000 3000 4000 4047 

Signed Value 
(-2000 ~ 2000) 

-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 
(0 ~ 1000) 

-12 0 250 500 750 1000 1011 

Percentile 
Value(0 ~ 1000) 

-12 0 250 500 750 1000 1011 
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8.5 Accuracy 
 

 
Accuracy of digital output value does not changed even if input range is changed. Figure below shows 
the range of the accuracy with analog input range of 0 ~ 10 V and digital output type of unsigned value 
selected.  
Accuracy of XBO-AD02A is ±1.0%. 

 

0

0V 5V

2000

10 V

4000

Analog input voltage

D
igital output value

3980

4020

-20

20

 
           [ Accuracy ] 

      
 

(1) Accuracy when using 5V input 
4000 × 1.0% = 40 
Therefore the range of the accuracy will become (2000-40) ~ (2000+40) = 1960 ~ 2040 
when using 5V input. 

 
(2) Accuracy when using 10V input  

4000 × 1.0% = 40 
Therefore the range of the accuracy will become (4000-40) ~ (4000+40) = 3960 ~ 4040  
when using 10V input. 
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8.6 Functions of Analog Input Option Board 
 

 The functions of analog input option board are as follows.  
 

Function Description 
Channel 
operation/stop setting 

● Specify operation/stop of the channel which will perform A/D conversion. 
● Specifying unused channels as Stop can shorten overall operation time. 

Input Voltage /current 
range setting  

● Specify desired range of analog I/O. 
● Analog input option board provides 2 ranges(4~20mA, 0~20mA) of current I/O and 1 
range ( 0~10V) of voltage I/O. 

Output data type 
setting 

● Specify digital I/O types. 
● This module provides 4 output data types (Unsigned, Signed, Precise, and Percentile 
Values) 

A/D input conversion 
method 

● Sampling Process 
- If A/D conversion method has not been specified, the module processes sampling. 

● Averaging process 
- Outputs A/D converted value averaged by count to reduce rapid change of input 

value caused by external noise 
 
 
 

8.6.1 Sampling Process 
In popular A/D conversion process, analog input signals are collected at constant time intervals and 
A/D converted. The time elapsed for the analog signals to be converted into digital signals and 
saved in memory device depends upon the number of channels used.  

 
(Process Time) = (No. of Channels Used) x (Conversion Speed + Scan time) 

 
(Ex.) Process time when using 1 of 2 I/O channels and scan time is 2㎳;  

1  x  (1 ㎳ +  2㎳)  =  3 ㎳ 
 
The term ‘sampling’ means taking sample value among continuous analog signal values at regular 
intervals. 

  
 
 

.  
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8.6.2 Count Averaging Function 
 

The input values of the designated channel are accumulated for the preset cycles, and the average 
value of the total sum is outputted in digital data. 

Channel Scanning Intervals (1ms/Ch. Used)

Averaged input value 
Actual input value

Averaging 
Section

Averaging 
Section

Sampling 
Section  

Setting Range = 2 ~ 64000 [times] 
For count averaging, averaging interval is calculated with the No. of channels used. 
 
 
Averaging interval [ms] = Averaging count x (No. of channels used x1ms + Scan time) 

 
 

 

 

Note  

(1) Averaging interval varies according to scan time  
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8.6.3 Gain Adjustment Function 
 

You can adjust input gain of the analog input option board.  
 
When selecting current input for analog input range, the digital output (4000) corresponding to analog 
input max. value (20mA) is standard gain value. When selecting voltage input, the digital output 
(4000) corresponding to analog input max. value (10V) is standard gain value. 
 
(1) You can adjust input gain at I/O parameter 
 
(2) Input gain setting range = - 40 ~ 40 
 
(3) Adjusting gain for each channel is available 
 

  
 

(4) Example  
  When you set “Input gain” as -5, 3996 (=4000-5) applies for gain.   

 
 

Note  

(1) When you adjust the input gain, max. resolution changes, too. 
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8.7 Wiring  
 

8.7.1 Precaution for wiring  
(1) Don’t let AC power line near to A/D conversion module’s external input sign line. With an enough 

distance kept away between, it will be free from surge or inductive noise. 
 (2) Cable shall be selected in due consideration of ambient temperature and allowable current, 

whose size is not less than the max. cable standard of AWG22 (0.3㎟). 
 (3) Don’t let the cable too close to hot device and material or in direct contact with oil for long, which 

will cause damage or abnormal operation due to short-circuit. 
 (4) Check the polarity when wiring the terminal. 
 (5) Wiring with high-voltage line or power line may produce inductive hindrance causing abnormal 

operation or defect. 
 (6) Enable only needed channels  

 
8.7.2 Wiring examples  

 

 
 
 

  
*(a) In case of current input, connect V+ terminal to I+ terminal  
*(b) Input resistance of current input circuit is 250 Ω (typ.). 
*(c) Input resistance of voltage input circuit is 1 MΩ (min.)  

 
(3) Terminal block configuration 
 

 
 
 

 

+

-

+

-

CH0

CH1

V0+

I0+

V1+

I1+

COM

R
R

R

R
R

R

XBO-AD02A

*(a) *(b)

*(c)

(1) Current input 

(2) Voltage input 
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(4) Relationship between voltage input accuracy and wiring length 
In voltage input, the wiring (cable) length between transmitter or sensor and option board has an 
effect on digital-converted values of the option board as specified below; 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
       

 
 

 
Where,        
 
Rc: Resistance value due to line resistance of cable 

        
       Rs: Internal resistance value of transmitter or sensor 
 
       Ri: Internal resistance value (1㏁) of voltage input module 
  
       Vin: Voltage allowed to analog input module  
 
       % Vi: Tolerance of converted value (%) due to source and cable length in voltage input 
 
 

                 ( )[ ]RiRcRs
VsRiVin

+×+
×

=
2

  

 
 

1001% ×





 −=

Vs
VinVi %  

 
 

Vs 

Rs Rc 

Rc 
Ri 

Load 
 

Analog input (Voltage) 

Vin 
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8.8 Operation Parameter Setting 
 

Analog input option board’s operation parameters can be specified through XG5000’s [I/O parameters]. 
 

(1) Settings 
For the user’s convenience, XG5000 provides GUI (Graphical User Interface) for parameters setting 
of analog option board. Setting items available through [I/O parameters] on the XG5000 project 
window are as described below in the table.  

 
 

Item Details 

[I/O parameter] (a) Specify the following setting items necessary for the option board  
operation. 
1) Channel Enable/Disable setting 
2) Setting ranges of input voltage/current 
3) Output data format setting 
4) Count averaging 
5) Input gain 

 (b) If downloading is complete, Parameter set by user in XG5000 is 
saved in Flash memory of XGB main unit.  

 
(2) Usage of [I/O Parameter] 

(a) Create a project with XG5000. See XG5000 Program Manual for project creation. 
(b) In the Project window, double-click [I/O Parameter]. 
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(c) In the [I/O Parameter Setting] window, find out the slot of the base where the analog input 
option board is installed, and click it.  

 
 

(d) In the above window, click the arrow button to call the window where the module can be 
selected. Find out the module and select it.  

 
 

 (e) To set up parameter, double click with the respective slot being selected, or click [Detail] button. 
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(f) The window below where parameters can be set up by channel appears. Click the item to set 

up. The parameters which can be set up appear by item.  
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The functions of the special module monitor are as follows. 
 

(1) Start-up of [Special Module Monitor] 
Select [Online] -> [Connect], and [Monitor] -> [Special Module Monitor] to start up. [Special Module 
Monitor] menu is enabled only in the [Online] condition. 

 

 
 

 
Note  

1) The screen may not function properly if the system resources are not sufficient. In this case, close  
the screen, exit other applications, and rerun XG5000. 

2) The I/O parameters set up in [Special Module Monitor] condition are temporarily set up for testing  
purpose. Therefore, these I/O parameters are deleted after exit from [Special Module Monitor]. 

3) The test function of the [Special Module Monitor] enables testing analog input option board without  
sequence programming. 

 
 
 

(2) Usage of [Special Module Monitor] 
(a) With the XG5000 in connection (online) with the base unit of PLC, select [Monitor] -> [Special 

Module Monitor]. The Select Special Module window shown below will appear showing the type 
of the special modules and base/slot information. In the list dialog, the modules present in the 
PLC system are displayed. 

 

8.9 Special Module Monitoring Functions 
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(b) In the above window, select the special module and click [Module Info.] to see the 

information window below.  

 
 
(c) Click the [Monitor] button in the “Special Module” window. The “Special Module Monitor’ 

window will appear as shown below.  
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(d) [Start Monitoring]: click [Start Monitoring] to look up the digital input data of the channel 

currently in operation. The screen shot below is a monitoring window when all the 
channels are in operation status.  

Monitoring

Detailed 
information of CH0

 
The screen executing [Start Monitoring]  

 
(e) [Test]: this function is used to change the current parameter settings of the analog mix 

module. Click the settings in the fields in the bottom screen to change the parameters. 
[Test] can be set up only when the operation status of the XGB base unit is STOP mode. 

 
        The screen executing [Test] 
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(f) Minimum/Maximum Value Monitoring  
    The minimum and maximum values of the input channels in operation can be monitored. 

However, the Max/Min values in the window are based on the current value. Therefore, 
the Max/Min values are not saved when exiting from the [Monitoring/Testing Screen]. 

Monitor max/min 
value

Reset max/min 
value

 
 
The screen executing [Max/Min Value Monitoring]  
 

 
(g) Close 

[Close] button is for ending/closing the monitoring/testing screen. Maximum, 
minimum, and current values are not saved at exit. 
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8.10 Register U devices 
 

The variables for each module are automatically registered by referring to the information of the special 
modules set up in the [I/O Parameter]. User can modify variables and descriptions. 

 
(1) Registration Procedure 
     (a) In [I/O Parameter], set up special module in slot. 

 
 
     (b) Double click [Variables/Comment]. 

 
 

    (c) In the ‘Edit’ menu, select ‘Register U device’ 
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(d) Click ‘Yes.’ 

 

 
 
 (e) Variables are registered as shown below.  

 
 

  
(2) Saving Variables 

(a) The contents in the ‘View Variables’ tab can be saved in a text file. 
 (b) In the ‘Edit’ menu, select ‘Save as Text File.’ 
 (c) The contents in the ‘View Variables’ tab are saved in a text file. 
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(3) Viewing Variables in Program 
 
 The figures below present examples of use in XGB compact “E” and “S” types 
 
   (a) Below is an exemplary program for XG5000.  

 
 

    (b) In the ‘View' menu, click ‘View Variables.’ The devices are changed into variables. 
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(c) In the ‘View' menu, click ‘View Device/Variables’ to look up the devices and variables at 

the same time. 

 
 
 
 
(d) In the ‘View' menu, click ‘View Device/Comment’ to look up the devices and descriptions at the 

same time. 
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(e) In the ‘View' menu, click ‘View Variable/Comment’ to look up the devices and descriptions at 

the same time. 
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(f) For IEC type also, as shown in Fig. (a) ~ (e), you can look up variables with 

           diversified options in the ‘View’ menu. The figure below is the case of an IEC type 
           with which the ‘View Device/Variables’ option. 
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8.11 Configuration and Function of Internal Memory 
 

An analog input option board has internal memory for data communication with XGB base unit. 
 
8.11.1 Analog Data I/O Area 

The table below presents the analog data I/O area. 

Variable Type Device assignment Description R/W 
Signal 

direction XBC IEC 

_0y_ERR BIT U0y.00.0 %UX0.y.0 Module Error 
R Option → CPU 

_0y_RDY BIT U0y.00.F %UX0.y.15 Module Ready 

_0y_AD0_ACT BIT U0y.01.0 %UX0.y.16 CH0 Active 
R Option → CPU 

_0y_AD1_ACT BIT U0y.01.1 %UX0.y.17 CH1 Active 

_0y_AD0_IDD BIT U0y.01.4 %UX0.y.20 CH0 Disconnection flag 
R Option → CPU 

_0y_AD1_IDD BIT U0y.01.5 %UX0.y.21 CH1 Disconnection flag 

_0y_AD0_ERR BIT U0y.01.8 %UX0.y.24 CH0 error 
R Option → CPU 

_0y_AD1_ERR BIT U0y.01.9 %UX0.y.25 CH1 error 

_0y_AD0_DATA WORD U0y.04 %UW0.y.4 CH0 Output R Option → CPU 

_0y_AD1_DATA WORD U0y.05 %UW0.y.5 CH1 Output R Option → CPU 

 
- In the device allocation, the small letter ‘y’ is the No. of the slot where the module is installed. 
- For example, to read the ‘CH0 Input A/D Value’ of the analog module installed in the slot 9, write in 

U09.05. (%UW0.9.4 for IEC types) 

Device Type

U 0 9 . 0 4

Slot No.
Word

[XBC type]

Word classifier

                   

Device Type
Slot No.

Base No

Word

[IEC type]

 % U W 0 . 9 . 4
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(1) Module Ready/Error Flag ( ( ) is for IEC types, y: slot No.) 

(a) U0y.00.F(%UX0.y.15): at power on or reset of PLC CPU, turns on when the analog I/O 
conversion is ready and analog conversion is performed. 

   (b) U0y.00.0(%UX0.y.0): the flag indicating the error status of analog input option board module. 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

-----------

Uty.tt
(iUWt.y.t)

 

E..o. occu..ence 
info.)ation
Bit On (1): e..o.
Bit Off (0): No.)a(

R
e
a
d
y

E
rro

r- - -

 

Mo u(e READY
Bit On (1): No.)a(
Bit Off (0): e..o.

 
 

 
(2) Operation channel information/ channel error information flag ( ( ) is for IEC types, y: slot No.) 

This is the area for storing the operation information and channel error information by channel. 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

- -

In
pu
t C
H

1

In
pu
t C
H

0
------

U0y.01
(%UW0.y.1)

 

Operating CH 
information
Bit On (1): operating
Bit Off (0): stop

In
pu
t C
H

1

In
pu
t C
H

0
- -

In
pu
t C
H

1

In
pu
t C
H

0

 

CH error information
Bit On (1): error
Bit Off (0): normal

 

CH disconnection 
information
Bit On (1): disconnection
Bit Off (0): normal

 
(3) Digital Output Values ( ( ) is for IEC types, y: slot No.) 

(a) A/D converted digital values are outputted to buffer memory address U0y.04 ~ U0y.05 by  
channel-basis. 

    (b) Digital output values are saved in 16-bit binary figures. 
bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Input CH0 conversion valueU0y.04
(%UW0.y.4)

Input CH1 conversion valueU0y.05
(%UW0.y.5)  
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8.11.2 Operation Parameter Setting Area 
The operation parameter setting area of the analog mix module is as follows. 

 
Memory 

Add. Description  Setting R/W Command 

0 Enable channel Bit Off (0): disable, Bit ON (1): enable R/W 

PUT/GET 

1 Input  range setting 

Input range setting (4 bit per channels) 
0: 4 ~ 20 ㎃ 
1: 0 ~ 20 ㎃ 
2: 0 ~ 10 V 

R/W 

2 Output data type setting 

Output data type setting  
(4 bit per channels) 
0: 0 ~ 4000 
1: -2000 ~ 2000 
2: Precise value 
3: 0 ~ 1000 
- In case of precise value 
4 ~ 20 ㎃: 400 ~ 2000 
0 ~ 20 ㎃: 0 ~ 2000 
0 ~ 10 V: 0 ~ 1000 

R/W 

3 Input channel 0 count 
average value setting  

0 or 2 ~ 64000 [times] 
R/W 

4 Input channel 1 count 
averaging value setting  R/W 

9 Input channel 0 gain 
weighting 

-40~40 
R/W 

10 Input channel 1 gain 
weighting R/W 

13 Setup error information  

10#: input ch range setting error 
20#: input ch data type setting error 
30#: input ch average value setting error  
40#: input ch gain weighting setting error 
(#: channel number) 

R GET 
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(1) Operating Channel Setting (address 0) 
(a) You can set “Enable/Disable” of analog input option board per each channel  
(b) Disable the unused channels to reduce the conversion period. 
(c) Default value is “Disable” for all channels 
(d) When using PUT instruction, address is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

- -

In
pu
t C
H

1

In
pu
t C
H

0
------

Addresst 

 

Enable CH
Bit On (1): enable
Bit Off (0):  isable

---- --

 
 

(e) The values set in bit 2~15 are ignored. 
(f)This area is same as setting in “Channel status” of I/O parameter  
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(2) Input range setting area (address 1) 
(a) Set the type of input range with the following code 
   

Bit (HEX) Input range 
0000 (0) 4 ~ 20 ㎃ 
0001 (1) 0 ~ 20 ㎃ 
0010 (2) 0 ~ 10 V 

 
(b) If you set more than 3, 0 (4~20㎃) will be set forcibly  

But, U0X.01.8~ U0X.01.9 (Setup error flag) will be ON. 
(c) When using PUT instruction, address is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Input CH 0

Addressu

 

Input range (4bit per channel)
0 : 4 ~ 20 ㎃
1 : 0 ~ 20 ㎃
2 : 0 ~ 10 V

Input CH 1---- ----

 
(d) The values set in bit 8~15 are ignored. 
(e)This area is same as setting in “Input range” of I/O parameter  
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(3) Output data type setting area (address 2) 

(a) Set the type of output data type with the following code  
Bit (HEX) Output data type 
0000 (0) 0~4000 
0001 (1) -2000~2000 
0010 (2) Precise value 
0011 (3) 0~1000 

 
In case of precise value, output data type is designated as the following value according to each 
input range type 

 
Input range Precise value 
4 ~ 20 ㎃ 400 ~ 2000 
0 ~ 20 ㎃ 0 ~ 2000 
0 ~ 10 V 0 ~ 1000 

 
 (b) If you set more than 4, 0 (0~4000) will be set forcibly. 

But, U0X.01.8~ U0X.01.9 (Setup error flag) will be ON. 
 (c) When using PUT instruction, address is as follows 
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

Input CH 0

Address2

 

Output type (4bit per channel)
0 : 0 ~ 4000
1 : -2000 ~ 2000
2 : precise 2alue
3 : 0 ~ 1000

Input CH 1

- In case of precise 2alue
   4 ~ 20 ㎃: 400 ~ 2000
   0 ~ 20 ㎃: 0 ~ 2000
   0 ~ 10 V: 0 ~ 1000

---- ----

 
(d) The values set in bit 8~15 are ignored. 
(e)This area is same as setting in “Output type” of I/O parameter  
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(4) Count average value setting area (address 3~4) 
(a) Set count average value with 0 or value of 2~6400  
(b) If you set the count average value as 0, corresponding channel will not perform averaging 

process and output sampled analog input value 
(c) If you set 1 or more than 64001, 0 (Disable averaging) will be set forcibly. 

But, U0X.01.8~ U0X.01.9 (Setup error flag) will be ON.  
(d) When using PUT instruction, address is as follows 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Input CH0 count average value  (0 or 2 ~ 64000 [times)Address3

Input CH1 count average value  (0 or 2 ~ 64000 [times)Address4
 

 
(e) This area is same as setting in “Count-Avr” of I/O parameter  
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(5) Input gain weighting setting area (address 9~10) 

(a) Set input gain weighting with value of -40~40  
(b) If you set this as 0 (default value), 4000 will apply for gain value  
(c)For example, if you set this as -10, 4010 (=4000-(-10)) will apply for gain value 
(d) When using PUT instruction, address is as follows 
 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Input CH0 gain (-40 ~ 40)Address9

Input CH1 gain (-40 ~ 40)Addressut 
 

 
(e) This area is same as setting in “Input gain” of I/O parameter  

 
 

 
(6) Setup error information output area (address 13) 

(a) Saves error code detected when setting (setting by program) 
(b) Setting error is canceled when value is reset to make it in the valid range  
(c) When U0X.01.8~ U0X.01.9 (setting error flat) is on, check that area and fix the corresponding 

setting to cancel the error 
(d) When using GET instruction, address is as follows 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Setting error informationAddress13
 

 

Type Error 
code Description Priority Remark 

Setting 
error 

10# Input CH range setting error 1 

#: CH number 
Input CH 0,1 

20# Input CH data type setting error 2 
30# Input CH count average value setting error 3 
40# Input CH gain weighting setting error 4 

 
(e) When more than two errors occur simultaneously, it saves error code having higher priority.  
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8.12 Example Program 
 

(1) This sample program sets up operating parameters of analog input option board. 
(2) Initial settings are saved in the internal memory of the XGB main unit by one input. 
(3) The sample program below controls the I/O data of the analog input option board at option slot #0 

(I/O slot #9) and check open wire. 
 

8.12.1 Example of [I/O Parameter] Usage 
 

 (1) I/O Parameter Setting Window 
 

 
 

 
 
    (a) Input Channel 0 is set to operating channel and input range is set to 4~20mA. 
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(2) Sample Program (XBC Type) 
 

 
 

(a) When the option board is in normal operation, M0000 is turned On. 
U09.00.0 (Module Error) = Off 
U09.00.F (Module Ready) = On 
U09.01.0 (Input Channel 0 in-operation) = On 
U09.01.8 (Input Channel 0 Error) = Off 

(b) When M0000 is ON, Input Channel 0 Converted Value(U09.04) is moved to D00100. 
(c) If open-wire error occurs in channel 0, U09.01.4 (channel 0 open-wire) is ON, and M0001 bit is 

set. 
 

(3) Sample Program (IEC Type) 
 

 
 

(a) When the option board is in normal operation, %MX0 is turned On. 
%UX0.9.0 (Module Error) = Off 
%UX0.9.15 (Module Ready) = On 
%UX0.9.16 (Input Channel 0 in-operation) = On 
%UX0.9.24 (Input Channel 0 Error) = Off 

(b) When M0000 is ON, Input Channel 0 Converted Value((%UW0.9.4) is moved to “CH0_DATA”. 
(c) If open-wire error occurs in channel 0, %UX0.9.20 (channel 0 open-wire) is ON, and %M1 bit is 

set. 
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8.13 Troubleshooting 
 
This section describes methods for identifying the troubles which may occur during the operation of analog 
input option board, and their solutions. 
 

8.13.1 Troubleshooting 
 
        (1) Analog input value is abnormal. 
 

Analog input value is abnormal.

Installation is OK.

Install the option board properlyd No

Yes

FG ground is OK

Correct FG grounding according to the wiring 
in the user manual

d No

Yes

Wiring is OK
(Current input wiring, voltage input 
wiring)

Refer to the manual and wire properlyd No

Yes

Parameter setting is OK
(Operation channel permit, I/O range 
setting

Set up the parameters correctly according to 
the user manual

d No

Yes

Contact nearest dealer or A/S center
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Chapter 9 Analog Output Option Board 
 

9.1 Setting Sequence before Operation  
 

Before using the analog output option board, follow steps below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 

 

XBO-DA02A 

 

 

 

 

 Checking performance specification 

Wiring 

Writing analog output data 

Setting parameter 

Programming 

Specification (9.2.2 performance specification) 
 Operating environment 
 Digital input range 
 Analog output range 

Wiring 
 Analog output wiring 

Analog output test 
 XG5000 special module monitor 

test mode 

Parameter 
 XG5000 I/O parameter 

Programming 
 Program for writing digital data  

(U device) 

 
If there is error or analog output is 
abnormal, refer to the trouble shooting. 
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9.2  Specification 
 

9.2.1 General specifications 
 
Here describes general specification of analog output option board. 

No. Items Specification Reference 

1 
Operating 

temperature 0 ~ 55 °C 

− 

2 
Storage 

Temperature −25 ~ +70 °C 

3 
Operating 
humidity 5 ~ 95%RH (Non-condensing) 

4 
Storage 
humidity 5 ~ 95%RH (Non-condensing) 

5 
Vibration 
immunity 

Occasional vibration − 
Frequency Acceleration Pulse width Times 

IEC61131-2 

10  ≤  f  <  57㎐ − 0.075㎜ 

10 times 
each 

direction  
(X,Y and Z) 

57  ≤  f  ≤  150㎐ 9.8㎨ (1G) − 
Continuous vibration 

Frequency Acceleration Pulse width 
10  ≤  f  <  57㎐ − 0.035㎜ 
57  ≤  f  ≤  150㎐ 4.9㎨ (0.5G) − 

6 
Shocks 

immunity 

• Peak acceleration : 147 ㎨ (15G) 
• Duration : 11ms 
• Pulse wave type : Half-sine (3 times each direction per each axis) 

7 
Noise 

immunity 

Square wave 
impulse noise 

AC : ±1,500 V 
DC :  ± 900 V 

LSIS standard 

Electrostatic 
discharge 

Voltage: 4kV (Contact discharge) 
IEC61131-2 

IEC61000-4-2 
Radiated 

electromagnetic 
field noise 

80 ~ 1,000㎒, 10V/m 
IEC61131-2, 

IEC61000-4-3 

Fast transient 
/Burst noise 

Segment 
Power 
supply 

Digital/Analog Input/Output, 
Communication Interface 

IEC61131-2 
IEC61000-4-4 

Voltage 2㎸ 1㎸ 

8 
Ambient 

conditions 
No corrosive gas or dust 

− 9 
Operating 

height 
2000m or less 

10 Pollution degree 2 or less 

11 Cooling type Natural air cooling 
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9.2.2 Performance specifications 

 
Here describes performance specification of analog output module. 

Item Specification 

No. of channels 2 channels 

Analog 
output 
range 

Type Voltage Current 

Range 

DC 0 ~ 10V 
(Load resistance: 2㏀ Min.) 

DC 4 ~ 20㎃ 
DC 0 ~ 20㎃ 
(Load resistance: 450Ω Max.) 

Output range can be set at user program or I/O parameter for each 
channel 

Digital 
input 

Type 12-bit binary data 

Range 

Unsigned 
value 

0~4000 

Signed value -2000 ~ 2000 

Precise value 0 ~ 1000 (DC0~10V) 
400 ~ 2000 (DC4~20㎃) 
0 ~ 2000 (DC0~20㎃) 

Percentile value 0 ~ 1000 

Maximum resolution 
1/4000 (DC 4 ~ 20㎃: 1/3200) 

2.5㎷ (DC 0 ~ 10V) 5㎂ (DC 0~20㎃) 
6.25㎂ (DC 4~20㎃) 

Accuracy ±1.0% or less 
Maximum conversion speed 1㎳/channel + scan time 

Additional function 
Channel output state setting (former, min, middle, max value) 
Gain adjustment function 

Insulation method 
no insulation between analog output channels  
no insulation between output terminal and PLC main unit  

I/O terminal 5-point terminal block 
Power supply Internal 5V 

I/O points occupied Fixed type: 64 points 
Supply power Internal DC5V 

Current consumption 150㎃ 
Weight 20g 

 
Note1) In order to use analog output option board, the following version is needed. 
 

Main unit Version information 
XBC E type V1.1 or above 
XBC S type V1.1 or above 

XBC SU type V1.0 or above 
XEC E type V1.0 or above 

XEC SU type V1.0 or above 
XG5000 V.3.61 or above 

 
Note2) Offset/gain value on analog I/O range can be adjusted at XG5000 - I/O parameter 
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9.3 Designations and Functions  
 

 
Here describes designation and functions.  

 

① Hook for fixation

② Terminal block

③ Cover

④ Hook for fixation

⑤ Connector for
    option board

⑥ Input
    connector

35.0mm

49.0mm

10.3mm

 
 

 
 

No. Name Description 

①④ Hook for fixation ▶ Hook for fixing the option board to main unit 

② Terminal block 
▶ Wiring terminal block to connect with external device 

(Analog input) 

③ Cover ▶Option board cover 

⑤ 
Connector for option 
board 

▶Connection connector for connecting the option board to the main 
unit 

⑥ Input connector ▶Wiring connector for connecting with the external device 
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9.4 Characteristic of I/O Conversion  
 

The output ranges of voltage and current can be set up per channel with user program or I/O 
parameters. The input types of digital data are defined as follows. 

(1) Unsigned Value 
(2) Signed Value 
(3) Precise Value 
(4) Percentile Value 

 

Digital 
input

0

1000

2000

3000

4000
4047

-2000

-1000

0

1000

2000
2047

0

250

500

750

1000
1011

DC 4 ~ 20 mA

DC 0 ~ 20 mA

DC 0 ~ 10 V

4 mA 20 mA12 mA

0 mA

0 V 5 V 10 V

Analog 
output

Analog output practical 
range

Offset

Gain

20 mA10 mA

 
(1) DC4~20mA range output 

Digital input 
range 

Analog output current (mA) 
4mA or 

less 4 8 12 16 20 Over 
20mA  

Unsigned value 
(0 ~ 4000) 

0 or less 0 1000 2000 3000 4000 Over 4000 

Signed value 
(-2000 ~ 2000) 

-2000 or 
less 

-2000 -1000 0 1000 2000 Over 2000 

Precise value 
(400 ~ 2000) 

400 or less 400 800 1200 1600 2000 Over 2000 

Percentile value 
(0 ~ 1000) 

0 or less 0 250 500 750 1000 Over 1000 
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(2) DC 0 ~ 20mA range output 

Digital input 
range 

Analog output current (mA) 
0mA or 

less 0 5 10 15 20 Over 
20mA  

Unsigned value 
(0 ~ 4000) 

0 or less 0 1000 2000 3000 4000 Over 4000 

Signed value 
(-2000 ~ 2000) 

-2000 or 
less 

-2000 -1000 0 1000 2000 Over 2000 

Precise value 
(0 ~ 2000) 

0 or less 0 500 1000 1500 2000 Over 2000 

Percentile value 
(0 ~ 1000) 

0 or less 0 250 500 750 1000 Over 1000 

 
 
 (3) DC 0 ~ 10V range output 

Digital input 
range 

Analog output voltage (V) 
0V or less 0 2.5 5 7.5 10 Over 10V 

Unsigned value 
(0 ~ 4000) 

0 or less 0 1000 2000 3000 4000 Over 4000 

Signed value 
(-2000 ~ 2000) 

-2000 or 
less 

-2000 -1000 0 1000 2000 Over 2000 

Precise value 
(0 ~ 1000) 

0 or less 0 250 500 750 1000 Over 1000 

Percentile value 
(0 ~ 1000) 

0 or less 0 250 500 750 1000 Over 1000 

 

 

Note  

(1) There is “Dead Band” area around voltage output (0V), current output (0mA). 
(a) Digital input-based: about 0 ~ 10  
(b) Analog output-based: voltage(about 0 ~ 25㎷), current (about 0 ~ 50㎂) 

(2) In “Dead Band” area, digital input and analog output may not coincide (within accuracy) 
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9.5 Accuracy 
 

Accuracy for analog output value does not changed even if output range is changed. Figure below shows 
the range of the accuracy with analog output range of 0 ~ 10 V and digital output type of unsigned value 
selected.  
Accuracy of XBO-DA02A is ±1.0%. 

 

2000 40000

10V

0V

5V

10.1V
9.9V

0.1V
-0.1V

Digital input

A
na
lo
g 
ou
tp
ut

20mA
20.2mA
19.8mA

0mA
0.2mA

-0.2mA

10mA

 
 

 
 (1) Accuracy in case of 5V output 
 4000 × 1.0% = 40 
         So in case of 5V output, accuracy range is (5V - 40×0.0025V) ~ (5V+40×0.0025V) = 4.9 ~ 5.1V 
 
 (2) Accuracy in case of 10V  
 4000 × 1.0% = 40  

So in case of 10V output, accuracy range is (10V-40×0.0025V) ~ (5V+40×0.0025V) = 9.9 ~ 10.1V 
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9.6 Functions of Analog Output Option Board 
 

 
Here describes functions of XBO-DA02A option board 

Function Details 

Enable/Disable 
channel 

1) It sets up Run/Stop of a channel that will operate an analog output. 
2) You can save the time of whole operation by stopping unused channels. 

The range of 
output 

voltage/current 

1) It sets up the range of an analog output. 
2) Analog output option board offers one voltage output (DC 0 ~ 10V) and two 

current output (DC 4 ~ 20mA, DC 0 ~ 20mA). 

The input data 
type 

1) It sets up the type of a digital input. 
2) It offers four types of a digital input. 
  (Unsigned value, signed value, precise value, percentile value) 

The status of 
output 

1) It sets up the output status of a channel when it switches Run to Stop. 
2) It offers four types of output status. 
  (Former, min, middle, max value) 

 
9.6.1 Channel Output State Setting Function 

 
It sets output against PLC stop and abnormal state  

 
(1) Function 

It is used to output an already set value when PLC system switches RUN to Stop 
 

(2) Type 
You can select one among former, min, middle and max value.  
(a) Former value: keeps last normal output value 
(b) Min. value: outputs minimum value of the each output range 
(c) Middle value: outputs middle value of the each output range 
(d) Max. value: outputs max. value of the each output range. 
 

(3) Example 
When output is 10mA and range of output channel is 4~20mA, if system switches Run to Stop, 
it outputs as follows according to output state setting.  
 
(a) Former value: keeps previous output, 10mA 
(b) Min. value: outputs min. value of corresponding range, 4mA. 
(c) Middle value: outputs middle value of corresponding range, 12mA 
(d) Max. value: outputs max. value of corresponding range, 20mA. 
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9.6.2 Gain Adjustment Function 

 
You can adjust output gain of the analog output option board.  
 
When selecting current output for analog output range, the digital input (4000) corresponding to 
analog output max. value (20mA) is standard gain value. When selecting voltage output, the digital 
input (4000) corresponding to analog output max. value (10V) is standard gain value. 
 
(1) You can adjust output gain at I/O parameter 
 
(2) Output gain setting range = - 40 ~ 40 
 
(3) Adjusting gain for each channel is available 
 

  
 

(4) Example  
  When you set “Output gain” as -5, 4,005 (=4000- (-5)) applies for gain.   

 
 

Note  

(1) When you adjust the output gain, max. resolution changes, too. 
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9.7  Wiring  
 

9.7.1 Precautions for wiring  
 
(1) Don’t let AC power line at close range to output option board to prevent a surge or inductive 

noise from the A.C. side. 
(2) Select the cable with consideration of an ambient temperature and a permitted current limit. It is 

recommended over AWG22 (0.3㎟). 
(3) Don’t let the cable at close range to hot devices or materials. And don’t bring it into contact with 

oil for a long time. These are the factors of a short circuit occurs unusual operation or damages 
devices. 

(4) Check the polarity before external power is supplied to the terminal. 
(5) It may produce inductive hindrance that is a cause of unusual operations or defects if you wire 

the cable with a high-voltage line or a power line. 
(6) Enable the only channel you want to use 
 
 

9.7.2 Wiring example  
 

 

 
 

(3) Terminal block configuration 

                 
 

(1) Current output 

(2) Voltage output 

V0+

I0+

V1+

I1+

COM

XBO-DA02A

CH0

CH1

510Ω or 
less

Motor etc.

Motor etc.

2kΩ or 
above

450Ω or 

less 



Chapter 9 Analog Output Option Board (XBO-DA02A) 

9 - 11 

 

 

9.8 Operation Parameter Setting   
 

You can specify operation parameters of the analog output option board through [I/O parameters] menu in 
XG5000. 
 

(1) Setting items  
For the user’s convenience, XG5000 provides GUI (Graphical User Interface) for parameters setting of 
analog output option board. 
Followings are available through [I/O parameters] on the XG5000 project window. 

 

Item Details 
[I/O Parameters] (1) Parameter setting 

It specifies the following items for the option board operation. 

- Channel Enable/Disable 

- Analog output range (Voltage/current) 

- Input data type 

- Channel output type 

- Output gain 
(2) After the parameters that user specified in XG5000 are downloaded, 

they will be saved to a flash memory in the XGB main unit. 
 
(2) How to use [I/O Parameters] menu  

(a) Run XG5000 to create a project. (Refer to XG5000 program manual for details on how to create 
the project) 

 
(b) Double-click [I/O Parameters] on the project window. 
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(c) Click the slot of the base that contains analog output option board in the [I/O Parameter Setting] 

window.  

 
 
 
(d) Click the arrow button then you can see the menu to choose the applicable module. Select the 

applicable option board. 

 
 
 
(e) Double-click the applicable slot that is selected for the parameters setting or click [Details]. 
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(f) A screen will be displayed for you to specify parameters for respective channels as shown below. 

Click a desired item to display parameters to set for respective items. 

 
 

9.9 Special Module Monitoring Function 
 

    The function of the special module monitor is as follows. 
(1) Start of [Special Module Monitoring] 

Go through [Online]  [Connect] and [Monitor]  [Special module Monitoring] to start. If the 
status is not online, [Special Module Monitoring] menu will not be activated.  
 

 
 

 
Note  

1) The screen may not function properly if the system resources are not sufficient. In this case, close  
the screen, exit other applications, and rerun XG5000. 

2) The I/O parameters set up in [Special Module Monitor] condition are temporarily set up for testing  
purpose. Therefore, these I/O parameters are deleted after exit from [Special Module Monitor]. 

3) The test function of the [Special Module Monitor] enables testing analog output option board  
without sequence programming. 
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(2) How to use [Special Module Monitoring]  

(a) Connecting XG5000 with PLC basic unit, [Special Module List] window will show base/slot 
information and types of special module by click [Monitor]  [Special Module Monitoring].  

   Special Module List will display the modules that are installed in PLC now. 

 
 
 

(b) Select a special module then click [Module Info.] button to display the information as described 
below. 

 
 

(c) Click [Monitor] button in the [Special Module List] window to display the [Special Module 
Monitor] window as below 
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(d) [Start Monitoring] button will show you digital input data of the operating channel.  

Output monitoring

Detailed 
information of 
output CH0

 
[Start Monitoring] execution screen 

 
(e) [Test] is used to change the parameters of the voltage output module. You can change the 

parameters when you click the values at the bottom of the screen. It is only available when 
XGB CPU unit’s status is in [Stop Monitoring]. 

                     

 
[Test] execution screen 

 
(f) [Close] is used to escape from the monitoring/test screen.  

    When closing the “Monitoring/Test” screen, the setting value is not saved anymore.
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9.10 Register U devices (special module variable) 
 

Register the variables for each option board referring to the special module information that is set in the 
I/O parameter. The user can modify the variables and comments. 

  
 (1) Registration sequence 

(a) Select a special module type in [I/O Parameter Setting] window.  

 
 

 
(b) Double-click [Variable/Comment] from the project window. 

 
 

(c) Select [Edit]  [Register U Device]. 
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(d) Click ‘Yes’. 

 
 

(e) As shown below, the variables are registered. 

 
 
 

 
(2) Save variables 

(a) The contents of ‘View Variables’ can be saved as a text file 
(b) Click [Edit]  [Export to File]. 
(c) The contents of ‘View Variable’ are saved as a text file.  
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(3) View variables in a program 
   

The figure below present examples of use in XGB compact “E” and “S” types 
 
(a) The example of XG5000 is shown below.  

 
 

(b) Select [View]  [Variables]. The devices are changed into variables. 

 
 

(c) Select [View]  [Devices/Variables]. Device and variable both are displayed. 
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(d) Select [View]  [Devices/Comments]. Device and comment both are displayed. 
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  (e) Select [View]  [Variable/Comments]. Variable and comment both are displayed. 
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(f) For IEC type also, as shown in Fig. (a) ~ (e), you can look up variables with 

           diversified options in the ‘View’ menu. The figure below is the case of an IEC type 
           with which the ‘View Device/Variables’ option. 
 

 



XGB Analog edition manual  

9 - 22 

 

 

9.11 Internal memory  
 

Describes configuration and function of internal memory 
 
9.11.1 Data I/O area 

Describes data I/O area  

Variable name Type Device assignment Description R/W Signal 
direction XBC IEC 

_0y_ERR BIT U0y.00.0 %UX0.y.0 Module Error 
R Option → CPU 

_0y_RDY BIT U0y.00.F %UX0.y.15 Module Ready 

_0y_DA0_ACT BIT U0y.01.2 %UX0.y.16 CH0 active 
R Option → CPU 

_0y_DA1_ACT BIT U0y.01.3 %UX0.y.17 CH1 active 

_0y_DA0_ERR BIT U0y.01.A %UX0.y.20 CH0 error 
R Option → CPU 

_0y_DA1_ERR BIT U0y.01.B %UX0.y.21 CH1 error 

_0y_DA0_OUTEN BIT U0y.06.0 %UX0.y.24 CH0 output state setting 
W Option ↔ CPU 

_0y_DA1_OUTEN BIT U0y.06.1 %UX0.y.25 CH1 output state setting 

_0y_DA0_DATA WORD U0y.07 %UW0.y.4 CH0 input value W Option ↔ CPU 

_0y_DA1_DATA WORD U0y.08 %UW0.y.5 CH1 input value W Option ↔ CPU 

 
 

- In the device allocation, the small letter ‘y’ is the No. of the slot where the module is installed. 
- For example, to Write the ‘CH0 Output A/D Value’ of the analog module installed in the slot 9, write in 

U09.07 (%UW0.9.7 for IEC types) 

Device Type

U 0 9 . 0 7

Slot No.
Word

[XBC type]

Word classifier

                   

Device Type
Slot No.

Base No

Word

[IEC type]

 % U W 0 . 9 . 7
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(1) Module Ready/Channel Error information ( ( ) is for IEC types, y: slot No.)  

(a) U0y.00.F(%UX0.y.15): It will be ON when PLC CPU unit is powered or reset with the condition 
that an analog option board has prepared to convert. 

(b) U0y.00.0(%UX0.y.0): It is the flag which displays error status of each channel in the analog option 
board. 

 
bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

-----------

Uty.tt
(iUWt.y.t)

 

E..o. occu..ence 
info.)ation
Bit On (1): e..o.
Bit Off (0): No.)a(

R
e
a
d
y

E
rro

r- - -

 

Mo u(e READY
Bit On (1): No.)a(
Bit Off (0): e..o.

 
 

(2) Channel operation information ( ( ) is for IEC types, y: slot No.) 
(a) This area is used to display the channel being used and channel error information. 

 
bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

- -CH1 CH0------

U0y.01
(%UW0.y.1)

 

Operating CH 
information
Bit On (1): operating
Bit Off (0):  stop

- -- -CH1 CH0

 

CH error information
Bit On (1): error
Bit Off (0): normal

 
 
(3) Output setting ( ( ) is for IEC types, y: slot No.) 

(a) Each channel can be specified enable/disable the analog output. 
(b) If the output is not specified, output of all the channels will be disabled. 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

CH1 CH0------

Uty.t6
(iUWt.y.6)

 

Output setting
Bit On (1): enab(e output
Bit Off (0):  isab(e output

---- ----

 
(4) Digital input ( ( ) is for IEC types, y: slot No.) 

(a) Digital input value can be selected and used within the range of unsigned value (0~4047), signed 
value (-2000~2047), precise value and percentile value (0~1011) based on input type. 

(b) If the digital input value is not specified, it will be set to 0. 
bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Output CH0 input valueUty.t7
liUWt.y.7)

Output CH1 input valueUty.t8
liUWt.y.8)
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9.11.2 Setting area of operation parameters 
 

Memory 
address Description Setting value R/W Instruction 

0 Enable CH Bit Off (0): disable, bit On (1): enable R/W 

PUT/GET 

1 Output range setting 

Input range setting (4 bit per channel) 
0: 4 ~ 20 ㎃ 
1: 0 ~ 20 ㎃ 
2: 0 ~ 10 V 

R/W 

2 Input data type setting 

Input data type setting  
(4 bit per channel) 
0: 0 ~ 4000 
1: -2000 ~ 2000 
2: Precise value 
3: 0 ~ 1000 
- In case of precise value 
4 ~ 20 ㎃: 400 ~ 2000 
0 ~ 20 ㎃: 0 ~ 2000 
0 ~ 10 V: 0 ~ 1000 

R/W 

8 CH output state setting 

CH output state setting (4bit per channel) 
0: Former value 
1: min value 
2: middle value 
3: max value 

R/W 

11 Output CH0 gain weighting 
-40 ~ 40 

R/W 

12 Output CH1 gain weighting R/W 

13 Setup error information 

50#: output ch range setting error 
60#: output ch data type setting error 
70#: output ch output state setting error 
80#: output ch gain weighting setting error 
90#: output ch input value excess error 
(#: channel number) 

R GET 
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(1) Operating Channel Setting (address 0) 
(a) You can set “Enable/Disable” of analog output option board per each channel  
(b) Disable the unused channels to reduce the conversion period. 
(c) Default value is “Disable” for all channels 
(d) When using PUT instruction, address is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

- -

O
ut
pu
t C
H

1

O
ut
pu
t C
H

0

------

Addresst 

 

Enable CH
Bit On (1): enable
Bit Off (0):  isable

---- --

 
 
(e) The values set in bit 2~15 are ignored. 
(f)This area is same as setting in “Channel status” of I/O parameter  
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(2) Output range setting area (address 1) 

(a) Set the type of output range with the following code 
   

Bit (HEX) Input range 
0000 (0) 4 ~ 20 ㎃ 
0001 (1) 0 ~ 20 ㎃ 
0010 (2) 0 ~ 10 V 

 
(b) If you set more than 3, 0 (4~20㎃) will be set forcibly  

But, U0X.01.A~ U0X.01.B (Setup error flag) will be ON. 
(c) When using PUT instruction, address is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Output CH 0

Addressu

 

Output range (4bit per channel)
0 : 4 ~ 20 ㎃
1 : 0 ~ 20 ㎃
2 : 0 ~ 10 V

Output CH 1---- ----

 
(d) The values set in bit 8~15 are ignored. 
(e)This area is same as setting in “Output range” of I/O parameter  
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(3) Input data type setting area (address 2) 

(a) Set the type of input data type with the following code  
Bit (HEX) Input data type 
0000 (0) 0~4000 
0001 (1) -2000~2000 
0010 (2) Precise value 
0011 (3) 0~1000 

 
In case of precise value, input data type is designated as the following value according to each 
output range type 

 
Output range Precise value 

4 ~ 20 ㎃ 400 ~ 2000 
0 ~ 20 ㎃ 0 ~ 2000 
0 ~ 10 V 0 ~ 1000 

 
 
 (b) If you set more than 4, 0 (0~4000) will be set forcibly. 

But, U0X.01.A~ U0X.01.B (Setup error flag) will be ON. 
 (c) When using PUT instruction, address is as follows 
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

Output CH 0

Address2

 

Input  ata type (4bit per channel)
0 : 0 ~ 4000
1 : -2000 ~ 2000
2 : precise 2alue
3 : 0 ~ 1000

Output CH 1

- In case of precise 2alue
   4 ~ 20 ㎃: 400 ~ 2000
   0 ~ 20 ㎃: 0 ~ 2000
   0 ~ 10 V: 0 ~ 1000

---- ----

 
(d) The values set in bit 8~15 are ignored. 
(e)This area is same as setting in “Input type” of I/O parameter  
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(4) Channel output state setting area (address 8) 

(a) Set the output state setting with the following code  
 

Bit (Hex) Channel output state 
0000 (0) Former value 
0001 (1) Min value 
0010 (2) Middle value 
0011 (3) Max value 

 
 
 (b) If you set more than 4, 0 (former value) will be set forcibly. 

But, U0X.01.A~ U0X.01.B (Setup error flag) will be ON. 
 (c) When using PUT instruction, address is as follows 
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

Output CH 0

Address8

 

Input  ata type (4bit per channel)
0 : Former value
1 : Min value
2 : Mi  le value
3 : Max value

Output CH 1---- ----

 
(d) The values set in bit 8~15 are ignored. 
(e)This area is same as setting in “CH. Output type” of I/O parameter  
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(5) Output gain weighting setting area (address 11~12) 

(a) Set output gain weighting with value of -40~40  
(b) If you set this as 0 (default value), 4000 will apply for gain value  
(c)For example, if you set this as -10, 4010 (=4000-(-10)) will apply for gain value 
(d) When using PUT instruction, address is as follows 
 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Output CH0 gain (-40 ~ 40)Addressuu

Output CH1 gain (-40 ~ 40)Addressu2 
 

 
(e) This area is same as setting in “Output gain” of I/O parameter  
 

 
 

(6) Setup error information output area (address 13) 
(a) Saves error code detected when setting (setting by program) 
(b) Setting error is canceled when value is reset to make it in the valid range  
(c) When U0X.01.A~ U0X.01.B (setting error flat) is on, check that area and fix the corresponding 

setting to cancel the error 
(d) When using GET instruction, address is as follows 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Setting error informationAddress13
 

 

Type Error 
code Description Priority Remark 

Setting 
error 

50# Output CH range setting error 2 

#: CH number 
Output CH 0,1 

60# Output CH data type setting error 3 
70# Output CH state setting error 4 
80# Output CH gain weighting setting error 5 
90# Output CH input value excess error 1 

 
(e) When more than two errors occur simultaneously, it saves error code having higher priority.  
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9.12 Example Program 
 

(1) This sample program sets up operating parameters of analog output option board. 
(2) Initial settings are saved in the internal memory of the XGB main unit by one input. 
(3) The sample program below controls the I/O data of the analog output option board at option slot 

#0 (I/O slot #9) and check open wire. 
 

9.12.1 Example of [I/O Parameter] Usage 
 

(1) I/O Parameter Setting Window 
 

 
 

 
 
(a) Output Channel 0 is set to operating channel and output range is set to 4~20mA. 
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(2) Sample Program(XBC Type) 

 
 

(a) When the option board is in normal operation, M0000 is turned On. 
U09.00.0 (Module Error) = Off 
U09.00.F (Module Ready) = On 
U09.01.2 (Output Channel 0 in-operation) = On 
U09.01.A (Output Channel 0 Error) = Off 

(b) When M0000 is ON, it turns on CH0 output state (U09.06.0) and allows output   
(c) When M0000 is ON, D00100 data is moved to output CH0 Output value (U09.07) and outputs. 
 
 

 
(3) Sample Program/(IEC Type) 

 
 

(a) When the option board is in normal operation, %MX0 is turned On. 
%UX0.9.0 (Module Error) = Off 
%UX0.9.15 (Module Ready) = On 
%UX0.9.18 (Output Channel 0 in-operation) = On 
%UX0.9.26 (Output Channel 0 Error) = Off 

(b) When M0000 is ON, it turns on CH0 output state (%UX0.9.96) and allows output   
(c) When %MX0 is ON, CH0_Output_Value data is moved to output CH0 Output value 

(%UW0.9.7) and outputs. 
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9.13 Troubleshooting  
 

This section describes methods for idetifying the troubles which may occur during the operation of analog 
output option board, and their solutions.  
 

9.13.1 Troubleshooting 
 
      (1) Analog output value is abnormal. 
 

Analog output value is abnormal.

Installation is OK.

Install the option board properlyd No

Yes

FG ground is OK

Correct FG grounding according to the wiring 
in the user manual

d No

Yes

Wiring is OK
(Current output wiring, voltage output 
wiring)

Refer to the manual and wire properlyd No

Yes

Parameter setting is OK
(Operation channel permit, I/O range 
setting

Set up the parameters correctly according to 
the user manual

d No

Yes

Contact nearest dealer or A/S center
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Chapter 10 Analog I/O Option Board 

 

10.1 Setting Sequence before operation 
 

Before using the analog I/O option board, follow steps below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 

 

XBO-AH02A 

 

 

 

 

 Checking performance specification 

Wiring 

Reading/writing analog I/O data 

Setting parameter 

Programming 

Specification (10.2.2 performance specification) 
 Operating environment 
 I/O type and range 
 Digital I/O range 
 Analog I/O range 

Wiring 
 Wiring analog I/O 

Analog I/O test 
 XG5000 special module monitor test mode 

Parameter 
 XG5000 I/O parameter 

Programming 
 Programming for reading/writing 

analog data (U device) 
  

 Refer to trouble shooting when there is 
error or analog I/O data is not normal 
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10.2 Specifications 
 

10.2.1 General specifications 
General specifications are as follows. 

 

 
 

No. Items Specification Related 
standards 

1 
Operating 

temperature 
0 ~ 55 °C − 

2 
Storage 

Temperature 
−25 ~ +70 °C − 

3 
Operating 
humidity 

5∼95%RH (Non-condensing) − 

4 
Storage 
humidity 

5∼95%RH (Non-condensing) − 

5 
Vibration 
immunity 

For discontinuous vibration - − 

Frequency Acceleration Amplitude Times 

IEC61131-2 

10  ≤ f <  57㎐ − 0.075㎜ 

Each 10 
times in 
X,Y,Z 

directions 

57  ≤ f ≤  150㎐ 9.8㎨ (1G) − 

For continuous vibration 

Frequency Acceleration Amplitude 

10  ≤  f  <  57㎐ − 0.035㎜ 

57  ≤ f ≤  150㎐ 4.9㎨ (0.5G) − 

6 
Shocks 

immunity 

•  Max. impact acceleration : 147 m/s2(15G) 
•  Authorized time : 11ms 
•  Pulse wave : Sign half-wave pulse (Each 3 times in X,Y,Z 
 directions) 

IEC61131-2 

7 
Noise 

immunity 

Square wave 
impulse noise 

AC : ±1,500 V 
DC :  ± 900 V 

LSIS standard 

Electrostatic 
discharging 

Voltage : 4㎸ (contact discharging) 
IEC61131-2 

IEC61000-4-2 
Radiated 

electromagnetic 
field noise 

80 ~ 1,000 ㎒,  10V/m 
IEC61131-2, 

IEC61000-4-3 

Fast 
Transient 

/burst 
noise 

Segment Power 
module 

Digital/ 
Analog I/O 

communication interface IEC61131-2 
IEC61000-4-4 

Voltage 2㎸ 1㎸ 

8 
Ambient 

conditions 
No corrosive gas or dust − 

9 
Operating 

height 
2000m or less − 

10 
Pollution 
degree 

2 or less − 

11 Cooling type Natural air cooling − 
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10.2.2 Performance specifications 
Performance specifications are as follows. 

(1) Input performance specification  

Items Input performance specification 
Number of channels 1 channel 

Analog 
input 
range 

Type Voltage Current 

Range 

DC 0 ~ 10V 
(Input resistance: 1㏁ Min.) 

DC 4 ~ 20㎃ 
DC 0 ~ 20㎃ 
(Input resistance: 250 Ω) 

Set by external voltage/current wiring after being set at user program 
or I/O parameter per each channel 

Digital 
output 

Type 12 bit binary data 

Range 

Unsigned 
value 0 ~ 4000 

Signed value -2000 ~ 2000 
Precise 
value 

0 ~ 1000 (DC 0 ~ 10V) 
400 ~ 2000 (DC 4 ~ 20㎃) 
0 ~ 2000 (DC 0 ~ 20㎃) 

Percentile 
value 

0 ~ 1000 

Max. resolution 
1/4000 (DC 4~20㎃: 1/3200) 

2.5㎷ (DC 0~10V) 
5㎂ (DC 0~20㎃) 
6.25㎂ (DC 4~20㎃) 

Accuracy ±1.0% or less 
Max. conversion speed 1ms/channel + scan time 

Absolute max. input DC +12V / -10V DC ±25㎃ 

Additional 
function 

Average function Count average (2 ~ 64,000 times) 
Gain adjustment  

function 
Gain adjustment (-40~40) 
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(2) Output performance specification 
Items Output performance specification 

Number of channels 1 channel 

Analog 
output 
range 

Type Voltage Current 

Range 

DC 0 ~ 10V 
(Load resistance: 2kΩ Min.) 

DC 4 ~ 20㎃ 
DC 0 ~ 20㎃ 
(Load resistance: 450 Ω Max.) 

Set at user program or I/O parameter per each channel per each 
channel 

Digital 
input 

Type 12 bit binary data 

Range 

Unsigned 
value 

0 ~ 4000 

Signed value -2000 ~ 2000 
Precise 
value 

0 ~ 1000 (DC 0 ~ 10V) 
400 ~ 2000 (DC 4 ~ 20mA) 
0 ~ 2000 (DC 0 ~ 20mA) 

Percentile 
value 

0 ~ 1000 

Max. resolution 
1/4000 (DC 4 ~ 20㎃: 1/3200) 

2.5㎷ (DC 0~10V) 
5㎂ (DC 0~20㎃) 
6.25㎂ (DC 4~20㎃) 

Accuracy ±1.0% or less 
Max. conversion speed 1ms/channel + scan time 

Additional function 
CH output status setting  
(select among former, min, middle, max value) 
Gain adjustment function 

 
 

(3) I/O Common performance specification 
Items I/O common performance specification 

Insulation method Non-insulation betweens analog I/O channels 
Non-insulation between I/O terminal and PLC main unit 

I/O terminal 5-point terminal block 
I/O occupation point Fixed type: 64 points 

Supply power Internal DC5V 
Consumption current 150㎃ 

Weight 20g 
 

Note1) In order to use analog I/O option board, the following version is needed. 
 

Main unit Version information 
XBC E type V1.1 or above 
XBC S type V1.1 or above 

XBC SU type V1.0 or above 
XEC E type V1.0 or above 

XEC SU type V1.0 or above 
XG5000 V.3.61 

 
Note2) Offset/gain value on the analog output range can be adjusted at XG5000- I/O parameter 
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10.3 Name of Part and Function 
 

 
Respective designations of the parts are as described below. 
 
   

① Hook for fixation

② Terminal block

③ Cover

④ Hook for fixation

⑤ Connector for
    option board

⑥ Input
    connector

35.0mm

49.0mm

10.3mm

 

 
No. Name Description 

①④ Hook for fixation ▶ Hook for fixing the option board to main unit 

② Terminal block 
▶ Wiring terminal block to connect with external device 

(Analog Input/Output) 

③ Cover ▶Option board cover 

⑤ 
Connector for option 
board 

▶Connection connector for connecting the option board to the main 
unit 

⑥ Input connector ▶Wiring connector for connecting with the external device 
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10.4 Characteristic of I/O conversion 
 

The input ranges of voltage and current can be set up per channel with user program or I/O 
parameters. The output types of digital data are defined as follows. 

(1) Unsigned Value 
(2) Signed Value 
(3) Precise Value 
(4) Percentile Value 

10.4.1 Input characteristic  
Data conversion characteristic per input range is as follows. 

 

Digital 
output

0

1000

2000

3000

4000
4047

-2000

-1000

0

1000

2000
2047

0

250

500

750

1000
1011

DC 4 ~ 20 mA

DC 0 ~ 20 mA

DC 0 ~ 10 V

4 mA 20 mA12 mA

0 mA

0 V 5 V 10 V

Analog 
input

Analog input practical 
range

Offset

Gain

20 mA10 mA

-48-2048-12

 
 

 
 (1) DC 4 ~ 20mA Range Input 

Digital  
Output Range 

Analog Input Current (mA) 
3.81 4 8 12 16 20 20.18 

Unsigned Value 
(0 ~ 4000) -48 0 1000 2000 3000 4000 4047 

Signed Value 
(-2000 ~ 2000) -2048 -2000 -1000 0 1000 2000 2047 

Precise Value 
(400 ~ 2000) 381 400 800 1200 1600 2000 2018 

Percentile 
Value(0 ~ 1000) -12 0 250 500 750 1000 1011 
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(2) DC 0 ~ 20mA Range Input 
Digital  

Output Range 
Analog Input Current (mA) 

-0.24 0 5 10 15 20 20.23 
Unsigned Value 
(0 ~ 4000) 

-48 0 1000 2000 3000 4000 4047 

Signed Value 
(-2000 ~ 2000) 

-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 
(0 ~ 2000) 

-24 0 500 1000 1500 2000 2023 

Percentile Value 
(0 ~ 1000) 

-12 0 250 500 750 1000 1011 

 
 
 (3) DC 0 ~ 10V Range Input 

Digital  
Output Range 

Analog Input Voltage  (V) 
-0.12 0 2.5 5 7.5 10 10.11 

Unsigned Value 
(0 ~ 4000) 

-48 0 1000 2000 3000 4000 4047 

Signed Value 
(-2000 ~ 2000) 

-2048 -2000 -1000 0 1000 2000 2047 

Precise Value 
(0 ~ 1000) 

-12 0 250 500 750 1000 1011 

Percentile Value 
(0 ~ 1000) 

-12 0 250 500 750 1000 1011 
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10.4.2 Output characteristic  

Data conversion characteristic per output range is as follows. 
 

Digital 
input

0

1000

2000

3000

4000
4047

-2000

-1000

0

1000

2000
2047

0

250

500

750

1000
1011

DC 4 ~ 20 mA

DC 0 ~ 20 mA

DC 0 ~ 10 V

4 mA 20 mA12 mA

0 mA

0 V 5 V 10 V

Analog 
output

Analog output practical 
range

Offset

Gain

20 mA10 mA

 
(1) DC 4~20mA range output 

Digital input 
range 

Analog output current (mA) 
4mA or 

less 4 8 12 16 20 Over 
20mA  

Unsigned value 
(0 ~ 4000) 

0 or less 0 1000 2000 3000 4000 Over 4000 

Signed value 
(-2000 ~ 2000) 

-2000 or 
less 

-2000 -1000 0 1000 2000 Over 2000 

Precise value 
(400 ~ 2000) 

400 or less 400 800 1200 1600 2000 Over 2000 

Percentile value 
(0 ~ 1000) 

0 or less 0 250 500 750 1000 Over 1000 

 
(2) DC 0 ~ 20mA range output 

Digital input 
range 

Analog output current (mA) 
0mA or 

less 0 5 10 15 20 Over 
20mA  

Unsigned value 
(0 ~ 4000) 

0 or less 0 1000 2000 3000 4000 Over 4000 

Signed value 
(-2000 ~ 2000) 

-2000 or 
less 

-2000 -1000 0 1000 2000 Over 2000 

Precise value 
(0 ~ 2000) 

0 or less 0 500 1000 1500 2000 Over 2000 

Percentile value 
(0 ~ 1000) 

0 or less 0 250 500 750 1000 Over 1000 
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 (3) DC 0 ~ 10V range output 

Digital input 
range 

Analog output voltage (V) 
0V or less 0 2.5 5 7.5 10 Over 10V 

Unsigned value 
(0 ~ 4000) 

0 or less 0 1000 2000 3000 4000 Over 4000 

Signed value 
(-2000 ~ 2000) 

-2000 or 
less 

-2000 -1000 0 1000 2000 Over 2000 

Precise value 
(0 ~ 2000) 

0 or less 0 250 500 750 1000 Over 1000 

Percentile value 
(0 ~ 1000) 

0 or less 0 250 500 750 1000 Over 1000 

 

 

Note  

 (1) There is “Dead Band” area around voltage output (0V), current output (0mA). 
(a) Digital input-based: about 0 ~ 10  
(b) Analog output-based: voltage(about 0 ~ 25㎷), current (about 0 ~ 50㎂) 

(2) In “Dead Band” area, digital input and analog output may not coincide (within accuracy) 
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10.5 Accuracy 
 

10.5.1 Input accuracy 
 
Accuracy of digital output value does not changed even if input range is changed. Figure below shows 
the range of the accuracy with analog input range of 0 ~ 10 V and digital output type of unsigned value 
selected.  
Accuracy of XBO-AH02A is ±1.0%. 

 

0

0V 5V

2000

10 V

4000

Analog input voltage

D
igital output value

3980

4020

-20

20

 
           [ Accuracy ] 

      
 

(1) Accuracy when using 5V input 
4000 × 1.0% = 40 
Therefore the range of the accuracy will become (2000-40) ~ (2000+40) = 1960 ~ 2040  
when using 5V input. 

 
(2) Accuracy when using 10V input  
4000 × 1.0% = 40 
Therefore the range of the accuracy will become (4000-40) ~ (4000+40) = 3960 ~ 4040  
when using 10V input. 
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10.5.2 Input accuracy 
 

Accuracy for analog output value does not changed even if output range is changed. Figure below 
shows the range of the accuracy with analog output range of 0 ~ 10 V and digital output type of 
unsigned value selected.  
Accuracy of XBO-DA02A is ±1.0%. 

 

2000 40000

10V

0V

5V

10.1V
9.9V

0.1V
-0.1V

Digital input

A
na
lo
g 
ou
tp
ut

20mA
20.2mA
19.8mA

0mA
0.2mA

-0.2mA

10mA

 
 

 
 (1) Accuracy in case of 5V output 
 4000 × 1.0% = 40 
 So in case of 5V output, accuracy range is  
(5V - 40×0.0025V) ~ (5V+40×0.0025V) = 4.9 ~ 5.1V 

 
 (2) Accuracy in case of 10V  
 4000 × 1.0% = 40  
So in case of 10V output, accuracy range is  
(10V-40×0.0025V) ~ (5V+40×0.0025V) = 9.9 ~ 10.1V 
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10.6 Functions of Analog I/O Option Board 
 

 The functions of XBO-AH02A analog I/O option board are as follows.  
 

Function Description 
Channel 

operation/stop setting 
● Specify operation/stop of the channel which will perform A/D, D/A conversion 
● Specifying unused channels as Stop can shorten overall operation time. 

I/O Voltage/current 
range setting 

● Specify desired range of analog I/O. 
● Select voltage/current with external switch, and set up range with parameter. 
● Analog I/O option board provides 2 ranges(4~20mA, 0~20mA) of current I/O and 1 
range ( 0~10V) of voltage I/O. 

I/O data type setting 
● Specify digital I/O types. 
● This option board provides 4 output data types (Unsigned, Signed, Precise, and 
Percentile Values) 

A/D input conversion 
method 

● Sampling Process 
- If A/D conversion method has not been specified, it processes sampling. 

● Averaging process 
- Outputs A/D converted value averaged by count to reduce rapid change of input 

value caused by external noise 

D/A output status 
setting 

● When switching form RUN to STOP, it sets output status of channel 
● Provides 4 types of output status (former, min, middle and max value) 

 
 
 

10.6.1 Sampling Process 
In popular A/D conversion process, analog input signals are collected at constant time intervals and 
A/D converted. The time elapsed for the analog signals to be converted into digital signals and 
saved in memory device depends upon the number of channels used.  

 
(Process Time) = (No. of Channels Used) x (Conversion Speed + Scan time) 

 
(Ex.) Process time when using 1 of 2 I/O channels and scan time is 2㎳;  

1  x  (1 ㎳ +  2㎳)  =  3 ㎳ 
 
The term ‘sampling’ means taking sample value among continuous analog signal values at regular 
intervals. 

  
 
 

.  
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10.6.2 Count Averaging Function 
 

The input values of the designated channel are accumulated for the preset cycles, and the average 
value of the total sum is outputted in digital data. 

Channel Scanning Intervals (1ms/Ch. Used)

Averaged input value 
Actual input value

Averaging 
Section

Averaging 
Section

Sampling 
Section  

Setting Range = 2 ~ 64000 [times] 
For count averaging, averaging interval is calculated with the No. of channels used. 
 
 
Averaging interval [ms] = Averaging count x (No. of channels used x1ms + Scan time) 

 
 

 

 

Note  

(1) Averaging interval varies according to scan time  
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10.6.3 Channel Output State Setting Function 

 
It sets output against PLC stop and abnormal state  
 
(1) Function 

It is used to output an already set value when PLC system switches RUN to Stop 
 

(2) Type 
You can select one among former, min, middle and max value.  
(a) Former value: keeps last normal output value 
(b) Min. value: outputs minimum value of the each output range 
(c) Middle value: outputs middle value of the each output range 
(d) Max. value: outputs max. value of the each output range. 
 

(3) Example 
When output is 10mA and range of output channel is 4~20mA, if system switches Run to Stop, 
it outputs as follows according to output state setting.  
 
(a) Former value: keeps previous output, 10mA 
(b) Min. value: outputs min. value of corresponding range, 4mA. 
(c) Middle value: outputs middle value of corresponding range, 12mA 
(d) Max. value: outputs max. value of corresponding range, 20mA. 
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10.6.4 Gain Adjustment Function 
 

You can adjust I/O gain of the analog I/O option board.  
 
When selecting current input for analog input range, the digital output (4000) corresponding to analog 
input max. value (20mA) is standard gain value. When selecting voltage input, the digital output 
(4000) corresponding to analog input max. value (10V) is standard gain value. 
 
(1) You can adjust input gain at I/O parameter 
 
(2) I/O gain setting range = - 40 ~ 40 
 
(3) Adjusting gain for each channel is available 
 

 
  
 

(4) Example  
  When you set “Input gain” as -5, 4005 (=4000-(-5)) applies for gain.   

 
 

Note  

(1) When you adjust the I/O gain, max. resolution changes, too. 
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10.7 Wiring  
 

10.7.1 Precaution for wiring  
(1) Don’t let AC power line near to A/D conversion module’s external input sign line. With an enough 

distance kept away between, it will be free from surge or inductive noise. 
 (2) Cable shall be selected in due consideration of ambient temperature and allowable current, 

whose size is not less than the max. cable standard of AWG22 (0.3㎟). 
 (3) Don’t let the cable too close to hot device and material or in direct contact with oil for long, which 

will cause damage or abnormal operation due to short-circuit. 
 (4) Check the polarity when wiring the terminal. 
 (5) Wiring with high-voltage line or power line may produce inductive hindrance causing abnormal 

operation or defect. 
 (6) Enable only needed channels  

 
10.7.2 Terminal block configuration 
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10.7.3 Analog input wiring example  
 
(1) Current input wiring example 
 

+

-

CH0

V0+

I0+

V0+

I0+

COM

R
R

R
*(b)

XBO-AH02A

*(a)

INPUT

OUTPUT

 
  

*(a) In case of current input, connect V+ terminal to I+ terminal  
*(b) Input resistance of current input circuit is 250 Ω (typ.). 
 

(2) Voltage input wiring example 
 

+

-

CH0

V0+

I0+

V0+

I0+

COM

R
R

R

XBO-AH02AINPUT

OUTPUT

*(a)

 
 
*(a) Input resistance of voltage input circuit is 1 MΩ (min.)  
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(3) Relationship between voltage input accuracy and wiring length 
In voltage input, the wiring (cable) length between transmitter or sensor and option board has an 
effect on digital-converted values of the option board as specified below; 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
       

 
 

 
Where,        
 
Rc: Resistance value due to line resistance of cable 

        
       Rs: Internal resistance value of transmitter or sensor 
 
       Ri: Internal resistance value (1㏁) of voltage input module 
  
       Vin: Voltage allowed to analog input module  
 
       % Vi: Tolerance of converted value (%) due to source and cable length in voltage input 
 
 

                 ( )[ ]RiRcRs
VsRiVin

+×+
×

=
2

  

 
 

1001% ×





 −=

Vs
VinVi %  

 
 

Vs 

Rs Rc 

Rc 
Ri 

Load 
 

Analog input (Voltage) 

Vin 
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10.7.4 Analog output wiring example 

 
 
(1) Current output wiring example 
 

V0+

I0+

V0+

I0+

COM

R
R

R

XBO-AH02AINPUT

OUTPUT

510Ω or 
less

Motor etc.

 
 
 
 
(2) Voltage output wiring example 
 

INPUT

OUTPUT

2kΩ or 
above

Motor etc.

V0+

I0+

V0+

I0+

COM

R
R

R

XBO-AH02A

 

450Ω or 

less 

2㏀ or 

above 
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10.8 Operation Parameter Setting 
 

Analog I/O option board’s operation parameters can be specified through XG5000’s [I/O parameters]. 
 

(1) Settings 
For the user’s convenience, XG5000 provides GUI (Graphical User Interface) for parameters setting 
of analog option board. Setting items available through [I/O parameters] on the XG5000 project 
window are as described below in the table.  

 

Item Details 

[I/O parameter] 

(a) Input parameter setting  
Specify the following setting items necessary for the option board 
operation. 
1) Channel Enable/Disable setting 
2) Setting ranges of input voltage/current 
3) Output data format setting 
4) Count averaging 
5) Input gain 

(b) Output parameter setting 
Specify the following setting items necessary for the option board 
operation. 

1) Channel Enable/Disable 

2) Analog output range (Voltage/current) 

3) Input data type 

4) Channel output type 

5) Output gain 
 
(c) If downloading is complete, Parameter set by user in XG5000 is saved  

in Flash memory of XGB main unit.  
 

(2) Usage of [I/O Parameter] 
(a) Create a project with XG5000. See XG5000 Program Manual for project creation. 
(b) In the Project window, double-click [I/O Parameter]. 
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(c) In the [I/O Parameter Setting] window, find out the slot of the base where the analog input 
option board is installed, and click it.  

 
 

(d) In the above window, click the arrow button to call the window where the module can be 
selected. Find out the module and select it.  

 
 

 (e) To set up parameter, double click with the respective slot being selected, or click [Detail] button. 
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(f) The window below where parameters can be set up by channel appears. Click the item to set 

up. The parameters which can be set up appear by item.  

 

 

 

 
The functions of the special module monitor are as follows. 
 

(1) Start-up of [Special Module Monitor] 
Select [Online] -> [Connect], and [Monitor] -> [Special Module Monitor] to start up. [Special Module 
Monitor] menu is enabled only in the [Online] condition. 

 

 
 

 
Note  

1) The screen may not function properly if the system resources are not sufficient. In this case, close  
the screen, exit other applications, and rerun XG5000. 

2) The I/O parameters set up in [Special Module Monitor] condition are temporarily set up for testing  
purpose. Therefore, these I/O parameters are deleted after exit from [Special Module Monitor]. 

3) The test function of the [Special Module Monitor] enables testing analog input option board without  
sequence programming. 

 
 
 

10.9 Special Module Monitoring Functions 
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(2) Usage of [Special Module Monitor] 
(a) With the XG5000 in connection (online) with the base unit of PLC, select [Monitor] -> 

[Special Module Monitor]. The Select Special Module window shown below will appear 
showing the type of the special modules and base/slot information. In the list dialog, the 
modules present in the PLC system are displayed. 

                 
 
(b) In the above window, select the special module and click [Module Info.] to see the 

information window below.  

 
 
(c) Click the [Monitor] button in the “Special Module” window. The “Special Module Monitor’ 

window will appear as shown below.  
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(d) [Start Monitoring]: click [Start Monitoring] to look up the digital input data of the channel 

currently in operation. The screen shot below is a monitoring window when all the 
channels are in operation status.  

Detailed 
information of 
output CH0

Output monitoring

Input monitoring

Detailed 
information of input 

CH0

 
The screen executing [Start Monitoring]  

 
(e) [Test]: this function is used to change the current parameter settings of the analog mix 

module. Click the settings in the fields in the bottom screen to change the parameters. 
[Test] can be set up only when the operation status of the XGB base unit is STOP mode. 

 
        The screen executing [Test] 
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(f) Minimum/Maximum Value Monitoring  
    The minimum and maximum values of the input channels in operation can be monitored. 

However, the Max/Min values in the window are based on the current value. Therefore, 
the Max/Min values are not saved when exiting from the [Monitoring/Testing Screen]. 

Max/Min value 
monitoring

Max/Min value 
reset

 
 
The screen executing [Max/Min Value Monitoring]  
 

 
(g) Close 

[Close] button is for ending/closing the monitoring/testing screen. Maximum, 
minimum, and current values are not saved at exit. 
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10.10 Register U devices 
 

The variables for each module are automatically registered by referring to the information of the special 
modules set up in the [I/O Parameter]. User can modify variables and descriptions. 

 
(1) Registration Procedure 
     (a) In [I/O Parameter], set up special module in slot. 

 
 
     (b) Double click [Variables/Comment]. 

 
 

     (c) In the ‘Edit’ menu, select ‘Register U device’ 
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(d) Click ‘Yes.’ 

 

 
 
 (e) Variables are registered as shown below.  

 
 

  
(2) Saving Variables 

(a) The contents in the ‘View Variables’ tab can be saved in a text file. 
 (b) In the ‘Edit’ menu, select ‘Save as Text File.’ 
 (c) The contents in the ‘View Variables’ tab are saved in a text file. 
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(3) Viewing Variables in Program 
 
 The figures below present examples of use in XGB compact “E” and “S” types 
 
   (a) Below is an exemplary program for XG5000.  

 
 

    (b) In the ‘View' menu, click ‘View Variables.’ The devices are changed into variables. 

 
 

(c) In the ‘View' menu, click ‘View Device/Variables’ to look up the devices and variables at 
the same time. 
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(d) In the ‘View' menu, click ‘View Device/Comment’ to look up the devices and descriptions at 
the same time. 
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(e) In the ‘View' menu, click ‘View Variable/Comment’ to look up the devices and descriptions at 

the same time. 
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(f) For IEC type also, as shown in Fig. (a) ~ (e), you can look up variables with 
           diversified options in the ‘View’ menu. The figure below is the case of an IEC type 
           with which the ‘View Device/Variables’ option. 
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10.11 Configuration and Function of Internal Memory 
 

An analog input option board has internal memory for data communication with XGB base unit. 
 
10.11.1 Analog Data I/O Area 

The table below presents the analog data I/O area. 

Variable Type Device assignment Description R/W Signal 
direction XBC IEC 

_0y_ERR BIT U0x.00.0 %UX0.0y.0 Module Error 
R Option → CPU 

_0y_RDY BIT U0x.00.F %UX0.0y.15 Module Ready 

_0y_AD0_ACT BIT U0x.01.0 %UX0.0y.16 Input CH0 Active 
R Option → CPU 

_0y_DA0_ACT BIT U0x.01.2 %UX0.0y.18 Output CH0 Active 

_0y_AD0_IDD BIT U0x.01.4 %UX0.0y.20 Input CH0 Disconnection flag R Option → CPU 

_0y_AD0_ERR BIT U0x.01.8 %UX0.0y.24 Input CH0 error 
R Option → CPU 

_0y_DA0_ERR BIT U0x.01.A %UX0.0y.26 Output CH0 error 

_0y_AD0_DATA WORD U0x.04 %UW0.0y.4 Input CH0 converted value R Option → CPU 

_0y_DA0_OUTEN BIT U0x.06.0 %UX0.0y.6 CH0 output status setting W Option ↔ CPU 

_0y_DA0_DATA WORD U0x.07 %UW0.0y.7 Output CH0 input value W Option ↔ CPU 

 
- In the device allocation, the small letter ‘y’ is the No. of the slot where the module is installed. 
- For example, to read the ‘CH0 Input A/D Value’ of the analog module installed in the slot 9, write in 

U09.05. (%UW0.9.4 for IEC types) 

Device Type

U 0 9 . 0 4

Slot No.
Word

[XBC type]

Word classifier

                   

Device Type
Slot No.

Base No

Word

[IEC type]

 % U W 0 . 9 . 4

 
- To read the ‘Ch0 Output Value’ of the analog I/O module installed in the 9th slot, write in U09.07 
(%UX0.9.7 for IEC types) 

Device Type

U 0 9 . 0 7

Slot No.
Word

[XBC type]

Word classifier

                   

Device Type
Slot No.

Base No

Word

[IEC type]

 % U W 0 . 9 . 7
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 (1) Module Ready/Error Flag ( ( ) is for IEC types, y: slot No.) 

(a) U0y.00.F(%UX0.y.15): at power on or reset of PLC CPU, turns on when the analog I/O 
conversion is ready and analog conversion is performed. 

   (b) U0y.00.0(%UX0.y.0): the flag indicating the error status of analog input option board module. 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

-----------

Uty.tt
(iUWt.y.t)

 

E..o. occu..ence 
info.)ation
Bit On (1): e..o.
Bit Off (0): No.)a(

R
e
a
d
y

E
rro

r- - -

 

Mo u(e READY
Bit On (1): No.)a(
Bit Off (0): e..o.

 
 

 
(2) Operation channel information/ channel error information flag ( ( ) is for IEC types, y: slot No.) 

This is the area for storing the operation information and channel error information by channel. 
bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

- -

O
ut
pu
t C
H

0

In
pu
t C
H

0
------

U0y.01
(%UW0.y.1)

 

Operating CH 
information
Bit On (1): operating
Bit Off (0): stop

In
pu
t C
H

0
- -

O
ut
pu
t C
H

0

In
pu
t C
H

0

 

CH error information
Bit On (1): error
Bit Off (0): normal

 

CH disconnection 
Bit On (1): disconnection
Bit Off (0): normal

-

 (3) Digital Output Values ( ( ) is for IEC types, y: slot No.) 
(a) A/D converted digital values are outputted to buffer memory address U0y.04  

    (b) Digital output values are saved in 16-bit binary figures. 
bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Input CH0 conversion valueU0y.04
(%UW0.y.4)  

 
(4) Output setting ( ( ) is for IEC types, y: slot No.) 

(a) Each channel can be specified enable/disable the analog output. 
(b) If the output is not specified, output of all the channels will be disabled 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

-

O
ut
pu
t C
H

0

------

Uty.t6
(iUWt.y.4)

 

Output status setting
Bit On (1): enab(e output
Bit Off (0):  isab(e output

---- ----

 (5) Digital input ( ( ) is for IEC types, y: slot No.) 
(a) Digital input value can be selected and used within the range of unsigned value (0~4047), 

signed value (-2000~2047), precise value and percentile value (0~1011) based on input type. 
(b) If the digital input value is not specified, it will be set to 0. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Output CH0 input valueU0y.07
(%UW0.y.7)  
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10.11.2 Operation Parameter Setting Area 
The operation parameter setting area of the analog mix module is as follows. 

 
Memory 

Add. Description  Setting R/W Command 

0 Enable channel Bit Off (0): disable, Bit ON (1): enable R/W 

PUT/GET 

1 I/O range setting 

Input range setting (4 bit per channels) 
0: 4 ~ 20 ㎃ 
1: 0 ~ 20 ㎃ 
2: 0 ~ 10 V 

R/W 

2 I/O data type setting 

I/O data type setting  
(4 bit per channels) 
0: 0 ~ 4000 
1: -2000 ~ 2000 
2: Precise value 
3: 0 ~ 1000 
- In case of precise value 
4 ~ 20 ㎃: 400 ~ 2000 
0 ~ 20 ㎃: 0 ~ 2000 
0 ~ 10 V: 0 ~ 1000 

R/W 

3 Input channel 0 count 
average value setting 0 or 2 ~ 64000 [times] R/W 

8 CH output state setting 

CH output state setting (4bit per channel) 
0: Former value 
1: min value 
2: middle value 
3: max value 

R/W 

9 Input channel 0 gain 
weighting 

-40~40 

R/W 

11 Output channel 0 gain 
weighting R/W 

13 Setup error information 

100: input ch range setting error 
200: input ch data type setting error 
300: input ch average value setting error  
400: input ch gain weighting setting error 
500: output ch range setting error 
600: output ch data type setting error 
700: output ch output state setting error 
800: output ch gain weighting setting error 
900: output ch input value excess error 

R GET 
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(1) Operating Channel Setting (address 0) 
(a) You can set “Enable/Disable” of analog I/O option board per each channel  
(b) Disable the unused channels to reduce the conversion period. 
(c) Default value is “Disable” for all channels 
(d) When using PUT instruction, address is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

- -

O
ut
pu
t C
H

0

In
pu
t C
H

0
------

Addresst 

 

Enable CH
Bit On (1): enable
Bit Off (0):  isable

---- --

 
 

(e) The values set in bit 2~15 are ignored. 
(f)This area is same as setting in “Channel status” of I/O parameter  
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(2) I/O range setting area (address 1) 
(a) Set the type of I/O range with the following code 
   

Bit (HEX) I/O range 
0000 (0) 4 ~ 20 ㎃ 
0001 (1) 0 ~ 20 ㎃ 
0010 (2) 0 ~ 10 V 

 
(b) If you set more than 3, 0 (4~20㎃) will be set forcibly  

But, U0X.01.8~ U0X.01.A (Setup error flag) will be ON. 
(c) When using PUT instruction, address is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Input CH 0

Addressu

 

I/O range (4bit per channel)
0 : 4 ~ 20 ㎃
1 : 0 ~ 20 ㎃
2 : 0 ~ 10 V

Output CH 1---- ----

 
(d) The values set in bit 8~15 are ignored. 
(e)This area is same as setting in “Input range” of I/O parameter  
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(3) I/O data type setting area (address 2) 

(a) Set the type of I/O data type with the following code  
Bit (HEX) Output data type 
0000 (0) 0~4000 
0001 (1) -2000~2000 
0010 (2) Precise value 
0011 (3) 0~1000 

 
In case of precise value, I/O data type is designated as the following value according to each I/O 
range type 

 
I/O range Precise value 
4 ~ 20 ㎃ 400 ~ 2000 
0 ~ 20 ㎃ 0 ~ 2000 
0 ~ 10 V 0 ~ 1000 

 
 (b) If you set more than 4, 0 (0~4000) will be set forcibly. 

But, U0X.01.8~ U0X.01.A (Setup error flag) will be ON. 
 (c) When using PUT instruction, address is as follows 
 

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0

Input CH 0

Address2

 

I/O  ata  type (4bit per channel)
0 : 0 ~ 4000
1 : -2000 ~ 2000
2 : precise 2alue
3 : 0 ~ 1000

Output CH 0

- In case of precise 2alue
   4 ~ 20 ㎃: 400 ~ 2000
   0 ~ 20 ㎃: 0 ~ 2000
   0 ~ 10 V: 0 ~ 1000

---- ----

 
(d) The values set in bit 8~15 are ignored. 
(e)This area is same as setting in “Output type” of I/O parameter  
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(4) Count average value setting area (address 3) 

(a) Set count average value with 0 or value of 2~6400  
(b) If you set the count average value as 0, corresponding channel will not perform averaging 

process and output sampled analog input value 
(c) If you set 1 or more than 64001, 0 (Disable averaging) will be set forcibly. 

But, U0X.01.8 (Setup error flag) will be ON.  
(d) When using PUT instruction, address is as follows 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Input CH0 count average value  (0 or 2 ~ 64000 [times])Address3
 

 
(e) This area is same as setting in “Count-Avr” of I/O parameter  
 

 
 

(5) Channel output state setting area (address 8) 
(a) Set the output state setting with the following code  
 

Bit (Hex) Channel output state 
0000 (0) Former value 
0001 (1) Min value 
0010 (2) Middle value 
0011 (3) Max value 
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 (b) If you set more than 4, 0 (former value) will be set forcibly. 

But, U0X.01.A (Setup error flag) will be ON. 
 (c) When using PUT instruction, address is as follows 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Output CH 0

Address8

Output CH state setting( 4 bit)
0 : Former value
1 : min value
2 : middle value
3 : max value

---- ----

d

----

 
 
(d) The values set in bit 8~15 are ignored. 
(e)This area is same as setting in “CH. Output type” of I/O parameter  
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(6) I/O gain weighting setting area (address 9~11) 

(a) Set input gain weighting with value of -40~40  
(b) If you set this as 0 (default value),  

4000 will apply for input gain value 
4000 will apply for output gain value  

(c)For example, if you set this as -10, 4010 (=4000-(-10)) will apply for gain value 
(d) When using PUT instruction, address is as follows 
 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Input CH0 gain (-40 ~ 40)Address9

Output CH0 gain (-40 ~ 40)Addressuu 
 

 
(e) This area is same as setting in “I/O gain” of I/O parameter  
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(6) Setup error information output area (address 13) 

(a) Saves error code detected when setting (setting by program) 
(b) Setting error is canceled when value is reset to make it in the valid range  
(c) When U0X.01.8~ U0X.01.A (setting error flat) is on, check that area and fix the corresponding 

setting to cancel the error 
(d) When using GET instruction, address is as follows 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Setting error informationAddress13
 

 

Type Error 
code Description Priority Remark 

Input 
error 

100 Input CH range setting error 2 

− 

200 Input CH data type setting error 3 
300 Input CH count average value setting error 4 
400 Input CH gain weighting setting error 5 

Output 
error 

500 Output CH range setting error 6 
600 Output CH data type setting error 7 
700 Output CH state setting error 8 
800 Output CH gain weighting setting error 9 
900 Output CH input value excess error 1 

 
(e) When more than two errors occur simultaneously, it saves error code having higher priority.  
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10.12 Example Program 
 

(1) This sample program sets up operating parameters of analog input option board. 
(2) Initial settings are saved in the internal memory of the XGB main unit by one input. 
(3) The sample program below controls the I/O data of the analog I/O option board at option slot #0 

(I/O slot #9) and check open wire. 
 

10.12.1 Example of [I/O Parameter] Usage 
 

 (1) I/O Parameter Setting Window 
 

 
 

 
 
    (a) Input Channel 0 is set to operating channel and input range is set to 4~20mA. 
    (b) Output Channel 0 is set to operating channel and output range is set to 4~20mA. 
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(2) Sample Input Program (XBC Type) 

 
 
 

(a) When the option board is in normal operation, M0000 is turned On. 
U09.00.0 (Module Error) = Off 
U09.00.F (Module Ready) = On 
U09.01.0 (Input Channel 0 in-operation) = On 
U09.01.8 (Input Channel 0 Error) = Off 

(b) When M0000 is ON, Input Channel 0 Converted Value(U09.04) is moved to D00100. 
(c) If open-wire error occurs in channel 0, U09.01.4 (channel 0 open-wire) is ON, and M0001 bit is 

set. 
 

(3) Sample Output Program (XBC Type) 

 
 

(a) When the option board is in normal operation, M0000 is turned On. 
U09.00.0 (Module Error) = Off 
U09.00.F (Module Ready) = On 
U09.01.2 (Output Channel 0 in-operation) = On 
U09.01.A (Output Channel 0 Error) = Off 

(b) When M0000 is ON, it turns on CH0 output state (U09.06.0) and allows output   
(c) When M0000 is ON, D00100 data is moved to output CH0 Output value (U09.07) and outputs. 
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(4) Sample Input Program (IEC Type) 

 
 
 

(a) When the option board is in normal operation, %MX0 is turned On. 
%UX0.9.0 (Module Error) = Off 
%UX0.9.15 (Module Ready) = On 
%UX0.9.16 (Input Channel 0 in-operation) = On 
%UX0.9.24 (Input Channel 0 Error) = Off 

(b) When %MX0 is ON, Input Channel 0 Converted Value(%UW0.9.4) is moved to “CH0_DATA”. 
(c) If open-wire error occurs in channel 0, %UX0.9.20 (channel 0 open-wire) is ON, and %MX1 bit 

is set. 
 

(5) Sample Input Program (IEC Type) 

 
 

(a) When the option board is in normal operation, %MX0 is turned On. 
%UX0.9.0 (Module Error) = Off 
%UX0.9.15 (Module Ready) = On 
%UX0.9.18 (Output Channel 0 in-operation) = On 
%UX0.9.26 (Output Channel 0 Error) = Off 

(b) When %MX0 is ON, it turns on CH0 output state (%UX0.9.96) and allows output   
(c) When %MX0 is ON, CH0_Output_Value data is moved to output CH0 Output value 

(%UW0.9.7) and outputs. 
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10.13 Troubleshooting 
 
This section describes methods for identifying the troubles which may occur during the operation of analog 
I/O option board, and their solutions. 
 

10.13.1 Troubleshooting 
 
        (1) Analog input value is abnormal. 
 

Analog input value is abnormal.

Installation is OK.

Install the option board properlyd No

Yes

FG ground is OK

Correct FG grounding according to the wiring 
in the user manual

d No

Yes

Wiring is OK
(Current input wiring, voltage input 
wiring)

Refer to the manual and wire properlyd No

Yes

Parameter setting is OK
(Operation channel permit, I/O range 
setting

Set up the parameters correctly according to 
the user manual

d No

Yes

Contact nearest dealer or A/S center

  



XGB Analog edition manual  

10 - 46 

 

 
 
(2) Analog output value is abnormal. 

 

Analog output value is abnormal.

Installation is OK.

Install the option board properlyd No

Yes

FG ground is OK

Correct FG grounding according to the wiring 
in the user manual

d No

Yes

Wiring is OK
(Current output wiring, voltage output 
wiring)

Refer to the manual and wire properlyd No

Yes

Parameter setting is OK
(Operation channel permit, I/O range 
setting

Set up the parameters correctly according to 
the user manual

d No

Yes

Contact nearest dealer or A/S center
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Chapter 11 RTD Input Option Board 

 

11.1 Setting Sequence before Operation 
 

Before using the RTD input option board, follow steps below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 

 

XBO-RD01A 

 

 

 

 

 

 Checking performance specification 

System configuration and selection 

Wiring 

Reading temperature data 

Setting parameter 

Programming 

Specification 
 Operating environment 
 Digital input range  

System configuration 
 Installation count 

Wiring 
 RTD input wiring 

RTD input test 
 XG5000 special module 

monitor test mode 

Parameter 
 XG5000 I/O parameter 

Programming 
 Program for writing digital data  

(U device) 

If there is error or RTD input value is 
abnormal, refer to the trouble shooting 
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11.2 Specification 
 

11.2.1 General Specifications 
 
Here describes general specifications of RTD input option board. 

No. Items Specification Reference 

1 
Operating 

temperature 0 ~ 55 °C 

− 

2 
Storage 

Temperature −25 ~ +70 °C 

3 
Operating 
humidity 5 ~ 95%RH (Non-condensing) 

4 
Storage 
humidity 5 ~ 95%RH (Non-condensing) 

5 
Vibration 
immunity 

Occasional vibration − 
Frequency Acceleration Pulse width Times 

IEC61131-2 

10  ≤  f  <  57Hz − 0.075mm 

10 times 
each 

direction  
(X,Y and Z) 

57  ≤  f  ≤  150Hz 9.8m/s2 (1G) − 
Continuous vibration 

Frequency Acceleration Pulse width 
10  ≤  f  <  57Hz − 0.035mm 
57  ≤  f  ≤  150Hz 4.9m/s2 (0.5G) − 

6 
Shocks 

immunity 

• Peak acceleration : 147 m/s2 (15G) 
• Duration : 11ms 
• Pulse wave type : Half-sine (3 times each direction per each axis) 

7 
Noise 

immunity 

Square wave 
impulse noise 

AC: ±1,500 V 
DC:  ±900 V 

LSIS standard 

Electrostatic 
discharge 

Voltage: 4kV (Contact discharge) 
IEC61131-2 

IEC61000-4-2 
Radiated 

electromagnetic 
field noise 

80 ~ 1,000 MHz, 10V/m 
IEC61131-2, 

IEC61000-4-3 

Fast transient 
/Burst noise 

Segment 
Power 
supply 

Digital/Analog Input/Output, 
Communication Interface 

IEC61131-2 
IEC61000-4-4 

Voltage 2kV 1kV 

8 
Operation 
ambience 

Free from corrosive gases and excessive dust 

− 9 Altitude Less than 2,000m 

10 Pollution degree Less than 2  

11 Cooling method Air-cooling 
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11.2.2 Performance specifications 

 
Here describes general specifications of RTD input option board. 

 XBO-RD01A 

No. of input channels One channel 

Input sensor 
type 

PT100 JIS C1604-1997 

JPT100 JIS C1604-1981 , KS C1603-1991 

Temperature 
input range 

PT100 -200.0 ~ 600.0℃ (-328.0℉~1112.0℉) 

JPT100 -200.0 ~ 600.0℃ (-328.0℉~1112.0℉) 

Digital output 
PT100 -2000 ~ 6000 

JPT100 -2000 ~ 6000 

Accuracy Within ±1.0%  

Conversion speed 25ms/1Ch – note1) 

Insulation 

Channel to 
Channel 

 

Non-insulation 

Terminal to 
PLC Power 

 Insulation (Photo-Coupler) 

Terminal block 5-point terminal block 

I/O points occupied Fixed type: 64 points 

Wiring method 3-wire type 

Function 
Averaging Count averaging function 

Alarm Disconnection detection 

Current 
consumption 

Inner DC5V 30㎃ 

Weight 20g 

 
Note1) Conversion speed can be delayed because of scan delay per channel by XGB main unit 

 
 

Note2) In order to use analog input option board, the following version is needed. 
 

Main unit Version information 
XBC E type V1.1 or above 
XBC S type V1.1 or above 

XBC SU type V1.0 or above 
XEC E type V1.0 or above 

XEC SU type V1.0 or above 
XG5000 V.3.61 or above 
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11.3 Part Names and Functions  
 

Here describes part names and functions.  
 
 

① Hook for fixation

② Terminal block

③ Cover

④ Hook for fixation

⑤ Connector for
    option board

⑥ Input
    connector

35.0mm

49.0mm

10.3mm

 
 

 
 

No. Name Description 

①④ Hook for fixation ▶ Hook for fixing the option board to main unit 

② Terminal block 
▶ Wiring terminal block to connect with external device 

(RTD input) 

③ Cover ▶Option board cover 

⑤ 
Connector for option 
board 

▶Connection connector for connecting the option board to the main  
unit 

⑥ Input connector ▶Wiring connector for connecting with the external device 
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11.4 Temperature Conversion Characteristic 
 

Since RTD sensor has non-linear characteristic, RTD input module executes linearization per each 
section. 
The graph below is an example to describe the linearization process and is different with graph about 
actual sensor temperature input.   
 

  (1) PT100: JIS1604-1997 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 

 
 
(2) JPT100: JIS C1604-1981, KS C1603-1991 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 

 

 
 

Non-linear characteristics: The resistance-temperature characteristics for RTD sensor are presented 
with table (JIS C1604-1997). This characteristics table displays resistance value of the sensor to 
temperature, namely, the change of the resistance value per increment of 1℃. When the 
temperature is changed by 1℃, the change of resistance is not in constant width but in different 
width per section, which is called the non-linear characteristics.  

600.0℃ 

0.0℃ 

-200.0℃ 

18.52 
Measured temperature 
Resistance (Ω) 

 

Temperature (℃) 

100 313.71 
Linearized sensor characteristics 

   Real Sensor characteristics 

0.0℃ 

-

 

17.14 

Measured temperature 
Resistance (Ω) 

Temperature (℃) 

100 317.28 

Linearized sensor characteristics 
Real sensor characteristics 

600.0℃ 

Remark 
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11.5 Conversion Speed 
 

The conversion speed of RTD input option board is less than 25ms + 3 x scan time.  
The conversion speed includes the time to convert input temperature (resistance value) to digital 
value and to save the converted digital data into the internal memory. 

 
∴ Processing time = less than 25ms + 3 x scan time  

 
 

11.6 Accuracy 
 

The accuracy of RTD module is described below. 
• When the ambient temperature is 0 to 55℃: within ±1.0% of available input range  

 
 Example) PT100 is used and the ambient temperature is normal. 

To measure 100℃, the conversion data output range:   
 100℃ - [ { 600 - (-200) } x 1.0 % ]  ~  100℃ + [ { 600 - (-200) } x 1.0 % ] 
 Namely, 92.0 ~ 108.0 [℃] 

 
 
 

11.7 Temperature Display 
 

(1) The input temperature is converted to digital value down to the one decimal place. 
 

Ex.) If the detected temperature is 123.4℃, its converted value to be saved to the internal 
memory will be 1234. 

 
(2) Temperature can be converted to Celsius or Fahrenheit scale temperature value as desired. 

 
Ex) If Pt100 sensor is used, the temperature of 100.0℃ can be converted to 2120 when 

Fahrenheit scale is used. 

• Conversion ℃ to ℉, 32
5
9

+= CF   

• Conversion ℉ to ℃, ( )32
9
5

−= FC   

(3) temperature input ranges of sensor are as follows; 
• PT100 : -200.0 ~ 600.0℃  (-328.0℉~1112.0℉) 
• JPT100 : -200.0 ~ 600.0℃ (-328.0℉~1112.0℉) 
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11.8 Disconnection Detection Function 

 
(1) As a module used to measure the temperature with the RTD temperature sensor directly 

connected, it detects and displays disconnection of the sensor connected. If any disconnection 
occurs in the sensor used and extended lead wire, it will turn on the disconnection diction bit 

 
(2) The figure below shows the temperature sensor’s appearance of the 3-wired RTD.  

(The appearance depends on sensor type)  

 
 
 
 
 
  

* A disconnection: if disconnected between terminal A and module terminal block in the sensor 
figure. 
* B disconnection: if disconnected between terminal B (two for 3-wired sensor) and module 
terminal block in the sensor figure, or if A and B lines are all disconnected. 

 
(3) The basic connection between RTD module and RTD Sensor is based on 3-wired RTD sensor. 

If 2-wired or 4-wired sensor is used, the connection between the sensor and the module shall be 
kept as 3-wired. Disconnection will be detected on the basis of 3-wired wiring. 

 
        (4) In case of disconnection, operation of disconnection flag is as follows. 
     

Connection status Channel status Disconnection flag 

Normal 
Run Off 

Stop Off 

Disconnection 
Run On 

Stop  
Off 

Any sensor is not 
connected 

Run  
On 

Stop Off 

 
 
 

 

 

 

A terminal 

B terminal 
  

 

 

B 

b 

A 

Module terminal block 
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11.9 Wiring  
 

- 3 types of sensor-connecting methods are available (2, 3 and 4-wired). 
- The standard wiring method for XBO-RD1A module is 3-wired wiring. 
- Use an identical type of wire (thickness, length, etc.) for each 3 wire when extended lead wire is  
used. 

- The resistance of each conductor is to be less than 10Ω. (If larger than this, it will cause an error.) 
- Resistance difference of each conductor is to be less than 1Ω. (If larger than this, it will cause an  
error.) 

- Length of wire is to be as short as possible and it is recommended to connect the wire directly to the  
terminal block of module without connection terminal unit. If a connection terminal is to be used,  
compensating wire shall be connected as shown below.  

 
11.9.1 If 2-wired sensor is used (connection terminal unit is used) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

11.9.2 If 3-wired sensor is used (connection terminal unit is used) 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

*1 If sensor and compensating wire are shielded, 
shield line can be connected to FG terminal of 
the module. 

*2 Let the terminals B and b short on the terminal 
block of the module if 2-wired sensor is to be 
connected. 

B 

FG 

b 

A 

 

*1 

*2 

Terminal block 

 

 

 

NC 

NC 

 

*1 

*1 If sensor and compensating wire are shielded, 
shield line can be connected to FG terminal of 
the module. 

B 

FG 

b 

A 

 

 

Terminal block 

 

 

 

 
NC 

NC 
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11.9.3 If 4-wired sensor is used (connection terminal unit is used) 
 
           
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 

1* If sensor and compensating wire are 
shielded, shield line can be connected to FG 
terminal of the module. 

B 

FG 

b 

A 

 

*1

 

 

 

 

 

Terminal block 

NC 

NC 
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11.10 Average Function 
 

It accumulates temperature conversion values of a selected channel as many as average value and  
displays the average of the total sum in digital data 

 
 
- Setting range = 2 ~ 64000 [times] 
 
- Averaging interval is calculated according to the number of channel used 
 
- Averaging interval[ms] = Averaging count x (25ms + 3*scan time) 

 
 

 

Remark  

(1) Averaging interval varies according to change of scan time. 
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11.11 Operation Parameter Setting  
 

Operation parameters of RTD input option board can be specified through [I/O parameters] of XG5000. 
 

11.11.1 Setting items  
 
For the user’s convenience, XG5000 provides GUI (Graphical User Interface) for parameters setting 
of RTD module. Setting items available through [I/O parameters] of the XG5000 project window are 
described below.  

Item Details 

[I/O Parameter] 

(1) Specify the following setting items necessary for the module operation. 
- Channel Run/Stop 
- Sensor type  
- Temp. unit 
- Count average 

(2) The data specified by user through S/W package will be saved on the 
flash memory of basic unit when [I/O Parameters] are downloaded.  

 
11.11.2 How to use [I/O Parameter] 
 
(1) Run XG5000 to create a project. (Refer to XG5000 programming manual for details on how to 

create the project) 
 
(2) Double-click [I/O Parameter] on the project window. 

 
  

(3) On the ‘I/O parameters setting’ screen, find and click the slot of the base where RTD option board 
is installed on.  
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(4) Click the arrow button on the screen to display the screen where an applicable option board can be 

selected. Search for the applicable option board to select.  

 
 
(5) After the option board selected, click [Details] or double-click relevant slot. 

 
 
(6) A screen will be displayed to specify parameters for respective channels as shown below. Click a 

desired item to display parameters to set for respective items.  

 
 
(7) The initial values of respective items are as follows. 

(a) Channel status setting screen 

 



Chapter 11 RTD Input Option Board (XBO-RD01A) 

11 - 13 

 

 
(b) Input sensor type setting screen 

 
 

(c) Temp. unit setting screen 

 
 

(d) Count average setting screen 

 
 
(8) If necessary setting is complete, press OK.  
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11.12 Special Module Monitoring 
 

Run Special Module Monitoring by selecting [Online] -> [Connect] and [Monitor] -> [Special Module 
Monitoring]. If the status is not [On-Line], [Special Module Monitoring] menu will not be activated. 

 

Remark  

1) If the program is not displayed normally because of insufficient system resource, you may start  

XG5000 again after close the program and other applications. 

2) I/O parameters those are specified in the state of [Special Module Monitoring] menu are temporarily  

set up for the test. They will be disappeared when the [Special Module Monitoring] is finished. 

3) Testing of [Special Module Monitoring] is the way to test the analog output module. It can test the  

module without a sequence program. 
 
 

11.12.1 How to use special module monitoring 
 
 (1) Start of [Special Module Monitoring]  

Go through [Online]  [Connect] and [Monitor]  [Special module Monitoring] to start. If the  
status is not online, [Special Module Monitoring] menu will not be activated.  
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 (2) How to use [Special Module Monitoring]  

(a) [Special Module List] window will show base/slot information and types of special module by  
click [Monitor]  [Special Module Monitoring].In this list box, the modules that are now  
installed in PLC system will be displayed. 

 

 
  

(b) Select a special module then click [Module Info.] button to display the information as  
described below.  

 
 

(c) Select a special module then click [Start Monitoring] button to display the information as 
described below. 
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(d) [Start Monitoring]: [Start Monitoring] button will show you digital input data of the operating 

channel. The figure below is monitoring screen when all channels are Run status.  

 
[Start Monitoring] execution screen 

 
(e) [Test]: [Test] is used to change the parameters of the RTD input module. You can change the 

parameters when you click the values at the bottom of the screen. It is only available when 
XGB CPU unit’s status is in [Stop]. 

 
[Test] execution screen 

 

(g) [Close]: [Close] is used to escape from the monitoring/test screen. When the monitoring/test 
screen is closed, the max. value, the min. value and the present value will not be saved any 
more. 

 
 Remark  

[Test] function is only available when XGB CPU unit’s status is in [Stop]. 

Monitoring screen 

Detail of channel 0 
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Register the variables for each module referring to the special module information that is set in the I/O 
parameter. The user can modify the variables and comments. 

  
 (1) Procedure  

(a) Select the special module in the [I/O Parameter Setting] window.  

 
 

(b) Double click ‘Variable/Comment’ from the project window. . 

 
 

(c) Select [Edit] – [Register U Device]. 

 
 

11.13 Register U devices (Special module variable) 
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(d) Click ‘Yes’.  

 
 

(e) As shown below, the variables are registered.  

 
 
 
 (2) Save variables  

(a) The contents of ‘View Variable’ can be saved as a text file.  
(b) Select [Edit] -> [Export to File]. 
(c) The contents of ‘View variable’ are saved as a text file.  

 
(3) View variables  
  Example in the XGB compact “E” type and “S” type are as follows. 
 

(a) The example program of XG5000 is as shown below.    

 
 
 

(b) Select [View] -> [Variables]. The devices are changed into variables. 
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(c) Select [View] -> [Devices/Variables]. Devices and variables are both displayed. 

 
 

 
(d) Select [View] -> [Device/Comments]. Devices and comments are both displayed. 
 

 
 
 

(e) For IEC type also, as shown in Fig. (a) ~ (d), you can look up variables with 
   diversified options in the ‘View’ menu. The figure below is the case of an IEC type 
   with which the ‘View Device/Variables’ option. 
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11.14 Configuration and Function of Internal Memory  
 
Here describes configuration and function of internal memory. 

 
11.14.1  Data I/O area  

Data I/O area of RTD input option board is as shown below. 

Variable Type Device Description R/W Signal direction XBC IEC 

_0y_ERR Bit U0y.00.0 %UX0.y.0 Module error R 
Option → CPU 

_0y_RDY Bit U0y.00.F %UX0.y.15 Module Ready R 

_0y_CH0_ACT Bit U0y.01.0 %UX0.y.16 CH0 running R Option → CPU 

_0y_CH0_BOUT Bit U0y.01.4 %UX0.y.20 CH0 disconnection R Option → CPU 

_0y_CH0_TEMP Word U0y.04 %UW0.y.4 CH0 temp. value R Option → CPU 

 
- In the device allocation, the small letter ‘y’ is the No. of the slot where the module is installed. 
- For example, to read the ‘CH0 Temperature Value’ of the RTD module installed in the slot 9, write in 

U09.05. (%UW0.9.4 for IEC types) 

Device Type

U 0 9 . 0 4

Slot No.
Word

[XBC type]

Word classifier

                   

Device Type
Slot No.

Base No

Word

[IEC type]

 % U W 0 . 9 . 4
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(1) Module ready/error flag ( ( ) is for IEC types, y: slot No.) 
(a) U0x.00.F: It will be ON when PLC CPU is powered or reset with A/D conversion ready to 

process A/D conversion. 
(b) U0x.00.0: It is a flag to display the error status of A/D conversion option board. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

-----------

U0y.00
(%UW0.y.0)

 

Error occurrence 
information
Bit On (1): error
Bit Off (0): Normal

R
e
a
d
y

E
rro

r- - -

 

Module READY
Bit On (1): Normal
Bit Off (0): error

 
 

 
 
(2) Channel run, stop information / channel disconnection information flag  

It displays which channel is being used. ( ( ) is for IEC types, y: slot No.) 
bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

- - -

In
pu
t C
H

0
------

Uty.tu
(iUWt.y.u)

 

Ope.ating CH 
info.)ation
Bit On (1): ope.ating
Bit Off (0): stop

-

In
pu
t C
H

0
- - - -

 

CH  isconnection 
info.)ation
Bit On (1):  isconnection
Bit Off (0): no.)a(

 
(3) Temperature value ( ( ) is for IEC types, y: slot No.) 

It displays current temperature value. Its form is temperature value ×10. 
bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

 CH0 RTD Temperature ValueUtyrt4
liUWtryr4m
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11.14.2 Operation parameter setting area 
Operation parameter setting areas of RTD input option board are as follows. 

Memory 
address 

Contents Setting value R/W Instruction 

0 
Channel 
enable/disable 
setting 

CH status setting 
0: Stop 
1: Run 

R/W 

PUT/GET 1 sensor type setting 
Input range setting  
0: PT100 
1: JPT100 

R/W 

5 
Temperature display 
unit setting 

Data type setting  
0: Celsius 
1: Fahrenheit  

R/W 

6 
disconnection 
information  

0: Normal 
1: Disconnection 

R GET 

14 
Count average 
value 

0 or 2~64,000 R/W 
PUT 
GET 

15 Error information 
100: sensor type setting error 
300: count average value setting error 

R GET 
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(1) Run channel setting (address 0) 

(a) You can enable/disable the RTD input option board 
(b) If Run channel is not specified, all channels will be stop status. 
(c) When using Put instruction, Channel Status address is as follows 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

- - -
C
H
0

------

Address0 

d

Enable CH
Bit On (1): enable
Bit Off (0): disable

---- --

 
(d) Vales set in B1 ~ B15 are ignored. 
(e) This area shows the same results with “Channel status” in I/O parameter setting window. 
 

(2) Sensor type setting (address 1) 
(a) Sets sensor type with the following code. 

   
Word Sensor type 

0 PT100 
1 JPT100 

 
(b) When input value is larger than 2, 0 (PT100 type) is selected by force. 
(c) In case of using PUT instruction, Sensor Type Setting Area is as follows.  
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

Ch0 sensor type settingAddress1

Sensor type setting
0: PT100
1: JPT 100  

 
(3) Setting temperature display unit (address 5)  

(a) Sets temp. display unit with the following code. 
Bit Temp. display unit 
0 Celsius 
1 Fahrenheit 

 
(b) When input value is larger than 2, 0 (Celsius) is selected by force. 
(c) In case of using PUT instruction, Output Data Type Area is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

- - -
C
H
0

------

Address5

d

Temp. unit setting
Bit Off(0): Celsius
Bit On(1): Fahrenheit

---- --
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(4) Disconnection information (address 6) 
(a) Displays disconnection information of channel. 

 (b) In case of using GET instruction, Disconnection Information address is as follows. 
 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

CH0 disconnection information (0: normal, 1: disconnection)Address6 

 
 
(5) Count average value setting (address 14) 

(a) Count average value should be 0 or 2~64000. 
(b) If count average value is set as 0, averaging process is not applied and sampling-processed 

temperature value is outputted. 
(c) When count average value is larger than 64001, 0 (Averaging disabled) is selected by force 
(d) In case of using PUT instruction, Count Average Value Setting address is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

CH0 count average setting: 0 or 2~64,000Address14

 
 

(6) Error information (address 15) 
(a) Saves error code detected at setup (in case of setup by the program) 
(b) Setting error is canceled when invalid setting is corrected by resetting 
(c) In case of GET instruction, setting error information address is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

CH0 setup error informationAddress15

 

Type Error 
code Description Priority Remark 

Setup 
error 

100 Input sensor type setting error 1 
- 

300 Input count average value rage setting error 2 
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11.15 Example Program 
 

- Here describes how to specify the operation condition of RTD input option board.  
- RTD input option board is installed on slot 9. 
- Initial setting value is saved in internal memory of module with one input. 
- The following program is an example to read temperature value and disconnection information. 

 
 

(1) Program example using [I/O Parameter Setting] 

 
 

 
 

 
 
 
 
 
 
 

 

Moving channel 0 temp. value to  
D0 area 

Moving channel 0 disconnection 
information to M0 
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(2) Program example using PUT/GET command 
 

  
 
 
 
 
 
 
 
 
 
 
 
 

CH Enable  

Sensor type (PT100) 

Temperature unit (Celsius) 

Count average value setting  

Moving channel 0 temp. 
value to D0 

  
 

Moving channel 0 disconnection 
information to M0 
 



Chapter 11 RTD Input Option Board (XBO-RD01A) 

11 - 27 

 

 

11.16 Troubleshooting 
  

Describes troubleshooting about the problem that occurs during using RTD input option board 
 
11. 16.1 Troubleshooting 
 (1) Temperature conversion value is not normal. 

Temperature conversion value is not 
normal

Installation is correct

Install the option board correctly.d No

Yes

FG ground is normal

Execute FG ground properly referring to user 
manual

d No

Yes

Wiring is normal

Wire properly referring to user manuald No

Yes

Parameter setting is normal.
(Channel status, sensor type setting)

Set parameter properly referring to user 
manual.

d No

Yes

Contact the nearest agency or LS 
branch office.

 
 
11.16.2 Stats check of RTD input option board through XG5000 system monitor 

 
Module type, module information, O/S version and module status of RTD input module can be 
checked through XG5000 system monitoring function. 
 
(1) Execution sequence 

Two routes are available for the execution. 
(a) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button to 

display [Module Information]. 
(b) [Monitor] -> [System Monitoring] -> And Double-click the module screen. 

 
(2) Module information 

(a) Module type: shows the information of the module presently installed. 
(b) Module information: shows the O/S version information of module. 
(c) O/S version: shows the O/S prepared date of module. 
(d) Module status: shows the present error code.  
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Chapter 12 Thermocouple Input Option Module 
 

12.1 Setting sequence before operation 
 
Setting sequence before operation 
 

Before using the thermocouple input module, follow steps below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 

 

XBO-TC02A 

 

 

 

 

 

 Checking performance specification 

System configuration and selection 

Wiring 

Reading temp. data 

Setting parameter 

Programming 

Specification 
- Operating environment 
- Thermocouple sensor type and temperature range 
- Digital output range 

 
System configuration 
- Equip-able number  
- External power selection 

 

Wiring 
- Power wiring  
- Thermocouple input wiring 

 

Thermocouple input test 
- XG5000 special module monitor  
 test mode 

 

Parameter 
- XG5000 I/O parameter 

 

Programming 
- Program to read analog data 

(U device) 
 

If there is error or thermocouple input  
data is abnormal, refer to the trouble 
shooting. 
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12.2 Specification 
 

12.2.1 General specification 
 

General specifications of thermocouple input option module are as follows. 
 

No. Items Specification Related 
standards 

1 
Operating 

temperature 
0 ~ 55 °C − 

2 
Storage 

temperature 
−25 ~ +70 °C − 

3 
Operating 
humidity 

5∼95%RH (Non-condensing) − 

4 
Storage 
humidity 

5∼95%RH (Non-condensing) − 

5 
Vibration 
immunity 

For discontinuous vibration − − 

Frequency Acceleration Amplitude Times 

IEC61131-2 

10 ≤ f < 57Hz − 0.075mm 

Each 10 
times in 
X,Y,Z 

directions 

57 ≤ f ≤ 150Hz 9.8m/s2(1G) − 

For continuous vibration 

Frequency Acceleration Amplitude 

10 ≤ f < 57Hz − 0.035mm 

57 ≤ f ≤ 150Hz 4.9m/s2(0.5G) − 

6 
Shocks 

immunity 

•  Max. impact acceleration : 147 m/s2(15G) 
•  Authorized time : 11ms 
•  Pulse wave : Sign half-wave pulse (Each 3 times in X,Y,Z directions) 

IEC61131-2 

7 
Noise 

immunity 

Square wave 
impulse noise 

AC : ±1,500 V 
DC :  ± 900 V 

LSIS standard 

Electrostatic 
discharging 

Voltage : 4kV(contact discharging) 
IEC61131-2 

IEC61000-4-2 
Radiated 

electromagnetic 
field noise 

80 ~ 1,000 MHz,  10V/m 
IEC61131-2, 

IEC61000-4-3 

Fast 
Transient 

/burst 
noise 

Segment Power 
module 

Digital/ 
Analog I/O 

communication interface IEC61131-2 
IEC61000-4-4 

Voltage 2kV 1kV 

8 
Ambient 

conditions 
No corrosive gas or dust − 

9 
Operating 

height 
2000m or less − 

10 
Pollution 
degree 

2 or less − 

11 Cooling type Natural air cooling − 
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12.2.2 Performance Specification 

 
Performance specifications are as follows 
 

Items Specification 

Number of input channel 2 channels 

Type of input sensor Thermocouple K / J type 
(JIS C1602-1995) 

Range of input 
temperature 

K type sensor -200.0℃ ~ 1300.0℃ (-328.0℉ ~ 2372.0℉) 
J type sensor -200.0℃ ~ 1200.0℃ (-328.0℉ ~ 2192.0℉) 

Digital output Temp. display unit 
16 bit binary data 
Displaying down to one decimal place 
(K, J, type: 0.1℃) 

Accuracy ±1.0% or less 
Conversion speed 50ms/2chanelles –note1) 

Reference 
junction 

compensation 

Auto compensation by RJC sensing (Thermistor) 

Compensation amount ±1.0℃ 

Additional 
function 

Average process Count averaging 
Alarm Input disconnection detection 

Warming-up time 15 min or above – note2) 

Insulation method 
Non-insulation between input channels 
Non-insulation between input terminal and PLC 
main unit 

I/O terminal 5-point terminal block 

Supply power Internal 5V 

I/O occupied points Fixed type: 64 points 

Consumption current(Internal) 50㎃ 

Weight 20g 

 
Note1) Conversion speed can be delayed because of scan delay per channel by XGB main unit  
Note2) Warming-up time: for stability of measured temperature, 15 min is necessary after power is on. 

 
- In order to use analog input option board, the following version is needed. 

 

Main Unit Version 
XBC E type V1.1 or above 
XBC S type V1.1 or above 

XBC SU type V1.0 or above 
XEC E type V1.0 or above 

XEC SU type V1.0 or above 
XG5000 V.3.61 or above 
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12.3 Name and Function of Each Part 
 
Describes name and function of each part  
 

 

① Hook for fixation

② Terminal block

③ Cover

④ Hook for fixation

⑤ Connector for
    option board

⑥ Input
    connector

35.0mm

49.0mm

10.3mm

 
 

 

 
 

No. Name Description 

①④ Hook for fixation ▶ Hook for fixing the option board to main unit 

② Terminal block 
▶ Wiring terminal block to connect with external device 

(Analog input) 

③ Cover ▶Option board cover 

⑤ 
Connector for option 
board 

▶Connection connector for connecting the option board to the main 
 unit 

⑥ Input connector ▶Wiring connector for connecting with the external device 
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12.4 Characteristic of Thermocouple Temperature Conversion 
 
 

Thermocouple input module connect 2 kinds of thermocouple directly, input characteristic are as 
described below. 

(1) Thermocouple K (JIS C1602-1995): -200 ℃(-5891 ㎶) ~ 1300 ℃(52410 ㎶) 

 
 

(2) Thermocouple J (JIS C1602-1995): -200 ℃(-7890 ㎶) ~ 1200 ℃(69553 ㎶) 

 
 

 

 

 
Thermocouple characteristics: thermocouple sensor measures temperature by using fine voltage 
(electromotive force), which occurs when applying temperature gradient to a junction between two 
different metals.  
The temperature-electromotive force relation specification of normal thermocouple sensor provides 
the electromotive force, which is measured when a sensor’s measuring point is at O℃. On that 
account, when measuring temperature by using thermocouple sensor, cold junction compensation 
(reference junction compensation, RJC) is used. (built-in function of temperature measuring module).  

 

Remark 

Temperature 
 

Temperature 
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12.5 Accuracy 
 
Accuracy / Resolution are as follows according to ambient temperature 

 

Thermocouple 
type 

Measurement 
temperature 

range 
Indication temperature 

range 

Accuracy - note1) 

Resolution Normal 
temperature 

(25℃) 

Operating 
temperature - 

note2) 
(0℃ ~ 55℃) 

K -200.0℃ ~ 
1300.0℃ 

-200.0℃ ~ 0.0℃ 
±15.0℃ 

0.2℃ 
0.0℃ ~ 1300.0℃ 0.1℃ 

J -200.0℃ ~ 
1200.0℃ 

-200.0℃ ~ -100.0℃ 
±14.0℃ 

0.2℃ 
-100.0℃ ~ 1200.0℃ 0.1℃ 

 
Note1) Total accuracy (normal temp.) = accuracy (normal temp.) + cold junction compensation accuracy  

= ±(full scale X 0.2% + 1.0℃) 
     Cold junction compensation accuracy = ±1.0℃ 

Note2) Temp. coefficient: ±100 ppm/℃ 
 
 

(1) When ambient temp. is normal (25 ± 5℃): within the ±1% of entire measurement temp. range 
(2) When ambient temp. is operating temp. (0 ~ 55℃): within the ±1% of measurement temp. range 

 
Ex.) When K type thermocouple is used and ambient temperature is normal. 

In case of measuring 1000℃ temperature, output range of conversion data is 
 1000℃ - [{1300 - (-200)} x 1 %] - 1  ~  1000℃ + [{1300 - (-200)} x 1%] + 1 
 namely,  984.0 ~ 1016.0 [℃] 입니다. 

 
 

 
 
 

 
 

(1) For stabilization of measurement temperature, warming-up time more than 15 min. is necessary, after 
restart. 

(2) If ambient temperature changes rapidly, measurement temperature may change temporally. Keep the 
ambient temperature steady for stabilization of measuring temperature.  

(3) If wind of the cooling pan contacts with module directly in the panel, accuracy decreases. Do not 
contact with wind directly.  

 

Note 
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12.6  Conversion speed 
 

12.6.1 Conversion speed function 
(1) Conversion speed: 50ms/2Ch 
(2) Sequential process method 

The next channel is converted after conversion of one channel is completed. 
 (Run/Stop of the respective channels can be set independently.) 

(3) Concept of conversion time 
The time taken to convert the temperature from terminal block to digital value and save it at 
internal memory 

 

∴ Processing time = less than 50ms + 6 x scan time  
 

Example) PLC average scan time: 1 ms  
When using all channels: conversion time = 50ms+6 X1ms = 56 ms 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

12.7  Conversion speed 
 

12.6.1 Temperature Display function 
 
(1) The input temperature is converted to digital value down to the one decimal place. 

Ex.) If the detected temperature is 123.4℃, its converted value to be saved to the internal 
memory will be 1234. 

(2) Temperature can be converted to Celsius or Fahrenheit scale temperature value as desired. 
 

Ex) If Pt100 sensor is used, the temperature of 100.0℃ can be converted to 2120 when 
Fahrenheit scale is used. 

• Conversion ℃ to ℉, 32
5
9

+= CF   

• Conversion ℉ to ℃, ( )32
9
5

−= FC   

(3) temperature input ranges of sensor are as follows; 
• K Type : -200.0 ~ 1300.0℃ (-328.0℉ ~ 2372.0℉) 
• J Type: -200.0 ~ 1200.0℃ (-328.0℉ ~ 2192.0℉) 

SCAN1 SCAN2 SCAN3 SCAN4 SCAN5 SCAN6

CH1

CH0

RJC

SCAN

(㎳)

: Scan Time

SCAN

START

SCAN

END

: Register Setting Time

: A/D Conversion Time

50ms + 6 scan
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12.8  Disconnection detection 

 
12.8.1 Disconnection detection function 

 
Thermocouple input module has a function that detects the disconnection and displays it. 
That the module detects and displays disconnection means that the following cabling path would have 
partially bad connection, which requires taking measures  
 
(1) If disconnection occurs between thermocouple or compensating cable and module, it generates 

error code. 
 
(2) Disconnection can be detected by channels. However, it is available for the only channel(s) 

designated for operation.  
 

Thermocouple connection 
status Channel run Disconnection flag 

Normal 
Run Off 

Stop Off 

Thermocouple 
disconnection 

Run On 

Stop Off 

 
(3) In case disconnection occurs, disconnection flag of each channel will be turned on and in case 

disconnection is canceled, it will be turned off. 
 

Disconnection flag Contents 

U0y.01.4 Ch. 0 disconnection 

U0y.01.5 Ch. 1 disconnection 
 

(4) When disconnection occurs, the min value among indication temperatures is displayed  
 

Type 
Displayed temperature in case of 

disconnection 

K type -250.0℃ 

J type -210.0℃ 
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12.9  Disconnection detection 
 

12.9.1 Average function 
 

 (1) Count average 
It accumulates temperature conversion values of a selected channel as many as average value 
and displays the average of the total sum in digital data 

Channel conversion interval (50 ms + 6 scan time)

Input after averaging 
Actual input

Averaging 
section

Averaging 
section

Sampling 
section

 
 
- Setting range = 2 ~ 64000 [times] 
 
- Averaging interval is calculated according to the number of channel used 
 
- Averaging interval[ms] = Averaging count x (50ms + 6 scan time) 
 
 

 

Remark  

(1) Averaging interval varies according to change of scan time. 
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12.10  Disconnection detection 
 

12.10.1 Installation environment 
 
Attention should be paid to the followings in order to secure the reliance and stability of the system. 
 
(1) Environmental Conditions 

(a) Install on a water-proof and dust-proof control board. 
(b) Place free of continuous impact or vibration. 
(c) Place not directly exposed to direct sunrays. 
(d) Place where dew does not form due to rapid temperature change. 
(e) Place where ambient temperature is maintained between 0 - 55℃. 

 
(2) Installation Construction 

(a) In case of screw hole processing or wiring construction, wiring dregs should not go into PLC. 
(b) Install on a position easy to access. 
(c) Should not install on the same panel which high voltage device is installed on. 
(d) It should be 50mm and longer distant from duct and modules. 
(e) Should ground in the environment where is not interrupted from noise. 
(f) Install not to contact with cooling pan in the panel 

 
(3) Cautions in handling  

It describes caution in handling from unpacking module to installation. 
(a) Do not fall or apply excessive impact on it. 
(b) Never attempt to separate PCB from the case. 
(c) Make sure that any impurities including wiring dregs should not go into the upper part of  

module during wiring work. 
 

12.10.2 Wiring  
 

(1) Cautions in wiring  
(a) Do not place AC power line close to the AUX signal line of the module. To avoid surge or 

induced noise occurring from AC, make sure to leave a proper space.  
(b) Cable should be selected by considering ambient temperature and allowable current and the  

specification of cable should be as follows.  
 

Cable specification 
Lower limit Upper limit 

0.18mm2 (AWG24) 1.5 mm2 (AWG16) 
 
(c) If cable is placed too close to any heating device or materials or if it directly contacts oil and 

 similar materials for a long time, it may cause short-circuit, resulting in breakdown and  
malfunction.  

(d) Check the polarities during terminal strip wiring 
(e) Wiring with high voltage cable or power line may cause induction problem, causing malfunction  

or trouble.  
(f) External DC24V power should be same with power of XGB. If external DC24 V power of 

thermocouple input module is turned on/off while power of XGB main unit is on, temperature 
input value may have an error.  

(g) Thermocouple input module may use 4 types of thermocouple sensors. (K / J / T / R) 
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(2) Terminal array 

Terminal array of thermocouple input module is as follows. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(3) Wiring example 
Thermocouple can be connected with module directly. If point where temperature is measured is 
far from the module, use the compensating cable to connect 
(The compensating cables are different according to thermocouple type. For more information 
about the compensating cable, contact the producer of thermocouple.) 

 
 
1) In case sensor and compensating cable are shielded, shield connection is possible to PLC FG terminal. 
2) It is necessary to use extension terminal block of which material is kept at uniform temperature in order 

to reduce error.  
3) Compensating cable should use the same type of sensor, which was used for measuring. 
 

Signal 
name Purpose 

CH0 + Channel 0 thermocouple input CH0 - 
CH1 + Channel 1 thermocouple input CH1 - 

NC Not used 
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12.11 Operation Setting and Monitor 
 

12.11.1 Operation Parameter Setting 
 
Operation parameter of thermocouple input module can be set through [I/O Parameter] of XG5000 

 
 

(1) Setting items 
For user convenience, parameter setting of thermocouple input module is provided by GUI 
(Graphical User Interface) method in the XG5000. The items which can be set through [I/O 
Parameter] in the project window are as follows.  
 

Items Contents 

[I/O Parameter] 

(a) Sets the following items for operation of module. 
1) Channel status (Disable / Enable) 
2) Sensor type (K / J) 
3) Filter setup (Filter constant) 
4) Averaging process (Count averaging) 

(b) The parameter set by the user is saved in the flash memory of XGB main 
unit after download. 

 
 

(2) How to use [I/O Parameter] 
 

(a) Execute the XG5000 and make the project.  
(For how to make the project, refer to the XG5000 user manual) 

 
(b) Double-click [I/O Parameter] on the project window. 
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(c) If [I/O Parameter Setting] window shows, find slot of base where module is installed and click it 

 
 

(d) Register the module on a slot where module is installed on as follows. 

 
 

(e) Select a module and click [Details] or double-click a module for parameter setup. 
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(f) Parameter setup screen appears as follows. If you click the item you want to set, settable 
parameter will be displayed. 

 

     
 
(g) The initial values of each item are as figure shown below 
 

1) Channel status (Disable / Enable) 

 
 
2) Sensor type (K / J) 
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3) Temp. unit (Celsius / Fahrenheit) 

 
 
 
4) Average processing (Count averaging) 

 
 
 
 
5) If you input invalid number, error message will be displayed.  

(When average value is out o range) 
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12.11.2 Special module monitoring function 
 
While XG5000 is connected with PLC, through [Monitor] -> [Special Module Monitoring], the user can 
test the operation of the module. 

 
Remark  

1) If system resource is short, the screen may not be displayed properly. In case of this, shut down 
other application program and restart the XG5000.  

2) On the [Special Module Monitoring] status, I/O parameter is set temporarily to execute the test. So 
if [Special Module Monitoring] status ends, I/O parameter is not saved.  

3) By test function of [Special Module Monitoring], the user can check if analog module operates 
properly or not without any sequence program. 

 
 

(1) How to use special module monitoring 
 

(a) Start of [Special Module Monitoring] 
While XG5000 is connected with PLC, start [Monitor] -> [Special Module Monitoring]. If that is 
not online status, [Special Module Monitoring] is not activated. 
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(b) How to use [Special Module Monitoring] 

1) Click [Monitor] -> [Special Module Monitoring] while XG5000 is connected with PLC basic 
unit. ‘Special Module List’ screen is displayed as shown below and displays information of 
base/slot with special module type. On the list dialog box, the modules currently equipped 
at the PLC are displayed. 

 
 

2) Clicking [Module Info.] shows the information of special module 

 
 
3) Clicking [Monitor] shows the following screen  
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4) [Start Monitoring]: [Start Monitoring] button will show you digital input data of the operating 

channel. The figure below is monitoring screen when all channels are “Run” status. 

 
[Start Monitoring] execution screen 

 
5) [Test]: [Test] is used to change the parameters of the Thermocouple input module. You can 

change the parameters when you click the values at the bottom of the screen. It is only 
available when XGB CPU unit’s status is in [Stop]. 

 
[Test] execution screen 
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12.11.3 Register U devices (Special module variable) 
 
It registers the variables for each module referring to the special module information that is set in the 
I/O parameter. The user can modify the variables and comments. 
 

(1) Procedure 
(a) Select the special module type in the [I/O Parameter Setting] window. 

 
 
(b) Double click ‘Variable/Comment’ from the project window. 
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(c) Select [Edit] – [Register U Device]. 
   In case of XEC, select [Edit] - [Register special module variable] 
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(d) If you click “yes”, U device will be registered automatically. At this time, if there is U device 

comment inputted previously, the previous comment will be removed. 

 
 
(e) As shown below, the variables are registered. 

 
 
 

 (2) Save variables  
(a) The contents of ‘View Variable’ can be saved as a text file.  
(b) Select [Edit] -> [Export to File]. 
(c) The contents of ‘View variable’ are saved as a text 
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 (3) View variables 

(a) The example program of XG5000 is as shown below  

 
 
(b) Select [View] -> [Variables]. The devices are changed into variables. 

 
 
(c) Select [View] -> [Devices/Variables]. Devices and variables are both displayed 
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(d) Select [View] -> [Device/Comments]. Devices and comments are both displayed. 
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12.12 Configuration and Function of Internal Memory 
 

It describes the configuration and function of internal memory 
 

 12.12.1 Data I/O area (U device) 
 

(1) Data sent from module to XGB main unit (XGB PLC input area, read only 
Device 

assignment Type Device assignment Comment R/W Signal  
direction XBC IEC 

_0y_ERR BIT U0x.00.E %UX0.y.14 Module H/W error R 
TC02A→CPU 

_0y_RDY BIT U0x.00.F %UX0.y.15 Module Ready R 
_0y_CH0_ACT BIT U0x.01.0 %UX0.y.16 CH 0 running R 

TC02A→CPU 
_0y_CH1_ACT BIT U0x.01.1 %UX0.y.17 CH 1 running R 
_0y_CH0_BOUT BIT U0x.01.4 %UX0.y.20 CH 0 disconnection R 
_0y_CH1_BOUT BIT U0x.01.5 %UX0.y.21 CH 1 disconnection R 
_0y_CH0_TEMP WORD U0x.04 %UW0.y.4 CH 0 temp. conversion value R 

TC02A→CPU 
_0y_CH1_TEMP WORD U0x.05 %UW0.y.5 CH 1 temp. conversion value R 

 
- In the device allocation, the small letter ‘y’ is the No. of the slot where the module is installed. 
- For example, to read the ‘CH0 Temperature Value’ of the TC module installed in the slot 9, write in 

U09.05. (%UW0.9.4 for IEC types) 

Device Type

U 0 9 . 0 4

Slot No.
Word

[XBC type]

Word classifier

                   

Device Type
Slot No.

Base No

Word

[IEC type]

 % U W 0 . 9 . 4

 
 

 
 
. 
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(2) Writing operation parameters through program (PUT instruction is used.) 

 
 
 

 
Remark  

How to use PUT instruction 

COMMAND

PUT

는 PUT를 나타냄

COMMAND

      P slPUTP

sl S2 NS1

S2 NS1

 
 
[Area setting] 

Operand Description Data size 
sl Slot no. where special module is mounted WORD 
S1 Internal memory address of special module WORD 
S2 Device to save in special module WORD 
N The number of data WORD 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 indicates PUT instruction. 
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12.12.2 How to set operation parameter 
 
Operation parameter of thermocouple input module can be set by two methods. 
 
(1) Setting operation parameters through [I/O parameter setting] window. 
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12.12.3 Operation parameter setting area  
 
It describes operation parameter setting area of thermocouple input module. 
 

Memory 
address Description Setting value R/W Instruction 

Hex. Dec. 

00 H 0 Designate a channel to 
use 

bit0: bit3, 0: stop, 1: run R/W 

PUT/GET 

01 H 1 Set sensor type of CH 0 
K:0, J:1 R/W 

02 H 2 Set sensor type of CH 1 

05 H 5 Designate temperature 
metric system 

bit0: bit3, 0: Celsius, 1: 
Fahrenheit R/W 

0E H 14 CH0 average value Count average: 2~64000 times R/W 0F H 15 CH1 average value 

10 H 16 Error information 
10#: sensor type setting error 
20#: count average value 
setting error 

R GET 

11 H 17 
Cold junction 
compensation temp. 

Measured value of cold junction 
compensation temp. R GET 

12 H 
~18 H 

18 
~24 

System area 
(Offset gain storage area) Read/Write unavailable unavailable  - 

 
Remark  

 Warning  (1) System area (Offset gain storage area) is area where Read/Write is unavailable. 
If this area changes, malfunction or breakdown may occur. 
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(1) Designating Channel (Address 0)  

(a) Temperature conversion module Enable/Disable can be set to each channel. 
(b) By prohibiting a channel not to use from conversion, conversion interval by channels can be 

shortened. 
(c) If channel to use is not designated, every channel can not be used. 
(d) In case of using PUT instruction, temperature conversion module Enable/Disable are as 

follows. 
 

 
bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

- - CH1 CH0------

Address t

 

Channel status
Bit On (1): Enable
Bit Off (0): Disable

---- --

 
Bit Description 
0 Stop 
1 Run 

 
(e) Vales set in B4 ~ B15 are ignored. 
(f) This area shows the same results with “Channel status” in I/O parameter setting window. 

 
 

(2) Sensor type setting area (Address 1~2) 
(a) Sets sensor type with the following code. 

   
Word Sensor type 

0 K 
1 J 

 
(b) When input value is larger than 2, 0 (K type) is selected by force 
(c) In case of using PUT instruction, Sensor Type Setting Area is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

CH0 sensor type setting

CH1 sensor type setting

Address 1

Address 2

 
(d) Vales set in B8 ~ B15 are ignored. 
(e) This area shows the same results with sensor type designation in I/O parameter setting 

window. 
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(3) Temp. unit setting area (Address 5) 
(a) Temp. unit (Celsius/ Fahrenheit) of thermocouple input module can be set per channel. 
(b) In case of PUT instruction, Temp. unit setting area is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

- - CH1 CH0------

Address 5

 

Temp unit setting
0: Celsius
1: Fahrenheit

---- --

 
   

Bit Description 
0 Celsius 
1 Fahrenheit 

 
(c) Vales set in B2 ~ B15 are ignored. 
(d) This area shows the same results with temp. unit setting in I/O parameter setting window. 
 

 
 
 
 

(4) Average value setting area (Address 14~15) 
(a) Average value can be set per channel. 
(b) If count average value is set as 0, averaging process is not applied and sampling-processed 

thermocouple input value is outputted. 
(c) In case of using PUT instruction, average value setting address is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

CH# average value setting 
Count-average: 2 ~ 64000[times]

Address 14

Address 15
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(d) This area shows the same results with count average value setting in I/O parameter setting 

window. 
(e) In the I/O parameter setting window, prohibition function is provided not to set value that is out 

of range. (In case of setting value that is out of range, error message is displayed.)   
 
1) Count-Avr. setting 

 
 

(5) Setting error information area (Address 16) 
(a) Saves error code detected at setup by the program 
(b) Setting error is canceled when invalid setting is corrected by resetting 
(c) When U0X.01.8~ U0X.01.9 (setting error flag) is on, you can cancel the error by checking this 

area and resetting  
(d) In case of GET instruction, setting error information address is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

CH0, 1 setting error informationAddress 16

 
 

Type Error 
code Description Priority Remark 

Setting 
error 

10# Input sensor type setting error 1 # means channel number  
Input channel 0,1 20# Input count average value rage 

setting error 2 

 
(e) If there are more than one errors, error code having higher priority will be saved. 

.  
 

(10) Cold junction compensation temp. area (Address 17) 
(a) Cold junction compensation temp. can be seen per channel. 
(b) In case of GET instruction, cold junction compensation temp. area is as follows. 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0

CH0,1 cold junction compensation temp.Address 17

 
 

(11) System area (offset gain storage area: address 18~24) 
(a) In the system area (18~24: offset gain storage area), Read/Write is unavailable 
 

 Caution 
If the user changes this area, it may cause malfunction or breakdown.  
So do not handle this area. 
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12.13 Example Program 
 

(1) It describes how to set operation parameter. 
(2) The initial settings are saved in the internal memory of thermocouple module 
(3) The following is program example that reads the temp. value of thermocouple input module of slot 

1 and check whether disconnection occurs or not. 
  

12.13.1 Example using [I/O Parameter] 
 
(1) I/O parameter setting window 

 
 

 
 
(2) Program example 

 
(a) If module is under normal operation, M0000 is on. 

U0A.00.F(module Ready) = On 
U0A.00.E(module H/W error) = Off 
U0A.01.0(CH0 running) = On 

(b) If M0000 is on, temp. conversion value (U0A.04) of CH0 moves to D0000. 
(c) If disconnection error occurs at CH0, U0A.01.4 (CH0 disconnection) is on and M0001 bit is set. 
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12.13.2 Program example using PUT/GET instruction 
 
(1) Program example (XBC Type) 

 
 

(a) It writes h0001 at address 0 of slot 1 in order to enable CH0 by using PUT instruction. 
(b) If module is under normal operation, M0000 is on. 

U0A.00.F(Module Ready) = On 
U0A.00.E(Module H/W error) = Off 
U0A.01.0(CH 0 running) = On 

(c) If M0000 is on, temp. conversion value of CH0 moves to D0000. 
Current temp. conversion value, 278(27.8℃2) is saving in U0A.04. 

(d) If disconnection error occurs at CH0, U0A.01.4 (CH0 disconnection) is on and M0001 bit is set. 
(e) If M0000 is on, setting error (address 16) of CH0 moves to D0001. Since setting error (address 

16) of CH0 is 0, there is no setting error. 
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(2) Program example (IEC Type) 

 
 

(a) It writes 1 at address 0 of slot 1 in order to enable CH0 by using PUT instruction. 
(b) If module is under normal operation, %MX0 is on. 

%UX0.10.15 (Module Ready) = On 
%UX0.10.14 (Module H/W error) = Off 
%UX0.10.16 (CH 0 running) = On 

(c) If M0000 is on, temp. conversion value of CH0 moves to CH0_DATA. 
Current temp. conversion value, CH0 Temp Value(%UW0.10.4)is saving in CH0_DATA. 

(d) If disconnection error occurs at CH0, %XU0.10.20 (CH0 disconnection) is on and %MX1 bit is 
set. 

(e) If %MX0 is on, setting error (address 16) of CH0 moves to ERR_DATA. Since setting error 
(address 16) of CH0 is 0, there is no setting error. 
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12.13.3 Example when error occurs  
 
(1) Program Example 

 
(a) If disconnection error occurs at CH0, U0A.01.4 (CH0 disconnection) is on and M0001 bit is set 
(b) If disconnection error occurs at CH0, min. value within the range of K type temperature senor 

is displayed at U01.04. 
(c) It is monitored as follows according to monitor display type. 
   When monitoring the temp. conversion value, select “Unsigned Decimal”. 
 

Monitor display type Display content 
Unsigned Decimal 63036 
Signed Decimal -2500 (-250.0℃) 
Hexadecimal hF63C 
As Instruction 63036 
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12.14 Troubleshooting 
 

The chapter describes diagnostics and measures in case any trouble occurs during use of 
thermocouple input module. 

 

12.14.1 Status in case of error 
     

You can check whether there is error or not according to the module status. 
 

Items Normal Disconnection 
Module H/W error 

(Heavy error) 

Operation 
Normal operation 

Every function works 

Normal operation 

Min. temp. is displayed 
Module function stops 

Measure − Checking sensor wiring Customer service 
 
 
 

12.14.2 Stats check of module 
 
Module type, module information, O/S version and module status of thermocouple input module can 
be checked through XG5000 system monitoring function. 

 
(1) Execution sequence 

Two routes are available for the execution. 
(a) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button to 

display [Module Information]. 
(b) [Monitor] -> [System Monitoring] -> And Double-click the module screen. 

(2) Module information 
(a) Module type: shows the information of the module presently installed. 
(b) Module information: shows the O/S version information of module. 
(c) O/S version: shows the O/S prepared date of module. 
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12.14.3 Troubleshooting 
 

Temperature conversion value is not 
normal

Installation is correct

Install the option board correctly.d No

Yes

FG ground is normal

Execute FG ground properly referring to user 
manual

d No

Yes

Wiring is normal
(K,J type thermocouple sensor input 
wiring)

Wire properly referring to user manuald No

Yes

Parameter setting is normal.
(Channel status, input range setting)

Set parameter properly referring to user 
manual.

d No

Yes

Contact the nearest agency or LS 
branch office.
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Chapter 13 Analog Input Module (XBF-AD04C) 
 

13.1 Setting Sequence before Operation 
 

Before using the analog input module, follow steps below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 

 

XBF-AD04C 

 

 

 

 

 Checking performance specification 

 

Wiring 

 

Reading analog input data 

 

Setting parameter 

 

Programming 

Specification(13.2.2 performance specification)) 
 Operating environment 
 Input type and range 
 Digital output range 

 

Wiring 
 Wiring power (External DC24V) 
 Wiring analog input  

(Setting types of Voltage/Current input) 

Analog input test 
 XG5000 special module monitor test mode 

 

Parameter 
 XG5000 I/O parameter 

Programming 
 Programming for reading analog data 

 (U device) 

 

 
 Refer to trouble shooting when there is  

error or analog data is abnormal. 
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13.2 Specifications 
 

13.2.1 General specifications 
General specifications are as follows. 

 

 
 

No. Items Specification 
Related 

standards 

1 
Operating 

temperature 
0 ~ 55 C - 

2 
Storage  

temperature 
25 ~ 70 C - 

3 
Operating 

humidity 
5∼95%RH  non-condensing - 

4 
Storage 

humidity 
5∼95%RH  non-condensing - 

5 
Vibration 

Immunity 

For discontinuous vibration  - 

Frequency Acceleration Amplitude Times 

IEC61131-2 

10    f    57Hz  0.075mm 

10 times in 

each 

direction for 

 X, Y, Z 

57    f    150Hz 9.8m/s
2
(1G)  

For continuous vibration 

Frequency Acceleration Amplitude 

10    f    57Hz  0.035mm 

57    f    150Hz 4.9m/s
2
(0.5G)  

6 
Shocks 

Immunity 

  Max. impact acceleration : 147 m/s
2
(15G) 

  Authorized time : 11ms 
  Pulse wave : Sign half-wave pulse (Each 3 times in X,Y,Z directions) 

IEC61131-2 

7 
Noise 

Immunity 

Square wave 

impulse noise 
1,500 V LSIS standard 

Electrostatic 

discharge 
Voltage : 4kV(contact discharge) 

IEC61131-2 

IEC61000-4-2 

Radiated 

electromagnetic 

field noise 

80 ~ 1,000 MHz,  10V/m 
IEC61131-2, 

IEC61000-4-3 

Fast transient 
/Burst noise 

Segment 

Power 

Supply 

module 

Digital/Analog I/O 

communication interface IEC61131-2 

IEC61000-4-4 

Voltage 2kV 1kV 

8 
Ambient 

conditions 
No corrosive gas or dust - 

9 
Operating 

height 
2,000m or less - 

10 
Pollution 

degree 
2 or less - 

11 Cooling type Natural air cooling - 
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13.2.2 Performance specifications 
Performance specifications are as follows. 

 

Items Performance specification 

Number of channels 4 channels 

Analog 

input 

Type Voltage Current 

Range 

DC 1 ~ 5V 

DC 0 ~ 5V 

DC 0 ~ 10V 

DC -10 ~ 10V 

(Input resistance: 1 ㏁ min) 

DC 4 ~ 20mA 
DC 0 ~ 20mA 
(Input resistance: 250 Ω) 

Current input or Voltage input can be selected through the external 

terminal wiring setting. 

►In voltage mode, use V+ and COM terminal for the channel. 

In current mode, short V+ and COM terminal and then use I+  

and COM terminal. 

Digital 
output 

Type 16 bit binary data (Data : 14Bit) 

Range 

Unsigned 
value  

0 ~ 16,000 

Signed value -8,000 ~ 8,000 

Precise value 

1,000 ~ 5,000 (1 ~ 5V) 

0 ~ 5,000 (0 ~ 5V) 

0 ~ 10,000 (0 ~ 10V) 

-10,000 ~ 10,000 (±10V) 

4,000 ~ 20,000 (4 ~ 20㎃) 

0 ~ 20,000 (0 ~ 20㎃) 

 

 

Percentile 
value 

0 ~ 10,000 

Max. resolution 

1/16,000 

0.250㎷ (1 ~ 5V) 

0.3125㎷ (0 ~ 5V) 

0.625㎷ (0 ~ 10V) 

1.250㎷ (±10V) 

1.0㎂ (4 ~ 20㎃) 

1.25㎂ (0 ~ 20㎃) 

 

 

Accuracy 
±0.2% or less (When ambient temperature 25℃) 

±0.3% or less (When ambient temperature 0 ~ 55℃) 

Max. conversion speed 1㎳/ channel 

Absolute max. input DC ±15V DC ±30㎃ 

 

Addition 

function 

Filter  Digital filter(4 ~ 64,000㎳) 

Average  
Time average (4~16,000㎳) 

Count average (2~64,000times) 

Detection alarm Disconnection(DC 1~5V, DC 4~20㎃) 

Hold last value 
When input signal exceeds the effective range, holds the last 

effective value. 

Alarm function 
When input signal exceeds the effective range,  

relevant flag turns on. 

Insulation method 
Photo-coupler insulation between input terminal and 
PLC power (No insulation between channels) 

Connection terminal 15 point terminal block 

I/O points occupied Fixed type assignment: 64 

Max. attachable number 
7ea (when using XBM(C)-DxxxS type) 
10ea (when using XB(E)C-DxxxH type) 

Consumption 
current 

Internal (DC 5V) 105mA 

External (DC 24V) 100mA 

Weight 72g 

Module input power DC 20.4~28.8V 
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Remark 1) To use the analog input module (14 Bit), It needs the basic unit more than below table. 
  

Segment Version 

XBM-DxxxS Type V3.30 or above 

XBC-DxxxH Type V2.20 or above 

XBC-DxxxSU Type V1.30 or above 

XBC-DxxxS Type V1.20 or above 

XEC-DxxxH Type V1.50 or above 

XEC-DxxxSU Type V1.10 or above 

XG5000 V3.64 or above 

 
 
 



Chapter 13 Analog Input Module (XBF-AD04C) 

 

13 - 5 

 

 

13.3 Name of each Part and Functions 
 

Respective designations of the parts are as described below.   

 

①

②

③

④

XBF-AD04C

RUN

XBF-AD04C

DC24V

-10~10V

0~20mA

V0+

I0+

COM0

V1+

I1+

COM1

V2+

I2+

COM2

V3+

I3+

COM3

 
 
 

No. Name Description 

① RUN LED 

▶ Displays the operation status of module  

On: Operation normal 

Blinks: Error occurs (Flickering 1s intervals)  

Off: Power off or module error 

② Terminal ▶ Wiring terminal block to connect with external device 

③ 
External 

power supply 
▶ Terminal for supplying the external DC24V 

④ Ext. Connector ▶ Connector for extension modules. 
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13.4 Characteristic of I/O Conversion 
 

Voltage/Current input ranges are able to set from each channel by using user program or I/O 
parameter. Data output type of digital is defined as below. 
(1) Unsigned Value 
(2) Signed Value 
(3) Precise Value 
(4) Percentile Value 

Digital

output

value

0

4000

8000

12000

16000
16191

-192
-8000

-4000

0

4000

8000
8191

-8192
0

2500

5000

7500

10000
10119

-120

DC 1 ~ 5 V

DC 0 ~ 5 V

DC 0 ~ 10 V

DC 4 ~ 20 mA

1 V 5 V3 V

0 V 2.5 V 5 V

0 V 5 V 10 V

4 mA 12 mA 20 mA

Analog 

input

value

Analog input applicable

range

Offset 

value

Gain

value

DC 0 ~ 20 mA 0 mA 10 mA 20 mA

DC -10 ~ 10 V -10 V 0 V 10 V  
 

 (1) DC 4 ~ 20mA Input range 

Digital 
output range 

Analog input current (㎃) 

3.808 4 8 12 16 20 20.191 

Unsigned value 
(-192 ~ 16191) -192 0 4,000 8,000 12,000 16,000 16,191 

Signed value 
(-8192 ~ 8191) -8,192 -8,000 -4,000 0 4,000 8,000 8,191 

Precise value 
(3808 ~ 20191) 3,808 4,000 8,000 12,000 16,000 20,000 20,191 

Percentile value 
(-120 ~ 10119) -120 0 2,500 5,000 7,500 10,000 10,119 

 
(2) DC 0 ~ 20mA Input range 

Digital 
output range 

Analog input current (㎃) 

-0.24 0 5 10 15 20 20.239 

Unsigned value 
 (-192 ~ 16191) -192 0 4,000 8,000 12,000 16,000 16,191 

Signed value 
 (-8192 ~ 8191) -8,192 -8,000 -4,000 0 4,000 8,000 8,191 

Precise value 
 (-240 ~ 20239) -240 0 5,000 10,000 15,000 20,000 20,239 

Percentile value 
 (-120 ~ 10119) -120 0 2,500 5,000 7,500 10,000 10,119 
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     (3) DC 1 ~ 5V Input range 

Digital 
output range 

Analog input voltage (V) 

0.952 1 2 3 4 5 5.047 

Unsigned Value 
(-192 ~ 16,191) -192 0 4,000 8,000 12,000 16,000 16,191 

Signed Value 
(-8,192 ~ 8,191) -8,192 -8,000 -4,000 0 4,000 8,000 8,191 

Precise Value 
(952 ~ 5,047) 952 1,000 2,000 3,000 4,000 5,000 5,047 

Percentile Value 
(-120 ~ 10,119) -120 0 2,500 5,000 7,500 10,000 10,119 

 
 

(4) DC 0 ~ 5V Input range 

Digital 
output range 

Analog input voltage (V) 

-0.06 0 1.25 2.5 3.75 5 5.059 

Unsigned Value 
 (-192 ~ 16,191) -192 0 4,000 8,000 12,000 16,000 16,191 

Signed Value 
 (-8,192 ~ 8,191) -8,192 -8,000 -4,000 0 4,000 8,000 8,191 

Precise Value 
 (-60 ~ 5,059) -60 0 1,250 2,500 3,750 5,000 5,059 

Percentile Value 
 (-120 ~ 10,119) -120 0 2,500 5,000 7,500 10,000 10,119 

 
 

 (5) DC 0 ~ 10V Input range 

Digital 
output range 

Analog input voltage (V) 

-0.12 0 2.5 5 7.5 10 10.119 

Unsigned Value 
 (-192 ~ 16,191) -192 0 4,000 8,000 12,000 16,000 16,191 

Signed Value 
 (-8,192 ~ 8,191) -8,192 -8,000 -4,000 0 4,000 8,000 8,191 

Precise Value 
 (-120 ~ 10,119) -120 0 2,500 5,000 7,500 10,000 10,119 

Percentile Value 
 (-120 ~ 10,119) -120 0 2,500 5,000 7,500 10,000 10,119 

 
 

 (6) DC -10 ~ 10V Input range 

Digital 
output range 

Analog input voltage (V) 

-10.24 -10 -5 0 5 10 10.239 

Unsigned Value 
 (-192 ~ 16,191) -192 0 4,000 8,000 12,000 16,000 16,191 

Signed Value 
 (-8,192 ~ 8,191) -8,192 -8,000 -4,000 0 4,000 8,000 8,191 

Precise Value 
 (-10,240 ~ 10,239) -10,240 -10,000 -5,000 0 5,000 10,000 10,239 

Percentile Value 
 (-120 ~ 10,119) -120 0 2,500 5,000 7,500 10,000 10,119 
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13.5 Accuracy 
 
 

Accuracy of digital output value does not changed even if input range is changed. Figure below  
shows the range of the accuracy with analog input range of 0 ~ 10 V and digital output type of  
unsigned value selected.  
Accuracy of XBF-AD04C is ±0.2% (ambient temperature of 25 degrees) 

 
 
 

0
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(1) Accuracy when using 5V input 
 16,000 × 0.2% = 32 
 Therefore the range of the accuracy will become (8,000-32) ~ (8,000+32) = 7,968 ~ 8,032  
 when using 5V input. 

 
 

(2) Accuracy when using 10V input  
16,000 × 0.2% = 32 
Therefore the range of the accuracy will become  
(16,000-32)~(16,000+32) = 15,968 ~16,032 when using 10V input. 
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13.6 Functions of Analog Input Module 
 

 
Functions of XBF-AD04C conversion module are as described below.  

 

Function Description 

Channel Run/Stop 

setting 

● Specify Run/Stop of the channel to execute A/D conversion. 

● If the unused channel is set to Stop, whole Run time can be reduced. 

Input voltage/current 

range setting 

● Specify analog input range to be used. 

● Select range in parameter setting after select Voltage/Current switch. 

● Analog input module provides two kinds of current input ranges (4~20mA,  

0~20mA) and four kinds of voltage input ranges (1~5V, 0~5V, 0~10V,10~10V) 

Output data format 

setting 

● Specify digital output type. 

● 4 output data formats are provided in this module. 

  (Unsigned value, Signed value, Precise value, Percentile value) 

A/D conversion 

methods 

● Sampling processing 

- Sampling process will be performed if A/D conversion type is not specified. 

● Filter processing 

- Used to delay the sudden change of input value. 

● Average processing 

- Outputs average A/D conversion value based on frequency or time. 

● Detection alarm  

- After detecting whether disconnection of the input circuit, the alarm is  

displayed by a single flag. 

(Input signal range : 4 ~ 20㎃, 1 ~ 5 V) 

● Maintenance function of valid conversion value. 

- When valid conversion value is exceeded, whether conversion value 

 retains will be able to set. 

● Alarm function 

- When exceeding valid input range, alarm and maximum /minimum flag  

will be generated. 

 
 
 

13.6.1 Sampling processing 
 

It collects analog input sign through general A/D conversion processing at a specific interval  
to convert to digital. The time required for A/D conversion of analog input sign till saved on the 
memory depends on the number of channels used.  

 

(Processing time)  = (Number of channels used) X (Conversion speed) 

 

  (Ex.) If the number of channels used is 3, its process time will be 

3  x  1 ㎳ = 3 ㎳ 

 
 Sampling is to calculate the sampling value of continuous analog sign at a specific interval.  
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13.6.2 Filter processing 
 

Pre-filter input value and specified channel are calculated as below. 

) channels used ofNumber 1(ConstantFilter 

) channels used ofNumber 1ValueInput Current ()Constant Filter   ValueInput  Filtered-Pre(
 Value Filtered






ms

ms

 
 
Setting range of Filter constant = 4 ~ 64,000 [ms] 
 
 

 

Input 

value

10000

6320

0

Input value after filtering 

Actual input value

Filter constant

(ms)

Time(ms)

 
 
As the above graph, if the input value rapidly decreases from 0 to 10,000, the input value will be 
filtered. Specified time with filter constant is that the input value is the time to change by 63.2% 
of actual time constant. 
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13.6.3 Average processing 

 

1) Time average 
 
Input value of specified channel accumulates during setting time and then the average 
value of the sum is shown with digital data.  

평균처리후 입력값

실제 입력값

평균처리구간 샘플링처리구간

Channel scan Interval (1ms/ used channel)

Input value after 

average processing

Actual input value

Average processing interval Average processing interval Sampling processing interval

 
Setting range = 4 ~ 16,000 [ms] 
In case of the time average, the average processing count is calculated by depending on 
the number of used channels. 

ms1 channels used ofNumber 

 timeAverage
count processing Average


   

 

2) Number of averages 
 
Input value of specified channel accumulates during setting numbers and then the average 
value of the sum is shown with digital data.  

평균처리후 입력값

실제 입력값

Average processing interval 평균처리구간 샘플링처리구간

Channel scan interval (1ms/ used channel)

Input value after 

average processing

Actual input value

Average processing interval Average processing interval
Sampling processing interval

 
Setting range = 2 ~ 64,000 [times] 
In case of number of averages, the average processing interval is calculated by depending 
on used channels. 
 

Average processing interval [㎳]  

= Number of averages × Number of used channels × 1㎳ 
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(1) In case of the time/number of average, every conversion time input value is not outputted. And 
precondition is retained until the average time/number is arrived. 

(2) Two kinds of average functions and introduced filtering functions that are above are able to deal with 
at the same time.  
When those are chosen at the same time, the top priority is filter function in the processing  
sequence. And then the chosen average function is adapted. Finally, digital data is outputted. At that 
time digital data value is outputted as the final processing value. 

Notes 
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13.6.4 Detecting disconnection wire 
 
In case that Input voltage(DC 1~5V) or Input current (DC 4~20 mA) is chosen with analog input range, 
the analog input module has diagnostic function by checking disconnection and showing.  
If the module shows disconnection, that means the parts of connections in the wiring connection are 
faulty. If so, check and take action. 
 
(1) Detection conditions 

When input signal range of 4~20mA and 1~5V is used, disconnection of input circuit can be 
detected. The detection conditions of each input signal range are as below. 

Input signal range Voltage/Current recognized as a disconnection 

4 ~ 20 ㎃ 0.8 ㎃ or less 

1 ~ 5 V 0.2 V or less 

 
(2) When between used wiring and module is disconnected, the LED will be turned on/off 1s intervals 

and make an error code. 

 
(3) Each channel can detect disconnection. However, Disconnection is only displayed for specified 

operation channel. The LED can commonly use the channel from 0 to 3. If one or more channel is 
disconnected, LED will be turned on/off. 

 

Input connections 
Channel 

operation 
 LED condition 

Disconnection 
flag 

Normal 
Operation On Off 

Stop On Off 

Input wiring is disconnected 

or Input is not connected. 

Operation 
Flickering 1s 

intervals 
On 

Stop On Off 

 
(4) In case of disconnection, disconnection flag of relevant channel will turn on and In case of 

 connection, disconnection flag of relevant channel will turn off. 

Disconnection flag 
Description Condition 

XBM/XBC XEC 

U0y.10.0 %UX0.y.160 Channel 0 disconnection 

Off: Normal 

On: Disconnection 

U0y.10.1 %UX0.y.161 Channel 1 disconnection 

U0y.10.2 %UX0.y.162 Channel 2 disconnection 

U0y.10.3 %UX0.y.163 Channel 3 disconnection 

※ The 'y' is a slot number equipped with a module. 
 

 (5) In case of disconnection, the input value displays the lowest value among each input range. 
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13.6.5 Function retaining valid conversion value 
 
When the valid signal is out of the range, the last converted valid input value is retained. 
The function retaining valid conversion value is able to designate for each channel by user program  
and I/O parameter setting. 
 

1) Used input range 
 
In the channels that allow the function retaining valid conversion value, the actual ranges 
provided within each digital conversion value are shown. 

For example, in case of operating output data type of unsigned value, original digital output value  

is shown from -192 to 16,191.  

However, if this function is allowed, it will be shown from 0 to 16,000. 

 

(1) Digital output value depending on input range ( unsigned value, signed value, percentile value) 

 

Classification  
Unsigned 

value 
Signed  
value 

Precise  
value 

Percentile 
value 

Unapplied case -192~16,191 -8,192~8,191 

(2) Reference 

-120~10,119 

Applied case 0~16,000 -8,000~8,000 0~10,000 

 

 

(2) Digital output value depending on input range (Precise value)          

 

Analog input range Classification Precise value 

4 ~ 20㎃ 
Unapplied case 3,808~20,191 

Applied case 4,000~20,000 

0 ~ 20㎃ 
Unapplied case -240~20,239 

Applied case 0~20,000 

1 ~ 5V 
Unapplied case 952~5,047 

Applied case 1,000~5,000 

0 ~ 5V 
Unapplied case -60~5,059 

Applied case 0~5,000 

0 ~ 10V 
Unapplied case -120~10,119 

Applied case 0~10,000 

-10 ~ 10V 
Unapplied case -10,240~10,239 

Applied case -10,000~10,000 

 
 

2) Operation 
 
When operating with 4 ~ 20mA while being allowed this function, output value for input value 
change of the moment is as follows. (Output data type : In case of 0~16,000) 

Input 

current(㎃) 
12㎃ 3㎃ 4㎃ 12㎃ 21㎃ 20㎃ 

Digital output 
value 

8,000 8,000 0 12,000 12,000 16,000 

Remarks for 
reference 

- 
Retaining 
previous 

value 
- - 

Retaining 
previous 

value 
- 
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13.6.6 Alarm function 
 
When the input signal is exceeded from valid value, the alarm will be shown through alarm flag of 
relevant channel. 
 
 

1)Input detection function 
 

Detection condition for each input signal range is as below. 

 

Analog input 
range 

Difference 
Permission 

range 
Low limit High limit 

4 ~ 20㎃ 16㎃ 

1.2% 

3.808㎃ 20.192㎃ 

0 ~ 20㎃ 20㎃ -0.24㎃ 20.24㎃ 

1 ~ 5V 4V 0.952V 5.048V 

0 ~ 5V 5V -0.06V 5.06V 

0 ~ 10V 10V -0.12V 10.12V 

-10 ~ 10V 20V -10.24V 10.24V 

 
 

2)Alarm sign of each channel 
 
Alarm detection signal about each input channel is shown on U0y.11 and U0y.12. If the input 
signal come back, the alarm detection sign will automatically come back. (The 'y' is the slot 
number of equipped modules.) 

 

(1) High limit alarm (U0X.11) 

Device assignment 
Description Status description 

XBM/XBC XEC 

U0y.11.0 %UX0.y.176 Channel0 high limit alarm 

Off: Normal 
On: Maximum alarm 

occurrence 

U0y.11.1 %UX0.y.177 Channel1 high limit alarm 

U0y.11.2 %UX0.y.178 Channel2 high limit alarm 

U0y.11.3 %UX0.y.179 Channel3 high limit alarm 

 

 (2) Low limit alarm (U0X.12) 

Device assignment 
Description Status description 

XBM/XBC XEC 

U0y.12.0 %UX0.y.192 Channel0 low limit alarm 

Off: Normal 
On: Maximum alarm  

occurrence 

U0y.12.1 %UX0.y.193 Channel1 low limit alarm 

U0y.12.2 %UX0.y.194 Channel2 low limit alarm 

U0y.12.3 %UX0.y.195 Channel3 low limit alarm 
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13.7 Installation and Wiring 
 

13.7.1 Installation and separation of module 
 

Notices in handling 
Use the PLC within general specification ranges from instructions. 
When the PLC is used out of the specified ranges, it will cause burning, getting electric shock, 
abnormal operation. 
 
 
 
 
 Fix the module after being equipped with binding bump of module.  
  If the module is incorrectly attached, the module will be broken and malfunction. 
 
 Please be careful for external impact, like falling the case of module, terminal connector. 
 
 Do not separate the PCB board of module from the case. 
 
 
 
(1) Installation of module 
 

 Remove the extension cover above the module to connect.  

 Push modules to connect each other after situating four positions binding correctly. 

 After connection, fix the binding hook that is in the upward part and downward part  
 completely. 
 
 

 
 
 
 
 
 

  Caution 

Hook for module fixing 
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(2) Separation of module 
 

 Divide connections by lifting hook for module fixing in the upward part and downward part. 

 Separate modules by holding modules with both hands. (Do not hold strongly in the 
module.) 

 

 
 
 
 
 
 
 
 
 
 
 
 
 When you try to separate the modules strongly,  the hook and bump for fixing will be 

 broken. 
 
 

 
 
 
 
 
 
 
 
 
 

Hook for module separating 

Caution 
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13.7.2 Notices in wiring 
 

(1) Do not put the power line near the external I/O signal line of analog input module. You have to  
secure enough distance to avoid the interruption from the induced noise and the surge.  

(2) The wire has to select by considering permitted current and the ambient temperature.  

The maximum wire size is good in case of AWG22 (0.3㎟) or more.  

(3) When the wire is so near with high temperature machines and materials and touched with oil for  
a long time, it can be short circuit and malfunction. 

(4) When doing terminal ports wiring, check the polarity. 
(5) In case that the high voltage line and the power line are wired at the same time, the induced  

interruption is caused. So it can be a reason for breakdown. 

 
13.7.3 Example for the wiring 
 

(1) The input resistance of current input circuit is 250Ω (typ.).  
(2) The input resistance of voltage input circuit is 1 MΩ (min.).  
(3) Set the operation mode only if you want to use channels. 
(4) The analog input module doesn't provide the power for input device. 

Use the external power device. 
(5) Example for analog input wiring 

When inputting the voltage, relevant channel V+ and COM terminal is used. When inputting  
the current, relevant channel V+ and COM terminal is used after connecting between V+ and I+ 
terminal. 

 

 
a) Voltage wiring 

XBF-AD04C

RUN

XBF-AD04C

DC24V

-10~10V

0~20mA

V0+

I0+

COM0

V1+

I1+

COM1

V2+

I2+

COM2

V3+

I3+

COM3

CH0+

-

CH1+

-

CH0 -
CH2+

-

CH3+

-

CH0+

CH1 -

CH1+

CH2 -

CH2+

CH3 -

CH3+

V0+

COM0

V1+

COM1

V2+

COM2

V3+

COM3

DC24V+

DC24V-DC Power
(For analog module)

FG

 

※ DC power for analog power supply have to connect DC24V- with FG. 
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b) Current wiring 

XBF-AD04C

RUN

XBF-AD04C

DC24V

-10~10V

0~20mA

V0+

I0+

COM0

V1+

I1+

COM1

V2+

I2+

COM2

V3+

I3+

COM3

CH0+

-

CH1+

-

CH0 -
CH2+

-

CH3+

-

CH0+

CH1 -

CH1+

CH2 -

CH2+

CH3 -

CH3+

I0+

COM0

I1+

COM1

I2+

COM2

I3+

COM3

DC24V+

DC24V-

FG

DC Power
(For analog module)

 

※ DC power for analog power supply have to connect DC24V- with FG. 
 

(6) The example of analog input 2-Wire sensor/transmitter wiring(The current wiring) 

 Use the I+ and COM terminal after connecting V+ with I+ terminal. 
 

DC

+

-

2- Wire

Transmitter

XBF-AD04C

RUN

XBF-AD04C

DC24V

-10~10V

0~20mA

V0+

I0+

COM0

V1+

I1+

COM1

V2+

I2+

COM2

V3+

I3+

COM3

CH0

CH1

CH0 -
CH2

CH3

CH0+

CH1 -

CH1+

CH2 -

CH2+

CH3 -

CH3+

I0+

COM0

I1+

COM1

I2+

COM2

I3+

COM3

DC

+

-

2- Wire

Transmitter

DC

+

-

2- Wire

Transmitter

DC

+

-

2- Wire

Transmitter

DC24V+

DC24V-

FG

DC Power
(For analog module)

 

※ DC power for analog power supply have to connect DC24V- with FG. 
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(7) The example of analog input 4-Wire sensor/transmitter wiring(The current input) 

Use the I+ and COM terminal after connecting V+ with I+ terminal. 

DC

+

-

4- Wire

Transmitter

XBF-AD04C

RUN

XBF-AD04C

DC24V

-10~10V

0~20mA

V0+

I0+

COM0

V1+

I1+

COM1

V2+

I2+

COM2

V3+

I3+

COM3

CH0

CH1

CH0 -
CH2

CH3

CH0+

CH1 -

CH1+

CH2 -

CH2+

CH3 -

CH3+

I0+

COM0

I1+

COM1

I2+

COM2

I3+

COM3

DC

+

-

4- Wire

Transmitter

DC

+

-

4- Wire

Transmitter

DC

+

-

4- Wire

Transmitter

DC24V+

DC24V-

FG

DC Power
(For analog module)

 

※ DC power for analog power supply have to connect DC24V- with FG. 
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(8) Relationship between voltage input accuracy and wiring length 

In voltage input, the wiring (cable) length between transmitter or sensor and module has an effect 
on digital-converted values of the module as specified below; 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
       

 
Where,        

 
Rc: Resistance value due to line resistance of cable 

         
       Rs: Internal resistance value of transmitter or sensor 
 

       Ri: Internal resistance value (1㏁) of voltage input module 

  
       Vin: Voltage allowed to analog input module  
 
       % Vi: Tolerance of converted value (%) due to source and cable length in voltage input 

                 
  RiRcRs

VsRi
Vin






2
  

 

%1001% 









Vs

Vin
Vi     

 
 

Vs 

Rs Rc 

Rc 

Ri 

Load 
 

The analog input(voltage) 

Vin 
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13.8 Operation Parameter Setting 
 

A/D conversion module’s operation parameters can be specified through XG5000’s [I/O parameters]. 

 

(1) Settings 

For the user’s convenience of A/D conversion module, XG5000 provides GUI (Graphical User 
Interface) for parameters setting of A/D conversion module. Setting items available through [I/O 
parameters] on the XG5000 project window are as described below in the table.  

 

Item Details 

[I/O parameter] 

(a) Parameter setting 
Specify the following setting items necessary for the module operation. 

1) Channel Enable/Disable setting 

2) Input voltage(current) range 

3) Output data format setting 

4) Filter constant setting 

5) Average processing method setting 

6) Average value setting 

(b) When the parameters set by user in XG5000 is downloaded, that data is 

saved in flash memory of XGB basic unit. 

 

2) [I/O Parameter] Using method 

 (1) Run XG5000 to create a project. 
(Refer to XG5000 program manual for details on how to create the project) 

 (2) Double-click [I/O parameters] on the project window. 
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 (3) [I/O Parameter setting] On the 'I/O parameters setting’ screen, find and click the slot  
equipped with analog input module.  

 

 

 

 (4) Click the arrow button on the screen above to display the screen where an applicable  
module can be selected. Search for the applicable module to select.  

 

  

 

 (5) After the module selected, click [Details]. 
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 (6) A screen will be displayed for you to specify parameters for respective channels as below. 
Click a desired item to display parameters to set for respective items.  
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13.9 Special Module Monitoring Functions 
 

Functions of Special Module Monitoring are as described below.  

 

1) Start of [Special Module Monitoring] 
Go through [Online]  [Connect] and [Monitor]  [Special module Monitoring] to start. If the 
status is not online, [Special Module Monitoring] menu will not be activated. 

 
 

 

Notes  

1) The screen may not normally be shown due to the lack of system resource. In this case, terminate  
all applications and try to start XG5000 again. 

2) I/O parameter set in status of [Special Module Monitor] is temporally set to implement the test.  
So, If status of [Special Module Monitor] is ended, I/O parameter which is set becomes extinct. 

3) The test of [Special Module Monitor] is a examination function to check operation of the analog  
input module when the sequence program is not made up. 

 

 

2) How to use special module monitoring 
(1) With XG5000 connected to PLC CPU (on-line status), click [Monitor] -> [Special Module 

Monitoring] to display ‘Special Module Select’ screen as below showing base/slot 

information in addition to special module type. The module installed on the present PLC 

system will be displayed on the list dialog box. 
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(2) Select “Special Module” and click [Module information] to display the information as below.  

 

 
 

(3) Click [Monitor] on the “Special Module” screen in [Special Module List] to display [Special 

Module Monitoring] screen as below.  
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(4) Start Monitoring: Click [Start Monitoring] to show digital input data of current operated 

channel. When the channel is operating you can see the painting through monitor. 

 
Execution screen of [Start Monitoring] 

 

(5) Test: [Test] is a function to change the parameter of the analog input module which is 

presently set. In case of clicking the setting value in the bottom of the screen, you can 

change the parameter. [Test] is able to set only if operation status of XGB's basic unit is 

stop. 

 
 Execution screen of [Test] 

Monitoring 

CH0 details 
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(6) Max/Min Value Monitor 

 Max/Min value of input channel in operation can be monitored. However, visible Max/Min  
values are based on present value. 

 So Max/Min value is not saved when [Monitoring/Test Screen] is closed. 
 

 
[Max/Min Value Monitor] execution screen 

 
(7) Close 
   [Close]: [Close] is used to escape from the monitoring/test screen. When the monitoring 

/test screen is closed, the max. value, the min. value and the present value will not be  
saved any more. 

 

 

Reset of Max/Min value 

Monitoring of Max/Min value 
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13.10  Register U Devices 
 

 Register the variables for each module referring to the special module information that is set in the  
I/O parameter. The user can modify the variables and comments. 
 

 1) Procedure 
 

(1) Select the special module type in the [I/O Parameter Setting] window. 
 

 
 

(2) Double click ‘Variable/Comment’ from the project window. 
 

 
 

(3) Select [Edit] – [Register U Device]. 
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(4) Click ‘Yes’ 
 

 
 

(5) As shown below, the variables are registered. 
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(6) For IEC type, as shown below, the variables are registered. 
 

 
 

 

2) Save variables 
(1) The contents of ‘View Variable’ can be saved as a text file. 
(2) Select [Edit] -> [Export to File]. 
(3) The contents of ‘View variable’ are saved as a text file. 
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 3) View variables 
 

 The example of XBC type is as follows. 

 
 

(1) The example program of XG5000 is as shown below.  
 

 
 

 (2) Select [View] -> [Variables]. The devices are changed into variables. 
 

 
 

  
 
(3) Select [View] -> [Devices/Variables]. Devices and variables are both displayed. 
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(4) Select [View] -> [Device/Comments]. Devices and comments are both displayed. 
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(5) Select [View] -> [Variables/Comments]. Variables and comments are both displayed. 
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(6) In case of IEC, you can see variables with diverse option at ‘View’ menu like (1)~(5). 
The following is example selecting ‘View Variable/Comment’ at IEC type. 
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13.11 Configuration and Function of Internal Memory 
 

A/D conversion module has the internal memory to transmit/receive data to/from PLC CPU.  

. 

13.11.1  I/O area of A/D converted data 

I/O area of A/D converted data is as displayed in table. 
 

Variable name Type 

Device assigned 

Details R/W 
Direction 

of signal XBM/XBC 
XEC 

(IEC type) 

_0y_ERR BIT U0y.00.0 %UX0.y.0 Module Error 
R 

AD04C → 

CPU _0y_RDY BIT U0y.00.F %UX0.y.15 Module Ready 

_0y_CH0_ACT BIT U0y.01.0 %UX0.y.16 Channel 0 Run 

W 
AD04C → 

CPU 

_0y_CH1_ACT BIT U0y.01.1 %UX0.y.17 Channel 1 Run 

_0y_CH2_ACT BIT U0y.01.2 %UX0.y.18 Channel 2 Run 

_0y_CH3_ACT BIT U0y.01.3 %UX0.y.19 Channel 3 Run 

_0y_CH0_ERR BIT U0y.01.8 %UX0.y.24 Channel 0 Error 

R 
AD04C → 

CPU 

_0y_CH1_ERR BIT U0y.01.9 %UX0.y.25 Channel 1 Error 

_0y_CH2_ERR BIT U0y.01.A %UX0.y.26 Channel 2 Error 

_0y_CH3_ERR BIT U0y.01.B %UX0.y.27 Channel 3 Error 

_0y_CH0_DATA WORD U0y.02 %UW0.y.2 Channel 0 Conversion value 

R 
AD04C → 

CPU 

_0y_CH1_DATA WORD U0y.03 %UW0.y.3 Channel 1 Conversion value 

_0y_CH2_DATA WORD U0y.04 %UW0.y.4 Channel 2 Conversion value 

_0y_CH3_DATA WORD U0y.05 %UW0.y.5 Channel 3 Conversion value 

_0y_CH0_IDD BIT U0y.10.0 %UX0.y.160 Channel 0 Disconnection detection 

R 
AD04C → 

CPU 

_0y_CH1_IDD BIT U0y.10.1 %UX0.y.161 Channel 1 Disconnection detection 

_0y_CH2_IDD BIT U0y.10.2 %UX0.y.162 Channel 2 Disconnection detection 

_0y_CH3_IDD BIT U0y.10.3 %UX0.y.163 Channel 3 Disconnection detection 

_0y_CH0_HOOR BIT U0y.11.0 %UX0.y.176 Channel 0 High limit alarm 

R 
AD04C → 

CPU 

_0y_CH1_HOOR BIT U0y.11.1 %UX0.y.177 Channel 1 High limit alarm 

_0y_CH2_HOOR BIT U0y.11.2 %UX0.y.178 Channel 2 High limit alarm 

_0y_CH3_HOOR BIT U0y.11.3 %UX0.y.179 Channel 3 High limit alarm 

_0y_CH0_LOOR BIT U0y.12.0 %UX0.y.192 Channel 0 Low limit alarm 

R 
AD04C → 

CPU 

_0y_CH1_LOOR BIT U0y.12.1 %UX0.y.193 Channel 1 Low limit alarm 

_0y_CH2_LOOR BIT U0y.12.2 %UX0.y.194 Channel 2 Low limit alarm 

_0y_CH3_LOOR BIT U0y.12.3 %UX0.y.195 Channel 3 Low limit alarm 

 
 

- In the device assigned, 'y' means slot number equipped with module. 
- In order to read ‘CH3 conversion value’ of A/D conversion module installed on Slot No.4, it  
shall be displayed as U04.05. (In case of IEC type %UW0.4.5) 

 
 

Device Type

U 0 4 . 0 5

Slot No.
Word

[XBC type]

Word Separator

                   

Device Type
Slot No.

Base No

Word

[IEC type]

 % U W 0 . 4 . 5
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 1) Module Ready/Error flag ( ‘( )’ means the case of IEC type, y: slot number) 
(1) U0y.00.F(%UX0.y.15) : It will be ON when PLC CPU is powered or reset with A/D 

conversion ready to process A/D conversion. 
(2) U0y.00.0(%UX0.y.0) : It is a flag to display the error status of A/D conversion module. 

 
Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

-----------

U0y.00

(%UW0.y.0)

 

Error information

Bit On (1): Error

Bit Off (0): Normal

R
e

a
d

y

E
rro

r

- - -

 

Moudule READY

Bit On (1): Normal

Bit Off (0): Error

 
 

 2) Run channel flag (‘( )’ means the case of IEC type, y: slot number) 
The area where Run information of respective channels is saved  

* XGB series base number is 0. 
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------

U0y.01

(%UW0.y.1)

- -

 

Channel information

Bit On (1): In operation

Bit Off (0): Stop

 

Channel information

Bit On (1): Error

Bit Off (0): Normal
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l 0

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 
 

 3) Digital output value (‘( )’ means the case of IEC type, y: slot number) 
(1) A/D converted-digital output value will be output to buffer memory addresses UXY.02 ~  

UXY.05 (%UW0.x.2 ~ %UW0.x.5) for respective channels. 
(2) Digital output value will be saved in 16-bit binary. 

      ※ XGB PLC’s base number is 0. 
 

Channel 0 conversion value
U0y.02

(%UW0.y.2)

Channel 1 conversion value
U0y.03

(%UW0.y.3)

Channel 2 conversion value

Channel 3 conversion value

U0x.04

(%UW0.x.4)

U0x.05

(%UW0.x.5)

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
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 4) Input disconnection flag (( ) means the case of IEC type, y: slot number) 
The area where the input disconnection detection signal of each channel is saved. 
U0y.10.0 ~ U0y.10.3 (%UX0.y.160 ~ %UX0.y.163) 
※ XGB PLC’s base number is 0. 
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----

U0y.10
(%UW0.y.10)

 

Input disconnection detection

Bit On (1): occurrence of input disconnection    

Bit Off (0): Normal

---- ----

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 
 

 5) High limit alarm flag (( ) means the case of IEC type, y: slot number) 
The area where the high limit alarm detection signal of each channel is saved. 
U0y.11.0 ~ U0y.11.3 (%UX0.y.176 ~ %UX0.y.179) 
※ XGB PLC’s base number is 0. 
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U0y.011
(%UW0.y.11)

 

Maximum warning detection

Bit On (1): occurrence of maximum warning

Bit Off (0): Normal

---- ----

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6

 
 

 6) Low limit alarm flag (( ) means the case of IEC type, y: slot number) 
The area where the low limit alarm detection signal of each channel is saved. 
U0y.12.0 ~ U0y.12.3 (%UX0.y.192 ~ %UX0.y.195) 
※ XGB PLC’s base number is 0. 
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U0y.12

(%UW0.y.12)

 

---- ----

Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6

Minimum warning detection

Bit On (1): occurrence of minimum warning

Bit Off (0): Normal

 
 

Notes  

(1) If the external 24V power is not provided, operating channel information [U0y.01.0~U0y.01.3 
 (%UX0.y.16 ~%UX0.y.19)], input disconnection flag [U0y.10.0~U0y.10.3(%UX0.y.160~  
%UX0.y.163)], high limit alarm flag [U0y.11.0~U0y.11.3(%UX0.y.176~%UX0.y.179)], low limit 
alarm flag [U0y.12.0~U0y.12.3 (%UX0.y.192 ~ %UX0.y.195)] will be off.  
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13.11.2 Operation parameters setting area 

Setting area of A/D conversion module’s Run parameters is as described in Table. 

Memory 
address 

Descriptions Details R/W Remark 

0 Specify channel to use 
Bit 0 ~ Bit 3 
0: Stop, 1: Run 

R/W 

PUT/GET 

1 
Specify range of input 
voltage/current 

Input range setting (4 Bits) 

0000 : 4 ~ 20㎃ 

0001 : 0 ~ 20㎃ 

0010 : 1 ~ 5 V 
0011 : 0 ~ 5 V 
0100 : 0 ~ 10 V 
0101 : -10 ~ 10V 

R/W 

3 
Specify range of output 
data 

Output data format setting (2 Bit) 
00: 0 ~ 16,000 
01: -8,000 ~ 8,000 
10: Precise value 
11: 0 ~ 10,000 
- In case of precise value 

4 ~ 20㎃: 4,000 ~ 20,000 

0 ~ 20㎃: 0 ~ 20,000 

1 ~ 5V: 1,000 ~ 5,000 
0 ~ 5V: 0 ~ 5,000 
0 ~ 10V: 0 ~ 10,000 
-10 ~ 10V: -10,000 ~ 10,000 

R/W 

4 CH0 filter constant 

0 or 4 ~ 64,000 R/W 
5 CH1 filter constant 

6 CH2 filter constant 

7 CH3 filter constant 

12 
Specify average 
processing method 

Average process (2 Bits) 
00 : Sampling process 
01 : Time average process 
10 : Number of average process 

R/W 

13 CH0 average value 
Input channe average type setting  
Time average : 4 ~ 16,000 [ms]  
Count average : 2 ~ 64,000 [times] 

R/W 
14 CH1 average value 

15 CH2 average value 

16 CH3 average value 

21 Hold last value 
Bit 0 ~ Bit 3 
0: Disable, 1: Enable 

R/W 

22 Setting error 

0-3: CH 0-3 (10Dec, #: Channel No.) 
10#: Channel range over 
20#: Filter constant range over 
30#: Average constant range over 

R/W GET 

 

Notes  

(1) When memory addresses of 1, 4~7, 13~16 areas are entered from external setting values,  

U0y.01.8~U0y.01.B (representative flag of setting error, in case of IEC type) is on and operates 

with basic setting value. Error information is shown on error information area(No. 22).  

(2) The system area (after No. 23 ) is prohibited for reading/writing. If this area is changed,  

malfunction and breakdown can be made. 
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1) Setting operation channels 
If the channel to use is not specified, all the channels will be set to Prohibited. 
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C
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l 0

----

Address 

No. 0 

 

Designation of used channel

Bit On (1): Operation

Bit Off (0): Stop

---- ----

Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6

 
 

2) Setting input range 
(1) The range of analog input voltage are DC 1~5V, DC 0~5V, DC 0~10V, DC -10~10V, the   

range of analog current input are DC 4~20mA, DC 0~20mA. 
(2) When the input range is not set, it is handled as range of DC 4~20mA. 

 

Channel 0 

Input range setting (4 bit per channel)

0 : 4 ~ 20 ㎃

1 : 0 ~ 20 ㎃
2 : 1 ~ 5 V

3 : 0 ~ 5 V

4 : 0 ~ 10 V

5 : -10 ~ 10 V

Channel 1Channel 2Channel 3

Address 

No. 1 

Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6

 
 

3) Setting output data type 
(1) The range of digital output data for analog input can be specified for respective channels. 
(2) If the output data range is not specified, the range of all the channels will be set to  
   0 ~ 16000. 
 

비트15 비트14 비트13 비트12 비트11 비트10 비트9 비트8 비트7 비트6 비트5 비트4 비트3 비트2 비트1 비트0

3 번지

 

Output data setting (2bit per channel)

0 : 0 ~ 16000

1 : -8000 ~ 8000

2 : Precise value

3 : 0 ~ 10000

  Case of precise value

   4 ~ 20 ㎃: 4000 ~ 20000

   0 ~ 20 ㎃: 0 ~ 20000

   1 ~ 5 V: 1000 ~ 5000

   0 ~ 5 V: 0 ~ 5000

   0 ~ 10 V: 0 ~ 10000

   -10 ~ 10V: -10000 ~ 10000
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---- ----

Address 

No. 3

Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6
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4) Setting filter constant 
(1) When the filter constant is specified with 0, the filter will not be operated. 
(2) If the filter constant is not specified with anything, it can't filter and it will be handled in 0. 

 

Channel 0 filter constant (0 or 4 ~ 64000 ms)

Channel 1 filter constant(0 or 4 ~ 64000 ms)
Address 

No. 5 

Channel 2 filter constant(0 or 4 ~ 64000 ms)
Address 

No. 6 

Channel 3 filter constant(0 or 4 ~ 64000 ms)
Address 

No. 7

Address 

No. 4 

Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6

 
 
 

5) Setting average process method 
(1) When setting average process, the average process method is selected among  

time average, number of averages, moving average. 
(2) If setting average process is not specified, all channels will not handle the average  

process. 
 

Designation of average processing method(2bit per channel)

0 : Sampling processing

1 : Time average processing

2 : Average of number of rocessing
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---- ----

Address 

No. 12 

Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6

 
 

6) Setting average value 
(1) The average value is set depending on setting area of average process method. 
(2) When the average value is out of the setting area, the average process will not be made. 
 

Channel 0 average value

Channel 1 average value

 

Input channel average value setting

Time average : 4 ~ 16000 [ms] 

Number of average : 2 ~ 64000 [times]

Channel 2 average value

Channel 3 average value

Address 

No. 13

Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6

Address 

No. 14

Address 

No. 15

Address 

No. 16
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7) Maintaining valid conversion value 
(1) In case that retaining valid conversion value is set at the same time, if the invalid value is 

 come, the late valid value will only be retained. For example, firstly, it is operated with 4  
~20mA. Secondly, 10mA comes in. Finally, the signal is immediately falling down to 3mA  
without falling down the current continually. In this case, relevant channels will retain the  
output value of 10mA. 

(2) When this function is set, digital output value related with actual range of analog input is  
only shown. Refer to the actual range of the analog from "chapter 13.4".  

(3) This function can only be operated within input range. 

   1) 4 ~ 20㎃  

2) 0 ~ 20㎃  

 Refer to the using method from "chapter 13.6.5" for detail..  
(4) Setting of retaining valid conversion value is as below. 
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---- ----

Address 

No. 21

Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6

Designation of used channel

Bit On (1): Permission

Bit Off (0): Stop
 

 

8) Error code 

(1) It saves the error code detected from A/D conversion module. 
(2) Error type and details is as below. 

 

Error information of setting
Address 

No. 21

Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6

 
 
 

Type 
Error 
code 

LED sign Details 
Priority of 
error code 

Remarks for 
reference 

Error 

10# LED 
Flickering 
1s intervals 

Setting error of channel range 1 ‘#’  
is the number 
of CH 1~3 

20# Setting error of channel filter value 2 

30# Setting error of channel average value 3 

 
(3) When errors of two or more are caused, the high priority error code is saved. And when 

 the same error code is caused in channels of two or more, the error code of low channel 
number is saved preferentially.  

 

9) System area (after No. 23) 

(1) The system area (after No. 23) is prohibited for reading/writing. 
 
 

 Caution 

 If this area is changed, the product can malfunction and be broken. 
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13.12 Example Program 
 

(1) Setting of operation parameter of analog input module is explained. 
(2) The initial setting condition is saved in internal memory of the analog input module by inputting  

once. 
(3) As below, these example programs are that the analog input modules of the slot No. 1 control the 

 output data of the analog input module and detect whether wire is disconnect. 
 

13.12.１ Analog input program 

 

 1) Setting I/O parameter 
 

 
 

 
 
    (1) The channel 0 is set with operation channel, the ranges are set with 4~20mA. 
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2) Example program 
 

 
 

(1) The 'M0000' is on while the module normally operates. 
U01.00.0(Module Error) = Off 
U01.00.F(Module Ready) = On 
U01.01.0(CH0 Run) = On 
U01.01.8(CH0 Error) = Off 

(2) When the 'M0000' is on, conversion value (U01.02) of CH0 is moved to the 'D00100'. 
(3) If the error is caused on CH0, U01.10.0 Bit(CH0 disconnection) and the M00001 will be on. 
 

3) Example Program (In case of IEC) 

 

 
(1) If the module operation is normal, the '%MX0' will be on. 

%UX0.1.0(Module Error) = Off 
%UX0.1.15(Module Ready) = On 
%UX0.1.16(CH0 Run) = On 
%UX0.1.24(CH0 Error) = Off 

(2) If the '%MX0' is on, conversion value (%UW0.1.2) of CH0 will be moved to the variable of  
"input value of CH0". 

(3) If the disconnection error of CH0 is caused, %UX0.1.160 (CH0 disconnection) and the 'MX1'  
Bit will be on. 
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13.13 Breakdown test 
 
       Explain the test and measure method of breakdown while using the analog input module. 
 
 

13.13.1 Checking the LED status in case of error 
 

The analog input module has a LED and is able to check whether there is error of the module  
through the sign of LED. 

 

Item Normal Status 
When CH is disconnected 

(Input) 

When parameter setting 

is error 

LED Light on Flickering 1s intervals 

Flickering 1s intervals  

(When the input parameter 

setting is error) 

Module Operation 
Normal operation 

Operation of all functions 

Operation of all functions 

Sign of minimum input value 

Operation of all functions 

(Operation by basic value of 

parameter) 

Measure - Check wiring Check parameter setting 

 

 

13.13.2 Check the module status 
 

The status of analog input module (Module type/information/OS version) can be checked through the  
system monitor of XG5000. 

 

1) The order of execution 
It can be implemented through one of the methods among next items. 

(1)[Monitor] -> [System Monitor] -> Click the right button of mouse on the painting of module. 
-> [Module Information] 

(2)[Monitor] -> [System Monitor] -> Double click the painting of module 
(3)[Monitor] -> [Special Module Monitor] -> [XBF-AD04C] Selection ->Click the module information 
(4)[Online] -> [I/O Information] -> [XBF-AD04C] Selection -> Click the details 
(5)[Online] -> [I/O Information] -> [XBF-AD04C] Double click 
 

 

2) Module information 
(1) Module Name: Information of recently equipped module device is shown. 
(2) OS Version: OS version of module is shown. 
(3) OS Update Date: The OS prepared date of module is shown. 
(4) Module status: The present error code is shown. 
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13.13.3 Check and Measure the breakdown 
 
 

        1) The LED is turned off. 
 

The LED is turned off.

The analog module is installed on 

correct position.

Install the analog module correctly. No

Yes

I/O information is shown in XG5000 

software.

Call our near agency or A/S center. No

Yes

When the abnormal analog input 

module is changed into normal one, 

it operates well.

 Yes Call our near agency or A/S center.

 
 
 

        2) The LED is flickering. 
 

The LED is flikering.

The LED is flikering 1s intervals.

The wiring is normal.

Make wiring correctly by referring the 

instructions.( Check disconnection)
 No

Yes

The parameter setting is correct.

(Check 'PUT' )

The operation parameter is error.

Set correctly by referring parameter setting 

rules from instructions.

(Check error code)

 No
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3) The analog input value is abnormal. 
 

The analog input value is abnormal.

The external DC24V is normal.

Supply  input power source of external 

DC24V.
 No

Yes

FG ground is normal.

Modify FG ground correctly by referring 

wiring method from instructions.
 No

Yes

The parameter setting is normal.

(Permission of driving channels, 

Input range setting)

Modify correctly by referring parameter 

setting method from instructions.
 No

Yes

External terminal wiring is normal.

Modify correctly by referring wiring method 

from instructions.
 No

Yes

Call our near agency or A/S center.
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Chapter 14 Analog Output Module (XBF-DV04C/XBF-DC04C) 
 

14.1 Setting Sequence before Operation 
 

Before using the analog input module, follow steps below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 

 

XBF-DV04C / XBF-DC04C 

 

 

 

 

 Checking performance specification 

 

Wiring 

 

Reading analog output data 

 

Setting parameter 

 

Programming 

 
Refer to trouble shooting when there is error 

or analog data is abnormal. 

Programming 
 Programming for reading analog data 

 (U device) 

 

Parameter 
 XG5000 I/O parameter 

Analog input test 
 XG5000 special module monitor test mode 

 

Wiring 
 Wiring power (External DC24V) 
 Wiring analog output  

(Setting types of Voltage/Current input) 

Specification(14.2.2 performance specification) 
 Operating environment 
 Output type and range 
 Digital output range 
 Analog output range 
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14.2 Specifications 
 

14.2.1 General specifications 
General specifications are as follows. 

 

 

No. Items Specification 
Related 

standards 

1 
Operating 

temperature 
0 ~ 55 C  

2 
Storage 

temperature 
25 ~ 70 C  

3 
Operating 

humidity 
5∼95%RH (Non-condensing)  

4 
Storage 

humidity 
5∼95%RH (Non-condensing)  

5 
Vibration 

Immunity 

For discontinuous vibration   

Frequency Acceleration Amplitude Times 

IEC61131-2 

10    f    57Hz  0.075mm 

10 times in 

each 

direction for 

 X, Y, Z 

57    f    150Hz 9.8m/s
2
(1G)  

For continuous vibration 

Frequency Acceleration Amplitude 

10    f    57Hz  0.035mm 

57    f    150Hz 4.9m/s
2
(0.5G)  

6 
Shocks 

Immunity 

  Max. impact acceleration : 147 m/s
2
(15G) 

  Authorized time : 11ms 

  Pulse wave : Sign half-wave pulse (Each 3 times in X,Y,Z directions) 

IEC61131-2 

7 
Noise 

Immunity 

Square wave 

impulse noise 
1,800 V LSIS standard 

Electrostatic 

discharge 
Voltage : 4kV(Contact discharging) 

IEC61131-2 

IEC61000-4-2 

Radiated 

electromagnetic 

field noise 

80 ~ 1,000 MHz, 10V/m 
IEC61131-2, 

IEC61000-4-3 

Fast transient 
/Burst noise 

Segment 

Power 

supply 

module 

Digital/Analog I/O 

communication interface IEC61131-2 

IEC61000-4-4 

Voltage 2kV 1kV 

8 
Ambient 

conditions 
No corrosive gas and dust  

9 
Operating 

height 
2,000m or less  

10 
Pollution 

degree 
2 or less  

11 Cooling type Natural air cooling  
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14.2.2 Performance specifications 
 Performance specifications are as follows. 
 

Items 
Performance specification 

XBF-DV04C XBF-DC04C 
Channels 4 channels 

Analog 

output 

range 

Type Voltage Current 

Range 

DC 1 ~ 5V 
DC 0 ~ 5V 
DC 0 ~ 10V 
DC -10 ~ 10V 
(Load resistance: 1㏀ or more) 

DC 4 ~ 20㎃ 
DC 0 ~ 20㎃ 
(Load resistance: 600Ω or less) 

Output ranges are set in user program or I/O parameter per each 
channel. 

Digital 
input 

Type 16 bit binary data (Data : 14Bit) 

Range 

Unsigned 
value  0 ~ 16,000 

Signed value -8,000 ~ 8,000 

Precise value 

1,000 ~ 5,000 (1 ~ 5V) 
0 ~ 5,000 (0 ~ 5V) 
0 ~ 10,000 (0 ~ 10V) 
-10,000 ~ 10,000 (±10V) 

4,000 ~ 20,000 (4 ~ 20㎃) 
0 ~ 20,000 (0 ~ 20㎃) 
 
 

Percentile 
value 0 ~ 10,000 

Max. resolution 

1/16,000 

0.250㎷ (1 ~ 5V) 
0.3125㎷ (0 ~ 5V) 
0.625㎷ (0 ~ 10V) 
1.250㎷ (±10V) 

1.0㎂ (4 ~ 20㎃) 
1.25㎂ (0 ~ 20㎃) 

Accuracy 
±0.2% or less (When ambient temperature is 25℃) 
±0.3% or less (When ambient temperature is 0 ~ 55℃) 

Max. conversion speed 1㎳/ channel 

Additional function 

Setting of channel output status 
(Select one among previous, Min, Max value) 
Setting of interpolation method  
(Linear interpolation, S-type interpolation) 

Insulation method 
Photo-coupler insulation between output terminal and PLC power 
(no insulation between channels) 

Terminal connected 11 point terminal 

I/O occupied points  Fixed point assignment: 64 points 

Max. attachable number 
7ea (when using XBM(C)-DxxxS type) 
10ea (when using XB(E)C-DxxxH type) 

Weight 68g 69g 

Consumed 
current 

Internal (DC 5V) 70mA 
External (DC 24V) 160mA 

Power Supply DC 20.4V ~ 28.8V 
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Remark 1) To use the analog input module (14 Bit), It needs the basic unit more than below table. 
  

Segment Version 

XBM-DxxxS Type V3.30 or above 

XBC-DxxxH Type V2.20 or above 

XBC-DxxxSU Type V1.30 or above 

XBC-DxxxS Type V1.20 or above 

XEC-DxxxH Type V1.50 or above 

XEC-DxxxSU Type V1.10 or above 

XG5000 V3.64 or above 
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14.3 Name of each Part and Functions 
 
 

Respective designations of the parts are as described below.  
 

①

②

③

④

XBF-DV04C

XBF-DV04C

①

②

③

④

 

XBF-DC04C

XBF-DC04C

 

 

 

 

 

 

 

 
 

No. Name Description 

① RUN LED 

▶ Displays the operation status of analog output module 

On: Normal operation 

Flickers: Error occurs (Flickering 1s intervals) 

Off: Power off or Module error 

② Terminal block 
▶ Analog output(voltage, current) terminal, whose respective  

channels can be connected with external devices 

③ 

External power 

supply 

terminal 

▶ Terminal for supplying the external DC24V 

④ Ext. Connector ▶ Connector for extension modules 
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14.4 Conversion Characteristic of each Output Range 
 

The output conversion characteristic is described by graphs as follows after changing digital input set from 
XBG basic unit to analog output (Voltage, Current).  
In the digital input range, there are four kinds of value. Those are unsigned value, signed value, precise 
value, percentile value.  
I/O conversion characteristic is as follows depending on each range of digital input. 
 

1) Conversion characteristic of analog output module (XBF-DV04C) 

 

Analog

output 

value

-10V

-5V

0V

5V

10V
10.24

-10.24
0V

1.25V

2.5V

3.75V

5V
5.06

-0.06
1V

2V

3V

4V

5V
5.048

0.952

Percentile value

Unsigned value

5000

0 8000 16000
Digital 

input value

P
ra

c
tic

a
l ra

n
g

e
 o

f th
e

 a
n

a
lo

g
 o

u
tp

u
t

Offset value

Gain value

Signed value -8000 0 8000

100000

16191

8191

10119

-191

-8192

-120

0V

2.5V

5V

7.5V

10V
10.12

-0.12

 
 
         (1) DC 1 ~ 5V Output range 

Digital input 
Analog output voltage (V) 

0.952 1 2 3 4 5 5.047 

Unsigned value 
(-192 ~ 16,191) -192 0 4,000 8,000 12,000 16,000 16,191 

Signed value 
(-8,192 ~ 8,191) -8,192 -8,000 -4,000 0 4,000 8,000 8,191 

Precise value 
(952 ~ 5,047) 952 1,000 2,000 3,000 4,000 5,000 5,047 

Percentile value 
(-120 ~ 10,119) -120 0 2,500 5,000 7,500 10,000 10,119 

 
         (2) DC 0 ~ 5V Output range 

Digital value 
Analog output voltage (V) 

-0.06 0 1.25 2.5 3.75 5 5.059 

Unsigned value 
(-192 ~ 16,191) -192 0 4,000 8,000 1,2000 16,000 16,191 

Signed value 
(-8,192 ~ 8,191) -8,192 -8,000 -4,000 0 4,000 8,000 8,191 

Precise value 
(-60 ~ 5,059) -60 0 1,250 2,500 3,750 5,000 5,059 

Percentile value 
(-120 ~ 10,119) -120 0 2,500 5,000 7,500 10,000 10,119 
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         (3) DC 0 ~ 10V Output range 

Digital input 

Analog output voltage (V) 

-0.12 0 2.5 5 7.5 10 10.119 

Unsigned value 
(-192 ~ 16,191) -192 0 4,000 8,000 12,000 16,000 16,191 

Signed value 
(-8,192 ~ 8,191) -8,192 -8,000 -4,000 0 4,000 8,000 8,191 

Precise value 
(-120 ~ 10,119) -120 0 2,500 5,000 7,500 10,000 10,119 

Percentile value 
(-120 ~ 10,119) -120 0 2,500 5,000 7,500 10,000 10,119 

 
        (4) DC -10 ~ 10V Output range 

Digital input 

Analog output voltage (V) 

-10.24 -10 -5 0 5 10 10.239 

Unsigned value 
(-192 ~ 16,191) -192 0 4,000 8,000 12,000 16,000 16,191 

Signed value 
(-8,192 ~ 8,191) -8,192 -8,000 -4,000 0 4,000 8,000 8,191 

Precise value 
(-10,240 ~ 10,239) -10,240 -10,000 -5,000 0 5,000 10,000 10,239 

Percentile value 
(-120 ~ 10,119) -120 0 2,500 5,000 7,500 10,000 10,119 
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2) Conversion characteristic of analog output module (XBF-DC04C: Current)  
 

Analog 

output 

value

0mA

5mA

10mA

15mA

20mA
20.24

4mA

8mA

12mA

16mA

20mA
20.192

3.808

Percentile value

Unsigned value

5000

0 8000 16000
Digital 

input value

P
ra

c
tic

a
l ra

n
g

e
 o

f th
e

 a
n

a
lo

g
 o

u
tp

u
t

Offset value

Gain value

Signed value -8000 0 8000

100000

16191

8191

10119

-191

-8192

-120
 

 
         (1) DC 4 ~ 20㎃ Output range 

Digital input range 
Analog output current (㎃) 

3.808 4 8 12 16 20 20.191 

Unsigned value 
(-192 ~ 16,191) -192 0 4,000 8,000 12,000 16,000 16,191 

Signed value 
(-8,192 ~ 8,191) -8,192 -8,000 -4,000 0 4,000 8,000 8,191 

Precise value 
(3,808 ~ 20,191) 3,808 4,000 8,000 12,000 16,000 20,000 20,191 

Percentile value 
(-120 ~ 10,119) -120 0 2,500 5,000 7,500 10,000 10,119 

 
         (2) DC 0 ~ 20㎃ Output range 

Digital input range 
Analog output current (㎃) 

 0 5 10 15 20 20.239 

Unsigned value 
(-192 ~ 16,191) 

 0 4,000 8,000 12,000 16,000 16,191 

Signed value 
(-8,192 ~ 8,191) 

 -8,000 -4,000 0 4,000 8,000 8,191 

Precise value 
(0 ~ 20,239) 

 0 5,000 10,000 15,000 20,000 20,239 

Percentile value 
(-120 ~ 10,119) 

 0 2,500 5,000 7,500 10,000 10,119 
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14.5 Accuracy 
 

 
Accuracy of digital output value does not changed even if input range is changed. When digital input 

range is selected with unsigned value, accuracy is ±0.2% (Ambient temperature of 25 ± 5 ℃) 

 

 

 

A
n

a
lo

g
 o

u
tp

u
t v

a
lu

e

-10V

0V

0 8000 16000Digital input value

-10.04V

-9.96V

10V

9.96V

10.04V

0V

5V

-0.02V

0.02V

10V

9.98V

10.02V

0V

2.5V

-0.01V

0.01V

5V

4.99V

5.01V

0mA

10mA

-0.04mA

0.04mA

20mA

19.96mA

20.04mA

4mA

8mA

3.97mA

4.03mA

20mA

19.97mA

20.03mA

1V

3V

0.99V

1.01V

5V

4.99V

5.01V

 
 
 

(1) Accuracy when using -10~10V output 
16000 × 0.2% = 32 
Accuracy range when using -10V output will become  

(-10V - 32×1.25㎷) ~ (-10V + 32×1.25㎷) = -10.04 ~ -9.96V, 

 
Accuracy range when using 10V output will become  

(10V - 32×1.25㎷) ~ (10V + 32×1.25㎷) = 9.96 ~ 10.04V 

 
 

(2) Accuracy when using 4~20㎃ output 

16000 × 0.2% = 32 
 

Accuracy range when using 4㎃ output will become 

(4㎃ - 32×1㎂) ~ (4㎃ + 32×1㎂) = 3.97㎃ ~ 4.03㎃ 

 

Accuracy range when using 20㎃ output will become 

(20㎃ - 32×1㎂) ~ (20㎃ + 32×1㎂) = 19.97㎃ ~ 20.03㎃ 
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14.6 Functions of Analog Output Module 
 

Functions of XBF-DV04C / DC04C conversion module are as described below.  

Function Description 

Channel 

Run/Stop setting 

● Specify Run/Stop of channel to execute analog output. 

● If the unused channel is set with Stop, whole operation time can be shorter.  

Range setting of 

the output data  

● Set analog output range. 

● The analog voltage output module provides four kinds of output ranges  

(DC 1~5V, DC 0~5V, DC 0~10V, DC -10~10V).  

And the analog current output module provides two kinds of output ranges  

(DC 4~20mA, DC 0~20mA). 

Range setting of 

the Input data 

● Set digital input range. 

● The four kinds of digital input ranges are provided. (Refer from 14.2.2) 

Channel output 

status 

● Set the output status of channel when changing 'Run' to 'Stop'. 

● The four kinds of output statuses (Previous, Min, Mid, Max value) are provided. 

Interpolation 

method setting 
● Set linear interpolation, S-type interpolation method. 

 
 

14.6.1 Setting function of channel output status  

Set the output against stop and abnormal condition of PLC. 
 
1) Function 

When initialization of module and error of PLC system are happened,  
use to prevent abnormal output. 
 

2) Type 
You can set an output status of channel among Previous, Min, Mid, Max value. 
(1) Previous value: The last output operated normally is retained. 
(2) Min: The Min value of each range is outputted. 
(3) Mid: The Mid value of each range is outputted. 
(4) Max: The Max value of each range is outputted. 

 
3) Example 

When the range of output channel is set by 4 ~ 20mA and the output is 10mA, and then If the 
system is changed from 'Run' to 'Stop', the output will be as follows depending on setting data  
of channel output status. 
(1) Previous value: 10mA which is previous output value is retained. 
(2) Min value: 4mA which is min value of relevant range is outputted. 
(3) Mid value: 12mA which is mid value of relevant range is outputted 
(4) Max value: 20mA which is max value of relevant range is outputted.  
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14.6.2 Interpolation method setting 

 
1)  Functions 

The output signal of module is used in order to execute interpolation output depending on set 
interpolation time. When the voltage and current is outputted, it can be used to prevent 
transient response of load system as a suddenly changed output. 

 
2) Interpolation method setting 

Interpolation method can set the one among interpolation prohibition, linear interpolation 
S-type interpolation. 
 
(1) Interpolation prohibition : It doesn't execute interpolation operation. 

And it outputs digital input value intactly. 
 
(2) Linear interpolation : The output is changed up to objective value with linear during the 

 interpolation time. 

Interpolation time

Analog output value

t / 4 t / 4 t / 4 t / 4

t

D / 4

D / 4

D / 2

D

Change of the output value

Reaching 

a target value

 
 
(3) S-type interpolation : The output is changed up to objective value with S-type during the  

interpolation time. 
 

t / 4 t / 4 t / 4 t / 4

t

D / 8

D / 8

D / 2

D

Analog output value

Reaching 

a target value

Change of the output value

Interpolation time

 
3) Interpolation time setting 

The interpolation time can be set with the one among 10[ms], 100[ms], 1[s], 60[s]. 
The output is changed depending on interpolation method setting during the set  
interpolation time. 
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4) Interpolation output value 
The interpolation operation value that is currently being outputted can check in parameter 
area (Address No. 17 ~ 20) while using interpolation function. 
. 

 

Address of interpolation output value Details 

No.17 Channel 0 interpolation operation value 

No.18 Channel 1 interpolation operation value 

No.19 Channel 2 interpolation operation value 

No.20 Channel 3 interpolation operation value 

 
5) Interpolation flag turns on while the interpolation is outputted. And when the interpolation 

output value is reached at objective value, It will turn off. 
 

Interpolation flag Details 

U0y.01.8 Channel 0 interpolation output in operation 

U0y.01.9 Channel 1 interpolation output in operation 

U0y.01.A Channel 2 interpolation output in operation 

U0y.01.B Channel 3 interpolation output in operation 

 
6) Example 

The output is changed from 4mA to 20mA and then when it is reached at 20mA, if the output 
comes back 4mA again, you have to do as follows. 
 
 

Interpolation 

time

Analog 

output value

60s

4mA

20mA

15s

6mA

12mA

18mA

15s 15s 15s

60s

15s 15s 15s 15s

Reaching 

a target value

Interpolation 

flag On

Interpolation 

flag On Interpolation 

flag Off

Interpolation 

flag Off

Reaching a target value Change of the output value

Change of

the output value

 
 
 
 
 
 
 

Notes  

1) During the interpolation output, If the internal parameter is changed, the interpolation operation will 
be temporarily stopped and the output can be immediately changed to objective value. 

2) If the change of internal parameter is needed, change the parameter during interpolation output 
after the flag turns off when the analog output value is not changed. 
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14.6.3 Disconnection detecting function  

(Only for current output module XBF-DC04C) 
 

If the analog current output module detects disconnection of output, it can show the status of 
module. 
In case that the module checks the disconnection and it is shown as the disconnection status, 
there are faulty in parts of wiring connection paths. Please check and take action. 
 
1) In case that the disconnection between used output wiring and module is caused, LED 

can flicker 1s intervals and make an error flag. 
 
2) The disconnection can be detected per each channel only for designed channels for  

operation. LED can use from channel 0 to 3 in common.  
If the one channel or more is disconnected, flickering will be generated. 
 

Output connections 
Channel 

operation 
 LED condition 

Disconnection 
flag 

Normal 
Operation On Off 

Stop On Off 

Output wiring is 

disconnected or Output is 

not connected 

Operation 
Flickering 1s 

intervals 
On 

Stop On Off 

 
3) If the disconnection is happened, disconnection flag of relevant channel will turn. 

However, if the disconnection is changed to connection, the disconnection flag will turn off. 
 

Disconnection flag Details 

U0y.01.C Channel 0 Disconnection 

U0y.01.D Channel 1 Disconnection 

U0y.01.E Channel 2 Disconnection 

U0y.01.F Channel 3 Disconnection 
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14.7 Installation and Wiring 
 

14.7.1 Installation and separation of module 
 
Notices in handling 
Use the PLC within general specification ranges from instructions. 
When the PLC is used out of the specified ranges, it will cause burning, getting electric  
shock, abnormal operation. 

 
 
 
 

 
 Fix the module after being equipped with binding bump of module.  
  If the module is incorrectly attached, the module will be broken and malfunction. 
 
 Please be careful for external impact, like falling the case of module, terminal connector. 
 
 Do not separate the PCB board of module from the case. 
 
 
 

 
(1) Installation of module 

 

 Remove the extension cover above the module to connect.  

 Push modules to connect each other after situating four positions binding correctly. 

 After connection, fix the binding hook that is in the upward part and downward part  
 completely. 
 

 
 

 
 
 
 

 Caution 

의 

Hook for module fixing 
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(2) Separation of module 
 

 Divide connections by lifting hook for module fixing in the upward part and downward part. 

 Separate modules by holding modules with both hands. (Do not hold strongly in the 
module.) 

 

 
 
 
 
 
 
 
 
 
 
 
 

  When you try to separate the modules strongly, the hook and bump for fixing will be 
 broken. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

Hook for module separating 

 

Caution 

의 
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14.7.2 Notices in wiring 
 

(1) Do not put the power line near the external I/O signal line of analog input module. You have to  
secure enough distance to avoid the interruption from the induced noise and the surge.  

(2) The wire has to select by considering permitted current and the ambient temperature.  

The maximum wire size is good in case of AWG22 (0.3㎟) or more.  

(3) When the wire is so near with high temperature machines and materials and touched with oil for  
a long time, it can be short circuit and malfunction. 

(4) When doing terminal ports wiring, check the polarity. 
(5) In case that the high voltage line and the power line are wired at the same time, the induced  

interruption is caused. So it can be a reason for breakdown. 

  

14.7.3 Example for wiring 
 

(1) Example for analog voltage output wiring (XBF-DV04C : Voltage) 

XBF-DV04C

XBF-DV04C

+

-

CH0

+

-

CH1

CH0-

DC24V+

DC24V-

+

-

CH2

+

-

CH3

CH0+

CH1-

CH1+

CH2-

CH2+

CH3-

CH3+

1kΩ
or more

Motor-driven devices

1kΩ
or more

1kΩ
or more

1kΩ
or more

DC Power

(For analog module)

FG

 
 

※1: Two-core twisted shield wire should be used as wire. 

※2: DC power for analog power supply has to connect DC24V- with FG. 
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(2) Example for analog current output wiring (XBF-DC04C : Current) 

 

 

+

-

CH0

+

-

CH1

CH0-

DC24V+

DC24V-DC Power

(For analog module)

+

-

CH2

+

-

CH3

CH0+

CH1-

CH1+

CH2-

CH2+

CH3-

CH3+

600Ω
or less

Motor-driven devices

600Ω
or less

600Ω
or less

600Ω
or less

XBF-DC04C

XBF-DC04CFG

 
 

※1: Two-core twisted shield wire should be used as wire. 

※2: DC power for analog power supply has to connect DC24V- with FG. 
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14.8 Operation Parameter Setting 
 

A/D conversion module’s operation parameters can be specified through XG5000’s [I/O parameters]. 

 

(1) Settings 

For the user’s convenience of D/A conversion module, XG5000 provides GUI (Graphical User 
Interface) for parameters setting of D/A conversion module. Setting items available through [I/O 
parameters] on the XG5000 project window are as described below in the table.  

 

Item Details 

[I/O parameter] 

(1) Specify the following setting items necessary for the module operation. 

- Channel Enable/Disable setting 

- Output voltage(current) range 

- Input data format setting  

- Channel output status setting 

- Interpolation method setting 

- Interpolation time 
(2) When the parameters set by user in XG5000 is downloaded, that data is 

saved in flash memory of XGB basic unit. 

 

2) [I/O Parameter] Using method 

(1) Run XG5000 to create a project. 
(Refer to XG5000 program manual for details on how to create the project) 

(2) Double-click [I/O parameters] on the project window. 
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(3) [I/O Parameter setting] On the 'I/O parameters setting’ screen, find and click the slot  
equipped with analog input module. 

 

 

(4) Click the arrow button on the screen above to display the screen where an applicable 
module can be selected. Search for the applicable module to select. 

    

 

(5) After the module selected, click [Details]. 
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(6) A screen will be displayed for you to specify parameters for respective channels as below. 
Click a desired item to display parameters to set for respective items.  
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14.9 Special Module Monitoring Functions 
 

You can start to test the analog output module connecting by [Online]  [Connect] and then click 
[Monitor]  [Special Module Monitoring] menu in XG5000. 
 

14.9.1  How to use special module monitoring 
 
Special module monitoring function is described below based on the analog voltage output module  
(XGF-DV04C). 

 

1) Start of [Special Module Monitoring] 
Go through [Online]  [Connect] and [Monitor]  [Special module Monitoring] to start. If the 
status is not online, [Special Module Monitoring] menu will not be activated. 

 

 
 

Notes  

1) The screen may not normally be shown due to the lack of system resource. In this case, terminate  
all applications and try to start XG5000 again. 

2) I/O parameter set in status of [Special Module Monitor] is temporally set to implement the test.  
So, If status of [Special Module Monitor] is ended, I/O parameter which is set becomes extinct. 

3) The test of [Special Module Monitor] is a examination function to check operation of the analog  
input module when the sequence program is not made up. 

 

2) How to use [Special Module Monitoring] 
(1) Connecting XG5000 with PLC basic unit, [Special Module List] window will show base/slot 

information and types of special module by click [Monitor]  [Special Module Monitoring].  
   Special Module List will display the modules that are installed in PLC now. 
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(2) Select a special module then click [Module Info.] button to display the information as 
described below.  

 

 

 

(3) Click [Monitor] button in the [Special Module List] window to display the [Special Module 
Monitor] window as below. 
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(4) [Start Monitoring] button will show you digital input data of the operating channel. 

  

Execution screen of [Start Monitoring]  
 
(5) [Test] is used to change the parameters of the voltage output module. You can change the 

parameters when you click the values at the bottom of the screen. It is only available when 
XGB CPU unit’s status is in [Stop Monitoring]. 

 

 Execution screen of [Test] 
 

(6) [Close] is used to escape from the monitoring/test screen. The Max value, Min value, 
current value will not saved anymore after the monitoring/test screen is closed. 

Monitoring 

CH0 details 
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14.10 Register U Devices 
 
Register the variables for each module referring to the special module information that is set in the  
I/O parameter. The user can modify the variables and comments. 
 
1) Procedure 

 
(1) Select the special module type in the [I/O Parameter Setting] window. 
 

 
 

(2) Double click ‘Variable/Comment’ from the project window. 
 

 
 

(3) Select [Edit] – [Register U Device]. 
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(4) Click ‘Yes’ 

 
 

(5) As shown below, the variables are registered. 

 
 
(6) For IEC type, as shown below, the variables are registered. 
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2) Save variables 
(1) The contents of ‘View Variable’ can be saved as a text file. 
(2) Select [Edit] -> [Export to File]. 
(3) The contents of ‘View variable’ are saved as a text file. 

 
3) View variables 

(1) The example of XBC type is as follows.  

 
 
 

(2) Select [View] -> [Variables]. The devices are changed into variables. 

 
 

 
(3) Select [View] -> [Devices/Variables]. Devices and variables are both displayed. 
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(4) Select [View] -> [Device/Comments]. Devices and comments are both displayed 

 
 
(5) In case of IEC-type can also see variety option variables like (1) ~ (4). As shown below, there 
is an example when 'Variable/Instruction window' is selected in the IEC-type. 
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14.11 Internal Memory 
 

Describes configuration and function of internal memory 
 

14.11.1  Data I/O area 
Describes data I/O area of analog output module. 

Device assigned 
Type Description Details R/W 

Direction 
of signal 

XBM/XBC XEC 

U0y.00.0 %UX0.y.0 BIT Channel0 Error 

Parameter setting 
On(1): Setting error 
Off(0): Setting normal R 

DV04C / 
DC04C → 
CPU 

U0y.00.1 %UX0.y.1 BIT Channel1 Error 

U0y.00.2 %UX0.y.2 BIT Channel2 Error 

U0y.00.3 %UX0.y.3 BIT Channel3 Error 

U0y.00.F %UX0.y.15 BIT Module Ready 
On(1): Ready for action 
Off(0): Not ready 

U0y.01.0 %UX0.y.16 BIT Channel0 In operation 

Channel operation 
On(1): Operation 
Off(0): Stop 

R 
DV04C / 
DC04C → 
CPU 

U0y.01.1 %UX0.y.17 BIT Channel1 In operation 

U0y.01.2 %UX0.y.18 BIT Channel2 In operation 

U0y.01.3 %UX0.y.19 BIT Channel3 In operation 

U0y.01.8 %UX0.y.24 BIT Channel 0 Interpolation output 

Interpolation output status 
On(1): Interpolation output 
Off(0): Stop 

R 
DV04C / 
DC04C → 
CPU 

U0y.01.9 %UX0.y.25 BIT Channel 1 Interpolation output 

U0y.01.A %UX0.y.26 BIT Channel 2 Interpolation output 

U0y.01.B %UX0.y.27 BIT Channel 3 Interpolation output 

U0y.01.C %UX0.y.28 BIT Channel0 disconnection detection 
Disconnection detection 
On(1): Disconnection  

detection 
Off(0): Stop 
(Only for XBF-DC04C) 

R 
DC04C → 
CPU 

U0y.01.D %UX0.y.29 BIT Channel1 disconnection detection 

U0y.01.E %UX0.y.30 BIT Channel2 disconnection detection 

U0y.01.F %UX0.y.31 BIT Channel3 disconnection detection 

U0y.02 %UW0.y.2 WORD Output enable setting Output status setting W 
DV04C / 
DC04C ↔ 
CPU 

U0y.02.0 %UX0.y.32 BIT Channel0 Output enable setting 

Output enable setting 
On(1): Output enable 
Off(0): Output prohibition 

W 
DV04C / 
DC04C ↔ 
CPU 

U0y.02.1 %UX0.y.33 BIT Channel1 Output enable setting 

U0y.02.2 %UX0.y.34 BIT Channel Output enable setting 

U0y.02.3 %UX0.y.35 BIT Channel3 Output enable setting 

U0y.03 %UW0.y.3 WORD CHannel0 Input value 

Output conversion value 

W 
DV04C / 
DC04C ↔ 
CPU 

U0y.04 %UW0.y.4 WORD Channel1 Input value W 
DV04C / 
DC04C ↔ 
CPU 

U0y.05 %UW0.y.5 WORD Channel2 Input value W 
DV04C / 
DC04C ↔ 
CPU 

U0y.06 %UW0.y.6 WORD Channel3 Input value W 
DV04C/ 
DC04C↔  
CPU 
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- In the device assigned, 'y' means slot number equipped with module.  
- In order to read ‘CH2 conversion value’ of A/D conversion module installed on Slot No.4, it  
shall be displayed as U04.05. (In case of IEC type %UW0.4.5) 
 

Device Type

U 0 4 . 0 5

Slot No.

Word

      [XBC type]

Word Separator

                 

Device Type

Slot No.

Base No

Word

[IEC type]

 % U W 0 . 4 . 5

 
 

- In order to read ‘CH1 conversion value’ of A/D conversion module installed on Slot No.5, it  
shall be displayed as U05.02.1 (In case of IEC type %UW0.5.33) 

Device Type

U 0 5 . 0 2

Slot No.

Word Separator

Word

. 1

Bit Separator

     [XBC type]

Bit 1

               

Device Type

 % U X 0 . 5 . 33

Slot No.

Base No

[IEC type]

Bit 33

 
 

1) Module Ready/Error flag ( ‘( )’ means the case of IEC type, y: slot number)  
(1) U0y.00.F(%UX0.y.15): It will be ON when PLC CPU is powered or reset with D/A 

conversion ready to process A/D conversion. 
 (2) U0y.00.0 ~ U0y.00.3(%UX0.y.0 ~ %UX0.y.3): It is a flag to display the error status of D/A  

conversion module. 

※ The base number of XGB PLC is ‘0’. 

 

 

Error information

Bit On (1): Error

Bit Off (0): Normal

 

Moudule READY

Bit On (1): Normal

Bit Off (0): Error

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

-----------

U0y.00

(%UW0.y.0) R
e

a
d

y

C
h

a
n

n
e

l 0

C
h

a
n

n
e

l 3

C
h

a
n

n
e

l 2

C
h

a
n

n
e

l 1
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2) Channel operation information 
(1) This area shows the channel being used. 

※ The base number of XGB PLC is ‘0’. 

 
 

C
h

a
n

n
e

l 3

C
h

a
n

n
e

l 2

C
h

a
n

n
e

l 1

C
h

a
n

n
e

l 0

------

U0y.01
(%UW0.y.1)

 

Channel information

Bit On (1): In operation

Bit Off (0): Stop

- -- - - -

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 

3) Status of interpolation output 
(1) This area shows the channel being outputting interpolation. 

※ The base number of XGB PLC is ‘0’. 

 
 

         

비트15 비트14 비트13 비트12 비트11 비트10 비트9 비트8 비트7 비트6 비트5 비트4 비트3 비트2 비트1 비트0

----

U0y.01
(%UW0.y.1)

C
h

a
n

n
e

l 2

C
h

a
n

n
e

l 3

C
h

a
n

n
e

l 1

C
h

a
n

n
e

l 0

---- ----

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

Interpolation output condition

Bit On (1): Interpolation output 

Bit Off (0): Off
 

 

4) Output disconnection detection (Only for current output module XBF-DC04C) 
(1) This area shows the channel detecting output disconnection. 

※ The base number of XGB PLC is ‘0’. 

 
 

         

C
h
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e

l 0

C
h
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n

n
e

l 1

C
h

a
n

n
e

l 2

C
h

a
n

n
e

l 3

U0y.01

(%UW0.y.1)

---- --------

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

Disconnection detection information

Bit On (1): occurrence of disconnection    

Bit Off (0): Normal
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5) Output permission setting 
(1) The output enable / disable for each channel can be set. 
(2) When the output permission is not set, the output of all channels will be prohibited. 

※ The base number of XGB PLC is ‘0’. 

 
 

         

C
h

a
n

n
e

l 3

C
h

a
n

n
e

l 2

C
h

a
n

n
e

l 1

C
h

a
n

n
e

l 0

------

U0y.02
(%UW0.y.2)

 

Output permission information

Bit On (1): Permission

Bit Off (0): Prohibition

- -- - - -

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 
 

6) Digital input value 
(1) Unsigned value(-192~16,191 / 0~16,191), Signed value(-8,192~8,191 / -8,000~8,191), 

Precise value(-952~5,047 / -60~5,059 / -120~10,119 / -10,240~10,239 / 3,808~20,191 / 
0~20,239), Percentile value(-120~10,119 / 0~10,119) can be used within these ranges 
depending on the setting of input data type.  

(2) If the digital input value is not set, it will be handled as '0'. 

※ The base number of XGB PLC is ‘0’. 

 Channel 0 Digital input data
U0y.03

(%UW0.y.3)

 Channel 1 Digital input data
U0y.04

(%UW0.y.4)

 Channel 2 Digital input data
U0y.05

(%UW0.x.5)

 Channel 3 Digital input data
U0y.06

(%UW0.y.6)

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 
 

Notes  

(1) If the external 24V is not supplied, the operation channel information [U0y.01.0 ~ 
U0y.01.3, (%UX0.y.16 ~ %UX0.y.19)], interpolation output status flag [U0y.01.8 ~  
U0y.01.B (%UX0.y.24 ~ %UX0.y.27)], output disconnection detection flag [U0y.01.C 
~   U0y.01.F (%UX0.y.28 ~ %UX0.y.31) ], will be turned off.  
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14.11.2  Operation parameters setting area 
Setting area of D/A conversion module’s Run parameters is as described in Table. 

 

Memory 
address 

Descriptions Details R/W Remark 

0 Specify channel to use 
Bit 0 ~ Bit 3 
0: Stop, 1: Operation 

R/W 

PUT/GET 

1 Specify voltage output range 

Output range setting (2Bit) 

00 : 1 ~ 5 V (4 ~ 20㎃) 

01 : 0 ~ 5 V (0 ~ 20㎃) 

10 : 0 ~ 10 V 
11 : -10 ~ 10V 

R/W 

2 Specify input type 

Input data type setting (2Bit) 
00: 0 ~ 16,000 
01: -8,000 ~ 8,000 
10: Precise value 
11: 0 ~ 10,000 
- In case of precise value 

4 ~ 20㎃: 4,000 ~ 20,000 

0 ~ 20㎃: 0 ~ 20,000 

1 ~ 5V: 1000 ~ 5,000 
0 ~ 5V: 0 ~ 5,000 
0 ~ 10V: 0 ~ 10,000 
-10 ~ 10V: -10,000 ~ 10,000 

R/W 

3 Specify Ch0 output setting Output status setting (2Bit) 
00: Previous value output 
01: Min value output 
10: Mid value output 
11: Max value output 

R/W 
4 Specify Ch1 output setting 

5 Specify Ch2 output setting 

6 Specify Ch3 output setting 

11 Interpolation method 

Interpolation method setting (2Bit) 
00: Prohibition 
01: Linear interpolation 
10: S-type interpolation 

R/W 

12 Interpolation time 

Interpolation time setting (2Bit) 

00: 10[㎳] 

01: 100[㎳] 

10: 1[s] 
11: 60[s] 

R/W 

13 CH0 setting error 0: Normal operation 
31#: Excess error of output range setting  
41#: Excess error of digital input value range 
51#: Excess error of interpolation method  

range 
(Decimal, #:Channel number, CH 0-3) 

R GET 
14 CH1 setting error 

15 CH2 setting error 

16 CH3 setting error 

17 CH 0 interpolation value 
When the interpolation operates:  
Show operated current output digital value. 
When the interpolation is prohibited: 
Show the output value in the data I/O area. 
(U0y.03~06, %UW0.y.3~6) 

R GET 
18 CH 1 interpolation value 

19 CH 2 interpolation value 

20 CH 3 interpolation value 

22 ~ 44 
System area 

(Offset/Gain save area) 
Read / Write Prohibited - - 
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Notes  

(1) In case of U0y.00.0~U0y.00.3 and IEC type, %UX0.y.0~%UX0.y.3 turns on and 

 operates as the basic setting value when Inputting except set value in 1, 2, 11 area  

of memory address.  

(2) The system area (after No. 22) is prohibited to read/write. 

If this area is changed, malfunctions or breakdowns will be happened. 

 

1) Operation channel setting 
If the operation channel is not set, all channels will be stopped. 

C
h

a
n

n
e

l 3

C
h

a
n

n
e

l 2

C
h

a
n

n
e

l 1

C
h

a
n

n
e

l 0

------

Address
No. 0

 

Designation of used channel

Bit On (1): In operation

Bit Off (0): Stop

---- --

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 
 

2) Output range setting 
The range of analog output voltage is DC 0 ~ 10V. And the range of analog output current is DC 4 
~ 20mA, DC 0 ~ 20mA. 

 

Channel 0

Address
No. 1

 

Output range setting (Channel per 2 bits)

00 : 1 ~ 5V (4 ~ 20 ㎃)

01 : 0 ~ 5V (0 ~ 20 ㎃
10 : 0 ~ 10 V

11 : -10 ~ 10 V

Channel 1Channel 2Channel 3---- ----

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 
 

3) Input data type setting 
(1) Input data type can be set for each channel. 
(2) All channels will be handled as the range of 0~ 16,000 when the input data type is not set. 

 

 

Input data type setting (2 bits per channel)

00 : 0 ~ 16000

01 : -8000 ~ 8000

10 : Precise value

11 : 0 ~ 1000

-In case of precise value

4 ~ 20㎃: 4000 ~ 20000

0 ~ 20㎃: 0 ~ 20000

1 ~ 5V: 1000 ~ 5000

0 ~ 5V: 0 ~ 5000

0 ~ 10V: 0 ~ 10000

-10 ~ 10V: -10000 ~ 10000

 

Channel 0

Address
No. 2

 

Channel 1Channel 2Channel 3---- ----

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
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4) Output status setting 
(1) When the XGB basic unit is stopped, set the analog output status. 
(2) When the output status setting is not specified, output the previous value. 

 

Setting 
value

---- ----
Address 
No. 3~ 6

-- ----

 

Set the output status ( 2 bits)

00 : Previous value output

01 : Min value output

10 : Mid value output

11 : Max value output

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 

Address Details Setting 

3 Channel 0 Output status setting 
Input data type setting (bit) 
 00: Previous value 
 01: Min value 
 10: Mid value 
 11: Max value 

4 Channel 1 Output status setting 

5 Channel 2 Output status setting 

6 Channel 3 Output status setting 

 

5) Interpolation method setting 
Show the setting of the interpolation method of each channel. 

 

Channel 0

Address
No. 11

 

Interpolation method setting (2 bits per channel)

00 : Prohibition

01 : Direct interpolation

10 : S type interpolation

Channel 1Channel 2Channel 3---- ----

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 
 

6) Interpolation time setting 
Show the setting of interpolation time of each channel. 

 

Channel 0

Address
No. 12

 

Interpolation time setting (2 bits per channel)

00 : 10[ms]

01 : 100[ms]

10 : 1[s]

11 : 60[s] 

Channel 1Channel 2Channel 3---- ----

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
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7) Channel error 

Show the error code of each channel. 
When two error or more are happened, the high priority of error code will be saved. 

 

Channel 1 error code

Channel 2 error code

Address
No. 14

Address
No. 15

Channel 3 error code
Address
No. 16

Channel 0 error code
Address
No. 13

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 
 
 

Error code 
(Decimal) 

Details 
Error code  
order of priority 

Remarks 

0 Normal operation  

#:CH number 0-3 
31# Excess error of output range setting 2 

41# Excess error of digital input value range 1 

51# Excess error of interpolation method range 3 

 
 

8) Interpolation operation value 
Show the interpolation operation value of each channel. 

 

Channel 1 Interpolation operation value

Channel 2 Interpolation operation value

Address

No. 18
Address

No. 19

Channel 3 Interpolation operation value
Address

No. 20

Channel 0 Interpolation operation value
Address

No. 17

Bit 15 Bit 14 Bit 13 Bit 12 Bit 11 Bit 10 Bit 9 Bit 8 Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

 
 
 

9) System area 
The system area (after No. 22) is prohibited to read/write. 
 

 Warning 
If this area is changed, malfunctions or breakdowns will be happened. So do not 

control this area. 
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14.12 Example Program 
 

14.12.1  Analog output program  
 

(1) Program example using [I/O Parameter Setting]. 

 
 

 
 

 

 
 
  

Channel 
operation 
information 

Module 
Ready 

Digital input data 
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(2) Program example with PUT/GET instruction 
 

 
 
(3) Program example using parameter in case of IEC type 
 

 

Operating CH(0,1,2,3) 
 

Output Voltage range(1~5) 
 
Input data type(0~16000) 
 
CH0 Output status  
(Previous value) 

CH1 Output status (Min value) 
 
CH2 Output status (Mid value) 
 
CH3 Output status (Max value) 
 

Output Voltage range(1~5) 
 

Output Voltage range(1~5) 
 

Output Voltage range(1~5) 
 

Output Voltage range(1~5) 
 

Output Voltage range(1~5) 
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(4) Program example using PUT/GET instruction in case of IEC type 
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14.13 Breakdown Test 
 
      Explain the test and measure method of breakdown while using the analog input module. 
 

14.13.1 Checking the LED status in case of error 
 

The analog input module has a LED and is able to check whether there is error of the module  
through the sign of LED. 

 

Item Normal Status When CH is disconnected 
When parameter setting 

is error 

LED Light on Flickering 1s intervals 

Flickering 1s intervals 

(When the output parameter 

setting is error) 

Module 

Operation 

Normal operation 

Operation of all 

functions 

Operation of all functions 
Operation of all functions 

(Operation by basic value of 

parameter) 

Measure  Check output wiring Check parameter setting 

 

 

14.13.2 Check the module status 
 

The status of analog input module (Module type/information/OS version) can be checked through the  
system monitor of XG5000. 

 

1) The order of execution 
It can be implemented through one of the methods among next items. 

(1)[Monitor] -> [System Monitor] -> Click the right button of mouse on the painting of module. 
-> [Module Information] 

(2)[Monitor] -> [System Monitor] -> Double click the painting of module 
(3)[Monitor] -> [Special Module Monitor] -> [XBF-AD04C] Selection ->Click the module information 
(4)[Online] -> [I/O Information] -> [XBF-AD04C] Selection -> Click the details 
(5)[Online] -> [I/O Information] -> [XBF-AD04C] Double click 
 
 

 

2) Module information 
(1) Module Name: Information of recently equipped module device is shown. 
(2) OS Version: OS version of module is shown. 
(3) OS Update Date: The OS prepared date of module is shown. 
(4) Module status: The present error code is shown. 
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14.13.3 Check and Measure the breakdown 
 

(1)  RUN LED is turned off. 
 

RUN LED is turned off.

The analog module is installed on 

correct position.

Install the analog module correctly. No

Yes

I/O information is shown in XG5000 

software.

Call our near agency or A/S center. 
No

Yes

When the abnormal analog input 

module is changed into normal one, 

it operates well.

 Yes Call our near agency or A/S center.

 
 

(2) RUN LED is flickering. 
 

RUN LED is flickering.

RUN LED is flikering 1s intervals.

Output wiring is disconnected.

(Only for current output. 

Make wiring correctly by referring 

instructions.
 

No

Yes

The parameter setting is correct.

(Check 'PUT' )
The operation parameter is error.

Set correctly by referring parameter setting 

rules from instructions.

(Check error code)

 No

Output channel input value is exceeded.

Enter correct value by referring output range 

from instructions.
 

No

Yes
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(3)  The analog output value is abnormal. 
 

The analog output value is abnormal.

The external DC24V is normal.

Supply  input power source of external 

DC24V.
 No

Yes

The wiring of each channel is normal.

Refer wiring method from instructions. No

Yes

The parameter setting is normal.

(Operation channel , Output permission, 

Output range )

Set the parameter by referring the method of 

parameter setting from instructions.
 No

Yes

Call our near agency or A/S center.
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Chapter 15 PID Function (Built-in function) 
 

15. 1General  
 

15.1.1 General 

Here describes built-in PID (Proportional Integral Derivative) function. When there is plant (target of control), 

Control means that the user changes the status such as velocity, temperature, position, voltage, current etc. 

as the user wishes. Here describes PID control that is most frequently used among diverse control methods. 

Basic concept of PID control is as follows. First, it detects the PV (Process Value) through sensor and 

calculates what the difference with SV (Set value) is. Then it outputs MV (Manipulated Value) for PV to be 

same with SV.  

At this time, 3 types of operation, such as Proportion, Integration, Derivation is executed according to the 

requirement of the user. PID control has high compatibility, flexibility, affordability in comparison with Robust 

control and Linear optimal control. In case of other control methods, since control device can be applied to 

the system after mathematical analysis of system, if system or the requirement of the user changes, the 

analysis of system is done again. But in case of PID control, PID device copes with change of system or 

requirement of the user with simple auto-tunings without analysis of system rapidly.  

The figure 6.1 is example indicating system configuration of temperature control of heating system. 

 

 
 
 

 
< Figure 15.1 PID Temperature control system with PLC > 

 

At this time, PLC becomes control device for this system, output temperature of heating system becomes 

target for control. And temperature sensor and valve becomes devices to detect and manipulate the status 

of system respectively. If temperature sensor detects the output temperature and inputs that to PLC, PLC 

manipulate the valve status through PID operation and control the quantity of gas that goes into heating 

system. So temperature of heating system changes. This process is called control loop and PID control is 

executed by repeating the control loop. The control loop is repeated with a cycle of ms ~ s. 
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15.1.2 Features 

The built-in PID control functions of XGB series feature as follows.   

 

(1) Since operations are executed within CPU part, it can be controlled by PID parameters and PLC 

program without PID module.  

 

(2) A variety of controls can be selected 

▪ That is, a user can easily select P operation, PI operation and PID operation. 

 
(3) Precise control operation  

▪ It can make precise PID control operations possible through floating point operations.  

 
(4) PWM (Pulse Width Modulation) output available. 

▪ It outputs control operation results to the output contact point designated by a user through PWM.  

 
(5) Improving convenience of control settings and monitoring  

▪ Through parameter setting method and K area flag, it maximizes control parameter settings 

during operation and convenience of monitoring  

 
(6) Freely selectable operation direction 

▪ Forward, reverse and mixed forward/reverse operations are available 

 
(7) Cascade operation realizing quick and precise PID control  

▪ It can increase quickness of response to disturbance through cascade loop.  

 
(8) Various additional functions  

▪ PID control can be achieved by various methods a user wishes because set value ramp, the 

present value follow-up, limiting change of values and types of alarm functions are provided.  
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15.2 PID Control 
 

15.2.1 Basic theory of PID control 
Here describes basic theory of PID control and how to configure PID control. 

 
(1) Terms  

Terms used in this user manual are as follows. 

 

▪ PV: status of plant detected by sensor (Process value) 

▪ SV: Target value (Set Value) to control plant, if control is done normally, PV should follow the SV.   

▪ E: error between SV and PV. It can be expressed as (SV-PV). 

▪ Kp: proportional coefficient 

▪ Ti: Integral time constant. Sometimes called integral time 

▪ Td: Derivative time constant. Sometimes called derivative time  

▪ MV: Control input or control device output. The input to plant to make PV follow the V 

▪ Ts: Sampling time, a cycle of operation to execute PID control 

 
(2)PID operation expression  

          Basic PID operation expressions are as follows. 

 

   

  

   

   

   

 

 

 

         PID control operation expressions of XGB series are more complicate than expression (15.2.1) ~ 

(15.2.5) mathematically but those are base on the above expression. The followings describe the 

characteristics of control process with an example that controls the output temperature of heating 

system in figure 15.1. At this example, the system and PID parameters imaginary to help the 

comprehension and those may be different with real heating system. If the heating system in 

figure 15.1 is expressed as second order system with transfer function like expression (15.2.6) in 

frequency domain, it is expressed as differential equation like expression (15.2.6) in the time 

domain.  

  

 

   

 

 

 

       That is, x(t) is Manipulated value and y(t) is Process value.             

 

         

PVSVE 

EKMV PP 

 Edt
T

K
MV

i

P
i

dt

dE
TKMV dPd 

diP MVMVMVMV 

))53)(12(

32

 ss
Transfer function =                                (15.2.6)   

)()(5
)(

32

13)(

32

6
2

2

txty
dt

tdy

dt

tyd
 (15.2.7)   

       (15.2.1) 

       (15.2.2) 

       (15.2.3) 

       (15.2.4) 

       (15.2.5) 
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At this system, we assume that the PID parameter is specified as shown below to describe the PID control 

operation. 

 

Items Value Items Value 

Output temperature of 

heating system (PV) 
0℃ 

Proportional coefficient 

(KP) 
5 

Target temperature (SV) 50℃ Integral time (Ti) 3s 

Cycle of operation 0.01s Derivative time (Td) 0.19s 

                          <Table 15.1 example of control of heating system> 

 

At this system, if we assume that target value of output temperature is 50℃ and initial value of output 

temperature is 0℃, SV and PV becomes 50 and 0 respectively. In case of this, PID controller acts as follows. 

 
(3) Proportional control (P control) 

In the proportional control, the controller yields output that is proportional to error.  

Manipulated value of controller by Proportional control is as follows. 

 

                   (15.2.8) 
 
(a) If P control starts, output of controller by initial P operation is as follows.  

 

2004500 MV  

 

If P control is executed for 10 seconds, output temperature will be as table 15.2. 

If this is expressed with graph, it will be as Figure 15.2.  

 

Time Target temp. 
Proportional 

coefficient 
Output temp. Error 

0 50 5 0 50 

1 50 5 44.98 5.02 

2 50 5 53.08 -3.08 

3 50 5 50.15 -0.15 

4 50 5 48.42 1.58 

5 50 5 48.28 1.72 

6 50 5 48.44 1.56 

7 50 5 48.49 1.51 

8 50 5 48.49 1.51 

9 50 5 48.49 1.51 

                      

< Table 15.2 example of Proportional control > 

 

PP KEMV 
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     < Figure 15.2 simulation of proportional control > 

 
(b) Concerning the result of simulation, it has the maximum overshoot of about 23.4℃ at 0.62s 

and after 7s, it converges at 48.49℃ with offset of 1.51℃ (about 3%). 

 
(c) Offset is an unavoidable error when only P control is executed. Offset decreases proportional 

to P coefficient but overshoot increases proportional to P coefficient. Table 15.3 and Figure 
15.3 is simulation of offset and overshoot according to P coefficient.  

 

Time 
Target 

temperature 
Kp = 5 Kp = 2.5 Kp = 1 

0 50 0 0 0 

1 50 45.02 63.46 46.67 

2 50 53.11 42.52 46.77 

3 50 50.15 47.93 41.38 

4 50 50.22 47.25 41.60 

5 50 48.27 46.96 43.30 

6 50 48.35 46.92 43.25 

7 50 48.44 46.90 43.21 

8 50 48.53 46.90 43.18 

9 50 48.53 46.90 43.18 

<Table 15.3 Temperature- time table according to P coefficient> 

 

 

 

 

 

 

 

 

 

Offset 

Max. overshoot 
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< Figure 15.3 Temperature- time graph according to P coefficient > 

 
(c) Considering table 15.3, as P coefficient decreases, offset increases but overshoot decreases.  

 
(d) Generally, offset can’t be solved with only P control. In order to remove the offset, P control 

and I control is used together.  

 
(4) Proportional Integral Control (PI Control) 

   In I control, it yields the output proportional to error accumulated according to time. And the 

expression is as follows.    

 

        

 

 

 
(a) In the expression 15.2.9, Ti means the time takes for MVi, output by I control, to be added into 

real output. 

 
(b) Generally, I control is used with P control. So the expression of PI control is as follows. 

 

     

 

 

 
(c) In the above heating system, the simulation results are as shown in the table 15.4 when 

proportional coefficient is 2.5 and integral time is 1.5s.  

 

Time 
Target 

temp. 

Proportional 

coefficient 

Integral 

time 
P Control PI Control 

0 50 2.5 1.5 0 0 

1 50 2.5 1.5 63.46 74.41 

2 50 2.5 1.5 42.52 40.63 

3 50 2.5 1.5 47.93 52.99 

4 50 2.5 1.5 47.05 49.67 

 Edt
T

K
MV

i

P
i

 Edt
T

K
KEMVMVMV

i

P
PiP

(15.2.9) 

(15.2.10) 
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Time 
Target 

temp. 

Proportional 

coefficient 

Integral 

time 
P Control PI Control 

5 50 2.5 1.5 46.96 49.70 

6 50 2.5 1.5 47.12 50.38 

7 50 2.5 1.5 47.03 49.76 

8 50 2.5 1.5 47.07 50.14 

9 50 2.5 1.5 47.06 49.94 

10 50 2.5 1.5 47.06 50.02 

11 50 2.5 1.5 47.06 49.99 

12 50 2.5 1.5 47.06 50.00 

13 50 2.5 1.5 47.06 50.00 

14 50 2.5 1.5 47.06 50.00 

15 50 2.5 1.5 47.06 50.00 

< Table 15.4 Temp.- time table > 

 
(d) Considering table 15.4 and Figure 15.4, if P and I control is used together, offset is removed 

and temp. converges at 50℃, target temp. after 12s 

 
(e) But in this case, convergence time is longer than that of P control and overshoot is larger. 

Generally, as integral time increases, overshoot decrease. About this, refer to the Figure 15.5.  

 

 

 
< Figure 15.4 Temp.- time graph > 
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< Figure 15.5 overshoot according to integral time > 

 
(f) Like this, if I control is used, overshoot is larger. According to system, large overshoot can be 

problem. In order to solve this, PID control is used.  

 

 
(5) Proportional integral derivative control (PID control) 

In D control, when status of system changes rapidly, D control yields the output to reduce the 

error. Namely, D control yields the output proportional to change velocity of current status. So if 

D control is used, response speed of controller about status change of system increases, and 

overshoot decreases. Output of controller by D control is as shown in expression 15.2.11.   

 

. 

          

                 

 

 

 
(a) In the expression 15.2.11, Td means the time takes for MVd output by I control, to be added 

into real output. 
 

 
(b) Generally, D control is not used solely but with PD control. So PID control is expressed as 

expression 15.2.12.  

            

 

 

 
(c) The Figure 15.6 is simulation result when PID control is applied to above heating system. 

dt

dE
TKMV dPd 

dt

dE
TKEdt

T

K
KEMVMVMVMV dp

i

P
PdiP  

(15.2.11) 

(15.2.12) 
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Time 
Target 

temp. 

Proportional 

coefficient 

Integral 

time 

Derivative 

time 

PI 

Control 

PID 

Control 

0 50 2.5 1.5 0.3 0 0 

1 50 2.5 1.5 0.3 74.41 55.50 

2 50 2.5 1.5 0.3 40.63 56.33 

3 50 2.5 1.5 0.3 52.99 52.50 

4 50 2.5 1.5 0.3 49.67 50.92 

5 50 2.5 1.5 0.3 49.70 50.34 

6 50 2.5 1.5 0.3 50.38 50.12 

7 50 2.5 1.5 0.3 49.76 50.05 

8 50 2.5 1.5 0.3 50.14 50.02 

9 50 2.5 1.5 0.3 49.94 50.01 

10 50 2.5 1.5 0.3 50.02 50.00 

11 50 2.5 1.5 0.3 49.99 50.00 

12 50 2.5 1.5 0.3 50.00 50.00 

13 50 2.5 1.5 0.3 50.00 50.00 

< Table 15.5 comparison of PI control and PID control > 

 

    
< Figure 15.6 comparison of PI control and PID control > 

 
(d) Considering table 15.5, in case PID control is used, max. overshoot decreases from 16.5℃ to 

8.5℃. At this time, P coefficient, integral time, derivative time are not optimal values, just one of 
the examples. Actually, P coefficient, integral time, derivative time values vary according to PID 
control system. 
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15.2.2 Functional specifications of PID control 
(1) Functional Specifications 

The performance specifications of the built-in PID control function in XGB series are summarized 

in the below table. 

Item Specifications 

No. of loops 16 Loop 

Scope of 

setting 

PID 

constants 

Proportional 

constant(P) 
Real number (0 ~ 3.40282347e+38) 

Integral constant(I) Real number (0 ~ 3.40282347e+38), unit: second 

Differential 

constant(D) 
Real number (0 ~ 3.40282347e+38), unit: second 

Scope of set value INT (-32,768 ~ 32,767) 

Scope of present value INT (-32,768 ~ 32,767) 

Scope of maneuver value INT (-32,768 ~ 32,767) 

Scope of manual maneuver value INT (-32,768 ~ 32,767) 

Indication 

RUN/STOP 
Operation: PID RUN Flag On (by loops) 

Stop: PID RUN Flag Off (by loops) 

Error 

Normal: PID Error Flag Off (by loops) 

Error: PID Error Flag On, 

Error code occurrence (by loops) 

Warning 

Normal: PID Warning Flag Off (by loops) 

Error: PID Warning Flag On, 

Warnig code occurrence (by loops) 

Control operation 
Control of P,PI,PD and PID, control of forward/reverse 

operation 

Control interval 10.0ms ~ 6,553.6ms (0.1msUnit) 

Additional 

functions 

PWM output Supportable 

Mixed forward/reverse 

output 
Supportable 

Limiting change of 

present value 
INT (-32,768 ~ 32,767) 

Limiting change of 

maneuver value 
INT (-32,768 ~ 32,767) 

Equally dividing set 

value 
0 ~ 65,536 (frequency of control cycle time) 

Present value follow-

up 
0 ~ 65,536 (frequency of control cycle time) 

Cascade control Supportable. 

Min./max. present 

value 
-32,768 ~ 32,767 

Differential filter 0.01 ~ 655.35 (x 100 Scaled Up) 

Dead band setting 0 ~ 65,535 

Prevention of dual 

integral accumulation 
Supportable 

PID operation pause Supportable 

                       < Table 15.6 built-in PID control performance specification > 
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15.2.3 PID control parameter setting  
To use the built-in PID control function of XGB series, it is necessary to set PID control parameters by 
loops in the parameter window and operate it though the commands. Here, it explains parameters to 
use PID control functions and how to set them. 

 
(1) PID parameter settings 

     Follow the steps below to set the PID control function parameters of XGB series.  
(a) If selecting the built-in parameters in Parameter of the project window, it shows the built-in 

parameter setting window as in below figure.  
 

     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                        < Figure 15.7 Parameters setting window > 
 

(b) If selecting PID Control, it shows the PID control parameter setting window as in below figure. 
 

       
    [ Figure 15.8 Built-in PID function parameters setting window ] 
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(c) Input items  

The items to set in the built-in PID function parameter window and the available scope 
of them are summarized in below table. 
 

Items Description Scope 

RUN mode Set the operation mode of PID control. 
Auto/manual 

operation 

RUN direction Set the operation direction of PID control. Forward/reverse 

Prevention of dual 

integral accumulation 
Set whether to allow dual integral accumulation. Disabled/enabled 

PWM output 
Set whether to allow PWM output of maneuver 

value. 
Disabled/enabled 

Operation cycle time 
Set the operation cycle time of PID control 

cycle. 
100 ~ 65535 

Set value Set target control value.  -32,768 ~ 32,767 

Proportional gain Set proportional gain. Real number 

Integral time Set integral time. Real number 

Differential time Set differential time. Real number 

Limiting change of 

present value 

Set the limited change of present value per 

operation cycle. 
-32,768 ~ 32,767 

Limiting change of 

maneuver value 

Set the limited change of maneuver value per 

operation cycle. 
-32,768 ~ 32,767 

Max. maneuver value Set the max. maneuver value for control. -32,768 ~ 32,767 

Min. maneuver value Set the min. maneuver value for control. -32,768 ~ 32,767 

Manual maneuver 

value 
Set the manual maneuver value for control. -32,768 ~ 32,767 

DeadBand setting Set the deadband width of the set value. 0 ~ 65,535 

Differential filter value Set the filter coefficient of differential operation. 0 ~ 65,535 

PWM junction Set the junction to which PWM output is out. 
P20 ~ P3F 

(%QX0.0.0~%QX0.0.31) 

PWM output cycle Set the output cycle of PWM output. 100 ~ 65,535 

Set value ramp Set the frequency of set value ramp. 0 ~ 65,535 

Present value follow-

up 

Set the follow-up frequency of the present value 

follow-up function. 
0 ~ 65,535 

Min. present value Set the min. value of the input present value. -32,768 ~ 32,767 

Max. present value Set the max. value of input present value. -32,768 ~ 32,767 

< Table 15.7 PID function parameter setting items > 
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(2) Description of Setting of PID Parameters 
 

(a) Operation mode 
It is the mode to set the operation for PID control of a loop in question.  
The available scope is automatic operation or manual operation.  
If automatic operation is selected, it outputs the PID control result internally operated by the 
input PID control parameter as the maneuver value while if manual operation is selected, it 
outputs the value input to the manual maneuver value parameter without PID operation 
modified. The default is automatic operation.  

 
(b) Operation direction 

It is designed to set the operation direction for PID control of a loop in question. The available 
scope is forward or reverse direction. At the moment, forward direction means increase of PV 
when MV increases; reverse direction means decrease PV when MV increases. For instance, a 
heater is a kind of forward direction system because PV(temperature) increases when 
output(heating) increases. A refrigerator is a kind of reverse direction system in which 
PV(temperature) decreases when output increases.  
 

(c) Prevention of dual integral accumulation 

It makes dual integral accumulation function enabled/disabled. To understand integral 

accumulation prevention function, it is necessary to explain the phenomenon of integral 

accumulation first of all. Every drive has a limit. That is, a motor is limited to the speed and a 

valve can become status overcoming the complete open/close. If it happens that MV output 

from a control is beyond the output limit of a drive, its output is maintained as saturated, which 

may deteriorate the control performance of a system and shorten the life of a drive. Formula 

(7.2.3) shows that the integral control among PID control output components accumulates 

errors as time goes on, from which it may take more time to return the normal status after the 

actuator is saturated in a system of which response characteristically is slow. It is so called 

integral accumulation phenomenon as illustrated in Fig. 7.9, which shows that if the initial error 

is very large, the error is continuously accumulated by integral control. Accordingly, a drive is 

saturated within its output upper limit while the control signal is getting larger, keeping being 

saturated for a long while until the drift becomes negative and the integral term turns small 

enough. Due to the operation, the PV may have a large over-shoot as seen in the figure. Such 

a wind-up phenomenon may occur if the initial drift is large or by a large disturbance or due to 

malfunction of a device.  

The PID function of XGB series is basically with the integral accumulation prevention function, 

cutting off any integral accumulation phenomenon. In addition, it can detect a time when SV is 

suddenly decreased, providing a more strong dual integral accumulation prevention function. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

< Figure 15.9 Integral accumulation phenomenon > 
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(d) PWM Output Enabled 

PWM output means an output method to turn a junction on – off with a duty proportional to control 
output calculated by a uniform output cycle. If PWM output is enabled, it realizes PWM output in 
accordance with PWM output cycle set in the parameter of PWM output junction(P20 ~ P3F) 
designated in the parameter. At the moment, the PWM output cycle follows the PWM output cycle 
separately set in PID operation cycle. PWM output cycle is available between 10ms ~ 6553.5ms 
(setting value: 100 ~ 65,535) while it is set at a unit of integer per 0.1ms. figure shows the relation 
between PID control output and PWM output.  
 

Ex) if PWM output cycle: 1 second, PWM output junction: P20, max. output: 10000, min. output: 0 

 

Time Output P40 junction operation 

0 sec 5000 0.5 sec On, 0.5 sec Off 

1 sec 3000 0.3 sec On, 0.7 sec Off 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

[ Figure 15.10 Relation between PWM output cycle and MV ] 
 

(e) Set value 
It sets the target of a loop in question, that is, the target status a user wishes to control. In case of 
the PID control built in XGB, physical values (temperature, flow rate, pressure and etc) of an 
object to control is not meaningful and instead, it should use the physical amount of an object to 
control after converting them into numerals. For instance, in order to control a system using a 
sensor that the output is 0V when its heating device temperature is 0  while it is 10V when the ℃
temperature is 100  as much as 50 , it is necessary to set SV as 2000℃ ℃  (as long as it uses AD 
input module XBE-AD04A). 

 
(f) Operation cycle 

It sets the cycle to yield control output by executing the built-in PID operation. The setting cycle is 
0.1ms and available between 10ms ~ 6553.5ms (setting value: 100 ~ 65,535) while it is set at a 
unit of integer per 0.1ms. For instance, to set PID operation per 100ms, set the operation cycle as 
1000.  

 
(g) Proportional gain 

It is intended to set the proportional coefficient of a PID loop in question (Kp). As larger Kp, the 
proportional control operation is getting stronger. The scope is real number. 
 

(h) Integral time 
It sets the integral time of PID loop in question (Ti). As larger the integral time, the integral 
operation is getting weaker. The scope is real number at the unit of second.  

P20 output 
 

0.5sec 
 

0.5sec 0.3sec 0.7sec

MV = 5000 MV = 3000

Output cycle = 1sec Output cycle = 1sec 
Time 
 

(%QX0.0.0 
output) 
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(i) Differential time 

It sets the differential time of PID loop in question (Td). As larger the differential time, the 

differential operation is getting stronger. The scope is real number at the unit of second.  

 

(j) Limiting change of present value 

It sets the limit of change in present value of PID loop in question. If PV suddenly changes due to 

signal components such as sensor’s malfunction, noise or disturbance during control of PID, it 

may cause sudden change of PID control output. To prevent the phenomenon, a user can set the 

max. limit of change in present value that is allowed per PID operation cycle. If the change of 

present value is limited accordingly, it may calculate the present value as much as the limit 

although the present value is changed more than the limit once the limit of change in present 

value is set. If using the PV change limit function, it may prevent against sudden change of 

control output owing to noise or etc. If it is, however, set too small, it may reduce the response 

speed to the PV change of an actual system, not to sudden change by noise or etc, so it is 

necessary to set the value appropriately according to the environment of a system to control in 

order that the PV toward the set value does not take a longer time. The available scope is 

between -32,768 ~ 32,767. If setting the PV change limit as 0, the function is not available.  
 

(k) Limiting change of MV (ΔMV function)  
It limits the max. size that control output, which is output by PID operation is changed at a time. 
The output MV in this operation cycle is not changed more than the max. change limit set in the 
previous operation cycle. The function has an effect to prevent a drive from operating excessively 
due to sudden change of output by preventing sudden change of output resulting from 
instantaneous change of set value. If it is, however, set too small, it may cause taking a longer 
time until PV reaches to its target, so it is necessary to adjust it appropriately. The available 
scope is between -32,768 ~ 32,767. If setting it as 0, the function does not work.  

 
(l) Max. MV 

It sets the max. value of control output that may be output by the result of PID operation. The 
available scope is between -32,768 ~ 32,767. if it exceeds the max. output designated by PID 
operation result, it outputs the set max. output and alerts the max. output excess warning. For 
the types and description of warnings, refer to Error/Warning Codes.  

 
(m) Min. MV 

It sets the min. value of control output that may be output by the result of PID operation. The 
available scope is between -32,768 ~ 32,767. If it is smaller than the min. output value designated 
by PID operation result, it outputs the set min. MV and alerts the min. output shortage warning. 
For the types and description of warnings, refer to Error/Warning Codes.  
 

(n) Manual MV 
It sets the output when the operation mode is manual. The available scope is between -32,768 ~ 
32,767.  

 
(o) DeadBand setting 
It sets the deadband between set value and present value. Although it may be important to 
reduce normal status reply of PV for its set value even when MV fluctuates heavily, depending on 
control system, it may be more important to reduce the frequent change of MV although the 
normal status reply is somewhat getting larger. DeadBand may be useful in the case.  
Below figure shows an example of DeadBand setting. 
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 [ Figure 15.11 Example of DeadBand setting ] 

 
If setting deadband as in the figure, the PID control built in XGB may regard the error between PV 
and set value as 0 as long as PV is within the available scope of deadband from set value. 
 
That is, in this case, the change of MV is reduced. The available scope of setting is between 0 ~ 
65,535 and if it is set as 0, it does not work.  
 

(p) Differential Filter Value Setting 

It sets the coefficient of differential filter. Since differential control outputs in proportion to gradient 

of error and gradient of PV change, it may suddenly change MV as it generates a large response 

to instantaneous noise or disturbance. To prevent it, XGB series uses a value to which PV is 

filtered mathematically for differential control. Differential filter value is the coefficient to determine 

the filter degree for differential control. As smaller differential value set, as stronger differential 

operation is. The available scope is between 0 ~ 65,535 and if it is set as 0, the differential filter 

does not work.  

 
(q) Setting set value ramp 
Since the drift is suddenly large if SV is heavily changed during PID control, MV is also changed 
heavily to correct it. Such an operation may cause excessive operation of a system to control and 
a drive. To prevent it, SV ramp is used, changing SV gradually step by step when modifying SV 
during operation. If using the function, SV is gradually changed by SV ramp when SV is changed 
during PID control. At the moment, SV ramp setting represents the frequency of PID operation 
cycle taken from when SV starts changing to when it reaches to the final SV. For instance, if SV 
is to be changed from 1000 to 2000 during operation as PID operation cycle is 10ms and its SV 
ramp is 500, SV may reach to 2000 after 500X10ms = 5 seconds, that is, as it increases each 2 
per operation cycle and after the 500th operation scans. The available scope of setting is 
between 0 ~65,535 and it is set as 0, it does not work. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
     [ Figure 15.12 SV Ramp function ] 
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(r) PV Follow-up setting 
It is intended to prevent any excessive operation of a drive resulting from sudden change of 
output at the initial control and changes SV gradually from PV at the time when PID operation 
starts, not directly to SV in case control just turns from stop to operation mode or it changes from 
manual to automatic operation. At the moment, SV represents the frequency of PID operation 
cycles taken from when control starts to when it reaches to the set SV (other operations are same 
as SV ramp function). The available scope is between 0 ~ 65,535. If SV is changed again while 
PV follow-up is in operation, the SV would be also changed according to SV ramp.  

 
(s) Min./max. PV 
It sets the min./max. value entered as the present value of PID control. The available scope is 
between -32,768 ~ 32,767.  

 
 



XGB Analog edition manual  

15 - 18 

 

 

15.2.4 PID flag 
The parameter set by the XGB series built-in PID control function is saved into the flash memory of 

the basic unit. Such parameters are moved to K area for the built-in PID function as soon as PLC 

turns from STOP to RUN mode. PID control operation by PID control command is executed through K 

area data for PID functions. Therefore, if a user changes the value in the trend monitor window or 

variable monitor window during operation, PID operation is executed by the changed value. At the 

moment, if PLC is changed to RUN again after being changed to STOP, it loads the parameters in 

flash memory to K area, so the data changed in K area is lost. Thus, to keep applying the parameters 

adjusted in K area, it is necessary to write the parameter set in K area to flash memory by using WRT 

command. (In case of IEC, APM_WRT)   

 
(1) PID Flag Configuration  

     K area flags for XGB series built-in PID control function are summarized in the below table. 

 

Loop K area IEC type Symbol 
Data 

type 
Default Description 

Common 

K12000~F %KX19200~15 _PID_MAN Bit Auto 
PID output designation(0:auto, 

1:manual) 

K12010~F %KX19216~31 _PID_PAUSE Bit RUN PID pause (0:RUN, 1:pause) 

K12020~F %KX19232~47 _PID_REV Bit Forward 
Control direction(0:forward, 

1:reverse) operation control 

K12030~F %KX19248~63 _PID_AW2D Bit Disabled 
Dual integral accumulation 

prevention(0:enabled, 1:disabled) 

K12040~F %KX19264~79 _PID_REM_RUN Bit Disabled 
PID remote operation(0:disabled, 

1:enabled) 

K1205~K1207 %KW1205~%KW1207 Reserved WORD - Reserved area 

K12080~F %KX19328~43 _PID_PWM_EN Bit Disabled 
PWM output enable(0:disabled, 

1:enabled) 

K12090~F %KX19344~59 _PID_STD Bit - 
PID operation indication(0:stop, 

1:run) 

K12100~F %KX19360~75 _PID_ALARM Bit - PID warning(0:normal, 1:warning) 

K12110~F %KX19376~91 _PID_ERROR  Bit - PID error(0:normal, 1:error) 

K1212~K1215 %KW1212~%KW1215 Reserved WORD - Reserved 

Loop 0 

K1216 %KW1216 _PID00_SV INT 0 PID SV 

K1217 %KW1217 _PID00_T_s WORD 100 PID operation cycle[0.1ms] 

K1218 %KD609 _PID00_K_p REAL 1 PID proportional constant 

K1220 %KD610 _PID00_T_i REAL 0 PID integral time[sec] 

K1222 %KD611 _PID00_T_d REAL 0 PID differential time[sec] 

K1224 %KW1224 _PID00_d_PV_max WORD 0 PID PV change limit 

K1225 %KW1225 _PID00_d_MV_max WORD 0 PID MV change limit 

K1226 %KW1226 _PID00_MV_max INT 4000 PID MV max. value limit 

K1227 %KW1227 _PID00_MV_min INT 0 PID MV min. value limit 

K1228 %KW1228 _PID00_MV_man INT 0 PID manual output 

K1229 %KW1229 _PID00_PV INT - PID PV 

           < Table 15.8 K area flags for PID control >
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Loop K area IEC type Symbol 
Data 

type 
Default Description 

Loop 0 

K1230 %KW1230 _PID00_PV_old INT - PID PV of previous cycle 

K1231 %KW1231 _PID00_MV INT 0 PID MV 

K1232 %KD616 _PID00_ERR DINT - PID control error 

K1234 %KD617 _PID00_MV_p REAL 0 
PID MV proportional value 

component 

K1236 %KD618 _PID00_Mv_i REAL 0 
PID MV integral control 

component 

K1238 %KD619 _PID00_MV_d REAL 0 
PID MV differential control 

component 

K1240 %KW1240 _PID00_DB_W WORD 0 PID deadband setting 

K1241 %KW1241 _PID00_Td_lag WORD 0 PID differential filter coefficient 

K1242 %KW1242 _PID00_PWM WORD H’20 PID PWM junction setting 

K1243 %KW1243 _PID00_PWM_Prd WORD 100 PID PWM output cycle 

K1244 %KW1244 _PID00_SV_RAMP WORD 0 PID SV Ramp value 

K1245 %KW1245 _PID00_PV_Track WORD 0 PID PV follow-up setting 

K1246 %KW1246 _PID00_PV_MIN INT 0 PID PV min. value limit 

K1247 %KW1247 _PID00_PV_MAX INT 4000 PID PV max. value limit 

K1248 %KW1248 _PID00_ALM_CODE Word 0 PID warning code 

K1249 %KW1249 _PID00_ERR_CODE Word 0 PID error code  

K1250 %KW1250 _PID00_CUR_SV INT 0 PID SV of current cycle 

K1251-1255 %KW1251-1255 Reserved WORD - Reserved area 

Loop 1 K1256~K1295 %KW1256~%KW1295 - - - PID Loop1 control parameter 

~ 

Loop16 K1816~K1855 %KW1816~%KW1855 - - - PID Loop16 control parameter 

< Table 15.8 K area flags for PID control (continued) > 
K1200 ~ K1211 areas are the common bit areas of PID loops while each bit represents the status of 
each PID control loop. Therefore, each 16 bits, the max number of loops of XGB PID control 
represents loop status and setting respectively. K1216 ~ K1255 areas are K areas for PID control 
loop 0 and save the loop 0 setting and status. It also contains parameters such as SV, operation 
cycle, proportional coefficient, integral time and differential time set in the built-in parameter window 
and the XGB built-in PID function executes PID control by each device value in question. In addition, 
the output data such as MV calculated and output while PID control is executed is also saved into 
the K areas. By changing the values in K areas, control setting may be changed any time during 
PID control.  

  By changing value of area, you can change control setting whenever you want 

during the PID control      
1) PID control flag expression : _PID[n]_xxx  

 [n] : loop number 
 xxx : flag function 

Ex) _PID10_K_p : means K_p of loop 10. 

 
 
 
 

Remark       
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2) PID flag function 

Each function of K area flags for XGB series built-in PID control function is summarized as follows.  

   

(a) Common bit area 
The area is a flag collecting operation setting and information consisting of bits to each 16 loop. 
Each bit of each word device represents the information of each loop. That is, ‘n’ th bit represents 
the information about PID loop n.  
 

        1) _PID_MAN (PID RUN mode setting) 
 
 
 
 

 
I
It determines whether to operate the PID control of n loop automatically or manually. For more 
information about RUN mode, refer to 6.2.3 PID control parameter setting. If the bit is off, it 
operates automatically; if on, it runs manually.  

 
2) _PID_PAUSE (PID Pause setting) 

 
 
 
 

 
It changes PID control of n loop to pause status. If PID control is paused, the control MV is 
fixed as the output at the time of pause. At the moment, PID operation is continued internally 
with output fixed. If changing pause status to operation status again, it resumes control, so it 
may take a longer time until the PV is going to SV once system status is largely changed during 
pause. If the bit is off, it cancels pause; if on, it operates as paused.  
 

3) _PID_REV (PID RUN direction setting) 
 
 
 
 

 
I
It sets the RUN direction of PID control of ‘n’th loop. For more information about run direction, 
refer to 7.2.3 PID control parameter setting. If the bit is off, it operates normally; if on, it 
operates reversely.  
 

4) _PID_AW2D (Dual Integral accumulation prevention setting) 
 
 
 
 

 
 
I
It sets enable/disable of dual integral accumulation prevention of ‘n’th loop. For more 
information about dual integral accumulation prevention, refer to 7.2.3 PID control parameter 
setting. If the bit is off, it is enabled; if on, it is disabled.  

Flag name address 
IEC type 

address 
Unit Setting 

_PID_MAN  

(PID RUN mode setting) 
K1200n %KX19200 + n BIT Available 

Flag name Address 
IEC type 

address 
Unit Setting 

_PID_PAUSE (PID pause setting) K1201n %KX19216 + n BIT Available 

Flag name Address 
IEC type 

address 
Unit Setting 

_PID_REV  

(PID RUN direction setting) 
K1202n %KX19232 + n BIT Available 

Flag name Address 
IEC type 

address 
Unit Setting 

_PID_AW2D  

(dual integral accumulation 

prevention setting) 

K1203n %KX19248 + n BIT Available 
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5) _PID_REM_RUN (PID remote operation setting) 

 
 
 
 

 
X
GB series built-in PID function can be started by both run from command’s start junction and 
remote run bit setting. That is, XGB starts PID control if PIDRUN command’s start junction is on 
or remote run setting bit is on. Namely, if one of them is on, it executed PID control.  
 

6) _PID_PWM_EN (PWM output enable) 
 
 
 
 

 
I
It determines whether to output the MV of PID control of ‘n’th loop as PWM output. For more 
information about PWM output, refer to 15.2.3 PID control parameter setting. If the bit is off, it is 
disabled; if on, it is enabled.  
 

7) _PID_STD (PID RUN status indication) 
 
 
 
 

 
I
It indicates the PID control RUN status of ‘n’ th loop. If a loop is running or paused, it is on while 
if it stops or has an error during RUN, it is off. In the area as monitoring area, it is changed to 
the current run status by PLC although a user enters any value temporarily.  
 

8) _PID_ALARM (PID Warning occurrence) 
 
 
 
 

 
I
It indicates warning if any warning occurs during PID control of ‘n’th loop. Once a warning 
occurs during PID control operation of a loop, it is on while if it is normal, it is off. At the moment, 
despite of warning, PID control continues without interruption, but it is desirable to check 
warning information and take a proper measure. Once a warning occurs, the warning code is 
also indicated in warning code area of a loop. For more information about the types of warning 
codes and measures, refer to 15.5. In the area as monitoring area, it is changed to the current 
run status by PLC although a user enters any value temporarily. 
 

9) _PID_ERROR (PID Error occurrence) 
 
 
 
 

 
I
If an error that discontinues running during PID control of ‘n’ th loop occurs, it indicates the 
error’s occurrence. If an error generates warning, it is on; if normal, it is off. When an error 
occurs, PID control stops and MV is output as the min. output set in parameter. Also, if an error  

Flag name Address  
IEC type 

address 
Unit Setting 

_PID_REM_RUN  

(PID remote run setting) 
K1204n %KX19264 + n BIT Available 

Flag name Address 
IEC type 

address 
Unit Setting 

_PID_PWM_EN 

 (PWM output enable) 
K1208n %KX19328 + n BIT Available 

Flag name Address 
IEC type 

address 
Unit Setting 

_PID_STD 

 (PID RUN status indication) 
K1209n %KX19344 + n BIT Unavailable 

Flag name Address 
IEC type 

address 
Unit Setting 

_PID_ALARM  

(PID Warning occurrence) 
K1210n %KX19360 + n BIT Unavailable 

Flag name Address 
IEC type 

address 
Unit Setting 

_PID_ERROR  

(PID error occurrence) 
K1211n %KX19376 + n BIT Unavailable 
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occurs, the error code is indicated in the error code area of a loop. For more information about 
type of error codes and measures, refer to 15.5. In the area as monitoring area, it is changed to 
the current run status by PLC although a user enters any value temporarily. 
 

(b) PID Flag area by loops 
PID flag areas by loops are allocated between K1216 ~ K1855 and for totally 16 loops, each 40 
words is allocated per loop. Therefore, the individual data areas of ‘n’ th loop are between K 
(1216+16*n) ~ K (1255+16*n). Every setting of the PID flag areas by loops may be changed 
during PID control operation. Once the settings are changed, they are applied from the next PID 
control cycle.   
 
1) _PIDxx_SV (PID xx Loop SV setting) 

 
  It sets/indicates the SV of PID control of ‘xx’ th loop. For more information about SV, refer to 

15.2.3 PID control parameter setting. The available scope is between -32,768 ~ 32,767. 
 
2) _PIDxx_T_s (PID xx Loop operation cycle) 

 
It sets/indicates the operation cycle of PID control of ‘xx’ th loop. For more information about 
operation cycle, refer to 15.2.3 PID control parameter setting. The available scope is between 
100 ~ 65,535.  
 

3) _PIDxx_K_p (PID xx Loop proportional constant) 

 
It sets/indicates the proportional constant of PID control of ‘xx’ th loop. For more information 
about proportional constant, refer to 7.2.3 PID Control Parameter Setting. The available scope 
is real number (-3.40282347e+38 ~ -1.17549435e-38 , 0 , 1.17549435e-38 ~ 3.40282347e+38). 
If it is, however, set as 0 and lower, the PID control of a loop generates an error and does not 
work.  
 

4) _PIDxx_T_i (PID xx Loop Integral time) 

 
It sets/indicates integral time of PID control of ‘xx’ th loop. The available scope is real number. If 
it is set as 0 and lower, it does not execute integral control.  
 

Flag name Address IEC type address Unit Scope 

_PIDxx_SV  

(PID xx Loop SV setting) 
K1216+16*xx %KW1216+16*xx INT -32,768 ~ 32,767 

Flag name Address IEC type address Unit Scope 

_PIDxx_T_s 

 (PID xx Loop operation cycle) 
K1217+16*xx %KW1217+16*xx WORD 100 ~ 65,535 

Flag name Address IEC type address Unit Scope 

_PIDxx_K_p  

(PID xx Loop proportional constant) 
K1218+16*xx %KD609+20*xx REAL Real number 

Flag name Address IEC type address Unit Scope 

_PIDxx_T_i  

(PID xx Loop integral time) 
K1220+16*xx %KD610+20*xx REAL Real number 
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5) _PIDxx_T_d (PID xx Loop differential time) 

 
It sets/indicates differential time of PID control of ‘xx’ th loop. The available scope is real 
number. If it is set as 0 and lower, it does not execute differential control.  
 

6) _PIDxx_d_PV_max (PV change limit) 
 
 
 
 

 
It sets the PV change limit of ‘xx’ th loop. 
For more information about PV change limit, refer to 15.2.3 PID control parameter setting. If it 
is set as 0, the PV change limit function does not work.  
 

7) _PIDxx_d_MV_max (MV change limit) 
 
 
 
 

 
It sets the MV change limit of ‘xx’th loop. For more information about MV change limit, refer to 
15.2.3 PID control parameter setting. If it is set as 0, the MV change limit function does not work.  
 

8) _PIDxx_MV_max, _PIDxx_MV_min, _PIDxx_MV_man (max. MV, min. MV, manual MV) 
 
 
 
 

 
 
 
It sets the max. MV, min. MV and manual MV of ‘xx’ th loop. For more information about max. 
MV, min. MV and manual MV, refer to 15.2.3 PID control parameter setting. If the max. MV is 
set lower than the min. MV, the PID control loop generates an error and does not work.  
 

9) _PIDxx_PV (prevent value) 
 
 
 
 

 
It is the area that receives the present value of ‘xx’ th PID control loop. PV is the present status 
of the system to control and is normally saved into U device via input devices such as A/D input 
module if it is entered from a sensor. The value is used to execute PID operation by moving to 
_PIDxx_PV by means of commands like MOV.  
 

10) _PIDxx_PV_OLD (PV of previous control cycle) 
 
 
 
 

 
The area indicates the PV just before the xx th PID control loop. The flag, as a dedicated 
monitoring flag, would be updated by PLC although a user directly enters it.  

Flag name Address IEC type address Unit Scope 

_PIDxx_T_d  

(PID xx Loop differential time) 
K1222+16*xx %KD611+20*xx REAL Real number 

Flag name Address IEC type address Unit Scope 

_PIDxx_d_PV_max 

 (PV change limit) 
K1224+16*xx %KD612+20*xx WORD 0 ~ 65,535 

Flag name Address IEC type address Unit Scope 

_PIDxx_d_MV_max  

(MV change limit) 
K1225+16*xx %KD610+20*xx WORD 0 ~ 65,535 

Flag name Address IEC type address Unit Scope 

_PIDxx_MV_max (max. MV) K1226+16*xx %KW1226+16*xx 

INT -32,768 ~ 32,767 _PIDxx_MV_min (min. MV) K1227+16*xx %KW K1227+16*xx 

_PIDxx_MV_man (manual MV) K1228+16*xx %KW K1228+16*xx 

Flag name Address IEC type address Unit Scope 

_PIDxx_PV  

(present value) 
K1229+16*xx %KW1229+16*xx INT -32,768 ~ 32,767 

Flag name Address IEC type address Unit Scope 

_PIDxx_PV_OLD  

(PV of previous control cycle) 
K1230+16*xx %KW1230+16*xx INT Unavailable 
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11) _PIDxx_MV (Control MV) 

 
 
 
 

The area shows the MV of ‘xx’ th PID control loop. As the area in which XGB built-in PID 
operation result is output every PID control cycle, it delivers the value in the area to U device 
every scanning by using commands like MOV in the program and outputs to D/A output module, 
operating a drive.  
 

12) _PID00_ERR (Present error) 
 
 
 
 

T
he areas shows the current error of ‘xx’ th PID control loop. It is also used as an indicator about 
how much gap the present status has with a desired status and if an error is 0, it means the 
control system reaches a desired status exactly. Therefore, if control starts, error is quickly 
reduced at transient state and it reaches normal state, maintaining remaining drift as 0, it could 
be an ideal control system. The flag, as a dedicated monitoring, is updated although a user 
directly enters it.  

 
13) _PIDxx_MV_p, _PIDxx_MV_i, _PIDxx_MV_d (P/I/D control components of MV) 

 
 
 
 

 
 
 
 
 
It indicates ‘n’ th loop MV by classifying proportional control MV, integral control max. MV and 
differential control MV. The entire MV consists of the sum of these three components. The flag, 
as a dedicated monitoring, is updated although a user directly enters it. 
 

14) _PIDxx_DB_W (DeadBand setting) 
 
 
 
 

 
It sets the deadband of ‘xx’ th loop. For more information about Deadband function, refer to 
15.2.3 PID control parameter setting. If it is set as 0, the function does not work.  

 
15) _PIDxx_Td_lag (Differential filter coefficient) 

 
 
 
 

 
It sets the differential filter coefficient of ‘xx’ th loop. For more information about differential filter 
coefficient, refer to 15.2.3 PID control parameter setting. If it is set as 0, the function does not 
work.  
 

Flag name Address IEC type address Unit Scope 

_PIDxx_MV (control MV) K1231+16*xx %KW1231+16*xx INT Unavailable 

Flag name Address IEC type address Unit Scope 

_PID00_ERR  

(present error) 
K1232+16*xx %KW1232+16*xx DINT Unavailable 

Flag name Address IEC type address Unit Scope 

_PIDxx_MV_p  

(MV proportional control component) 
K1234+16*xx %KD616+20*xx 

REAL Unavailable 
_PIDxx_MV_i  

(MV integral control component) 
K1236+16*xx %KD617+20*xx 

_PIDxx_MV_d  

(MV differential control component) 
K1238+16*xx %KD618+20*xx 

Flag name Address IEC type address Unit Scope 

_PIDxx_DB_W  

(DeadBand setting) 
K1240+16*xx %KW1232+16*xx WORD 0 ~ 65,535 

Flag name Address IEC type address Unit Scope 

_PIDxx_Td_lag  

(differential filter coefficient) 
K1241+16*xx %KW1241+16*xx WORD 0 ~ 65,535 
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16) _PIDxx_PWM (PWM output junction setting) 
 
 
 
 

 
It sets the junction to which PWM output of ‘xx’ th loop is output. PWM output junction is valid 
only between H’20 ~ H’3F. If any other value is entered, PWM output does not work.  
 

17) _PIDxx_PWM_Prd (PWM Output cycle setting) 
 
 
 
 

 
It sets the PWM output cycle of ‘xx’ th loop. The available scope is between 100 ~ 65,535 at the 
unit of 0.1ms.  
 

18) _PIDxx_SV_RAMP (SV ramp setting) 
 
 
 
 

 
It sets the SV ramp value of ‘xx’ th loop. For more information about SV ramp of PV, refer to 
15.2.3 PID control parameter setting. If it is set as 0, the function does not work.  

 
19) _PIDxx_PV_Track (PV follow-up setting) 

 
 
 
 

 
It sets the PV follow-up SV of ‘xx’ th loop. For more information about PV follow-up, refer to 
15.2.3 PID control parameter setting. If it is set as 0, the function does not work.  
 

20) _PIDxx_PV_MIN, _PIDxx_PV_MAX(Min. PV input, Max. PV input) 
 
 
 
 

 
 
 
It sets the min./max. PV of ‘xx’ th loop. 
 

21) _PIDxx_ALM_CODE (Warning code) 
 
 
 
 

 
It indicates warning code if a warning occurs during ‘xx’ th loop run. The flag, as a dedicated 
monitoring, is updated although a user directly enters it. For more information about warning 
code, refer to 15.5.   
 

Flag name Address IEC type address Unit Scope 

_PID00_PWM  

(PWM output junction setting) 
K1242+16*xx %KW1242+16*xx WORD H’20 ~ H’3F 

Flag name Address IEC type address Unit Scope 

_PIDxx_PWM_Prd  

(PWM output cycle setting) 
K1243+16*xx %KW1243+16*xx WORD 100 ~ 65,535 

Flag name Address IEC type address Unit Scope 

_PIDxx_SV_RAMP 

(SV ramp setting) 
K1244+16*xx %KW1244+16*xx WORD 0 ~ 65,535 

Flag name Address IEC type address Unit Scope 

_PIDxx_PV_Track  

(PV follow-up setting) 
K1245+16*xx %KW1245+16*xx WORD 0 ~ 65,535 

Flag name Address IEC type address Unit Scope 

_PIDxx_MV_p  

(MV proportional control component) 
K1246+16*xx %KW1246+16*xx 

INT -32,768 ~ 32,767 
_PIDxx_MV_i  

(MV integral control component) 
K1247+16*xx %KW1247+16*xx 

Flag name Address IEC type address Unit Scope 

_PIDxx_ALM_CODE  

(Warning code) 
K1248+16*xx %KW1248+16*xx WORD Unavailable 



XGB Analog edition manual  

15 - 26 

 

 
 
22) _PIDxx_ERR_CODE (Error code) 

 
 
 
 

 
It indicates error code if an error occurs during ‘xx’ th loop run. The flag, as a dedicated 
monitoring, is updated although a user directly enters it. For more information about warning 
code, refer to 15.5. 
 

23) _PIDxx_CUR_SV (SV of the present cycle) 
 
 
 
 

 
It indicates SV currently running of ‘xx’ th loop. If SV is changing due to SV ramp or PV follow-
up function, it shows the currently changing PV. The flag, as a dedicated monitoring, is updated 
although a user directly enters it.  

 
 
 
 
 
 
 

Flag name Address IEC type address Unit Scope 

_PIDxx_ERR_CODE  

(error code) 
K1249+16*xx %KW1249+16*xx WORD Unavailable 

Flag name Address IEC type address Unit Scope 

_PIDxx_CUR_SV 

(SV of the present cycle) 
K1250+16*xx %KW1250+16*xx INT Unavailable 
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15.3 PID Instructions 
 

It describes PID control commands used in XGB series. The command type of PID control used in 

XGB series built-in PID control is 4.  

 

(1) PIDRUN 

PIDRUN is used to execute PID control by loops.  

 

 

- Operand S means the loop no. to execute PID control and avaiable only for constant(0~15).  

- If start signal is on, the PID control of a loop starts.  

- In case of IEC type, PID control is conducted by PIDRUN function block. 

- In case of XGB IEC type, inputs ‘0’ at BLOCK 

 
- PID_STAT, only supported on IEC type, indicates status of PID operation. For meaning of 

inidcation data, refer to indication contents of PID STATE.  
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Indication contents of PID STATE 

Item Indication Flag name Contents 

ALARM 

16#0001 PV_MIN_MAX_ALM 
Current value exceeds range of maximum, minimum 
value 

16#0002 
PID_SCANTIME_AL
M 

Operation cycle is too short.  

16#0003 PID_dPV_WARN 
Variation of current value of this PID cycle exceeds the 
current value variation limit. 

16#0004 PID_dMV_WARN 
Variation of manipulated value of this PID cycle exceeds 
the manipulated value variation limit. 

16#0005 
PID_MV_MAX_WAR
N 

Manipulated value of this PID cycle exceeds maximum 
manipulated value.  

16#0006 
PID_MV_MIN_WAR
N 

Manipulated value of this PID cycle is smaller than 
minimum manipulated value. 

ERROR 

16#0100 MV_MIN_MAX_ERR 
Maximum manipulated value is set to be smaller than 
minimum manipulated value. 

16#0200 PV_MIN_MAX_ERR 
Maximum current value is set to be smaller than current 
manipulated value. 

16#0300 
PWM_PERIOD_ER
R 

PWM output cycle is set to be smaller than 100(10ms). 

16#0400 SV_RANGE_ERR 

In case of forward operation, set value at start of auto-
tuning is smaller than current value. In case of reverse 
operation, set value at start of auto-tuning is larger than 
current value. 

16#0500 
PWM_ADDRESS_E
RR 

PWM output is set as contact point other 
than %QX0.0.0~0.0.31. 

16#0600 P_GAIN_SET_ERR Proportional constant is set to be smaller than 0.  

16#0700 I_TIME_SET_ERR Integral constant is set to be smaller than 0 

16#0800 D_TIME_SET_ERR Differential constant is set to be smaller than 0 

16#0900 
CONTROL_MODE_
ERR 

Control mode is other than P, PI, PD and PID. 

16#0B00 PID_PERIOD_ERR; PIC operation cycle is set to be smaller than 100(10ms) 

16#0C00 HBD_WRONG_DIR 

In combined operation, directional parameter of forward 
operation loop is set as reverse operation or directional 
parameter of reverse operation loop is set as forward 
operation 

16#0D00 
HBD_SV_NOT_MAT
CH 

In combined operation, set values of two loops are different 

16#0E00 LOOP_EXCEED PID LOOP number is larger 15 
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(2) PIDCAS 

PIDCAS is a command to execute CASCADE control.  

 

 

- Operand M and S mean master loop and slave loop respecively and available only for 

constant(0~15).  

- If start junction is on, cascade control is executed through master loop and slave loop.  

- In case of IEC type, PIDCAS function block is used for cascade control. 

 

 

Cascade control is called a control method which is intended to increase control stability through 

quick removal of disturbance by connecting two PID control loops in series and is structured as 

follows.  

   

  [Figure 15.13 Comparison of single loop control and cascade control]  

 

Looking at the figure, it is found that cascade control contains slave loop control within external 

control loop. That is, the control output of external loop PID control is entered as SV of the 

internal loop control. Therefore, if steam valve suffers from disturbance in the figure, single loop 

PID control may not be modified until PV, y(s) appears while cascade control is structured to 

remove any disturbance by the internal PID loop control before any disturbance that occurs in 

its internal loop affects the PV, y(s), so it can early remove the influence from disturbance.  

XGB internal PID control connects two PID control loops each other, making cascade control 

possible. At the moment, MV of external loop is automatically entered as the SV of internal loop, 

so it is not necessary to enter it through program.  
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(3) PIDHBD 

PIDHBD is a command to execute the mixed forward/reverse E control.  

 

 

- Operand F and R represent forward operation loop and reverse operation loop and available 

only for constant(0~15).  

- If start junction is on, it starts the mixed forward/reverse operation from the designated 

forward/reverse loops.  

- In case of IEC type, combined operation is executed by using PIDHBD function block 

 

 
 

The mixed forward/reverse control is called a control method to control forward operation control 

output and reverse operation control operation alternatively to a single control process. The XGB 

built-in PID control enables the mixed forward/reverse control by connecting two PID control loops 

set as forward/reverse operations. At the moment, it uses PIDHBD command. For more information 

about the command, refer to 15.2.5. The mixed forward/reverse run is executed as follows in the 

XGB built-in PID control.    

 

(a) Commencement of mixed run 

If PIDHBC command starts first, it starts reverse run when PV is higher than SV; it starts 

forward run if PV is lower than SV.  

 

        (b) Conversion of RUN direction 

The conversion of run direction is executed according to the following principles. In case of 

forward operation run, it keeps running by converting to reverse operation once PV is over SV 

+ DeadBand value. At the moment, the DeadBand setting value uses the deadband of a loop 

set for forward operation. If PV is below SV – DeadBand value during reverse operation, it also 

keeps running by converting to forward operation. In the case, the DeadBand setting uses the 

deadband of a loop set for reverse loop. It may be illustrated as 15.14.  
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[Figure 15.14 Conversion of RUN direction in the mixed forward/reverse control] 

 

        (c) At the moment, every control parameter uses the parameter of a loop set for forward operation 

while MV is output to MV output area of a loop of forward operation. Reversely, every control 

parameter uses the parameter of a loop set for reverse operation during reverse operation run 

while MV is also output to MV output area of reverse operation loop.  

 

(d) WRT 

WRT is a command to save K area flags changed during operation to the internal flash memory  

of PLC.  

 

 

- Once start juction is on, it writes K area values to flash memory.  

- Each operand description is summarized as follows. 

 

Operand 
Item 

designated 
Available device Remark 

OP1 Slot Constant Designating basic uit as 0 

OP2 N/A 
P,M,L,K,D,Z,R, 

constant 
Not used 

OP3 Parameter type P,M,L,K,D,Z,R,constant 

0 : positioning X axis 

1 : positioning Y axis 

2 : HS counter 

3 : PID parameter 

4 : PID auto-tuning parameter 
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- In case of IEC type, APM_WRT funcion block is used. 
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15.4 PID Auto-tuning 
 
15.4.1 Basic theory of PID auto-tuning 

It describes the function of PID auto-tuning. 

The performance of PID controller is very different according to P, I, D coefficient. Generally, It is very 

difficult and takes long time to predict the system and set P, I, D coefficient because of non-periodical 

disturbance, interference of other control loop, dynamic characteristic of control system though the 

engineer is good at handling the PID controller. So auto-tuning that sets the PID coefficient 

automatically is very useful. Generally, there are many methods in setting the PID coefficient. Here, it 

will describe Relay Auto-tuning.   
(1) PID coefficient setting by Relay auto-tuning 

It makes critical oscillation by force and uses the width and period of oscillation to specify the PID 

coefficient. It applies max. output and min. output to control system for auto-tuning. Then, 

oscillation with steady period and steady width occurs around the Set value like figure 6.15, and it 

can calculate the boundary gain by using it like expression (15.3.1).       

 

< Figure 15.15 Relay auto-tuning > 

 

width

outputMinoutputMax
Ku








). .(4
                  (15.4.1) 

 
 At this time, oscillation period is called boundary period. If boundary gain and period is specified, 
use table 15.9, Ziegler & Nichols tuning table to specify the PID coefficient. This Relay tuning is 
relatively simple to configure and easy to know the boundary gain and period so it is used 
frequently and XGB built-in PID auto-tuning uses this method.  

Controller 
Proportional gain 

(Kp) 
Integral time(Ti) 

Differential 

time(Td) 

P uK5.0
 - - 

PI uK45.0
 

2.1/uP
 - 

PID uK6.0
 

2/uP
 

8/uP
 

< Table 15.9 Ziegler & Nichols tuning table > 
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15.4.2 PID Auto-Tuning function specifications  

The specifications of the XGB series built-in PID auto-tuning function are summarized as in Table. 

 

Item Specifications 

Scope of SV INT (-32,768 ~ 32,767) 

Scope of PV INT (-32,768 ~ 32,767) 

Scope of MV INT (-32,768 ~ 32,767) 

 Error indication 
Normal: error flag off 

Error: error flag off, error code occurs 

AT direction setting Forward/Reverse 

Control cycle 100 ~ 65,536 (0.1msUnit) 

Additional 

function 

PWM output Supportable 

Hysteresis Supportable 

                           [Table 15.10 Spec. of built-in PID auto-tuning function] 

 

15.4.3 Auto-tuning parameter setting 
 

To use the XGB series auto-tuning function, it is necessary to start it by using a command after 
setting auto-tuning parameters by loops in the parameter window. It explains the parameters to 
use auto-tuning function and how to set them. 

 
(1) Auto-tuning parameter setting 

          To set the parameters of XGB series auto-tuning function, follow the steps.  
 

(a)  If selecting parameter in project window and the built-in parameter, it shows the built-in 
parameter setting window as seen in below figure.  

 

 
 
                   < Figure 15.16 Built-in parameter setting window > 
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(b) If selecting auto-tuning, it shows the parameter setting window as seen in Figure 15.17. 

 

  
  <Figure 15.17 Built-in auto-tuning function parameter setting window> 

 
(c) Input items  

Table shows the items to set in auto-tuning parameter window and the available scopes.  
 

Items Description Scope 

RUN direction Set the run direction of auto-tuning. Forward/reverse 

PWM output enable 
Set whether to set PWM output of MV enabled/ 

disabled. 
Disable/enable 

SV Set SV.  -32,768 ~ 32,767 

Operation time Set auto-tuning operation time. 100 ~ 65535 

Max. MV Set the max. MV in control. -32,768 ~ 32,767 

Min. mV Set the min. MV in control. -32,768 ~ 32,767 

PWM junction 

designation 

Designate the junction to which PWM output is 

output. 
P20 ~ P3F 

PWM output cycle Set the output cycle of PWM output. 100 ~ 65,535 

Hysteresis setting Set the hysteresis of auto-tuning MV. 0 ~ 65,535 

 < Table 15.11 Auto-tuning function parameter setting items> 
 

(2) Description of auto-tuning parameters and how to set them 
 

(a) RUN direction 
RUN direction is to set the direction of auto-tuning run of a loop. The available option is forward 
or reverse. The former (forward) means that PV increase when MV increases while the latter 
(reverse) means PV decreases when MV increases. For instance, a heater is a kind of forward 
direction system because PV (temperature) increases when output (heating) increases. A 
refrigerator is a kind of reverse direction system in which PV (temperature) decreases when 
output increases. 
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(b) PWM output enable  

PWM output means an output method to turn a junction on – off with a duty proportional to control  

 

 

output calculated by a uniform output cycle. If PWM output is enabled, it realizes PWM output in 

accordance with PWM output cycle set in the parameter of PWM output junction (P20 ~ P3F, in 

case of IEC type, %QX0.0.0~%QX0.0.15) designated in the parameter. At the moment, the PWM 

output cycle follows the PWM output cycle separately set in auto-tuning operation cycle.  

 

(c) SV  
It sets the auto-tuning SV of a loop in question. Similar to PID control, physical values 
(temperature, flow rate, pressure and etc) of an object to control is not meaningful and instead, it 
should use the physical amount of an object to control after converting them into numerals. For 
instance, in order to control a system using a sensor that the output is 0V when its heating device 
temperature is 0℃ while it is 10V when the temperature is 100℃ as much as 50℃, it is 
necessary to set SV as 2000(as long as it uses AD input module XBE-AD04A). 

 

(d) Operation time 

It sets the cycle to execute operation for auto-tuning. The setting cycle is 0.1ms and available 

between 10ms ~ 6553.5ms (setting value: 100 ~ 65,535) while it is set at a unit of integer per 

0.1ms.  
 

(e) Max./min. MV 
It sets the max./min. value of output for auto-tuning. The available scope is between -32,768 ~ 
32,767. If the max. MV is set lower than min. MV, the auto-tuning function of a loop generates an 
error and does not work.  

 
(f) Hysteresis setting 

Looking at relay tuning in Figure 15.15, it shows it outputs the max. MV as auto-tuning starts but 
it converts to min. output as PV is over SV and then, it converts to the max. output as PV is lower 
than SV. However, if input PV contains noise components or reply components, auto-tuning 
ends by a slight vibration of PV around SV, yielding incorrect tuning result. To prevent it, 
hysteresis may be set. XGB auto-tuning converts output at SV + Hysteresis when PV increases 
or at SV – Hysteresis when it decreases once hysteresis is set. With it, it may prevent incorrect 
tuning by a slight vibration around SV.  

  

 

 

 

 

 

 

 

 

 

 

 

 
      [Figure 15.16 Example of Hysterisis setting ] 
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SV 
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15.4.4 Auto-tuning flag 
 

The parameters set in the XGB series auto-tuning function are saved to the flash memory of basic unit. 

Such parameters are moved to K area for auto-tuning function as soon as PLC enters to RUN mode 

from STOP. Auto-tuning operation using auto-tuning command is achieved by data in K area. At the 

moment, if PLC is changed to RUN again after being changed to STOP, it takes the parameters in 

flash memory to K area, so the data changed in K area is lost. Therefore, to continuously apply the 

parameters adjusted in K area, it is necessary to write the parameters set in K area into flash memory 

by using WRT command. (In case of IEC type, APM_WRT function block) 

  
(1) Auto-tuning flag configuration 

  The K area flags of XGB series auto-tuning function are summarized in Table 15.12.  

Loops K area IEC type Symbol Data type Default Description 

Common 

K18560~F 
%KX29696  

~%KX29711  
_AT_REV Bit Forward 

Auto-tuning direction(0:forward,  

1:reverse) 

K18570~F 
%KX29712  

~%KX29727 
_AT_PWM_EN Bit Disable 

PWM output enable(0:disable,  

1:enable) 

K18580~F 
%KX29728  

~%KX29743 
_AT_ERROR Bit - 

Auto-tuning 

error(0:normal,1:error) 

K1859 %KW1859 Reserved WORD - Reserved area 

Loop0 

K1860 %KW1860 _AT00_SV INT 0 AT SV – loop 00 

K1861 %KW1861 _AT00_T_s WORD 100 
AT operation cycle 

(T_s)[0.1msec] 

K1862 %KW1862 _AT00_MV_max INT 4000 AT MV max. value limit 

K1863 %KW1863 _AT00_MV_min INT 0 AT MV min. value limit 

K1864 %KW1864 _AT00_PWM WORD 0 AT PWM junction setting 

K1865 %KW1865 _AT00_PWM_Prd WORD 0 AT PWM output cycle 

K1866 %KW1866 _AT00_HYS_val WORD 0 AT hysterisis setting 

K1867 %KW1867 _AT00_STATUS WORD 0 AT auto-tuning status indication 

K1868 %KW1868 _AT00_ERR_CODE WORD 0 AT error code 

K1869 %KD _AT00_K_p REAL 0 AT result proportional coefficient 

K1871 - _AT00_T_i REAL 0 AT result integral time 

K1873 - _AT00_T_d REAL 0 AT result differential time 

K1875 - _AT00_PV INT 0 AT PV  

K1876 - _AT00_MV INT 0 AT MV 

K1877~1879 
%KW1877 

~%KW1879 
Reserved  Word 0 Reserved area 

[Table 15.12 K area flags for auto-tuning] 
K1856 ~ K1859 areas (In case of IEC type, %KW1856~%KW1859) are the common bit areas for 
auto-tuning and each bit represents auto-tuning loop status respectively. K1860~K1879 areas save 
the setting and status of loop 0 as the K area for auto-tuning loop 0. In the area, the parameters 
such as PV, operation cycle and etc set in the built-in parameter window are saved and the XGB 
built-in auto-tuning function executes auto-tuning by the device values and saves the results into the 
K areas.  
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(2) Auto-tuning flag function 

  Each function of K area flags for XGB series auto-tuning is summarized as follows.  

   

A) Common bit area 
The area is a flag collecting operation setting and information consisting of bits to each 16 loop. 
Each bit of each word device represents the information of each loop.  
 

1) _AT_REV (auto-tuning run direction setting) 
 
 
 
 

 
It determines the run direction of auto-tuning of ‘n’ th loop. If the bit is off, it is forward operation; 
if on, it is reverse operation.  
 

2) _AT_PWM_EN (PWM output enable) 
 
 
 
 

 
It sets whether to output the auto-tuning MV of ‘n’ th loop as PWM output. If the bit is off, it is 
disabled; if on, it is enabled.  
 

3) _AT_ERROR (Auto-tuning error occurrence) 
 
 
 
 

 
It indicates the error in case an error that discontinues operation during auto-tuning of ‘n’th loop 
occurs. If an error occurs, it is on; if normal, it is off. Once an error occurs, auto-tuning stops 
and the MV is output as the min. output set in the parameter. Also, if an error occurs, it 
indicates the error code in the error code area of a loop. For more information about error code 
types and measures, refer to 15.5. The area, as a dedicated monitor area, is updated although 
a user directly enters it.  
 

B) Auto-tuning flag area by loops 
The auto-tuning flag areas by loops are K1860 ~ K2179 and each 20 words per loop are 
allocated to totally 16 loops. Therefore, individual data area of ‘n’ th loop is between K 
(1860+16*n) ~ K (1879+16*n). 
 
1) _ATxx_SV (auto-tuning xx Loop SV setting) 

 
 
 
 

 
It sets/indicates the auto-tuning SV of ‘xx’th loop.  
The available scope is between -32,768 ~ 32,767.  

 

Flag name Address IEC type address Unit Setting 

_AT_REV  

(PID RUN direction setting) 
K1856n %KX29696 + n BIT Available 

Flag name Address IEC type address Unit Setting 

_AT_PWM_EN  

(PWM output enable) 
K857n %KX29713 + n BIT Available 

Flag name Address IEC type address Unit Setting 

_PID_ERROR  

(PID error occurrence) 
K1858n %KX29728 + n BIT Unavailable 

Flag name Address IEC type address Unit Scope 

_ATxx_SV  

(AT xx Loop SV setting) 
K1860+16*xx %KW1860+16*xx INT -32,768 ~ 32,767 
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2) _ATxx_T_s (Auto-tuning xx Loop operation cycle) 

 
It sets/indicates the operation cycle of ‘xx’ th loop auto-tuning. The available scope is 100 ~ 
65,535. 
 

3) _ATxx_MV_max, _ATxx_MV_min(max. MV, min. MV) 

 
It sets max. MV and min. MV of ‘xx’ th loop respectively. If the max. MV is set lower than min. 
MV, the auto-tuning loop generates an error and does not work.  
 

4) _ATxx_PWM (AT output junction setting) 

 
It sets the junction that PWM output of ‘xx’th loop is output. The PWM output junction is valid 
only between H’20 ~ H’3F (hex). If any other value is entered, PWM output does not work.  
 

5) _ATxx_PWM_Prd (PWM output cycle setting) 

 
It sets the PWM output cycle of ‘xx’ th loop. The available scope is between 100 ~ 65,535 at the 
unit of 0.1ms.  
 

6) _ATxx_HYS_val (Hysterisis setting) 

 
It sets the hysterisis of ‘xx’ th loop. For more information about hysterisis function, refer to 6.3.3 
Auto-Tuning Parameter Setting. If it is set as 0, it does not work.  
 

7) _ATxx_STATUS (Auto-tuning status) 

 
It indicates the auto-tuning status of ‘xx’ th loop. If auto-tuning is in operation, it is 1;  
if completed, it is 128. In any other cases, it shows 0.  
 

Flag name Address IEC type address Unit Scope 

_PIDxx_T_s 

(Auto-tuning xx Loop operation cycle) 
K1861+16*xx %KW1861+16*xx WORD 100 ~ 65,535 

Flag name Address IEC type address Unit Scope 

_PIDxx_MV_max (Max. MV) K1862+16*xx %KW1862+16*xx 
INT -32,768 ~ 32,767 

_PIDxx_MV_min (Min. MV) K1863+16*xx %KW1863+16*xx 

Flag name Address IEC type address Unit Scope 

_AT00_PWM  

(AT output junction setting) 
K1864+16*xx %KW1864+16*xx WORD H’20 ~ H’3F 

Flag name Address IEC type address Unit Scope 

_ATxx_PWM_Prd  

(PWM output cycle setting) 
K1865+16*xx %KW1865+16*xx WORD 100 ~ 65,535 

Flag name Address IEC type address Unit Scope 

_ATxx_HYS_val (Hysterisis setting) K1866+16*xx %KW1866+16*xx WORD 0 ~ 65,535 

Flag name Address IEC type address Unit Scope 

_ATxx_STATUS  

(Auto-tuning status) 
K1867+16*xx %KW1867+16*xx WORD Unavailable 
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8) _ATxx_ERR_CODE (Error code) 

 
It indicates error code in case an error occurs during the auto-tuning of ‘xx’th loop. The flag, as 
a dedicated monitor, is updated although a user directly enters it. For more information about 
error code, refer to 15.5.  
 

 
9) _ATxx_K_p, _ATxx_T_i, _ATxx_T_d (AT result proportional coefficient, integral time, differential 

time) 

 
The area indicates proportional coefficient, integral time and differential time calculated after 
the auto-tuning of ‘xx’ th loop is normally completed. The flag, as a dedicated monitoring, 
updated although a user directly enters it.  
 

10) _ATxx_PV (PV) 

 
It is the area to receive PV of ‘xx’ th auto-tuning loop. PV is the present status of a system to 
control and in case of PID control, the entry from a sensor is saved into U device through input 
devices such as A/D input module and it moves the value to _ATxx_PV by using commands 
such as MOV every scanning, executing auto-tuning.  
 

11) _ATxx_MV (Auto-tuning MV) 

 
It is the area to output MV of ‘xx’ th auto-tuning loop. Every auto-tuning cycle, it saves XGB 
auto-tuning and it delivers the value in the area by using commands like MOV in a program and 
operates a drive every scanning.  
 

Flag name Address IEC type address Unit Scope 

_ATxx_ERR_CODE  

(Error code) 
K1868+16*xx %KW1868+16*xx WORD Unavailable 

Flag name Address IEC type address Unit Scope 

_ATxx_K_p  

(proportional coefficient) 
K1869+16*xx %KD934+20*xx 

Real Unavailable 

_ATxx_T_i  

(integral time) 

K1871+16*xx %KD1004+20*xx 

_ATxx_T_d  

(differential time) 

K1873+16*xx %K1005+20*xx 

Flag name Address IEC type address Unit Scope 

_ATxx_PV (PV) K1875+16*xx %KW1875+16*xx INT -32,768 ~ 32,767 

Flag name Address IEC type address Unit Scope 

_ATxx_MV (auto-tuning MV) K1876+16*xx %KW1876+16*xx INT Unavailable 
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15.4.5 Auto-tuning instructions 
       

The commands used in XGB series auto-tuning are as follows. 

 

1) PIDAT 
PIDAT is a command to execute auto-tuning by loops.  

 

  

- Operand S means the loop no. to execute auto-tuning and avaiable only for constant(0~15). 

- If start junction is on, the PID control of a loop starts. 

- In case of IEC type, the following PIDAT function block is used for start of auto-tuning 
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15.5 Example Programs 
 

The paragraph explains example programs regarding the directions of XGB built-in PID function.  

The example programs are explained with water level system as illustrated in 15.17.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 [ Figure 15.17 Example of water level control system ] 

 
15.5.1 System structure 

 

The example system in figure is an example of a system to control a pail’s water level to a desired 

level. The pail’s water level is sensed by a water level sensor and entered to A/D input module while 

PID control operation result, MV is output to a pump through D/A output module, controlling a pump’s 

rotation velocity, regulating the water amount flowing into a pail and regulating the water level as 

desired. Each mechanism is explained as follows.   

 

(1) XGB basic unit  
The XGB basic unit operates by PID control operating PID control operation. It receives PV from 
A/D input module (XBF-AD04A), executes the built-in PID control operation, output the MV to D/A 
(XBF-DV04A) and executes PID control.  

 
(2) A/D input module (XBF-AD04A) 

It functions as receiving PV of an object to control from a water level sensor and delivering it to 
basic unit. XBF-AD04A is a 4CH analog input module and settings of analog input types and 
scopes can be changed in the I/O parameter setting window appeared when selecting I/O 
parameter in the parameter item of project window. For more information, refer to Analog I/O 
Module.  
 

(3) D/A output module (XBF-DV04A) 
It functions as delivering control MV from basic unit to a drive (pump). XBF-DV04A is a 4CH 
analog voltage output module and ranges 0 ~ 10V. For detail setting, refer to Analog I/O Module.  

수통 
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Tank 
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(4) Water Level Sensor 
A water level sensor plays a role to deliver the PV of an object to control to XGB by measuring the 
water level of a pail and outputting it within 0 ~ 10V. Since the types and output scope of water 
level sensors varies, the output scope of a sensor should be identical with that of A/D input 
module’s input scope. The example uses a water level sensor outputting between 0 ~ 10V.  
 

(5) Drive (pump) 
A drive uses a pump that receives control output of XGF-DV04A and of which rotation velocity is 
variable. For accurate PID control, the output scope of XBF-DV04A (0~10V) should be same with 
that of a pump’s control input. The example uses a pump that receives its control input between 0 ~ 
10V.  
 

15.5.2. Example of PID Auto-tuning 
 

Here, with examples, it explains how to calculate proportional constant, integral time and differential 

time by using PID auto-tuning function  

 

(1) PID auto-tuning parameter setting 

 

(a) If double-clicking Parameter – Built-in Parameter – PID – Auto-tuning parameter in the 

project window, it opens up the auto-tuning parameter setting window as illustrated in 

Figure 15.18.  

 

 
                            [Figure 15.18 Auto-tuning parameter setting window] 

  

(b) Set each parameter and click OK.  

In the example, Loop 0 is set as follows.  

 

 RUN direction: forward  
  - Since in the system, water level is going up as MV increases and pump’s rotation 

velocity increases, it should be set as forward operation.  
 

 PWM output: disabled 
  - In the example, auto-tuning using PWM is not executed. Therefore, PWM output is set 

as disabled. 
 

 SV: 1000(2.5V) 
- It shows an example in which XBF-AD04A is set as the voltage input of 0~10V. 
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 Max. MV: 4000 
  - Max. MV is set as 4000. If MV is 4000, XBF-DV04A outputs 10V.  
 

 Min. MV: 0 
- Min. MV is set as 0. If MV is 0, XBF-DV04A outputs 0V.  

 

 PWM junction, PWM output cycle 
- It is not necessary to set it because the example does not use PWM output.  

 

 Hysteresis setting: 10 

 

(2) A/D input module parameter setting 

 

(a)  If double-clicking Parameter – I/O parameter, it opens up the setting window as illustrated 

in figure 15.19.  

 
[ Figure 15.19 I/O parameter setting window ] 

 

(b)  If selecting A/D module for a slot in A/D input module, it opens up the setting window as 

illustrated in Figure 15.20.  

 
[ Figure 15.20 A/D input mode setting window ] 

 

(c) Check A/D Module operation parameter and click OK. The example is set as follows.  

 

 RUN CH: CH0 RUN  
  - The example receives the water level sensor input as CH0. 
 

 Input scope: 0 ~ 10V  
  - Set XBF-AD04A input scope as 0 ~ 10V so that it should be identical with the output 
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scope of water level sensor.  
 

 Output data type: 0 ~ 4000  
  - It converts the input 0 ~ 10V to digital value from 0 ~ 4000 and delivers it to basic unit.  

- In the case, the resolving power of digital value 1 is 10/4000 = 2.5mV 
 

 Filter process, averaging: disabled 
  - The example sets the input values in order that filter process and averaging are not 

available.  
- For more information about each function, refer to 12 Analog I/O Module.  

 
 

(3) D/A Output Module Parameter setting 

 

(a) Set the parameter of D/A output module(XBF-DV04A) that output MV to a drive.  

How to set them is as same as A/D input module. In the example, it is set as follows.  

 

 
 

 RUN CH: CH0 RUN  
  - In the example, MV is output as CH0 of D/A output module.  

 Output scope : 0 ~ 10V  

 Input data type: 0 ~ 4000  
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4) Example of PID Auto-tuning program 

The example of PID auto-tuning program is illustrated as Figure 15.21. 

 

 
< Figure 15.21 Auto-tuning example program > 

 

(a) Devices used  

     

Device  Data type Application 

F0099 BIT It is always on, so it readily operates once PLC is RUN. 

U01.01.0 BIT It starts operation of CH0 of Slot 1 A/D input module. 

U02.02.0 BIT It starts operation of CH0 of Slot 2 D/A output module. 

U01.02 INT PV entered to A/D input module. 

U02.03 INT MV entered to D/A output module. 

K1875 INT Device to which PV is entered for LOOP 0 auto-tuning 

K1876 INT Device to which auto-tuning MV of LOOP 0 is output. 

K18677 BIT Junction that is on once auto-tuning is complete. 

K18580 BIT Junction that is on once auto-tuning has an error. 

K1863 INT Min. MV of auto-tuning designated in parameter. 

 

(b) Program explanation  

1) Since F0099(always on) is ON if PLC is converted form STOP to RUN, CH0 of A/D and D/A 

starts operating.  

2) At the moment, PV entered to CH0 is moved to K1875, the input device of PV and saved 

accordingly.  

3) Once M0000 junction is on, the auto-tuning of loop 0 starts.  

4) The auto-tuning MV of loop 0 that is output by PIDAT command is output to D/A output 

module by line 14 MOV command.  
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5) If auto-tuning is complete or there is any error during auto-tuning, M0001 junction is set, 

blocking operation of PIDAT command and it outputs min. MV set in parameter to D/A 

output module.  

 

(c) Monitoring and changing PID control variables using K area 
In XGB series built-in auto-tuning, it can monitor and change RUN status of auto-tuning by 
using K area allocated as fixed area by loops.  

 
1) Variable registration 

If selecting “Register in Variable/Description” by right clicking in the variable monitor 
window, “Variable/Device Selection” window appears. Select “Item” as PID, deselect 
“View All” and enter 0(means loop number) in “Parameter No”, K area device list to save 
every setting and status of loop 0 appears as shown Figure 15.22. Then, if selecting a 
variable to monitor and clicking “OK”, a selected device is registered to variable monitor 
window as illustrated in Figure 15.23. Through the monitor window, a user can monitor 
auto-tuning run status or change the settings.  

 

 
  [Figure 15.22 Variable registration window] 

 
 

 
[Figure 15.23 Auto-tuning variables registered]



XGB Analog edition manual  

15 - 48 

 

 

        (d) In case of IEC type, example program 

           In case of IEC type, the following program is used. 
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(5) Observing RUN status by using trend monitor function 
Since it is possible to monitor the operation status of XGB series built-in auto-tuning graphically, 
it is useful to monitor the operation status of auto-tuning clearly.  
(a) If selecting Monitor – Trend monitor menu, it shows the trend monitor widow as illustrated in 

Figure 15.24.  

 
    [ Figure 15.24 Trend Monitor window ] 
 

(b) If right-clicking trend setting, a user can select a variable to monitor as illustrated in Figure 
15.25.  

 
[ Figure 15.25 window to register trend monitor variable ] 

 
(c) For more information about trend monitor, refer to “XG5000 Use’s Manual.” 

 



XGB Analog edition manual  

15 - 50 

 

 
15.5.3. Stand-along operation after PID Auto-Tuning 
 

Here, with example, it explains how to execute PID control followed by PID auto-tuning. 

 

(1) PID auto-tuning parameter setting 

 

▪ PID auto-tuning parameters are set as same as examples of 15.4.2 Example of PID Auto-

tuning. 

 

(2) Setting parameters of A/D input module and D/A output module 

 

▪ Set the parameters of A/D input module and D/A output module as same as the example in 

15.4.2 Example of PID Auto-tuning. 

 

(3) PID parameter setting 

 

(a)  If double-clicking Parameter – Built-in Parameter – PID – PID Parameter, it shows the 

built-in PID parameter setting window as seen in Figure 15.26.  

 

 
[ Figure 15.26 Auto-tuning parameter setting window ] 

  

(b) Set each parameter and click OK.  

In the example, Loop 0 is set as follows.  

 

 RUN mode: automatic  
  - Set as automatic in order that PID control is executed as the built-in PID operation 

outputs MV.  
 

 RUN direction: forward 
- Since in the system, water level is going up as MV increases and pump’s rotation 

velocity increases, it should be set as forward operation. 
 

 PWM Output: disabled 
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  - In the example, auto-tuning using PWM is not executed. Therefore, PWM output is set 
as disabled. 

 
 

 SV: 1000(2.5V) 
- It shows an example in which XBF-AD04A is set as the voltage input of 0~10V 

 

 Operation cycle: 1000 
- In the example, it is set that PID control is executed every 100ms.  

 

 Proportional gain, integral time and differential time 
  - It should be initially set as 1,0,0 because PID auto-tuning results is used with PID 

constant.  
 

 Max. MV: 4000 
  - Max. MV is set as 4000. If MV is 4000, XBF-DV04A outputs 10V. 
 

 DeadBand: 0 
  - It is set as 0 because the example does not use DeadBand function. 
 

 Differential filter setting: 0 
  - it is also set as 0 because the example does not use differential filter. 
 

 Min. MV: 0 
- Min. MV is set as 0. If MV is 0, XBF-DV04A outputs 0V. 

 

 PWM junction, PWM output cycle 
- It is not necessary to set them because the example does not use PWM output. 

 

 SV ramp, PV follow-up: 0 
- It is not necessary to set SV ramp and PV follow-up because the example does not 

use them.  
 

 Min. PV, Max. PV: 0 
- Set them as 0 and 4000 respectively so that it could be identical with A/D input 
module’s input scope.  
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(c) Example of PID control program after PID auto-tuning 

The program example for PID auto-tuning is illustrated as Figure 15.27. 

 

 
 [Figure 15.27 Example program of PID control after auto-tuning] 

 

1) Devices used 

     

Device Data type Application 

F0099 BIT It is always on, so it readily operates once PLC is RUN. 

U01.01.0 BIT It starts operation of CH0 of Slot 1 A/D input module. 

U02.02.0 BIT It starts operation of CH0 of Slot 2 D/A output module. 

U01.02 INT PV entered to A/D input module. 

U02.03 INT MV entered to D/A output module. 

K1875 INT Device to which PV is entered for LOOP 0 auto-tuning 

K1876 INT Device to which auto-tuning MV of LOOP 0 is output. 

K18677 BIT Junction that is on once auto-tuning is complete. 

K18580 BIT Junction that is on once auto-tuning has an error. 

K1863 INT Min. MV of auto-tuning designated in parameter. 

K1229 INT Device to which PV is entered for Loop 0 PID control 

K1876 INT Device to which MV of loop 0 PID control is output. 
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2) Program explanation  

 

a) Since F0099 (always on) is ON if PLC is converted form STOP to RUN, CH0 of A/D and 

D/A starts operating.   

b) Once M0000 junction is on, the auto-tuning of loop 0 starts. At the moment, PV entered to 

CH0 is moved to K1875, the PV input device of loop 0 and saved accordingly.  

c) The auto-tuning MV of Loop 0 output by PIDAT command is output to D/A output module 

by line 11, MOV command.  

d) Once auto-tuning is complete, it moves P, I, D coefficients generated from auto-tuning to 

the input devices of P, I and D, K1218,K1220 and K1222, sets M001 and starts the 

operation of PID loop 0.  

 
 
            3) In case of IEC type, program example is as shown below. 
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15.6 Error/Warning Codes 
 

It describes error codes and warning codes of the XGB built-in PID function. The error codes and 

warning codes that may occur during use of the XGB built-in PID function are summarized as table.  

If any error or warning occurs, remove potential causes of the error by referring to the tables.  

 

15.6.1. Error codes 

 

Error 
codes 

Indications Measures 

H’0001 MV_MIN_MAX_ERR 
It occurs when max. MV is set lower than min. MV. Make 
sure to set max. MV larger than min. MV.  

H’0002 PV_MIN_MAX_ERR 
It occurs when max. PV is set lower min. Pv. Make sure to 
set max. PV larger than min. PV. 

H’0003 PWM_PERIOD_ERR 
It occurs when the period of auto tuning or PID operation 
loop is set under 100(10ms). Make sure to set output 
period more than 100. 

H’0004 SV_RANGE_ERR 

It occurs when SV is larger than PV at the start time of 
auto-tuning if auto-tuning is forward or when SV is larger 
than PV at the start time of auto-tuning if auto-tuning is 
reverse. 

H’0005 PWM_ADDRESS_ERR 
It occurs when the junction designated as PWM output 
junction is beyond between P20 ~ P3F.  

H’0006 P_GAIN_SET_ERR It occurs when proportional constant is set lower than 0. 

H’0007 I_TIME_SET_ERR It occurs when integral time is set lower than 0. 

H’0008 D_TIME_SET_ERR It occurs when differential time is set lower than 0. 

H’0009 CONTROL_MODE_ERR It occurs when control mode is not P, PI, PD or PID.  

H’000A TUNE_DIR_CHG_ERR 
It occurs when operation direction is changed during auto-
tuning. Never attempt to change operation direction during 
auto-tuning.  

H000B PID_PERIOD_ERR 
It occurs when period of operation is smaller than 100 
(10ms) at Auto-tuning or PID operation.  
Make sure to set period of operation larger than 100.  

H000C HBD_WRONG_DIR 

In mixed operation, It occurs when the direction parameter 
of forward operation set to reverse operation or the 
direction parameter of reverse operation set to forward 
operation. Make sure set to appropriate direction  each 
loop.  

H000D HBD_SV_NOT_MATCH 
In mixed operation, it occurs when the Set value of each 
loop is not concurrent. Make sure set to Set value 
concurrently.  

                                  [Table 15.13 : PID error codes] 
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15.6.2. Warning codes 

 

Error 
codes 

Indications Measures 

H’0001 PV_MIN_MAX_ALM It occurs when the set PV is beyond the min./max. PV.  

H’0002 PID_SCANTIME_ALM 
It occurs when PID operation cycle is too short. It is 
desirable to set PID operation cycle longer than PLC scan 
time.  

H’0003 PID_dPV_WARN 
It occurs when the PV change of PID cycle exceeds PV 
change limit.  

H’0004 PID_dMV_WARN 
It occurs when the PV cycle MV change exceeds MV 
change limit.  

H’0005 PID_MV_MAX_WARN 
It occurs when the calculated MV of PID cycle exceeds the 
max. MV.  

H’0006 PID_MV_MIN_WARN 
It occurs when the calculated MV of PID cycle is smaller 
than the min. MV 

[Table 15.14 : PID error codes] 
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Appendix 1 Standard Resistor of RTD  

 

Pt100Ω 

-200 18.52                   

-100 60.26 56.19 52.11 48.00  43.88 39.72 35.54 31.34 27.10  22.83 

0 100.00  96.09 92.55 88.22 84.27 80.31 76.33 72.33 68.33 64.30  

Temp.(℃) 0  10 20 30 40 50 60 70 80 90 

0 100.00  103.90  107.79 111.67 115.54 119.40  123.24 127.08 130.90  134.71 

100 138.51 142.29 146.07 149.83 153.58 157.33 161.05 164.77 168.48 172.17 

200 175.86 179.53 183.19 186.84 190.47 194.10  197.71 201.31 204.90  208.48 

300 212.05 215.61 219.86 222.68 226.21 229.72 233.21 236.70  240.18 243.64 

400 247.09 250.53 253.96 257.38 260.78 264.18 267.56 270.93 274.29 277.64 

500 280.98 284.30  287.62 290.92 294.21 297.49 300.75 304.01 307.25 310.49 

600 313.71          

JPt100Ω 

-200 17.14                   

-100 59.57 55.44 51.29 47.11  42.91 38.68 34.42 30.12 25.80  21.46 

0 100.00  96.02 92.02 88.01 83.99 79.96 75.91 71.85 67.77 63.68  

Temp.(℃) 0  10 20 30 40 50 60 70 80 90 

0 100.00  103.97  107.93 111.88 115.81 119.73  123.64 127.54 131.42  135.3 

100 139.16 143.01 146.85 150.67 154.49 158.29 162.08 165.86 169.63 173.38 

200 177.13 180.86 184.58 188.29 191.99 195.67  199.35 203.01 206.66  210.3 

300 213.93 217.51 221.15 224.74 228.32 231.89 235.45 238.99  242.53 246.05 

400 249.56 253.06 256.55 260.02 263.49 266.94 270.38 273.8 277.22 280.63 

500 284.02 287.4 290.77  294.12 297.47 300.8 304.12 307.43 310.72 314.01 

600 317.28               
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Appendix 2 Thermo Electromotive Force and Compensating Cable 

 

2.1 Table of Thermo Electromotive Force 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

unit: ㎶  Type K 

Temp. 
(℃) 

Temp. 
(℃) 

Type J 

Temp. 
(℃) 

Temp. 
(℃) 

unit: ㎶ 
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        Type T 

 

        

 

 

 

         Type R 

  

 

 

 

 

        

 

 

unit : ㎶ 

unit: ㎶ 
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 2.2.1 Common limit and overheat limit 

 

Symbol of materials 
Former symbols 

(cf) 
Nominal diameter 

(mm) 

Common limit (1) 

C 

Overheat limit (2) 

C 

K CA 

0.65 650 850 

1.00 750 950 

1.60 850 1050 

2.30 900 1100 

3.20 1000 1200 

J IC 

0.65 400 500 

1.00 450 550 

1.60 500 650 

2.30 550 750 

3.20 600 750 

T CC 

0.32 200 250 

0.65 200 250 

1.00 250 300 

1.60 300 300 

R - 0.50 1400 1600 

 
 
 

Remarks  

      (1): common limit refers to the temperature limit that continuously use in the air. 
      (2): overheat limit refers to the temperature limit that may inevitably use for a short time.  

 

 

 

 

 

 

 

     

 

 

 

 

2.2 Thermocouple  
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2.2.2 Allowance by temperature 

 

Symbol of materials Former symbols (cf) Temperature Grade Allowance 

K CA 

0 C ~ lower than 1000C 0.4 1.5C or 0.4% of temperature measured 

0C ~ lower than 1200C 0.75 2.5C or 0.75% of temperature measured 

-200C~ lower than 0C 1.5 2.5C or 1.5% of temperature measured 

J IC 

0C~ lower than 750C 0.4 1.5 C or 0.4% of temperature measured 

0C~ lower than 750C 0.75 2.5C or 0.75% of temperature measured 

T CC 

0C~ lower than 350C 0.4 0.5C or 0.4% of temperature measured 

0C~ lower than 350C 0.75 1C or 0.75% of temperature measured 

-200C~ lower than 0C 1.5 1C or  1.5% of temperature measured 

     R - 0 C ~ lower than 1600C 0.25 1.5 C or 0.25% of temperature measured 

 
 

Remark  

Allowance refers to the allowable max. limit subtracting the actual temperature of junction from the converted temperature, 

based on thermo electromotive force table. In addition, the allowance will be bigger one of C or %.  
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2.3 Compensating Cable 

 

     2.3.1 Type and specifications of compensating cable 

 
 

Type of 
compound 

thermocouple 
 

Type of 
compensating type 

Sectional ratio by 
application and 

allowance 

Materials 

Operating 
temp. 
range 

(C) 

Temp. 
of 

thermo.
and 

junction 

(C) 

Electric 
resistan

ce of 
compen
sating 
cable 

()(2) 

Electric 
resistan

ce of 
return 
cable 

()(2) 

Sheath 
colors 

Core cable’s color 

Remarks 

S
ym

bo
l 

F
or

m
er

 s
ym

bo
l 

sy
m

bo
l 

Fo
rm

er
 s

ym
bo

l 

+ point - point +  

K CA 

KX-G WCA-G 
Common for 
general us 

Alloy of 
nickel and 

chrome 

Alloy of 
nickel 

-20~90 

-20~150 

2.5 

1.5 

Blue Red White 

 

KX-GS WCA-GS 
Common for 
general use 

1.5 

KX-H WCA-H 
Common for 

heat-resistance 
0~150 

2.5 

KX-HS WCA-HS 
Common for 

heat-resistance 
1.5 

WX-G WCA-G 
Common for 
general us 

Iron 
Alloy of 
copper 

and nickel 

-20~90 

3.0 0.5 

 

WX-H WCA-H 
Common for 

heat-resistance 
0~150 

VX-G WCA-G 
Common for 
general us 

Copper 
Alloy of 
copper 

and nickel 
-20~90 -20~100 

2.5 

0.8 

J IC 

JX-G WIC-G 
Common for 
general us 

Iron 
Alloy of 
copper 

and nickel 

-20~90 

-20~150 

0.8 Yellow Red White 

 

JX-H WIC-H 
Common for 

heat-resistance 
0~150 

T CC 

TX-G WCC-C 
Common for 
general us 

Copper 
Alloy of 
copper 

and nickel 

-20~90 
2.0 

0.8 Brown Red White  

TX-GS - 
Precise for 
general use 

1.0 

TX-H WCC-H 
Common for 

heat-resistance 
0~150 

2.0 

TX-HS - 
Precise for 

heat-resistance 
1.0 

R - 

Rx-G 
- 
 

Common for 
general us 

Copper 
Alloy of 
copper 

and nickel 

0~90 

0~150 

+3(1) 

0.1 Black Red White 

RX-H 
Common for 

heat-resistance 
0~150  - 7 

 

Remark   

(1) The thermocouple electromotive force of thermocouple R and S is non-linear, so it does not indicate the actual temperature 
measurement error. 

    (2) applicable to nominal cross-sectional area of 1.25mm2 and more.     
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Appendix 3 Dimension 
 

1) Dimension of XBF-AD04A        

Unit: mm 

 

2) Dimension of XBF-DV04A / DV04C 

Unit: mm 
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3) Dimension of XBF-DC04A / DC04B / DC04C 

Unit: mm 

 

 

4) Dimension of XBF-RD04A / XBF-AD04C 

Unit: mm 

 

XBF-DV04A 

XBF-RD04A 

ALM 
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5) Dimension of XBF-TC04S        

Unit: mm 

 

6) Dimension of XBF-AH04A 

Unit: mm 

 

V↔I

XBF-AH04A
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7) Dimension of XBF-AD08A 

Unit: mm 

 
 

8) Dimension of XBO-AD02A 

Unit: mm 
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9) Dimension of XBO-DA02A 

Unit: mm 

 

 

10) Dimension of XBO-AH02A 

Unit: mm 
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11) Dimension of XBO-RD01A 

Unit: mm 

 

 

12) Dimension of XBO-TC02A 

Unit: mm 

 



 

 

 

 

 

Warranty and Environmental Policy 

 

 

 

     

 

 

Warranty 

 

 

1. Warranty Period 

 The product you purchased will be guaranteed for 18 months from the date of manufacturing.  

 

2. Scope of Warranty 

   Any trouble or defect occurring for the above-mentioned period will be partially replaced or repaired. However, please note the 

following cases will be excluded from the scope of warranty.  

  

(1) Any trouble attributable to unreasonable condition, environment or handling otherwise specified in the manual,  

(2) Any trouble attributable to others’ products, 

(3) If the product is modified or repaired in any other place not designated by the company,  

(4) Due to unintended purposes 

(5) Owing to the reasons unexpected at the level of the contemporary science and technology when delivered.  

(6) Not attributable to the company; for instance, natural disasters or fire 

 

 

3.  Since the above warranty is limited to PLC unit only, make sure to use the product considering the safety for system configuration 

or applications.  

 

 

 

 

Environmental Policy 

 

 

     LSIS Co., Ltd. supports and observes the environmental policy as below.  

 

 

 

  

 

LSIS considers the environmental preservation 

as the preferential management subject and 

every staff of LSIS use the reasonable 

endeavors for the pleasurably environmental 

preservation of the earth.   

 

 

     

LSIS’ PLC unit is designed to protect the 

environment. For the disposal, separate 

aluminum, iron and synthetic resin (cover) from 

the product as they are reusable.   

Environmental Management About Disposal 
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※ LSIS constantly endeavors to improve its product so that 
   information in this manual is subject to change without notice. 
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